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Notice

Saba Software, Inc. reserves the right to make changes in information contained
in this document without notice.

In no event shall Saba or its suppliers be liable for any damages whatsoever
(including, without limitation, damages for loss of business profits, business
interruption, loss of business information, or any other pecuniary loss) arising
out of or relating to this documentation or the information contained in it, even
if Saba has been advised of the possibility of such damages and whether arising
from tort (including negligence), breach of contract or otherwise.

This document may only be reproduced and distributed in whole for use by
licensed users. No part of this document may be reproduced in any form for any
other purpose without the prior written consent of Saba Software, Inc.

The software described in this documentation is copyrighted and is confidential
information and a proprietary product of Saba Software, Inc.

U.S. GOVERNMENT RESTRICTED RIGHTS. If licensee is the United States
Government or any contractor thereof, all licenses granted in the License
Agreement accompanying this product are subject to the following: (i) for
acquisition by or on behalf of civilian agencies, as necessary to obtain protection
as "commercial computer software" and related documentation in accordance
with the terms of this Commercial Software Agreement as specified in 48 C.F.R.
12.212 of the Federal Acquisition Regulations and its successors; (ii) for
acquisition by or on behalf of units of the Department of Defense ("DOD") as
necessary to obtain protection as "commercial computer software" and related
documentation in accordance with the terms of this commercial computer
software license as specified in 48 C.F.R. 227-7202-2 of the DOD F.A.R.
Supplement and its successors.

Saba and the Saba logo are registered trademarks of Saba Software, Inc. and
Saba product names are the trademarks of Saba Software, Inc. All other product
names mentioned in this manual are the property and may be trademarks or
registered trademarks of their respective owners, and are used for identification
purposes only.

© 2016 Saba Software, Inc. All rights reserved.
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New features at a glance by functional area

The below table summarizes the list of features introduced in the release and their potential impact on your environment.

o Note: Enabled by default does not necessary imply that the feature is immediately available to your users; it
may require a user with an appropriate administrator role to turn on applicable functionality, business rules, etc.

Table 1: Summary of features

Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
REST APIs Create a new_trammg un!t Developer
agreement using the Invoice Me o
payment method
APIs for retrieving, adding and o Developer
updating Delivery modes
Manager can now grant certific~ o Developer
ation/curriculum to a learner
Pass user-friendly IDs to REST o Developer
APIs
Assign, retrieve or remove an o Developer
owner of a Facility
Assign, retrieve or remove an o Developer
owner of a Location
Assign, retrieve or remove asso~ o Developer
ciations of a Job Role
Assign or retrieve a job of a Job o Developer
Family
Assign, retrieve or remove Job Developer
roles and Next career steps of a o
Job Type
Assign, retrieve or remove asso~ o Developer
ciations of an Organization
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support| configuration
ticket or data
to
enable

Assign, retrieve or remove asso~ ° Developer
ciations of a Competency
Search API to retrieve the de~ o Developer
tails of the security roles
APIs for retrieving, adding, up~ Developer
dating and deleting currency 0
exchange rates
APIs for retrieving, adding, up~ o Developer
dating and deleting list values
APIs for adding, updating, delet~ Developer
ing and retrieving Currency list o
of a person
The Create/Update Course Developer
REST APIs now considers the o
Customer Service Representat~
ive value
Audience Type to support ° Developer
Lookup
Merge Person's Profile API to Developer
support Audience type merge 0
and Person number swapping
GET THE DETAILS OF A Developer
PARTICULAR GOAL API to o
provide last progress details
Search for people based on Developer
whether they are marked as a 0
resource
APIs for retrieving, adding and ° Developer
updating Job Requistions
APIs for adding and updating ° Developer
Goals, Goal Progress and Status
API to mark a task/registration o Developer
module complete
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support| configuration
ticket or data
to
enable

API to delete a facility o Developer

Audience Type support for the Developer

Certification and Curriculum o

Search APIs

Lookup support for the Tran~ o Developer

script API

Lookup support for additional o Developer

REST APIs

Order details API to return Developer

Billing Address and Payment o

details

Enrollment details APl now o Developer

considers BST

PROFILE REST APIs auto-as~ o Developer

sign the OOB security roles

Caching for REST APIs o "Admin" user
System New settings for profile merge People admin

Terms and Conditions URL on System ad~ System admin

Sign Up page is configurable min

SMF enhancements o o "Admin" user

Support for Google Tag Man~ System ad~ o System admin

ager min

New keyword for Webhook ac~ o System ad~ End user

tions min

Rich text support for extended System ad~ All

custom fields min
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Enable new user creation notific~ o End user
ation for person data import
Search capability on import o System admin
monitoring pages
Import certain profile section o System ad~ System admin
data using person profile import min
Import approval policy for System ad~ System admin
courses and classes min
Record-level selective deletion System admin
o . . System ad~
of associations using data im~ .
min
port
Display CLOB data in import o System admin
logs
Support_to change unique II? for System ad- System admin
Transcript, Ad hoc Transcript o .
o min
and Person Profile imports
Changes to ILT/WBT class and o System ad~ Learning admin
course data imports min
Changes to certification and o System ad~ Learning admin
curricula data imports min
Bulk import ability for learning, . .
HR and people administrators Learning admin
o People admin
HR admin
Manage prescriptive rule when o People ad~ People admin
the rule creator is terminated min
New attributes in the Smart List o People ad~ People admin
criteria of a prescriptive rule min
Prescriptive rule member selec~ People admin

tion using local CSV upload
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Prescriptive rule for course and System admin
review can be executed by ad~ .
- L People admin
ministrator privileges
System ad~
. Performance ad~
min .
min
Learning admin
Unique URL for search results o All
Changes to the Team Overview o Manager
page
Dashboard level security to Svstem ad~ System admin
Benchmark module for Saba 4 min
Cloud Mabile application
New notification management System ad~ System admin
ul min
Analytics | Not contains as the new filter Analytics admin

operator

Analytics user

Report execution details to be
available on the top of the re~
ports

Analytics admin

Analytics user

Updated Reports

Analytics admin

Analytics user

New Reports

Analytics admin

Analytics user

Color picker accepts Hex color
code for Report Theme

Analytics admin

Analytics user

Grouping for Crosstab reports

Analytics admin

Analytics user

Quarterly and Hourly schedul~
ing of Analytics reports

© © © © ©  ©  ©

Analytics admin

Analytics user
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Functional
area

Feature

Enabled

by
default?*

Requires
admin
setup

Submit
a
Support
ticket
to
enable

Affects
existing
configuration
or data

Affected
audience

Report notice messages presen~
ted as notice bubbles

Analytics admin

Analytics user

Change in the behaviour of the
metric Unique Person Count

Analytics admin

Analytics user

Tent card reports

Analytics admin

Analytics user

Custom metrics support aggreg~
ation

Analytics admin

Analytics user

Reorder report filters

Analytics admin

Analytics user

Interchange axis/legend dimen~
sion values in a dashboard re~
port

Analytics admin

Analytics user

Additional attributes to support
dropdown (LOV)

Analytics admin

Analytics user

New Attributes

Analytics admin

Analytics user

Updated Attributes

©  ©  ©  © © © © ©  ©

Analytics admin

Analytics user

Share reports or dashboards
with specific users using man~
ager or employee as the audi~
ence

<

Analytics admin

Analytics user

Hide non-editable report filters

Analytics admin

Analytics user

Control the visibility of exten~
ded custom fields

Analytics admin

Analytics user
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Support for currency symbols Analytics admin
In reports o Analytics user
Attendance and Result Sum~ Analytics admin
mary by Class o Analytics user
Support for derived dimensions Analytics admin
o Analytics user
Branding support by domain Analytics admin
o Analytics user
Analytics to provide rich text Analytics admin
s_upport for extended custom o Analytics user
fields
Learning | Search enhancements for test o Learning admin
and survey assessments
Support for multiple questions Learning End user
per page in assessment player admin
Support to handle abrupt clos~ o End user
ure of an assessment
Hide correct answers while re~ Learning End user
viewing a test admin
Enhancements to the Manage o Learning admin
Test & Survey page
Persistent display of source Learning admin
language text for question o
translation
Display topic and section head~ Learning End user
ers in assessments admin
Improved survey scoring o Learning End user
admin
Adaptive branching in surveys Learning End user

admin




| New features at a glance by functional area | 16

Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Additional search filters in class S d Instructor
roster ystem ad~
min Learning admin
Roster print PDF enhancements s d Instructor
ystem ad~
min Learning admin
Configure display of credits on o System ad~ End user
completed learning of learners min
Display view credits link in o End user
catalog search results
Enhanced class and course de~ End user
tails pages
o Manager
Learning admin
Instructor
Display available credits in a o End user
popover
New reminder notification for End user
class commencement o System ad-~
min Learning admin
Enhanced order registration and End user
cancellation confirmation pages System ad-~
min Learning admin
Enhanced editing capability on o Learning admin
certification versioning
Restrict the ability to approve
or reject class enrollment re~ Manager
quests Alternate man~
System ad~ ager
min HR admin
People admin

Approver
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Enhanced remote content server All
security o 0
Course visible for request System admin
learning regardless of active System ad~
classes and associated curren~ o min End user
cies
Purchase a class in alternate o System ad~ End user
currency min
Ul indications related to registra~ Registrar
tions for registrar and learning o Learning admin
admin g
Buyer can view redemption End user
code in the order confirmation o
page
Choose the required credit card System ad~ System admin
type for payment o min End user
Fetch microsite configuration Svstem ad~ System admin
based on user's domain Y min o End user
Renew active subscriptions o End user
Buying learning items with de~ System admin
ferred payments System ad~ Registrar
min
End user
Show learner's preferred cur~ System admin
rency and shipping address System ad~
when Billing party is organiza~ min End user
tion
Set priority for refunds in case System admin
of split payment System ad~ End user
min

Registrar
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Shipping adcres ot ceails| Q)| SEmad- e s
ppPINg min Registrar
Select e-commerce configura~ System admin
. i : System ad~
tion based on domain or micros~ o .
ite min End user
Market~ Picker to select username and System admin
place the audience type while config~ o
uring a MicroApp
OAuth authentication support SystemAd~ System admin
for Adobe eSign integration min
Social Preview social files System ad~ o End user
min
Perform~ [ New settings for org objective o System ad~ System admin
ance ar_1d manager goals in My plan min End user
view
Update overall rating score via o System ad~ o System admin
RDI for active and completed min
reviews
Capture audit trail on updating o System ad~ System admin
the overall rating min
Performance ad~
min
End user
Attach files in a review Perform~ Performance ad~
ance admin min
Rater
Reviewee
Print To-Do List o End user
People admin and HRBP can o System ad~ System admin
access user's plan through pro~ min

file quicklinks

People admin

HRBP - Perform~
ance
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
Update approval flow for goals o People admin
End user
Manager
Recruiting Q?tglrtlonal keywords in offer o Recruiting Recruiting admin
admin Hiring manager
Assessment data prefilled when Candidate
candidate applies for another o
job
Default values in the component o System admin
attributes
Ul changes in the Hiring Team o Hiring team
view
Two step job application pro~ o Internal candidate
cess for internal candidates
Upgraded LinkedIn social au~
thentication APIs 0 End user
Ul enhancements in job requisi~ Recruiting admin
tion and job offer o Hiring manager
Recruiter
New fields on the job requisi~ - Recruiting admin
tion wizard o Recrm.t Ing .
admin Hiring manager
Compensa~ | Ul changes on budget distribu~ Compensation
tion tion for managers o Compensa~ admin
tion admin

Manager

Compensation letter enhance~
ments

Compensation
admin
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Functional | Feature Enabled | Requires | Submit Affects Affected
area by admin a existing audience
default?*| setup |Support | configuration
ticket or data
to
enable
New settings to show hide System admin
compensation statements and .
Svstem ad~ Compensation
letters Y! .
min admin
End user
People Snapshot Manager o Compensation
admin
Approved status for plan cycle Compensation
o admin
Manager
Usage of manager hierarchy Compensation
snapshot o admin
Manager
Talent Position word changed to job in
Career Planning 0 All
Job family field on Search by
Job popup o End user
Keys to Success functionality o System admin
in Career planning System ad~ Manager
min
End user
New setting to govern t_he _ System ad- System admin
Search by person functionality .
. . min End user
in Career Planning
N-box Ul changes
J (v Al
Ul enhancements for Career
o End user

planning
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New settings for profile merge

How did it work?

While merging a secondary person profile into a primary profile, Saba Cloud did not merge the audience types and
person number associated with the secondary profile.

How does it work now?

This update adds the following new settings to the Profile Merge page, which allow people administrators to merge the
audience types and person number associated with the secondary profile into the primary profile:
« Merge Audience Types and Sub Types

Select this checkbox to merge the audience types ans sub types associated with the secondary profile into the primary
profile.

e Swap Person Numbers

Select this checkbox to merge the person number associated with the secondary profile into the primary profile.
However, since a person number is unique in the system, the number is not directly merged; instead, the person
numbers of primary and secondary profiles are swapped with each other. This also provides the advantage where
the person number is carry forwarded so that it is treated as a lifetime ID for the user.



Profile Merge

Manage merging of Secandary profiles into Primary anes.

Frimary Profile* |

Secondary Profile* |

Secandary Profile Person Status | Select One- v | b
after merge. -

Merge Settings

Recalculate Completion Status for Cerifications/Curriculum
Merge Virtual And Blended Class Transcripts
WMerge Security Roles

Merge Audience Type
Swap Person Number

Figure 1: New settings on Profile Merge page

Use case
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While merging person profiles, organizations need additional settings that allow administrators to merge more person

attributes and associations from the secondary to the primary profile.

Terms and Conditions field on the Sign Up page is configurable

How did it work?

The Terms and Conditions field on the Sign Up page was not configurable.
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First Name*

Last Name*

Email*

Time Zone *
[GMT) Greenwich Mean Time : Dublin, Edinburgh, Lisbon, Londan =

[oa oo ( :
o o CAPTCHA
2

By clicking Sign Up, you agree to

SIGN UP

Already have an account? Sign in

Figure 2: Terms and Conditions text

How does it work now?

From this update, the Terms and Conditions field on the Sign Up page is made configurable by introducing a new field
Terms & Conditions URL in the mircosite. The system admin must navigate to System > Configure System >
Microsites > Click microsite name > Configure branding tab > 15. Terms & Conditions URL field and enter a valid
text and URL that includes the terms and conditions. The limit of this field is 512 characters.

13. Login Background Image C55

14. Mobile Assels

Uplead Tip File
Choose Fils | Mo fie chosen ) Cownioad
SAMplE 20

File URL.
hittpa: Magathdb 1 sabacked. comiproduc Bon/athdb 1 fpublic ATHDE | Ste_cesktDODI00000000001 _MobideAssats. 7ip

15. Terms & Conditions URL

hitp:ifaaba. com

Skip this st&p | Reset m

Figure 3: Terms & Conditions URL field in Microsite
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To add an URL, you must use HTML tags. For example, By clicking Sgn Up, you agree to the <a
href="http://mww.saba.com">Terms & Conditions</a>. The Terms & Conditions link will navigate the end user to

the actual terms & conditions.

Security Keyword

Organization

4
Custom1 label
Custom2_real_external
-Select One- v
|By clicking Sign Up, you agree to the T=rms and Condiions |

Already have an account? Sion in

Figure 4: Terms & Conditions field on Sign Up page

Use case

The admin can now configure Terms and Conditions field on the Sign Up page by adding a text and an URL.

SMF enhancements

How did it work?

Prior to this update:

e The SMF Health Dashboard did not display the source job ID for jobs created by other jobs.

« There was no support to retry or delete multiple jobs simultaneously.

« Ifatriggered job action failed, then the consecutive actions are not executed and the job exited right there.

« When SMF jobs were automatically or manually retried or when jobs were reprocessed due to JET restart or when
jobs were in-progress, users received duplicate emails.

How does it work now?

With this update, Saba Cloud provides the following SMF enhancements:

e Source Job ID

e The SMF Health Dashboard to display the new Source Job ID column. However, this column is displayed
only to Saba Cloud "admin™ users; it is not displayed to system administrators. If the source 1D is null for a job,
then the column entry for the job is blank.

e The Source Job ID is added as a job search criteria. This allows you to filter jobs based on the source job ID.



SMF Health Dashboard

Health Summary L1041

Queue Name

POD1scsmip.

PCD1.sc.smfi..

PCOD1.sc.smfa.

POD1.sc.smia.

PCD1.scsmia.

Range * Event

Today w

Start Date * Start Time

Job Id Source Job Id

Queus

v

Pr Pr Node
DEFALLT BE. aldspejetd00
INDEX alspcjetd002
DEFAULT.BE... aispcjetd0
DEFALULT BE... adspcjetd001
DEFALILT BE. adspcjetd00
DEFAULT BE... aldspcjetd001

POD1.sc.smip.

End Date

Status
SUCCESS

Source Node

adspcappd002

a3spcappd0o2

a3spcappdoo2

a3spcappd002

a3spcappd002

adspcappd002

Pags: |1

*®

¥ | Page Size:

Source Job Id

Site
» ATHDB1Site [PAID , TESTIBM]
* End Time
* Node
-
Source Object Id
nevnt000000000001220
index000000000001004

DatalmporCbject

ROILT Cffering

nevntD00000000120025

Figure 5: Source Job ID in SMF Health Dashboard

» Bulk Retry and Delete Jobs

27243279

27243300

27243300
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ey | SQ

| sepw |
Elapsed Time

Adds support to retry or delete multiple jobs simultaneously. Administrators can select multiple jobs by clicking the
checkboxes besides the job IDs and then click either the Retry or Delete button as required.
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SMF Health Dashboard

Page: |1 w | Page Size: |10 = Apply Q

Range * Event Site

Today v ASYNC v QADESite [PAID , QADE] v

Start Date * Start Time *  EndDate * End Time *

Job Id Source Job Id Status *  Node

FAILED w .
CQueue
s
Apply

WJob Id Job Name Status Site Processor Processed Node Queue Name
27321421 ExportRequestListener FAILED QADBSIte DEFAULT.BEM...  alspcjetdd0l POD1 .sc.smfa...
27321420 ExportRequestListener FAILED QADBSIte DEFAULT.BEN... a3spcjetd001 POD1.sc.smfa...
27321039 ExportRequestListener FAILED QADBSite DEFAULT,BEN adspcjetdd0l POD1 sc.smfa
27321038 ExportRequestListener FAILED QADBSite DEFAULT,BEN adspcjetd001 POD1 sc.smf.a
27319290 ExportRequestListener FAILED QADBSite DEFAULT,BEN... a3spcjetd(01 POD1.sc.smfa...
27320359 ExportRequestListener FAILED QADBESite DEFAULT,BEN... alspcjetd(01 POD1.sc.smfa...
27320358 ExportRequestListener FAILED QADBESIte DEFAULT.BEN...  alspcjetdd0l POD1.sc.smfa...
27320357 ExportRequestListener FAILED QADBSIte DEFAULT.BEN... a3spcjetdd01 POD1.sc.smfa...
27320356 ExportRequestListener FAILED QADBSite DEFAULT,BEN adspcjetdd01 POD1 sc.smfa
27320355 ExportRequestListener FAILED QADBSite DEFAULT,BEN... a3spcjetd01 POD1.sc.smfa...
Displaying 1 to 10 of 12 3

Figure 6: Retry or Delete Multiple Jobs Simultaneously

« Exception Handling of Jobs with Multiple Actions

If a triggered job has multiple actions and if one action fails with an exception, then it does not affect remaining
actions in the job; they now continue to execute. The job is marked failed if any action has failed, though.

» Duplicate Notification Handling

For every unique job-action instance, all email addresses to whom emails are successfully sent are now cached. When
the job is retried due to any reason, the cache is queried to check if the email notification is already sent. A new
email is sent only if no email was sent earlier to the intended email address. This feature uses the memcache so that
the data is remotely cached and not flushed due to restarts. This cache is refreshed to removed data for successful
jobs and failed jobs that are more than 30 days old on restart.

Note: This cache is not cleared by the flush all REST API of TenantManagementService. It can be cleared
individually.

Use case

An SMF job can be created by other parent jobs. Administrators need to search for jobs using the ID of a parent job and
even view the parent job ID.

Support for Google Tag Manager

How did it work?
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Prior to this update, Saba Cloud supported Google Analytics integration, which enabled administrators to configure
their own Google Analytics account and access their own Google Analytics data.

How does it work now?

This update provides support for integrating Google Tag Manager with Saba Cloud. If enabled, administrators can
manage tags (code snippets) for their sites using the Google Tag Manager.

To configure this integration, this update introduces a new setting and a new site-level property. To enable support for
Google Tag Manager, system administrators must enable both.

New Setting
Google Tag Manager
Possible values: On or Off

« If enabled, then Saba Cloud supports the Google Tag Manager.
« If disabled, then Saba Cloud supports Google Analytics.

Default value: Off

To configure this setting, navigate to Admin > System > Configure System > Services > Google Analytics >
Settings.

New Site-level Property for System administrators
Google Tag Manager

The Google Tag Manager code snippet that tracks all your tags. Copy the code snippet to this field. If the Google Tag
Manager setting under Google Analytics service is enabled for a site, then Saba Cloud reads the code snippet from this
property. If enabled, then system administrators can manage tags (code snippets) for the default site using the Google
Tag Manager.

To access this property, navigate to Admin > System > Configure System > Microsites > <default_sitename> >
Site Properties > Web Variables.

To manage tags using Google Tag Manager:

1. Go to tagmanager.google.com to create an account (or to access an existing account).
2. Create a container for your site in the account.
3. Add the container snippet to your site in the Google Tag Manager property.

New Site-level Property for Saba Cloud "‘admin"" users
Saba Google Tag Manager

The Google Tag Manager code snippet that tracks all Saba tags. Copy the code snippet to this field. If the Google Tag
Manager setting under Google Analytics service is enabled for a site, then Saba Cloud reads the code snippet from this
property. If enabled, then Saba administrators can manage tags (code snippets) for a Saba Cloud site using the Google
Tag Manager.

To access this property, navigate to System > Sites > <sitename> > Web Variables.
Use case

It is cumbersome to maintain tags (code snippets) for different websites and manually add them to your sites. Instead,
you can use a tag management solution such as the Google Tag Manager, which allows you to specify the tags that you
want to fire, and when you want them to fire, from within the Tag Manager user interface. Tag Manager uses its own
container tag that you can place on all your website pages.


https://tagmanager.google.com/
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New keyword for Webhook actions

How did it work?
N/A
How does it work now?

This update provides the capability to add a special keyword @SOURCE_ID@ to the Webhook URL or body. This
keyword internally resolves to the source ID of the object that triggers the notification.

= Note: This special keyword is not available from the Keyword dropdown for a Webhook action on the Saba Cloud
Ul; the keyword must be typed in.

Use case

There is a need to extend the Webhook event action to include more predefined keywords, which can be uses to define
JSON for Webhook configuration.

Rich text support for extended custom fields

How did it work?

Extended custom fields for components in Saba Cloud support only 255 characters and were not able to store HTML/rich
text.

How does it work now?

This update enhances the extended custom fields for components to support 1024 characters so that HTML/rich text
can be stored in them.

To change the data type, go to System > Configure System > <service-name> > Components <component-name> >
Attributes, and select the Rich Text from the Data Type column for the required extended custom attributes.

Extended Custom Attributes Add Extended Custom Atfribute | Print | Export | Modify Table
| Edit |Attributetab Ul Label Data Type | Delete |
7 ExCustom 1234 Rich Text v h 4
rd ExCustom2 ExCustom2 |Rich Text v | p 4
s BxCustom3 ExCustom3 String(255) value check ¥ x
7 ExCustomd4 ExCustomd String(255) value check x
Iy ExCustoms ExCustoms Integer v b 4
& BxCustomb ExCustoms String(255) value check ¥ X

Figure 7: New settings on Profile Merge page

Use case

There is a need to store HTML/rich text in extended custom fields for components.
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Unique URL for search results

How did it work?

When users performed a search using the global search, Saba Cloud displayed the search results on a page that had a
particular browser URL. Users could further narrow down the search results by applying various filters on the search
results page. However, each applied filter would change the browser URL of the results page.

How does it work now?

With this update, Saba Cloud provides the ability to generate a unique browser URL for global search results.

To generate the unique URL:

1. Search for the required resource using global search.

2. Apply filters as required to narrow down your search results.

3. Click the Generate URL link. Saba Cloud generates a unique URL based on the current filter conditions into the
browser URL.

You can then copy this unique URL and use it as a bookmark or a reference link.

communication/LEARNINGEVENT,OFFERINGTEMPLATE,CERTIFICATION,CURRICULUM,OFFERING, PACKAGE?st$si

& https://dglearning.sabacloud.com spf/Learning/commen/searchresults,

~ communication

Browse

Clear All | Bac(Generate URL, More than 61 results found for ‘communication’  Sortby | Relevance v| Resulisperpage |12 ¥ o= =
Learning Event Type

Apply -
Class/Course (235+ ] ] o

Delivery Type

Learning Catalog

Apply Filter | Clear Filter
Web-Based (164+

Language
Apply Filter = Clear Filter
English (164+

Interpersonal Communication: Interpersonal Communication: Listening Managing Communications ina Virtual Team
Communica ting Assertively Essentials e
Course (1 class) Course (1 class)
CPF: No
CPF: No CPF: No R

ousp ousD
Enroll

Enroll Enrol

Figure 8: Generate unique browser URL for search results

Use case

The browser URL of the search results page must remain the same irrespective of the filters being applied to narrow
down the results. This allows users to bookmark the URL or use it as a reference link consistently.

Dashboard level security to Benchmark module for Saba Cloud
Mobile application

How did it work?

Saba Benchmark functionality in Saba Cloud Mobile Application enable the organizations to gain real-time visibility
to make better decisions; leverage benchmarks to know where to focus; take quick actions to drive improvements; and
attract, develop, and retain employees more effectively. In Benchmark, dashboards are provided specifically on learning,
making the insights especially relevant for learning teams and leadership.
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This feature is available for all the Saba Cloud customers with a limited set of initial dashboards. The data comes from
completely anonymous, summary data observed in aggregate across Saba customers.

How does it work now?

From this update, each dashboard within the Benchmark tool will now be privilege based so that a security role can be
configured to allow a user to see a subset of the available dashboards. The viewing privileges for the Benchmarks
module in the mobile application will be set within Saba Cloud.

Note: To enable Benchmarks service, submit a support request. For assistance, contact your Customer Success
Manager.

[ N

To enable the view privileges for dashboards:

1. Navigate to Admin > System > Manage Security > Security Roles.
Search for and click the Benchmark Viewer security role.

Search for System component.

Enable the following privileges. By default, this privileges are disabled.

> wbd

a. View benchmark data: Allows the admin to view benchmark data in the available dashboards

b. View Learning Hours Dashboard Data: Allows the admin to view data in the Learning Hours Dashboard

c. View Utilization and Performance Dashboard Data: Allows the admin to view data in the Utilization and
Performance Dashboard

5. Click Save.

The admin needs to navigate to Admin > System > Manage Security > Security Roles and search for the role titled
Benchmark Viewer. You will want to validate that the necessary component has been enabled. Click the title to edit the
security role.
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Simple Security Role Details: Benchmark Viewer

Security Role* Benchmark Viewer
Description View benchmark data
Domain® world g
Tv Domain Based

ype Criteria Based

Components People
¥ ,

Component System .i

Component Privileges Print | Export | Modify Table

Grant Access | Privilege
Mew
Edit
Delete
View
Is Super Instructor
Can Access Analytics Menu
L4 View benchmark data
Admin View
Can Update Page Text
View Leaming Hours Dashboard Data
View Utilization and Performance Dashboard Data
Can Do Bulk Import

Figure 9: Privileges for Benchmark Viewer security role

Use case

While a Learning Admin should be able to view the benchmark data related to Learning, most companies will not want
to give them access to benchmark data outside of their domain of expertise. This dashboard-level security allows those
configurations to be possible.

New notification management Ul

How did it work?

Saba Cloud did not provide a way of searching for all notification events in the system. To see any notification event,
administrators had to navigate to the concerned service first and then see the associated notifications.

How does it work now?
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With this update, Saba Cloud provides a new user interface (Ul) for accessing all notification events in the system.

This Ul is not available by default. To enable the display of this new Ul for notification events, system administrators
must navigate to System > Configure System > Microsites > <sitename> > Site Properties > Web Variables, and
configure the following property:

* Rest Based Notification

If set to "true”, then the new Notifications Ul is enabled. If set to "false", the new Ul is not available.

To access the new Ul for notifications, navigate to System > Configure System > Notifications. The Notification

Events page appears.

System Home

Services

!\crol Pps

Notification Templates

Microsites.

Languages Type
Currencies

Exchange Rates

S50 Keys

ImportExport Configuration

Apply

Notification Dashboard
Manage Search et
Manage Integrations
Manage Security
Manage Engagement Tools
SAML S50 Errors
SMF
System Statistics

Configure Labels

Configure System Notifications Events

Triggered ¥

ICal Enabled Only: =] Enabled Events Cnly: [}

Name ~ Description

Compensation plan activated Triggered when a compensation plan is activated

Compensation plan has been reope... Triggered when compensation plan has been reopened by com...

Compensation plan marked comple Triggered when a compensation plan has been marked complet

Hot Content Digest Weekly Data Gather Weekly digest for Hot Contents, this event is responsible for data...

ltem Flagged Triggered when an item is flagged

Type

Triggered

Triggered

Triggered

Periodic

Triggered

Hide Filters

Export Print
Category

Compensation@Waork

Compensation@Work

Compensation@Waork

Collaboration

Collaboration

Figure 10: New Ul for notifications

The Notification Events page allows system administrators to:

 Search for the required notification event using the event name and description. Once you start typing in these fields,
matching strings are displayed in a dropdown for you to select.

« Use following advanced filters and click the Apply button to narrow down the search results:

* Type
« Category
» iCal Enabled Only

< Enabled Events Only

« Export the set of results by clicking the Export button.

Use case

A dedicated user interface to search for all notification events improves usability experience and reduces extra navigation

efforts for administrators.
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Enable new user creation notification for person data import

How did it work?

When new internal users were created in bulk in Saba Cloud using the person data import, Saba Cloud did not trigger
a "welcome" notification for the newly-created users.

How does it work now?

This update introduces the NEW_USER_NOTIFICATION functionality in data import functional metadata for both,
Person, Internal and Person, External objects. When this functionality is enabled, the application can use the following
system-level triggered notification events for person creation via data import:

* Internal person created
« External person created

However, these system-level notification events and actions must be enabled and correctly configured for this functionality
to work via data import.

g~ Note: To enable the feature, submit a support request. For assistance, contact your Customer Success Manager.

Table 2: Configure NEW_USER_NOTIFICATION functionality

Functionality Required Description
NEW_USER_NOTIFICATION YorN Y = Enabled
Default value: N N = Disabled

Example

The following query enables NEW_USER_NOTIFICATION functionality for "Person, Internal” object:

Update vet functional metadata
Set Required="Y"
Where object name="Person, Internal”
And functionality="NEW_USER_NOTIFICATION";
Supported Objects
The NEW_USER_NOTIFICATION functionality is applicable only to the following objects:

e Person, Internal
* Person, External

Use case

New internal users in an organization, who are created in bulk via data import, should be able to receive a welcome
notification email with instructions on accessing the application.
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Search capability on import monitoring pages

How did it work?

Saba Cloud did not provide any ability to search for imports on the monitoring pages for both Ul and scheduled imports.

How does it work now?

This update adds the following new search filters on the Import Monitoring pages for both Ul and scheduled data
imports:

e Input File
Specify the name of the data import file.
e Object Name
Select the name of the imported object from the dropdown list.
» Start Date >=
Specify a date. The search returns all imports that were processed after this date.
« Start Date <=
Specify a date. The search returns all imports that were processed before this date.

Specify the values in the search filters and click the Search button. The results matching your criteria are displayed in
the results table.

Import Monitoring Data Import Processes Monitoring

Data Import Process Refresh
Input File Cbject Name
w
Start Date == Start Date ==
Search
TimeZone: »
Start date End Date Input File Import Object Status Modified date
032272016 6:17 AM Persan, CPF.csv Persan, CPF Initiated 032272016 617 AM
031472016 3:31 AM Person, Internal_Worl... Person, Internal Initiated 03/14/2016 3:31 AM

Figure 11: New search filters on Import Monitoring page

Use case

Administrators need to narrow down results on the import monitoring pages based on various criteria.

Import certain profile section data using person profile import

How did it work?

Person Profile data import did not import a person's profile data such as Flight Risk, Retirement Risk, Potential Rating,
Languages, and so on through data import.
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How does it work now?

With this update, Saba Cloud enhances the Person Profile data import object to import data of following person profile
sections:

e Languages

» Potential Jobs

« Relocation Preferences Option

« Relocation Preferred Locations

e Career Interests

« Professional Interests, which include:

* Long-Term Aspirations
« Near-Term Aspirations

» Succession Details, which include:

e Flight Risk
* retirement Risk
* Potential Rating

To import this data, the following new fields are added to the Person Profile data import object:
Main Fields:

« FLIGHT_RISK
« RETIREMENT_RISK
 POTENTIAL_RATING

« RELOCATION_PREF_OPTION

« LONG_TERM_ASPIRATIONS

« LONG_TERM_ASPIR_TARGET DT
« NEAR_TERM_ASPIRATIONS

« NEAR_TERM_ASPIR_TARGET DT

g~ Note: The data in these fields can only be updated and rows with these fields cannot be added or dropped/deleted.

Association Fields:

« LANGUAGE_NAME

« LANGUAGE_SPEAKING_LEVEL

« LANGUAGE_READING_LEVEL

« LANGUAGE_WRITING_LEVEL

« LANGUAGE_NOTES

« POTENTIAL_JOB_NAME

« POTENTIAL_JOB_READINESS

« CAREER_INTERESTS JOB_TITLE
« CAREER_INTERESTS DESCRIPTION
« RELOCATION_PREF_LOCATION

« RELOCATION_PREF_DATE_AVAIL
« RELOCATION_PREF_ASSIGN_TYPE
« RELOCATION_PREF_LOC_COMMENTS

Note: Multiple entries for multiple records can be provided in a row of the data file to import multiple associations.
Associations fields can be extended up to as many as required.

Use case
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There is a need to import the person profile section data in bulk using data import.

Import approval policy data for courses and classes

How did it work?
Saba Cloud did not support bulk import of approval policies for courses and classes using data import.
How does it work now?

With this update, Saba Cloud enhances the course and class data import objects to support import of approval workflow
policy that has the following options:

< Do not override domain/course level policy
* No approval required

To implement this functionality, the MANAGER_APPROVAL_REQUIRED column is enhanced to support the following
new values:

« For pre-defined approval flow: 11, 12, 13, 14, 15, 16
« For manual approval flow: 100

Additionally, following new columns are added:

» For offerings: MANAGER_APPROVAL_FLOW
e For courses: MGR_APPROVAL_FLOW

These columns are used only when the MANAGER_APPROVAL_REQUIRED column value is 100.

The following table describes the mapping of the new values between columns.

Table 3: Mapping of values between columns

MANAGER_APPROVAL_REQUIRED |Description MANAGER_APPROVAL_FLOW /
MGR_APPROVAL_FLOW
11 Only Manager Approval re~ Not required
quired
N Manager OR Alternate Not required

Manager Approval Require

N Only Profile Additional | Ot reauired
Approver's Approval is Re~
quired

“ Not required

Manager OR Profile Addi~
tional Approver's Approval
is Required

15 Not required

Manager AND Profile Addi~
tional Approver's Approval
is Required
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MANAGER_APPROVAL_REQUIRED

Description

MANAGER_APPROVAL_FLOW /
MGR_APPROVAL_FLOW

Create Approval Chain giv~
en in approval flow column

16 Approval Chain > Manager Not required
at level 1 and "2nd Level
Manager" at Level 2

100 Required

Approval Flow String Syntax

START>LEVEL1[APPROVER KEYWORD1 #OR#/#AND# APPROVER KEYWORD2 #OR#/#AND#
APPROVER_KEYWORDN ] >LEVEL2[..] . -LEVELN[..]>END

Where,

 String starts with "START>" and ends with ">END".
e Level start with "LEVEL" followed by Level _number; keywords must be placed between "["* and "]". For example:

LEVEL1[KEYWORDS]

« Multiple keywords are separated by #OR# or #AND# as per requirement. For example, KEYWORD1 #OR#

KEYWORD2

» The following keywords are available for approval flow string:

« MANAGER
* ALTERNATE_MANAGER

* PROFILE_ADDITIONAL_APPROVER

« 2ND_LEVEL_MANAGER
* 3RD_LEVEL_MANAGER
*  SPECIFIC:<PERSON_USERNAME>

Example Strings
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Table 4: Example Strings

MANAGER_APPROVAL_ | Description |MANAGER_APPROVAL_FLOW / MGR_APPROVAL_FLOW
REQUIRED

100 Only 2nd Level
Manager START>LEVEL1[2ND_LEVEL_MANAGER]>END

100 Manager or Spe~
cific User ABC | START>LEVEL1[MANAGER #OR# SPECIFIC:ABC]>END

100 Manager and
Additional ap~ START>LEVEL1[MANAGER #AND# PROFILE_ADDITIONAL AP~
prover at level 1| PROVER]>LEVEL2[SPECIFIC:ABC]>END

and Specific
Person ABC at
level2

100 Manager or al~
ternate manager | START>LEVEL1[MANAGER #OR# ALTERNATE_MAN~

at levell, addi~ | AGER]>LEVEL2[PROFILE_ADDITIONAL_APPROVER #AND#
tional approver SPECIFIC:ABC]>LEVEL3[3RD_LEVEL_MANAGER]>END

and specific user
ABC on level2,
3rd level man~
ager on level 3

Supported Objects
This enhancement affects the following objects:

« Offering Template (Course)
e ILT Offering
«  WRBT Offering

Use case

There is a need to support bulk import of approval policies for courses and classes using data import.

Record-level selective deletion of associations using data import

How did it work?

Saba Cloud provided the ability to delete object associations at record level using data import for certain objects. However,
this ability was not available for certain other objects like Organization, Job Type, Location, and so on. To delete
associations of these remaining objects, users required the intervention of Saba Cloud administrators, who would then
configure the functional metadata of the specific association configured for that object.

How does it work now?

Saba Cloud allows system administrators to delete object associations at record level using data import for the following
objects:
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« Organization, Internal
e Organization, External
e Job Type

« Location

e Job Role

» Person Profile

System administrators can selectively remove or remove all existing associations of records from these objects as follows:
» DELETE_ prefix (Delete specific association of a record)

To support deletion of specific association, system administrators must add association with
DELETE_<ASSOCIATION_COLUMN> prefix in header and pass corresponding values in the data file. It also
supports "N" number of association deletion with a number suffix.

For example, when the import encounters the following record for association of attachments in "Organization,
Internal™ object, it processes deletion first, deleting doc3 and doc4 attachments passed under
DELETE_ATTACHMENT_ NAMEL|DELETE_ATTACHMENT NAME?2 and then associates docl and doc2
passed under ATTACHMENT_NAME1|ATTACHMENT_NAME?2 for the specific record. The sequence number
for add and delete actions is independent of each other.

ATTACHMENT NAME1 JATTACHMENT NAME2|DELETE_ATTACHMENT NAME1|DELETE_ATTACHMENT NAME2
docl]doc2]doc3]doc4

Note: For the new record-level delete feature to work, the object-level delete functionality
DROP_EXISTING_<Association> (e.g.; DROP_EXISTING_ATTACHMENT_NAME) must be OFF (add
association cumulatively, which is the default setting). If this functionality is ON, then it takes precedence and
all associations are deleted (current behavior).

« DELETE_ALL_ prefix (Delete all existing associations of a specific type of record)

To support deletion of all existing associations of a specific type of record, system administrators must add association
with DELETE_ALL_<ASSOCIATION_COLUMN> prefix in header and pass corresponding values in the data file.
When the import process encounters "yes" in this column, all associations are processed for deletion. Records with
Null and other values are not affected.

For example, when the import encounters the following record for association, it processes deletion first, deleting
all existing attachment associations and then associates doc1 passed under ATTACHMENT_NAMEL for the specific
record.

ATTACHMENT_NAME1 | DELETE_ALL_ATTACHMENT_NAME

docl]yes
g~ Note: For this option, the numeric suffix is not required and the association column as per template (for grouped
association columns) must be placed in the file first. For example, in case of attachment association:
ADD attachment association to the organization: ATTACHMENT_NAME1|DOMAIN1
DELETE attachment association from the organization :
DELETE_ATTACHMENT _NAME1 |DELETE_DOMAIN1
DELETE_ALL attachment association for the organization record :
DELETE_ALL_ATTACHMENT _NAME
Use case

There is a need to allow users to selectively remove or remove all existing associations of records in data import objects
without the need to contact Saba Cloud administrators.
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Display CLOB data in import logs

How did it work?

The import log files in Saba Cloud did not display CLOB (Character Large Object) data; instead, it displayed a reference
value for such data.

How does it work now?

With this update, the data import log files in Saba Cloud can now display CLOB (Character Large Object) data up to a
limit of 255 characters. If the data is larger than 255 characters, then the data is truncated in the log file and it ends with
a symbolic string . . . (truncated).

The CLOB data in import log files is displayed using has the following pattern:

<data>...(truncated)

Use case

Administrators need to see large data such as CLOB data type in data import log files. For large data that exceeds a
pre-defined limit, the log file must indicate the truncation beyond the limit.

Support to change unique ID for Transcript, Ad hoc Transcript and
Person Profile imports

How did it work?

Transcript, Ad hoc Transcript and Person Profile data imports do not provide an option to configure or change their
unique IDs. To make any changes to the unique IDs for these objects, users had to contact Saba Cloud operations, who
would execute scripts on the database server to update the unique ID configurations.

How does it work now?

This update provides support to change the unique IDs for Transcript, Ad hoc Transcript and Person Profile data import
objects from the Saba Cloud Ul. Note that all remaining data import objects in Saba Cloud already have this support.

The following unique IDs can be changed for these data import objects:
» Person Profile

« USERNAME
« PERSON_NO
« EMAIL
+ SS_NO

e Transcript

 LEARNER,OFFERING
¢ LEARNER,OFFERING,START_DATE
e Any custom field from CUSTOMO to CUSTOM9

Note: If a custom field is selected as a part of a unique ID, then by default, it is a combination of
CUSTOM%,LEARNER,OFFERING.

e Ad hoc Transcript
* LEARNER,COURSE,COMPLETION_DATE
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e Any custom field from CUSTOMO to CUSTOM9

g~ Note: If a custom field is selected as a part of a unique ID, then by default, it is a combination of
CUSTOM%,LEARNER,COURSE. Course always considers the course version.

Use case

User need the ability to configure unique 1Ds of data import objects in Saba Cloud without the need to contact the Cloud
operations team.

Changes to ILT/WBT class and course data imports

How did it work?

Certain fields for ILT/WBT classes and courses on the Saba Cloud Ul did not sync with the corresponding objects used
for bulk data import.

How does it work now?

This update introduces certain changes to the ILT/WBT class and course data imports by adding certain new columns
and removing some other so that they sync with the corresponding fields displayed on the Saba Cloud UI.

The following table indicates the changes to the data import XLS and CSV files:

Table 5: Data import changes

Object Name Columns Added Columns Removed

Offering Template (Course) | SHOWBEST ATTEMPT SCORE N/A

WET Offering . SHOWBEST ATTEMPT SCORE |+ RECURRING_REG_OPTION
« ACTIVITY_SEQ « RECURRING_REG_TYPE

ILT Offering

» SHOWBEST_ATTEMPT_SCORE RECURRING_REG_OPTION

» RECURRING_REG_TYPE

The new columns added are described as follows:

e SHOWBEST_ATTEMPT_SCORE - The "Show Best Attempt Score on Learner Transcript" policy for classes and
courses. This column supports True and False values.
e ACTIVITY_SEQ - Indicates the sequence of learning activities in a WBT class.

Use case

The columns in data import objects need to sync with the corresponding fields available on the Saba Cloud UI.

Changes to certification and curricula data imports

How did it work?
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Certain fields for certification and curricula on the Saba Cloud Ul did not sync with the corresponding objects used for
bulk data import.

How does it work now?

This update introduces changes to the certification and curricula data imports by adding certain new columns and
removing some others so that they sync with the corresponding fields displayed on the Saba Cloud UI.

The following table indicates the changes to the data import XLS and CSV files:

Table 6: Data import changes

Object Name Columns Added Columns Removed

Certification *+ VENDOR * OMIT_OFFERING_SEL

Curriculum * IS_FEATURED * REG_FOR_IND_ITEMS
* ONE_CLICK_REG * ENFORCE_PRG_REG

« CONTINUOUS LAUNCH
Association columns:

« KEYWORD
* FOLDER

Use case

The columns in data import objects need to sync with the corresponding fields available on the Saba Cloud UI.

Bulk import ability for learning, HR and people administrators

How did it work?

Saba Cloud allowed only system administrators to import bulk data for all objects in the system. Many of these objects
were actually managed by other administrators such as learning, HR and people administrators. However, these
administrators did not have any option to directly import such objects and had to rely on the system administrator.

How does it work now?

With this update, Saba Cloud now provides learning, HR and people administrators the ability to bulk import objects
in their respective areas. They can bulk import objects from the respective pages in Saba Cloud. For example, a learning
administrator can bulk import classes from the Classes page, or an HR administrator can import held skills of learners
from the Skills page.

A new bulk import icon is available on such pages. Administrators can click this icon to open the Bulk Import popup
window. They can upload a file, monitor the import and view history of the files uploaded by them.



Classes @
Course Title | | Class ID | |
Domain | |-;~% @ Audience Type/Sub Type | |.;w% @
Start Date >= | @  endDate == | &
Course ID | | Language | |.;w% @
Version | | Delivery | -Select One- v |
Figure 12: Bulk import icon
Bulk Import
CObject Name: 4 Download Sample
Impart Type: * @ Delimited
Delimiter: *
Import File Name: ™ —
Save

Import Monitoring Data Import Processes Manitoring

Data Import Process
Input File Ohbject Name
Start Date == Start Date ==

Search
TimeZone: w
Start date End Date Input File Import Object Status Moedified date
19-APR-2016 2254 PM 19-APR-2016 254 PM  123.csv Person, Internal Completed ~ 19-APR-2016 2:54 PM
19-APR-2016 2251 PM  19-APR-2016 251 PM  123.csv Person, Internal Completed ~ 19-APR-2016 2:51 PM
19-APR-2016 2:49 PM  19-APR-2016 248 PM  123.csv Person, Internal Completed  19-APR-2016 2:49 PIM
Figure 13: Bulk Import for other administrators
Table 7: Bulk import of objects
Role Page Object
Learning Admin Learning Catalog

Courses
» Certifications
e Curricula

Audience Types

Audience Types

Price Lists

Price lists
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Role Page Object
Session Templates Session Templates
Checklists Checklists
Classes ILT/WBT/Blended/Virtual classes
Resources * Locations
o Facility
* Rooms
e Equipment
e Inventory
Training Unit Training Units
Purchase Order Purchase Order
People Admin Internal People Internal People
External People External People
Enrollments Registrations
Certifications Learner Certifications
Curricula Learner Curricula
Skills Held Skills
Completed Courses Transcripts
Purchase Orders Purchase Orders
HR Admin Internal Organization Internal Organizations

External Organization

External Organizations

Skills Skills
Jobs - Job Families
e Job Types
+ Job Roles
Goal Library Goals
Locations & Facilities .
e Locations

* Facilities
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Use case

Administrators other than the system administrator need the ability to bulk import objects in their respective areas.

Marketplace

Picker to select username and the audience type while configuring
a MicroApp

How did it work?

While configuring a MicroApp (under Marketplace > MicroApps), the user was required to know the username and
the audience type as they were text fields.

# ME MYTEAM PEOPLE GROUPS ADMIN

TwitterMicro

TwitterMicro

Contact Emad™ cusTNEUshomern com

Saba Usemamd

Audence Type

[¥] Enable MicraApp on Profie View
[¥#] Enable MicroApp on Home View

&

= Additional Configuration Text
TaiREr (ESENDNON

Purpose |

tiviled Mafeabng b

Figure 14: Text field for username and audience type

How does it work now?

The username and the audience type are now pickers. The user can now select the appropriate username and the audience
type for a MicroApp.
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TwitterMicro
TwitterMicro

Contact Emai™ CLFITWNZLUSIOMmEr Com

Saba Usemam

Audeence Type

[¥] Enable MiraApp on Prodle Vikw

[¥] Enabla MicroApp on Home View

&

Purpose |

= Additional Configuration Text

ThiRer (e SCNpRon

taviigs mafketng beel

Figure 15: Picker for username and audience type

Use case

The username and the audience type were text fields making its cumbersome to determine the username and the audience
type before using it.

OAuth authentication support for Adobe eSign integration

How did it work?

Adobe eSign (previously called "EchoSign") integration with Saba Cloud marketplace was secured with a access-based
authentication mechanism.

How does it work now?

This update enhances the security for Adobe eSign integration with Saba Cloud marketplace by adding OAuth
authentication support.

Before you integrate Adobe eSign using OAuth authentication with Saba Cloud marketplace, you must Obtain OAuth

2.0 credentials from Adobe console as follows:

1. Sign in to Adobe Document Cloud account by visiting the Adobe site
https://acrobat.adobe.com/us/en/documents/integrations.html. Ensure that the account is a Developer edition account.

2. Create an application of the type Partner.
3. Obtain OAuth 2.0 credentials such as client ID, client secret, and redirect URL. The same client ID ,client secret and
redirect URL must be configured in Saba Cloud marketplace.


https://acrobat.adobe.com/us/en/documents/integrations.html
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To configure integration between Adobe eSign with OAuth security and Saba Cloud marketplace:
1. Specify the Adobe eSign account information, which includes the client ID ,client secret and redirect URL obtained
from Adobe.

2. Select one more values in eSign OAuth Scope parameters. By default, all scopes are selected. The eSign OAuth
Scope variable parameter controls the set of resources and operations that an access token permits.

Adobe eSign x

Adobe eSign

Client 1D:* CBJCHBCAABAARZNasUOEINSMY-258jaGeLNME1gCKik
Client Secret* BrFPFfS0gPgZhQoCts9hsojnHksNmaowW

Redirect URL:* hitps:fidgspcdemo.sabacloud.comiSabalapifrecruitingfechosignireceiv

#| EchoSign Oauth Scopes

agreement_write:Manage the status of documents on behalf of any
user in your account

Luser_readView users in your account
user_write:Create or manage users within your account
user_login:Login on behalf of any user in your account

library_write:Manage the templates and document library on behalf
of any user in your account

agreement_send:Send documents on behalf of any user in your
account

widget_readMiew widgets on behalf of any user in your account

widget_write:Create, edit or publish widgets an behalf of any user in

Figure 16: Adobe eSign OAuth Scopes

3. Click the Save button.

4. Click the Configure OAuth button. This procures the access token from the Adobe eSign Server and saves it. A
single access token can grant varying degrees of access to multiple APIs.
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Adobe eSign

library_readMiew templates and document library on behalf of any
user in your account

agreement_read:Access documents and data on behalf of any user
in your account

The Saba Marketplace integration with Adobe e Sign allows Saba Recruiting@Work
customers to streamline HR onboarding by creating and sending electronic documents
that new hires can view, verify, and e-sign quickly and conveniently. Using a dashboard,
you can track who has viewed the documents and when, and can set up automatic
reminders to ensure no onboarding steps are missed. Adobe eSign offers trusted electronic
signature software online. Send, e-sign, frack, and file documents and contracts securely.

Don't have an account yet?

Mo problem. Visit hitpsfacrobat adobe comiusfen/documentsies-contact html to get started
today. Once you have the Adobe eSign company login infarmation, just return to this
screen to get started.

Ready to get started?

Let's go! Just enter your credentials.

Terms & Conditions

httpffwrwew.adobe . comfegalterms.htmi

| agree to above terms and conditions

Configure Oauth

Figure 17: Adobe eSign OAuth configuration

5. Click the Test button. The test succeeds if the access token is generated correctly.

The access token is used by APIs in Saba Cloud Recruiting for authenticating the user data. For example, if a document
is uploaded, then the access token retrieved during eSign integration with marketplace is used and then the request is
sent to eSign.

Use case

There is a need to provide enhanced security using "OAUTH" authentication mechanism for integrating Adobe eSign
with Saba Cloud marketplace.
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Updated REST APIs

Create a new training unit agreement using the Invoice Me payment

method

How did it work?

The CREATE A NEW TRAINING UNIT AGREEMENT REST API only supported the paypal and credit card as the

payment methods.

How does it work now?

The CREATE A NEW TRAINING UNIT AGREEMENT REST API now supports the Invoice Me payment method

using the new invoiceRequest parameter.

Overview

Allows creating a new training unit agreement.

Requires OAuth
No

Method
POST

URL

https://< hostname-api.sabacl oud.com>/v1/tuagreement

Calling Options

Table 8: Calling Options

Unit Agreement

sn000000000200327, "dis~
playName": "aaa"}"

Name Description Sample Value Data Type Required?
owner_id Organization for Training | {"id": string Yes
Unit Agreement " rmpany000000000001001 s~
playName": "ExtOr~
ganization"}
order_contact Order contact for Training | {"id": "per~ string No
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Name Description Sample Value Data Type Required?
expiration_date Expiration date for Training string No
Unit Agreement
trainingunit_id Trainingunit for Training {"id": "tun~ string Yes
Unit Agreement it000000000001020","dis~
playName": "Train~
ing_unit_1"}
no_unit No of units for Training Unit | 1 string Yes
Agreement
currency Currency {"id™: string Yes
1 ||’Im~
playName™: "US Dol~
lars"}
paymentType Payment Type for Training | creditCard string Yes
Unit Agreement
o Note: Acceptable val~
ues:
» creditCard
* paypal
« invoiceMe
paymentTransactionld | Payment Transaction ID for | axxccssxx1001 string No
Training Unit Agreement
invoiceRequest Payment using InvoiceMe | {"details":"Payment |string No
for Training Unit Agreement | by invoice","cus~
tomQ™:"abc","cus~

tom1":"def","cus~
tom2":"Ok","cus~
tom9":"9th"}

Request Body

{

"currency':{
"displayName™:*""USD"

"expiration_date':"'2016-11-20T04:00:00.000-0400",
"no_unit'":"2",
"owner_id":{
"id":""cmpny000000000001003"*
by

"paymentTransactionld”:""ABC Non Credit Card",
"paymentType':""invoiceMe",

"invoiceRequest':{

"details":"Payment by invoice",
customO0™:*"0",

"customl™:"'1",

"‘custom2':"'2",
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""custom3':"'3",
"‘custom4':"'4'",
‘custom5":"5",
""custom6'':"'6"",
“‘custom7'":"7",
""custom8'':''8",
""custom9'':"'9"

}1

"trainingunit_id":{
"id":"tunit000000000001401"

he

}

Return Values

"1d": "tutpo000000000001407",
"displayName™: null,
"href":
"http://<hostname-api .sabacloud.com>/v1/tuagreement/tutpo000000000001407""

}

' Note: For more details on this see REST API Reference.

Use case

This enhancement provides additional payment options for creating training unit agreements.

Manager can now grant certification/curriculum to a learner

How did it work?

The GRANT CERTIFICATION/CURRICULUM TO A LEARNER REST API only allowed the People Admin to grant
certification/curriculum to a learner.

How does it work now?

The GRANT CERTIFICATION/CURRICULUM TO A LEARNER REST API now allows the following to grant
certification/curriculum to a learner:

* Manager

« Alternate manager

« Position manager

* People admin

e Group admin - Only Organization base (Criteria base cannot)

Overview

Allows the manager, alternate manager, position manager, people admin or group admin to grant certification/curriculum
to a learner. The status of such granted certification/curriculum will be shown as acquired for that learner.

g~ Note: To grant an already assigned certification the suppresswWarning flag should be true.
Requires OAuth
No


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

Method
POST

URL

http://< hostname-api.sabacl oud.com> /v1/learning/heldlearningevent/:cert_curr_ld/person?action=grant

Using the suppressWarning flag:
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http://< hostname-api.sabacl oud.con>/v1/learning/heldlearningevent/:cert_curr_ld/person?action=grant&suppressWarning=true

Calling Options

Table 9: Calling Options

jectReference"”, "id™:
"em~

plo000000000206652",
"displayName": "Shu~
chi Lau" }

Name Description Sample Value Data Type Required?
cert_curr_Id Certification/Curriculum ID | crt~ string Yes
fy000000000200360
@type Input detail type com.saba.rest.busi~ | string Yes
nesscompon-~
ent.dto.CertCurrActiv~
ityDTO
acquiredOn Date on which the certifica~ string Yes
tion/curriculum was acquired
expiredOn Date on which the certifica~ No
tion expires.
g Note: Only applicable
for certification.
assignee Assignee {"@type":
""com.saba.rest.ser~
vice.RESTServiceOb~

e Note: For more details on this see REST API Reference.

Use case

This enhancement syncs the APIs functionality with the functionality that the Ul provides.

Assign, retrieve or remove an owner of a Facility

How did it work?

The following REST APIs didn't allow assigning, retrieving or removing associations such as an owner of a Facility:


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

« CREATE A NEW FACILITY
 UPDATE THE DETAILS OF A FACILITY

e GET THE DETAILS OF A PARTICULAR FACILITY

How does it work now?

The following REST APIs now allow assigning, retrieving or removing associations such as an owner of a Facility:

» CREATE A NEW FACILITY
» UPDATE THE DETAILS OF A FACILITY

* GET THE DETAILS OF A PARTICULAR FACILITY

CREATE A NEW FACILITY

Overview

Allows creating a new facility.

Requires OAuth
No

Method
POST

URL
https://< hostname-api.sabacloud.com>/v1/facility/

Calling Options

Table 10: Calling Options
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facility

Name Description Sample Value Data Type Required?
name The name of the facility Facility 123 string Yes
enabled Whether the facility is en~ |true string No
abled (true or false)
securityDomain The domain for the facility. string Yes
Supports lookup (Domain). {I d"- "dom~
in00000000000000L
"name™:
"world"
contact_name The contact person's name | UONE string Yes
for the facility
facility_no The number of the facility |00200121 string No
corporate_no The corporate number of the | 78787676 string No
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Name Description Sample Value Data Type Required?
addrl Address 1 add1 string No
addr2 Address 2 add2 string No
address3 Address 3 add3 string No
city City Indore string No
state State MP string No
country Country India string No
zip Zip 112233 string No
contact_phone Contact phone 123456789 string No
contact_phone2 Contact phone 2 12345 string No
Contact Email Contact email abc@gmail.com string No
contact_fax Contact fax 12345 string No
location_id Location's ID locat000000000200121 | string No

Supports lookup (Location).
customValues Custom fields string No
locale Locale string No
associations Map of associations object | {"owner": [{"id": string

detail "em~

plo000000000200091", 'dis~

o Note: Only owner can
be passed as the associ~
ation object.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

playName": "test

user"}}

Request Body

{

"name'': "Domain_USSupport facilityen US REST Test 101",
"location_id": {

tidT

""1ocat000000000200210™",

"displayName™: "Domain_USSupport_locationen_US",
"loc_no": "001000"

"étate": "kerela",



"country'': ,
"‘corporate_no'': ,
"facility_no": '"00200030",
"enabled": true,

""contact_name': "UONE",

Yzip': ",

"city': "Bombay",

"contact_email': "saba@saba.com",
""contact_phone': "'022323232en_US",
"contact_fax'': "2344422en_US",
"addrl™: ""addlen_US",

"addr2': "add2en_US",

"customValues": {
"customl™: null,
"custom2™: null,
"custom3": null,
"custom4': null,
"custom5': null,
"custom6': null,
"custom7': null,
"custom8": null,
"custom9'': null,
"customO™: null

¥

,ecurityDomain": {
"id": "domin000000000201404",
"displayName": "Domain_USSupport

"éssociations": {
"owner":
"id": "enpl 0000000000200091",
"di spl ayName": "test user"
}
he
UPDATE THE DETAILS OF A FACILITY
Overview

Allows updating an existing facility based on the Facility's ID.

Requires OAuth
No

Method
PUT

URL
https://<hosthame-api.sabacl oud.com> /v1/facility/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the facility_no instead of the internal Facility's ID.

https://< hostname-api.sabacl oud.com> /v1/facility/facility_no%3D< FacilityNo>
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Calling Options

Table 11: Calling Options
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Supports lookup (Location).

Name Description Sample Value Data Type Required?
id Facility's ID string Yes
name The name of the facility Facility 123 string Yes
enabled Whether the facility is en~ |true string No
abled (true or false)
securityDomain The domain for the facility string Yes
Supports lookup (Domain). | «ijqe- *gom~
“"world"
}
contact_name The contact person's name | UONE string Yes
for the facility
facility_no The number of the facility |00200121 string No
corporate_no The corporate number of the | 78787676 string No
facility
addrl Address 1 add1 string No
addr2 Address 2 add2 string No
address3 address3 adds3 string No
city City Indore string No
state State MP string No
country Country India string No
zip Zip 112233 string No
contact_phone Contact phone 123456789 string No
contact_phone2 Contact phone 2 12345 string No
contact_email Contact email abc@gmail.com string No
contact_fax Contact fax 12345 string No
location_id Location's ID locat000000000200121 | string No
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Name Description Sample Value Data Type Required?
customValues Custom fields string No
locale Locale string No
associations Map of associations object | {"owner": [{"id": string No
detail "em~
plo000000000200091, "dis~

Note: Only owner can
be passed as the associ~
ation object.

playName": "test

user"}}

Request Body

"name'': "Domain_USSupport facilityen US REST Test 101",
"location_id": {
"id": "locat000000000200210",

}

"displayName™™: "Domain_USSupport_locationen_US",
"loc_no": "001000"

tate": "kerela",

"country":

"‘corporate_no'':

"facility_no': "00500030",

"enabled":

true,

"contact_name': "UONE",

zip":

"city': "Bombay",

"contact_email': 'saba@saba.com™,
"contact_phone': "'022323232en_US",
"contact_fax'': "2344422en_US",
"addrl': "addlen_US",

"addr2': "add2en_US",

"customValues": {
"customl': null,
"custom2'": null,
"custom3": null,
"custom4': null,
"custom5™: null,
"custom6': null,
"custom7': null,
"custom8": null,
"custom9'': null,
"customO': null

¥

ecurityDomain™: {

"id": "domin000000000201404",
"displayName': "Domain_USSupport"

"associations": {

"owner":
||i dll:

{
"enpl 0000000000200091",
"di spl ayNane":

"test user"”
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g~ Note: To remove the owner association details, use the PUT operation.

GET THE DETAILS OF A PARTICULAR FACILITY

Overview

Returns complete information about a facility based on the Facility's ID that is passed as a parameter value.

Requires OAuth
No

Method
GET

URL

https://< hostname-api .sabacl oud.com>/v1/facility/:id
g Note: Use ?includeassociation=true to retrieve the association details (such as owner) as well:
https://< hostname-api .sabacl oud.com>/v1/facility/:id?includeassociation=true

URL (User-friendly)
You can use a user-friendly URL which accepts the facility_no instead of the internal Facility's ID.

https://< hostname-api.sabacloud.com>/v1/facility/facility _no%3D<FacilityNo> ?includeassociation=true

Calling Options

Table 12: Calling Options

Name Description Sample Value Data Type Required?

id Facility's ID string Yes

Return Values

{
"id":" fclty000000000200082",
"name': "facility 1",
"location_id": {
"id": "locat000000000200210",
"displayName™: *‘Domain_USSupport_locationen_US",
"loc_no": "001000"

}

"state'": "kerela",
"country": "',
"‘corporate_no'': ,
“facility_no”: 00200030,
"enabled": true,

""contact_name': ""UONE",

“zipt: ",

"city': "Bombay",

"contact_email': "saba@saba.com",
"contact_phone™: '022323232en_US',
"contact_ fax': ''2344422en_US'",

"addrl': "addlen_ US",
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"addr2'": "add2en_US",
"customValues": {
"customl™: null,
"custom2™: null,
"custom3": null,
"custom4': null,
"custom5"™: null,
"custom6': null,
"custom7'': null,
"custom8": null,
"custom9': null,
"customO": null
}s
"'securityDomain™: {
"id": "domin000000000201404",
"displayName'": "Domain_USSupport"

"associ ations": {

"owner":
"id": "enpl 0o000000000200091",
"di spl ayName": "test user"
}

}
Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific
object search.

o Note: For more details on this see REST API Reference.

Use case

This enhancement makes the Facility REST APIs more flexible.

Assign, retrieve or remove an owner of a Location

How did it work?

The following REST APIs didn't allow assigning, retrieving or removing associations such as an owner of a Location:

» CREATE A NEW LOCATION
* UPDATE THE DETAILS OF A LOCATION
» GET THE DETAILS OF A PARTICULAR LOCATION

How does it work now?

The following REST APIs now allow assigning, retrieving or removing associations such as an owner of a Location:

« CREATE A NEW LOCATION
* UPDATE THE DETAILS OF A LOCATION
* GET THE DETAILS OF A PARTICULAR LOCATION

CREATE A NEW LOCATION

Overview

Allows creating a new location.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

Requires OAuth

No

Method
POST

URL

https://<hostname-api.sabacl oud.com> /v1/location/

Calling Options

Table 13: Calling Options
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Name Description Sample Value Data Type Required?
loc_name The location name location101 string Yes
contact_id Contact's ID string No
locale Locale string No
state State statel string No
securityDomain Security Domain string Yes

"id": "dom~

#in00000000000000L

"name’':

“world™

}
city City cityl string No
dept_id Department's ID string No
customValues Custom Values string No
homephone Home phone 12345 string No
workphone Work phone 22334455 string No
enabled Enabled false string No
zip Zip 1234 string No
fax Fax 556677 string No
country Country cntryl string No
addrl Address 1 addl string No
addr2 Address 2 add2 string No
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Name Description Sample Value Data Type Required?
email Email abc@gmail.com string No
addr3 Address 3 adds3 string No
loc_no Location number 0987 string No
timezone_id Timezone's ID string Yes
{ _
LAl I dll :
"oEme
"dis~
playName™:
"(GMT+05:30)
Chennai,
Kolkata, Mum~
bai, New Del~
hi"
}
associations Map of associations object |{"owner": [{"id": string No
detail "em~
. plo00000000020009L ", 'dis~
= Note: Only owner can "on LV
L - | playName": "test
be passed as the associ~ user"}}
ation object.
Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

Request Body

"'state': "'statel",

llcountryll: llll,

"enabled": true,

"loc_name'": "Location with_loacle REST TEST 102",
city'": "',

vtzipt: ",

"timezone_id": {

"id": "tzone000000000000005",

"displayName": "(GMT-08:00) Pacific Time (US & Canada), Tijuana"

"loc_no": "LOCATION_WITH_LOACLE",
"dept_id": ": {

"id": " bisut000000000200170",
"displayName': "companyl™

"éddrl": "address1",
"addr2": "addressl",

"phonel™: ,
llphonezll: llll,



"contact_id": {

"id": "emplo000000000200091",

"displayName'": "test user"

"phonel™: ***,
"phone2™: """,
“"email": ",
"fax'': ",
"customValues": {
"customl™: null,
"custom2'": null,
"custom3'": null,
"custom4': null,
"custom5"™: null,
"custom6': null,
"custom7"': null,
"custom8": null,
"custom9'': null,
"customO': null
¥

’ecurityDomain": {
"id": "domin000000000000001",

“displayName™: "world"

"associations": {

"owner": [

{

"id": "enpl 0000000000200091",

"di spl ayName": "test user"

]
}
}

UPDATE THE DETAILS OF A LOCATION

Overview

Allows updating an existing location based on the Location's ID.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api.sabacl oud.com>/v1/location/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the loc_no instead of the internal Location's ID.

https://< hostname-api.sabacl oud.com>/v1/location/loc_no%3D< LocationNo> ?includeassociation=true
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Calling Options

Table 14: Calling Options
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Name Description Sample Value Data Type Required?
id Location's ID string Yes
loc_name The location name location101 string Yes
contact_id Contact's ID string No
locale Locale string No
state State statel string No
securityDomain Security Domain string Yes
{"id": "dom:
"world"}
city City cityl string No
dept_id Department's ID string No
customValues Custom Values string No
homephone Home phone 12345 string No
workphone Work phone 22334455 string No
enabled Enabled false string No
zip Zip 1234 string No
fax Fax 556677 string No
country Country cntryl string No
addrl Address 1 add1 string No
addr2 Address 2 add2 string No
email Email abc@gmail.com string No
addr3 Address 3 adds3 string No
loc_no Location number 0987 string No
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Name

Description

Sample Value

Data Type

Required?

timezone_id

Timezone's ID

string

"dis~
playName"':
" (GMT+05:30)
Chennai,
Kolkata, Mum-~
bai, New Del~
hi"

}

Yes

associations Map of associations object | {"owner": [{"id": string
detail "em~
plo000000000200091, "dis~
playName": "test

user"}}

g~ Note: Only owner can
be passed as the associ~
ation object.

No

Request Body

"'state': "'statel",

"country': ",

"enabled": true,

"loc_name'": "Location_with_loacle REST TEST 102",
lICitle: llll,

Yzip': "M,

"timezone_ id": {

"1d": "tzone000000000000005",

“displayName™: "(GMT-08:00) Pacific Time (US & Canada), Tijuana"

"loc_no"™: "LOCATION_WITH_LOACLE",
"dept_id": ": {

"id": " bisut000000000200170",
"displayName'": "companyl"

"addrl”: "addressl",

"addr2'": "addressl",

"phonel™: "',

"phone2": "',

"contact_id": {

"1d": "emplo000000000200091",
“displayName': "test user"

"phonel™: "',
"phone2": "',
“"email": ",
"fax'": ",
"customValues™: {
"customl™: null,
"custom2™: null,

"custom3": null



"custom4': null,
"custom5': null,
"custom6': null,
"custom7"': null,
"custom8": null,
"custom9'': null,
"customO™: null

}

’ecurityDomain": {
"1d": ""domin000000000000001",
“displayName™: "world"

"associations": {
"owner": [

"id": "enpl 0000000000200091",
"di spl ayName": "test user"

]
}
}

g~ Note: To remove the owner association details, use the PUT operation.

GET THE DETAILS OF A PARTICULAR LOCATION

Overview

Returns complete information about a location based on the Location's ID that is passed as a parameter value.

Requires OAuth
No

Method
GET

URL
https://< hostname-api.sabacl oud.com>/v1/location/:id
g~ Note: Use ?includeassociation=true to retrieve the association details (such as owner) as well:

https://< hostname-api .sabacl oud.com>/v1/location/:id?includeassociation=true

URL (User-friendly)
You can use a user-friendly URL which accepts the loc_no instead of the internal Location's ID.

https://< hostname-api .sabacl oud.com>/v1/location/loc_no%3D< LocationNo>?includeassociation=true

Calling Options

Table 15: Calling Options
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Name Description Sample Value Data Type Required?

id Location ID locat000000000200263 | string Yes




Return Values

{ “i1d”:” locat000000000200300",

"'state': '"'statel,
"country": "',

"enabled": true,

"loc_name™: "Location_with_ loacle REST TEST 102",

“city'": "',

“zipt: ",

"timezone id": {

"id": ""tzone000000000000005",

"displayName": "(GMT-08:00) Pacific Time (US & Canada), Tijuana"

"loc_no™: "LOCATION_WITH_LOACLE™",
“"dept_id": ": {

"id": " bisut000000000200170",
"displayName'": "companyl"

"addrl: "addressl',
"addr2'": "addressl',
llphonelll: llll’
llphone2ll: llll’
"contact_id": {
"1d": "emplo000000000200091",

“displayName™: "test user"”

"phonel™: """,
"phone2": """,
“"email": ",
“fax'': ",
"customValues™: {
"customl': null,
"custom2™: null,
"custom3": null,
"custom4': null,
"custom5™: null,
"custom6': null,
"custom7': null,
"custom8": null,
"custom9'': null,
"customO': null
¥

ecurityDomain™: {

"id": "domin000000000000001",
“displayName': "world"

"associ ations": {

"owner": [
"id": "enpl 0000000000200091",
"di spl ayNane": "test user"
}

]

}

Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific

object search.

[ .

Note: For more details on this see REST API Reference.
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Use case

This enhancement makes the Location REST APIs more flexible.

Assign, retrieve or remove associations of a Job Role

How did it work?

The following REST APIs didn't allow assigning, retrieving or removing associations such as Learning Event (Course
/ Certification / Curriculum), Skill, Owner, Checklist, Continue Education of a Role:

« CREATE ANEW ROLE
 UPDATE THE DETAILS OF A ROLE
» GET THE DETAILS OF A PARTICULAR ROLE

How does it work now?

The following REST APIs now allow assigning, retrieving or removing associations such as Learning Event (Course /
Certification / Curriculum), Skill, Owner, Checklist, Continue Education of a Role:

» CREATE A NEW ROLE
» UPDATE THE DETAILS OF A ROLE
» GET THE DETAILS OF A PARTICULAR ROLE

CREATE ANEW ROLE

Overview

Allows creating a new job role.

Method
POST

Requires OAuth
No

URL

https://<hostname-api.sabacloud.com>/v1/role

Calling Options

Table 16: Calling Options

Name Description Sample Value Data Type Required?
name The name of the role EngineerRoleTech20 |string Yes
description The short description about | EngineerRo~ string No

the job role leTech20description




| System | 69

Name Description Sample Value Data Type Required?
securityDomain The domain for the role string Yes

"1d": ""dom~

In000000000000001

""name™:

"world"

}
customValues Custom Values string No
associations Map of associations object | { \"owner\":[ { string No

detail

- Note: You can the

following as the associ~
ation object:

e Learning Event
(Course / Certifica~
tion / Curriculum)

P Note: Sup~
ports lookup
(Course, Cer~
tification,
Curriculum).

» Skill

e Note: Sup~
ports lookup
(Compet~
ency).

«  Owner

g~ Note: Sup~
ports lookup
(Person).

If the logged
in person is
internal then
only the in~
ternal users
can be associ~
ated. Simil~
arly, if the
logged in per~
son is extern~
al then only
the external
users can be
associated.

e Checklist

\"id\":\"em~
plo000000000001000\",
\"display~
Name\":\"testowner\"
11, \"checklist\":[ {
\"id\":\"ch~
kIt000000000002023\",
\"displayName\":\"test~
checklist\" }\n 1,
\"learningevent\";[ {
\"isRequired\":true,
\"displayName\":\"test~
course\",

i ik o 0000000002000
\"type\":\"Course\",
\"version\":\"1.1\" } ],
\"continueeduca~
tion\":[ {

ok bk 000000000001160
\"displayName\":\"test~
plan\" } ], \"skill\":[ {
\"minimumRe~
quired\":\" Average\",
\"display~

Name\":\" Automa~
tionTesting\",

ikt tomp000000000001108
31}




| System | 70

¢ Continue Educa~

tion

g~ Note: Sup~
ports lookup
(CEPIan).

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

Name Description Sample Value Data Type Required?
- Note: Sup~
ports lookup
(Checklist).

Request Body

{

"name' : ""testRole",
"description™ : "test role",
"associ ations": {

"owner": [
{
"id": "enpl 0000000000001000",
"di spl ayName": "test owner"

]1
"checklist": [

"id": "chkl t000000000002023",
"di spl ayName": "test checklist"

1

}
I ear ni ngevent": [

{

"i sRequired": true,

"di spl ayName": "test course",
"id": "cours000000000200029",
"type": "Course",

"version": "1.1"

}

onti nueeducation": [

]

{
"id": "cepl n0O0O00D0D0000001160",
"di spl ayName": "test plan"

I,
"skill": [
{

"m ni munRequi red": "Average",

"di spl ayNanme": "Automation Testing",

"id": "conpt000000000001106"

}
]



}
}

"’ecurityDomain" - {"id": "domin000000000000001™," name™: "‘world"}

o Note: If you do not provide the "isRequired" attribute in the input json, it is set to the default value: false.

UPDATE THE DETAILS OF AROLE

Overview

Allows updating an existing job role based on the Role ID.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api .sabacl oud.com>/v1/role/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the name instead of the internal Role's ID.

https://< hostname-api .sabacl oud.com>/v1/role/name%3D< RoleName> ?includeassociation=true

Calling Options

Table 17: Calling Options
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Name Description Sample Value Data Type Required?
id Role's ID string Yes
name The name of the role EngineerRoleTech20 |string Yes
modified
description The short description about | EngineerRo~ string No
the job role leTech20description
securityDomain The domain for the role string Yes
"id": ""dom~
0000000000000+,
"name’"':
“"world"
}
customValues Custom Values string No
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Name

Description

Sample Value

Data Type

Required?

associations

Map of associations object
detail

- Note: You can the
following as the associ~
ation object:

* Learning Event
(Course/ Certifica~
tion / Curriculum)

g~ Note: Sup~
ports lookup
(Course, Cer~
tification,
Curriculum).

+ Skill

P Note: Sup~
ports lookup
(Compet~
ency).

e Owner

e Note: Sup~
ports lookup
(Person).

If the logged
in person is
internal then
only the in~
ternal users
can be associ~
ated. Simil~
arly, if the
logged in per~
son is extern~
al then only
the external
users can be
associated.

¢ Checklist

g Note: Sup~
ports lookup
(Checklist).

* Continue Educa~
tion
g~ Note: Sup~

ports lookup
(CEPIan).

{\"ownen\":[ {
\"id\":\"em~
plo000000000001000\",
\"display~
Name\":\"testowner\"
} 1, \"checklist\":[ {
\"id\":\"ch~
kIt000000000002023\",
\"displayName\":\"test~
checklist\" }\n ],
\"learningevent\":[ {
\"isRequired\":true,
\"displayName\":\"test~
course\”,

i ok ™ ou00000000020002
\"type\":\"Course\",
\"version\":\"1.1\" } ],
\"continueeduca~
tion\":[ {

\ o ¥ oepi000000000001160K
\"displayName\":\"test~
plan\" } ], \"skill\":[ {
\"minimumRe~
quired\":\"Average\",
\"display~
Name\":\"Automa~
tionTesting\",

ikt aonp00000000001108
31}

string

No
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Name Description Sample Value

Data Type

Required?

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

Request Body

{

"name': ""Role REST Test 102",
"description™: "Role desc",
"customValues™: {
"customl'™: "ir5customl',
"custom2': "ir5custom2',
"custom3'': "ir5custom3",
"custom4': "ir5custom4’,
"custom5': null,
"custom6': null,
"custom7'': null,
"custom8": null,
"custom9': null,
"customO™: ""ir5customO0™

3

’ecurityDomain": {
"id": "domin000000000000001",
"displayName": "world"

"associ ations": {

"| ear ni ngevent": [{
"i sRequi red": "true"
"di spl ayNanme": "test certification"
"id": "crtfy000000000200020"
"type": "Certification",

"version":
} L]
"i sRequi red": "true"
"di spl ayNane": "test course"

"id": "cours000000000200424",
"type": "Course",
"version": "1.1"

"i sRequi red": "true"

"di spl ayNane": "test Curricul uni,
"id": "curra000000000001003",
"type": "Curricul unt,

"version":
I
"skill": [{
"m ni munRequi red": "Average"

"di spl ayNane": "test skill",
"id": "cplvl 000000000001007"
H,
"owner":
"id": "enpl 0000000000200091",
"di spl ayName": "test owner"

"cbntinueeducatioWH
"id": "cepl n0O0OOO0O0000001000",
"di spl ayName": "test plan"
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H,
"checklist":
"id": "chklt000000000002001",
"di spl ayNanme": "test checklist"
}
}

g~ Note: To remove the owner association details, use the PUT operation.

If you do not provide the "isRequired" attribute in the input json, it is set to the default value: false.

GET THE DETAILS OF A PARTICULAR ROLE

Overview

Returns complete information about a job role based on the Role's ID that is passed as a parameter value.

Method
GET

Requires OAuth
No

URL
https://< hostname-api .sabacl oud.com>/v1/role/:id
g~ Note: Use ?includeassociation=true to retrieve the association details (such as owner) as well:

https://< hostname-api.sabacl oud.com> /v1/role/:id?includeassociation=true

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Role's ID.

https://< hostname-api .sabacl oud.com>/v1/role/name%3D< RoleName> ?includeassociation=true

Calling Options

Table 18: Calling Options

Name Description Sample Value Data Type Required?
id Role's ID string Yes
includeassociation Returns the details of associ~ | true string No

ations in the search

Return Values

"name': ""testRole35",
"description™: "test role35",
"customValues": {

"custom9": null,

"customO™: null,
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"custom3'": null,
"custom4': null,
"customl™: null,
"custom2™: null,
"custom7': null,
"custom8": null,
"custom5': null,
"custom6': null

}

,ecurityDomain": {
"id": "domin000000000000001",
"displayName™: "world"

}’
"1d": "roles000000000001211",
"associ ations": {
"owner": [
{
"id": "enpl 0000000000001001",
"di spal yName": "User Two"

}!
"conti nueeducation": |
{
"di spl ayNanme": "testPlanl",
"id": "cepl n000000000001160"
}
]
Covskillto[
., .
"m ni runRequi red": "Above average"
"id": "conpt000000000001003"
"di spal yNane": "Skill 4"
}

] L]
"checklist": {
"di spl ayName": " Checkli st2"
"id": "chkl t000000000002020"
}

ear ni ngevent": [

{
"di spl ayNanme": "EW O fering"
"id": "cours000000000200061",
"type": O,
"version": null

Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific
object search.

© Note: For more details on this see REST API Reference.

Use case

This enhancement makes the Role REST APIs more flexible


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
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Assign, retrieve or remove Job roles and Next career steps of a Job Type

How did it work?

The following REST APIs didn't allow assigning, retrieving or removing associations such as Job roles and Next career
steps of a Job Type:

« CREATE ANEW JOB TYPE
» UPDATE THE DETAILS OF A JOB TYPE
* GET THE DETAILS OF A PARTICULAR JOB TYPE

How does it work now?

The following REST APIs now allow assigning, retrieving or removing associations such as Job roles and Next career
steps of a Job Type:

« CREATE ANEWJOB TYPE
 UPDATE THE DETAILS OF AJOB TYPE
e GET THE DETAILS OF A PARTICULAR JOB TYPE

CREATE ANEW JOB TYPE

Overview

Allows creating a new Job Type.

Requires OAuth
No

Method
POST

URL
https://< hostname-api.sabacl oud.com>/v1/jobs/

Calling Options

Table 19: Calling Options

Name Description Sample Value Data Type Required?
name The Job Type Job Type REST 101 |string Yes
status Status 100 string No
locale Locale string No
family_id Family's ID jfmly000000000001040 | string Yes

Default Job Family
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Name Description Sample Value Data Type Required?
securityDomain Security Domain string Yes

"1d": ""dom~

In000000000000001

""name™:

"world"

}
end_date End date string No
description Description desc string No
customValues Custom Values string No
responsibilities Responsibilities string No
is_critical Is critical? false string No
start_date Start date string No
associations Map of associations object |{"role": [{"isRe~ string No

=

detail

Note: Only Role and
Next career step can be
passed as the associ~

ation objects.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

quired": "true","id":
"10kes000000000001140 s~
playName": "Engineer
Role 1"}],"nextcareer~
step™: [{"id": "job~
p000000000200309", 'dis~
playName":
"JObEW1"}]}

Request Body

"name': "JobEW16 REST TEST 101",
"“description’: "',

"end_date"

“family_id"

null,

"id": "jFfmly000000000001040",
"displayName": "Default Job Family"

},

"status': ""100",
> null,
"responsibilities”: null,
"iIs_critical”: false,

"start_date"

"customValues': {

"customl*
""custom2"
""custom3"*
"custom4'*
""custom5**

null,
null,
null,
null,
null,



"custom6': null,
"custom7": null,
"custom8": null,
"custom9'': null,
"customO™: null

}

’ecurityDomain": {
"id": "domin000000000000001",

"displayName": "world"

"associ ations": {
"role": [{
"i sRequi red": "true",
"di spl ayNane": "test role",

"id": "rol es000000000001044"

1,

"next careerstep":

{
"id": "jobtp000000000200063",

"di spl ayName": "test job2"
1

}
}

UPDATE THE DETAILS OF AJOB TYPE

Overview

Allows updating an existing Job Type based on the Job Type's ID.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api .sabacl oud.com>/v1/jobs/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the jobCode instead of the internal Job Type's ID.

https://< hostname-api.sabacl oud.com> /v1/jobs/jobCode%3D< JobCode>

Calling Options

Table 20: Calling Options
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Name Description Sample Value Data Type Required?
id Job Type's ID string Yes
name The Job Type Job Type REST 101 |string Yes
status Status 100 string No
locale Locale string No
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Name Description Sample Value Data Type Required?
family _id Family's ID jfmly000000000001040 | string Yes
Default Job Family

securityDomain Security Domain string Yes

L

"1d": ""dom~

1r00000000000000L

“name™:

"world"

}
end_date End date string No
description Description desc string No
customValues Custom Values string No
responsibilities Responsibilities string No
is_critical Is critical? false string No
start_date Start date string No
associations Map of associations object | {"role": [{"isRe~ string No

detail

o Note: Only Role and
Next career step can be
passed as the associ~
ation objects.

quired": "true","id":
"YolesD00000000001140 s~
playName": "Engineer
Role 1"}],"nextcareer~
step™: [{"id": "job~
p000000000200309",'dis~
playName":
"JobEW1"}}

Request Body

“name™: "JobEW16 REST TEST 101",

"description"
"end_date': n

ull,

“family_id": {

"idt: Ujfmly
"displayName

"status'': "10
"start_date':
"responsibili
"iIs_critical”
"customValues
“customl™: n
"custom2': n
"custom3": n
custom4': n
"custom5'': n
""custom6'': n

000000000001040",

": "Default Job Family"

o,
null,
ties": null,
: false,

ll: {

ull,

ull,

ull,

ull,

ull,

ull,



""custom7'':
""custom8'':
""custom9'':
""customO':

X

null,
null,
null,
null

’ecurityDomain": {
"id": "domin000000000000001",

“displayName': "world"

"associ ations": {

"role": [{
"i sRequi red": "true",
"di spl ayNane": "test role",

"id": "rol es000000000001044"

1,

"next careerstep":

{
"id": "jobtp000000000200063",

"di spl ayName": "test job2"
]

}
}

g~ Note: To remove the owner association details, use the PUT operation.

GET THE DETAILS OF A PARTICULAR JOB TYPE

Overview

Returns complete information about a Job Type based on the Job Type's ID that is passed as a parameter value.

Requires OAuth
No

Method
GET

URL

https://< hostname-api .sabacl oud.com>/v1/jobs/:id
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g~ Note: Use ?includeassociation=true to retrieve the association details (such as job role and next career step) as

well:

https://< hostname-api .sabacl oud.com>/v1/jobs/:id?includeassociation=true

URL (User-friendly)

You can use a user-friendly URL which accepts the jobCode instead of the internal Job Type's ID.

https://< hostname-api.sabacloud.com>/v1/jobs/jobCode%3D< JobCode> ?includeassociation=true

Calling Options

Table 21: Calling Options

Name

Description

Sample Value

Data Type

Required?

id

Job Type's ID

string

Yes
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Return Values

{ "id": "jobtp000000000200265",
"name": ""JobEW16 REST TEST 101",
"description: "',

"end_date'": null,

“family_id": {

"id": "jfmly000000000001040",
"displayName™: "Default Job Family"

"status': "100",
"start _date'": null,
"responsibilities”: null,
"is_critical": false,
"customValues": {
"customl™: null,
"custom2™: null,
"custom3": null,
"custom4': null,
"custom5': null,
"custom6': null,
"custom7': null,
"custom8": null,
"custom9'': null,
"customO™: null

}

,ecurityDomain": {
"id": "domin000000000000001",
"displayName": "world"

"associ ations": {

"role": [{
"i sRequi red": "true"
"di spl ayNane": "test role",

"id": "rol es000000000001044"
H,

"nextcareerstep": [{

"id": "jobtp000000000200063"
"di spl ayName": "test job2"

]

}

}

g~ Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific
~ object search.

g~ Note: For more details on this see REST API Reference.

Use case

This enhancement makes the Job Type REST APIs more flexible.

Assign or retrieve a job of a Job Family

How did it work?

The following REST APIs didn't allow assigning or retrieving associations such as a job of a Job Family:

*+ CREATE A NEW JOB FAMILY
» UPDATE THE DETAILS OF A JOB FAMILY


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

* GET THE DETAILS OF A PARTICULAR JOB FAMILY

How does it work now?

The following REST APIs now allow assigning or retrieving associations such as a job of a Job Family:

« CREATE A NEW JOB FAMILY
» UPDATE THE DETAILS OF A JOB FAMILY
» GET THE DETAILS OF A PARTICULAR JOB FAMILY

CREATE A NEW JOB FAMILY

Overview

Allows creating a new Job Family.

Requires OAuth
No

Method
POST

URL
https://< hostname-api .sabacl oud.com>/v1/jobfamily/

Calling Options

Table 22: Calling Options
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Name Description Sample Value Data Type Required?
name The name of the Job Family | Job Family 121 string Yes
description The short description for the | JobFamily Description | string No
Job Family
isCareerSiteCategory | Whether it is a career site | true string Yes
category
associations Map of associations object | {"job": [{"id": "job~ |string No
detail p000000000200309","dlis~
g Note: Only job can be p;?{g;me st
passed as the associ~ )
ation object.

Request Body

{
"isCareerSiteCategory': true,
“"name™: 1234,
"description': "1234",
"associations": {
"job": [{



"id

}
}

"j obt p000000000200309",
"di spl ayNane":

"test owner"

UPDATE THE DETAILS OF A JOB FAMILY

Overview

The update method of the Job Family web service allows updating an existing Job Family based on the Job Family's

ID.

Requires OAuth
No

Method
PUT

URL

https://<hosthame-api.sabacloud.com>/v1/jobfamily/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the name instead of the internal Job Family's ID.

https://< hostname-api.sabacl oud.com> /v1/jobfamily/name%3D< JobFamilyName>

Calling Options

Table 23: Calling Options
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detail

g Note: Only job can be
passed as the associ~
ation object.

p000000000200309", "dis~
playName™: "test

job"}}

Name Description Sample Value Data Type Required?
id Job Family's ID string Yes
name The name of the Job Family | Job Family 121 string Yes
description The description for the Job | JobFamily Description | string No
Family
isCareerSiteCategory | Whether it is a career site | true string Yes
category
associations Map of associations object |{"job": [{"id": "job~ |string No
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Request Body

{
"iIsCareerSiteCategory': true,
“name': "1234",
"description': "1234",
"associ ations": {
"job": [{
"id": "jobtp000000000200309"
"di spl ayNane": "test owner"

}
}

g~ Note: The PUT operation only supports adding jobs to the job family. It does not support removing the existing
~ jobs from the job family.

GET THE DETAILS OF A PARTICULAR JOB FAMILY

Overview

Returns complete information about a Job Family based on the Job Family's ID that is passed as a parameter value.

Requires OAuth
No

Method
GET

URL
https://<hosthame-api.sabacloud.com>/v1/jobfamily/:id
g~ Note: Use ?includeassociation=true to retrieve the association details (such as owner) as well:

https://<hosthame-api.sabacloud.com>/v1/jobfamily/:id?includeassociation=true

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Job Family's ID.

https://< hostname-api.sabacl oud.com> /v1/jobfamily/name%3D< JobFamilyName> ?includeassociation=true

Calling Options

Table 24: Calling Options

Name Description Sample Value Data Type Required?

id Job Family's ID string Yes

Return Values

{
"id": "jfmly000000000001020",
"iIsCareerSiteCategory': true,
"name'': "testjobFamily",
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"description™: "1234",

"associ ations": {

llj Obll : {
"id": "jobtp000000000200309"
"di spl ayName": "test owner"

g~ Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific
object search.

. Note: For more details on this see REST API Reference.

Use case

This enhancement makes the Job Family REST APIs more flexible.

Assign, retrieve or remove associations of an Organization

How did it work?
The following REST APIs didn't allow assigning, retrieving or removing associations such as child organization, approver
and continue education plan of an organization:

« CREATE A NEW INTERNAL ORGANIZATION

« CREATE A NEW EXTERNAL ORGANIZATION

* UPDATE THE DETAILS OF AN INTERNAL ORGANIZATION
* UPDATE THE DETAILS OF AN EXTERNAL ORGANIZATION
* GET THE DETAILS OF AN ORGANIZATION

How does it work now?

The following REST APIs now allow assigning, retrieving or removing associations such as child organization, approver
and continue education plan of an organization:

« CREATE A NEW INTERNAL ORGANIZATION

« CREATE A NEW EXTERNAL ORGANIZATION

* UPDATE THE DETAILS OF AN INTERNAL ORGANIZATION
» UPDATE THE DETAILS OF AN EXTERNAL ORGANIZATION
* GET THE DETAILS OF AN ORGANIZATION

CREATE A NEW INTERNAL ORGANIZATION

Overview

Allows creating a new Internal Organization.

Requires OAuth
No

Method
POST


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

URL

https://<hostname-api.sabacl oud.com> /v1/organization?type=internal

Calling Options

Table 25: Calling Options
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Name Description Sample Value Data Type Required?
name Name of the organization | Business Unit REST |string Yes
Test 101
parent_id Parent's ID of the organiza~ | Root string Yes
tion bisut000000000000001

vertical Vertical string No
currency_id The default currency string Yes

{"id":

"display~ ’

Name': "US

Dollars'}
state State statel string No
phone2 Phone 2 12345 string No
securityDomain Security Domain string Yes

"id": ""dom~

in00000000000000L

"name™ :

“"world"

}
phonel Phone 1 11223344 string No
aa_id AA's ID string No
city City cityl string No
description Description desc string No
customValues Custom Values string No
zip Zip 11223311 string No
fax Fax 12312 string No
number Number 123455 string No
country Country countryl string No
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Name Description Sample Value Data Type Required?
cost_center_no Cost center no ccl234 string No
addrl Address 1 addl string No
addr2 Address 2 add2 string No
email Email abc@gmail.com string No
addr3 Address 3 add3 string No
web_server Web server string No
contact_id Contact's ID string No
objectives_administrat~ | Objectives Administrator string No
or

billAddrl Bill Addr 1 billAddrl string No
billAddr2 Bill Addr 2 billAddr2 string No
billCity Bill City billCity string No
billState Bill State billState string No
billZip Bill Zip billZip string No
billCountry Bill Country billCountry string No
associations Map of associations object | {"childorg":[{"display~ | string No

detail

o Note: Only child or~
ganization, approver
and continue education
plan can be passed as
the association objects.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

Name": "Com~
pany1"},{"display~
Name":"anu_Extern~
al_Org","id™:

by Q0000000000082 o~
tinueeducation":[{"'dis~
playName": "test ce~
plan1"},{"display~
Name": "test continue
education'}],"budget~
approver":[{"display~
Name™":"CBUILD~
ER"},{"display~
Name"; "Catalogl
Builder1","id": "per~
sn000000000200920"}H}

Request Body

{

"name': ""test bu2",

"parent_id": {



"id": "bisut000000000000001",
"displayName™: ""Root"

"state': "bulstate",
"number': ""00200236",
"country': "bulcountry',
"description™: null,

"fax'': "bulfax",

"addrl': "buladdressl',
"addr2": "buladdress2",
"addr3T: "',

"currency_id": {

"1d": ""crncy000000000000001",
"displayName™: "US Dollars"

"email': "bul@sabaga.com",
“aa_1d": {

"id": "emplo000000000001026",
"displayName': "Userl Onel"

""cost_center_no'": "111",
"phone2™: ",

"phonel™: "*bulpphone™,
"contact_id": {

"id": "emplo000000000001000",
"displayName'": "User One"
illAddr1™: ",
11Addr2™: """,
ICity": ",
"billState": """,
“billZip": ",

"billCountry": ,

%
b
"b

"objectives_administrator™: null,

‘currencies':
"1d": "crncy000000000000001",
"displayName™: "US Dollars"

¥ {
"1d": "crncy000000000001005",
"displayName'": "Currencyl"

3. i
"id": "crncy000000000001006",
“displayName': "Currency2"
nid": "'crncy000000000200968"",
"displayName": "Rupees"

3,

"vertical”: null,
city'": "bulcity",
“'zip': "bulcity",
"web_server': "webserver",
"customValues": {
“custom9: null,

""customO™: "bulcustomO",
"custom3'': "bulcustom3",
"custom4'': "bulcustom4’,
"customl'™: "‘bulcustoml',
"custom2'™: "bulcustom2’,

"custom7': null,
"custom8": null,
"custom5™: null,
"custom6': null
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[ 1S

}

’ecurityDomain": {
"id": "domin000000000000001",
"displayName™: "world"

éssociations": {
"childorg": [{
"di spl ayNane": "Busi nessUnit4",
"id": "bisut000000000001003"
} il
"di spl ayName": "Busi nessUnit6",
"id": "bisut000000000001005"
3+,
"conti nueeducation": [{
"di spl ayNanme": "test ceplanl”,
"id": "cepl n0O0O0O0D0D0000001200"
booo
"di spl ayName": "test ce plan2"
"id": "cepln00O0000000001220"

H,
"budget approver": [{

"di spl ayNanme": " Catal og Buil der",

"id": "enpl 0000000000200000"
1
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Note: While creating an organization (internal / external), budget approver association is not supported as budget

approver must belong to the same organization.

Return Values

"https://<hostname-api .sabacloud.com>/v1/organization/bisut000000000200261"

}

CREATE A NEW EXTERNAL ORGANIZATION

"displayName'": "Business Unit REST Test 101",

id": "bisut000000000200261",
href':

Overview

Allows creating a new External Organization.

Requires OAuth

No

Method
POST

URL

https://<hosthame-api.sabacloud.com>/v1/organization?type=external



Calling Options

Table 26: Calling Options
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Name Description Sample Value Data Type Required?
name Name of the organization | Company REST Test |string Yes
101
parent_id Parent's ID of the organiza~ string No
tion
vertical Vertical string No
currency_id The default currency string Yes
{ll i dll :
"display~ '
Name': "'US
Dollars™}
state State statel string No
phone2 Phone 2 12345 string No
securityDomain Security Domain string Yes
"1d": ""dom~
1r00000000000000L
“name™:
"world"
}
phonel Phone 1 11223344 string No
sec_key sec_key string No
e the: Th_is is a non-
editable field. Hence
any value that is
passed to it will not be
updated.
city City cityl string No
description Description desc string No
customValues Custom Values string No
zip Zip 11223311 string No
fax Fax 12312 string No
number Number 123455 string No
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Name Description Sample Value Data Type Required?
country Country countryl string No
is_active is_active true string No
addrl Address 1 addl string No
addr2 Address 2 add2 string No
email Email abc@gmail.com string No
addr3 Address 3 adds3 string No
web_server Web server string No
contact_id contact_id string No
objectives_administrat~ | objectives_administrator string No
or

billAddrl Bill Addr 1 billAddrl string No
billAddr2 Bill Addr 2 billAddr2 string No
billCity Bill City billCity string No
billState Bill State billState string No
billZip Bill Zip billZip string No
billCountry Bill Country billCountry string No
learning_vendor Learning vendor true string No
learning_manufacturer | Learning manufacturer true string No
business_typ Business type string No
associations Map of associations object | {"childorg":[{"display~ | string No

detail

o~ NOte: Only child or~
ganization, approver
and continue education
plan can be passed as
the association objects.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

Name": "Com~
panyl1"},{"display~
Name":"anu_Extern~
al_Org","id":

oy 0000000000082 | b~
tinueeducation™:[{"'dis~
playName": "test ce~
plan1"},{"display~
Name": "test continue
education"}],"budget~
approver":[{"display~
Name":"CBUILD~
ER"},{"display~
Name": "Catalogl
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Name Description Sample Value Data Type Required?
Builder1"”,"id": "per~
sn000000000200920"}H}
Request Body
{
"name": ""test compl',

"parent_id": {
"id": "cmpny000000000200062",
"displayName': "Ext_org_Sales&Mkt"

"state': "bulstate",
"number™: 005001,
"country': "bulcountry’,
“description': null,
"fax'': "bulfax",
"addrl': "buladdressl',
"addr2'": "buladdress2",
"addr3T: "',
“currency_id": {
"1d": "crncy000000000000001",
"displayName™: "US Dollars"

"email': "bul@sabaga.com",
"Is_active': false,
"learning_vendor™: false,
"learning_manufacturer': false,
"phone2": "',
"phonel™: "bulpphone™,
"contact_id": {
"1d": "persn000000000001000",
"displayName™: "Client One"

},
“"billAddrl": "addi",
“"billAddr2": "add2",
"billCity": "cityl",
"billState': "statel",
“"billZip'": "123456",
“"billCountry': "Insia",
"objectives _administrator™: null,
"currencies':
"1d": ""crncy000000000000001",
"displayName™: "US Dollars"

3. i
"id": "crncy000000000001005",
"displayName'": "Currencyl"
3. {
"1d": "crncy000000000001006",
"displayName'": "Currency2"
3. i
"id": "crncy000000000200968",
"displayName": "Rupees"

"vertical': null,

"city': "bulcity",

"zip": "bulcity",
"business_typ'": "'
"web_server': "webserver',
"customValues": {
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"custom9": null,

"customO'": "‘bulcustom0',
"custom3'': "bulcustom3,
"custom4'': "bulcustom4’,
"customl'™: "bulcustoml',
"custom2': "bulcustom2',

"custom7'': null,
"custom8": null,
"custom5"™: null,
"custom6': null

X

’ecurityDomain": {
"id": ""domin000000000000001",
"displayName™: "world"

"associ ations": {

"childorg": [{
"di spl ayName": "Ext_org_Sal esl ndi a"
"id": "cnmpny000000000200064"

H,

"conti nueeducation": [{

"di spl ayNanme": "test ceplanl”,
"id": "cepl n0O000D0D0000001200"

}

Ldisplayhbne": "test continue education",
"id": "cepl n000000000001160"

H,
"budget approver": [{

"di spl ayName": "Cdient4 One4",
"id": "persn000000000001023"
}H

g~ Note: While creating an organization (internal / external), budget approver association is not supported as budget
- approver must belong to the same organization.

Return Values

{

"1d": ""cmpny000000000200224",

"displayName": "Company REST Test 101",

“href':

"https://<hostname-api .sabacloud.com>/v1/organization/cmpny000000000200224""
}

UPDATE THE DETAILS OF AN INTERNAL ORGANIZATION

Overview

Allows updating an existing Internal Business Organization based on the Organization's ID.

Requires OAuth
No

Method
PUT



URL

https://<hostname-api .sabacl oud.com>/v1/organization/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the number instead of the internal Organization's ID.

https://< hostname-api .sabacl oud.com>/v1/organization/number%3D< OrgNo>

Calling Options

Table 27: Calling Options
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Name Description Sample Value Data Type Required?
id Organization's ID string Yes
name Name of the organization | Business Unit REST |string Yes
Test 101
parent_id Parent's ID of the organiza~ | Root string Yes
tion bisut000000000000001

vertical Vertical string No
currency_id The default currency string Yes

{id":

"display~ '

Name': "'US

Dollars™}
state State statel string No
phone2 Phone 2 12345 string No
securityDomain Security Domain string Yes

"id": ""dom~

in00000000000000L

“name™:

"world"

}
phonel Phone 1 11223344 string No
aa_id AA'sID string No
city City cityl string No
description Description desc string No
customValues Custom Values string No
zip Zip 11223311 string No
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Name Description Sample Value Data Type Required?
fax Fax 12312 string No
number Number 123455 string No
country Country countryl string No
cost_center_no Cost center no ccl234 string No
addrl Address 1 addl string No
addr2 Address 2 add2 string No
email Email abc@gmail.com string No
addr3 Address 3 add3 string No
web_server Web server string No
contact_id Contact's ID string No
objectives_administrat~ | Objectives administrator string No
or

billAddrl Bill Addr 1 billAddrl string No
billAddr2 Bill Addr 2 billAddr2 string No
billCity Bill City billCity string No
billState Bill State billState string No
billZip Bill Zip billZip string No
billCountry Bill Country billCountry string No
currencies Currencies string No
associations Map of associations object | {"childorg":[{"display~ | string No

detail

o~ NOte: Only child or~
ganization, approver
and continue education
plan can be passed as
the association objects.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

Name": "Com~
panyl1"},{"display~
Name":"anu_Extern~
al_Org","id":

oy 0000000000082 | b~
tinueeducation™:[{"'dis~
playName": "test ce~
plan1"},{"display~
Name": "test continue
education"}],"budget~
approver":[{"display~
Name":"CBUILD~
ER"},{"display~
Name": "Catalogl
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Name Description

Sample Value

Data Type

Required?

Builder1"”,"id": "per~
sn000000000200920"}H}

Request Body

{

"name': "'test bu2",
"parent_id": {

"id": "bisut000000000000001",
"displayName™: "'Root"

"state': "bulstate",
"number: ""00200236",
"country': "bulcountry’,
“description': null,

"fax'': "bulfax",

"addrl': "buladdressl',
"addr2'": "buladdress2",
"addr3T: "',

“currency_id": {

"1d": "crncy000000000000001",
"displayName™: "US Dollars"

"email': "bul@sabaga.com",
"aa_id": {

"id": "emplo000000000001026",
"displayName': "Userl Onel™

""cost_center_no'": "111",
"phone2™: ",

"phonel™: "bulpphone™,
"contact_id": {

"id": "emplo000000000001000",
"displayName'": "User One"

“"ballZip": ",
"billCountry": """,
"objectives _administrator™: null,
"‘currencies'':
"1d": "crncy000000000000001",
"displayName': "US Dollars"
3. {
"1d": "crncy000000000001005",
"displayName'": "Currencyl"

¥, 1
nld
"di
¥, 1
nld
“di

"1 "crncy000000000001006"
splayName™: "Currency2"

“: "crncy000000000200968" ,
splayName™: “Rupees"

"vertical”: null,
city'": “bulcity",
“'zip': "bulcity",
"web_server': "webserver",



"customValues": {
"custom9": null,
"customO'": "bulcustom0',
"custom3'': "bulcustom3’,
"custom4': "bulcustom4',
"customl™: "bulcustoml',
"custom2': "bulcustom2',
"custom7'': null,
"custom8": null,
"custom5™: null,
""custom6': null

}

,ecurityDomain": {
"id": "domin000000000000001",
"displayName": "world"

"associ ations": {

"childorg": [{
"di spl ayName": "Busi nessUnit4",
"id": "bisut000000000001003"

Ldisplayhbne": "Busi nessUni t 6",
"id": "bisut000000000001005"
H,

"conti nueeducation": [{
"di spl ayNanme": "test ceplanl",
"id": "cepl n0O000D0D0000001200"

L
"di spl ayName": "test ce plan2"
"id": "cepl nO0O0O0D0D0000001220"

1,
"budget approver": [{

"di spl ayNanme": " Catal og Buil der",
"id": "enpl 0000000000200000"
}H

g~ Note: To remove the owner association details, use the PUT operation.

UPDATE THE DETAILS OF AN EXTERNAL ORGANIZATION

Overview

Allows updating an existing External Business Organization based on the Organization's ID.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api .sabacl oud.com>/v1/organization/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the number instead of the internal Organization's ID.
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https://< hostname-api .sabacl oud.com> /v1/organization/number%3D< OrgNo>

Calling Options

Table 28: Calling Options

| System | 98

Name Description Sample Value Data Type Required?
id Organization's ID string Yes
name Name of the organization | Company REST Test |string Yes
101
parent_id Parent's ID of the organiza~ string No
tion
vertical Vertical string No
currency_id The default currency string Yes
{ll i dll :
"display~ ’
Name®: "'US
Dollars'"}
state State statel string No
phone2 Phone 2 12345 string No
securityDomain Security Domain string Yes
"id": "dom~
in00000000000000L
"name™ :
"world"
}
phonel Phone 1 11223344 string No
sec_key sec_key aaaa string No
g Note: Thisis a non-
editable field. Hence
any value that is
passed to it will not be
updated.
city City cityl string No
description Description desc string No
customValues Custom Values string No
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Name Description Sample Value Data Type Required?
zip Zip 11223311 string No
currencies Currencies string No
fax Fax 12312 string No
number Number 123455 string No
country Country countryl string No
is_active Is active? true string No
addrl Address 1 addl string No
addr2 Address 2 add2 string No
email Email abc@gmail.com string No
addr3 Address 3 adds3 string No
web_server Web server string No
contact_id Contact's ID string No
objectives_administrat~ | Objectives administrator string No
or

billAddrl Bill Addr 1 billAddrl string No
billAddr2 Bill Addr 2 billAddr2 string No
billCity Bill City billCity string No
billState Bill State billState string No
billZip Bill Zip billZip string No
billCountry Bill Country billCountry string No
learning_vendor Learning vendor true string No
learning_manufacturer | Learning manufacturer true string No
business_typ Business type string No
associations Map of associations object |{"childorg™:[{"display~ | string No

detail

o Note: Only child or~
ganization, approver
and continue education

Name": "Com~
panyl1"},{"display~
Name":"anu_Extern~
al_Org","id":

by 3000000000082 | o~




| System | 100

Name Description Sample Value Data Type

Required?

plan can be passed as | tinueeducation:[{"dis~
the association objects. |playName™: "test ce~
plan1"}{"display~
Pass this attribute, only if | Name™: "test continue
you need to update the asso~ | education™}],"budget~
ciation. Pass it as NULL to |approver”:[{"display~
remove all the existing asso~ | Name":"CBUILD~
ciation data. ER"},{"display~
Name": "Catalogl
Builderl","id": "per~
sn000000000200920"}H}

Request Body

{

"name": "‘test compl',

“"parent_id": {

"id": ""cmpny000000000200062",
"displayName': "Ext_org_Sales&Mkt"

"state': "bulstate",
"number™: 005001,
"country': "bulcountry’,
“description’: null,

"fax'': "bulfax",

"addrl': "buladdressl',
"addr2": "buladdress2",
"addr3T: "',

“currency_id": {

"1d": "crncy000000000000001",
"displayName™: "US Dollars"

"email': "bul@sabaga.com",
"Is_active': false,
"learning_vendor™: false,
"learning_manufacturer': false,
"phone2": """,

"phonel™: "bulpphone™,
"contact_id": {

"1d": "persn000000000001000",
"displayName™: "Client One"

}.
"billAddrl™: "addl",
"billAddr2™": "add2",
"billCity": "cityl",
"billState': "statel",
“"billZip': "123456",
“"billCountry': "Insia",
"objectives _administrator™: null,
"currencies':
"1d": ""crncy000000000000001",
"displayName™: "US Dollars"
3. {
"id": "crncy000000000001005",
"displayName': "Currencyl"
3. {
"1d": "crncy000000000001006",
"displayName'": "Currency2"
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3. {
"id": "crncy000000000200968",
"displayName": "Rupees"

“vertical”: null,

“city': "bulcity",

“'zip': "bulcity",
"business_typ'": """,
"web_server': "webserver",
"customValues": {
“custom9: null,

"customO™: "bulcustomO',
"custom3'': "bulcustom3",
"custom4'': "bulcustom4’,
"customl'™: "‘bulcustoml',
"custom2'™: "bulcustom2’,

"custom7': null,
"custom8": null,
"custom5"™: null,
"custom6': null

}

,ecurityDomain": {
"id": "domin000000000000001",
"displayName™: "world"

"associ ations": {

"childorg": [{
"di spl ayNane": "Ext_org_Sal esl ndi a",
"id": "cnmpny000000000200064"

1

"conti nueeducation": [{

"di spl ayNanme": "test ceplanl",
"id": "cepl n0O000D0D0000001200"

}

Ldisplayhhne": "test continue education”,
"id": "cepl n0O0O0O0D0D0000001160"

M,
"budget approver": [{

"di spl ayNanme": "Cdient4 One4d",
"id": "persn000000000001023"
}H

g~ Note: To remove the owner association details, use the PUT operation

GET THE DETAILS OF AN ORGANIZATION

Overview

Returns complete information about an Organization based on the Organization's ID that is passed as a parameter value.

Requires OAuth
No

Method
GET



URL

https://< hostname-api.sabacl oud.com>/v1/organization/:id

[ 1

https://< hostname-api .sabacl oud.com>/v1/organization/:id?includeassociation=true

URL (User-friendly)

Note: Use ?includeassociation=true to retrieve the association details as well:

You can use a user-friendly URL which accepts the number instead of the internal Organization's ID.

https://< hostname-api.sabacl oud.com> /v1/organization/number%3D< OrgNo> ?includeassociation=true

Calling Options

Table 29: Calling Options
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Name Description

Sample Value

Data Type

Required?

id Organization's ID

string

Yes

Return Values

"name': 'test bu2",
"parent_id": {

"id": "bisut000000000000001",
"displayName': "Root"

""'state': "bulstate",
"number': 00200236,
"country": "bulcountry",
"description™: null,

"fax'': "bulfax',

"addrl': "buladdressl’,
"addr2'": "buladdress2",
"addr3T: "',

"currency_id": {

"1d": "crncy000000000000001",
"displayName': "US Dollars"

"émail": "bul@sabaqga.com",

"aa_id": {
"id": "emplo000000000001026",
"displayName™: "Userl Onel"

"‘cost_center_no': "111",
"phone2": "',

"phonel™: "bulpphone™,
"contact_id": {

"1d": "emplo000000000001000",
"displayName™™: "User One"
illAddrl™: ",

1Addr2™: ",

ICity": "',

illState™: ",

“"billZip": ",

"billCountry": """,

"objectives _administrator™: null,

“bil
“bil
"bil
"bil
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"currencies':
"id": "crncy000000000000001",
"displayName™: "US Dollars"

"1d": "crncy000000000001005",
"displayName™": "Currencyl"
3, {
"1d": "crncy000000000001006",
"displayName'": "Currency2"
3. {
"1d": "crncy000000000200968",
"displayName™™: "Rupees"
.

"vertical": null,

"city': "bulcity",

“zip": "bulcity",
"web_server': "webserver’,
"customValues™: {

"custom9'': null,

"customO'": "‘bulcustom0',
"custom3'': "‘bulcustom3,
"custom4'': "bulcustom4’,
"customl™: "bulcustoml',
"custom2': "bulcustom2',
"custom7': null,

"custom8": null,

"custom5"™: null,

"custom6': null

X

’ecurityDomain": {
"id": ""domin000000000000001",
"displayName™: "world"

"id": "bisut000000000200275",
"associ ations": {
"childorg": [{
"di spl ayName": "Busi nessUnit4",
"id": "bisut000000000001003"

Ldisplayhbne": "Busi nessUni t 6",
"id": "bisut000000000001005"
H,
"conti nueeducation": [{
"di spl ayNanme": "test ceplanl",
"id": "cepl n00O0000000001200"
b
"di spl ayName": "test ce plan2"
"id": "cepl n000000000001220"
H,
"budget approver": [{
"di spl ayNanme": " Catal og Buil der",
"id": "enpl o000000000200000"
}H

g~ Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific
- object search.

© Note: For more details on this see REST API Reference.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
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Use case

Currently using REST API, an admin is able to create only the fields that are part of the base organization component. The
attributes associated with an organizations are missing. With this enhancement, the user will be able to add/remove these
fields.

Assign, retrieve or remove associations of a Competency

How did it work?

The following REST APIs didn't allow assigning, retrieving or removing associations such as Proficiency Levels,
Behavioral Indicators,Weights, Skill Groups and Mode of Skill Rating of a competency:

« CREATE A NEW COMPETENCY
* UPDATE THE DETAILS OF A COMPETENCY
» GET THE DETAILS OF A PARTICULAR COMPETENCY

How does it work now?

The following REST APIs now allow assigning, retrieving or removing associations such as Proficiency Levels,
Behavioral Indicators,Weights, Skill Groups and Mode of Skill Rating of a competency:

 CREATE A NEW COMPETENCY
 UPDATE THE DETAILS OF A COMPETENCY
» GET THE DETAILS OF A PARTICULAR COMPETENCY

CREATE A NEW COMPETENCY

Overview

Allows creating a new competency.

Requires OAuth
No

Method
POST

URL

https://<hostname-api .sabacl oud.com> /v1/competency/

Calling Options

Table 30: Calling Options

Name Description Sample Value Data Type Required?
name The name of the competency | General Computer string Yes
Knowledge
description The short description about | Understanding relation~ | string No
the competency ship of CPU, 1/0O,
Storage, and operating
system.
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Name Description Sample Value Data Type Required?
securityDomain The domain for the facility string Yes
Supports lookup (Domain). | «jqe- "gdom~

In000000000000001

""name™:

"world"

}
customValues Custom Values string No
associations Map of associations object | { "skillGroup":[], string No

detail

[

Note: Only Profi~
ciency Levels, Behavi~
oral Indicat~
ors,Weights, Skill
Groups and Mode of
Skill Rating can be
passed as the associ~
ation objects.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

[

Note: The default
value of weights of be~
havioral indicators and
rating weights of com~
petency methods is 0.

Note: While creating
associations, the exist~
ing proficiency levels
are associated to the
competency by default.
The proficiency level
specified in the Input
JSON should be differ~
ent from the ones
already existing.

"rateskillby":"Profi~
ciency Levels", "beha~
vioralindicator":[{
"displayName":"test~
BI", "weight":30 },{
"displayName":"test~
BI2", "weight™:30 } ],
"weights":[ { "meth~
0d":"ManagerAssess~
ment", "rating":105 },
{ "method":"Sel~
fAssessment", "rat~
ing":105 }, { "meth~
od":"Feedbackfro~
mOthers", "rat~
ing":1000 }, { "meth~
od":"LearningOffer~
ing", "rating":10 } ],
"proficiency":[ { "dis~
playName":"testprofi~
ciency", "descrip~
tion":"proficiencyde~
scription”, "profi~
ciencylLevel™:7}, {
"displayName":"test~
Proficiency2", "de~
scription™;"proficiency~

descriptiontest"”, "profi~
ciencylLevel":8} 1}

Request Body

"description’: "testSkill",
"name': "testSkill",
"securityDomain™: {
"id": "domin000000000000001",
"displayName™: "world"



}1
"associations": {
"rateskill by" : "Behavioral Indicators"
"skill Goup": [
"di spl ayName": " Sanple G oup",
"id": "cpgrp000000000001000"
}1
U, -
"di spl ayNane": "I ndi vi dua
"id": "cpgrp000000000001020"
"di spl ayName": " Manager",
"id": "cpgrp000000000001021"
]}
"’ehavioralindicator": [{
"di spl ayNanme": "nmethodl",
"wei ght" : 30
’ "di spl ayNane": "nmet hod2"
"wei ght " 50
.
"wei ghts": |
"met hod": "Learning Ofering"
"rating": 10
%!
"met hod": "Self Assessnent",
"rating": 100
{
"met hod": "Feedback from O hers”
"rating": 100
%1
"met hod": "Manager Assessnent",
“rating": 10
}
b
"proficiency": [
"di spl ayNane": " CQutstandi ngl”
"description": null,
"proficiencyLevel": 6
%l
"di spl ayNanme": " Qutstandi ng2",
"description": null,
"proficiencyLevel": 7
}
]
}
}

Return Values

{

"id": "compt000000000001223",
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Excel | ence",



“displayName': "testSkill5",
“href':

"https://<hostname-api .sabacloud.com>/v1/competency/compt000000000001223"
}

UPDATE THE DETAILS OF A COMPETENCY

Overview

Allows updating an existing competency based on the Competency's ID.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api .sabacl oud.com>/v1/competency/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the Competency's ID.

https://< hostname-api .sabacl oud.com>/v1/competency/:id/name%3D< CompetencyName>

Calling Options

Table 31: Calling Options
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Name Description Sample Value Data Type Required?
id Competency's ID string Yes
name The name of the competency | General Computer string Yes
Knowledge
description The short description about | Understanding relation~ | string No
the competency ship of CPU, I/0,
Storage, and operating
system.
securityDomain The domain for the facility string Yes
Supports lookup (Domain). | 4t - “gom~
in00000000000000L
"name™ :
“"world"
}
customValues Custom Values string No
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Name Description Sample Value Data Type Required?
associations Map of associations object | { "skillGroup™:[], string No
detail "rateskillby":"Profi~

o~ NOte: Only Profi~
ciency Levels, Behavi~
oral Indicat~
ors,Weights, Skill
Groups and Mode of
Skill Rating can be
passed as the associ~
ation objects.

Pass this attribute, only if
you need to update the asso~
ciation. Pass it as NULL to
remove all the existing asso~
ciation data.

us Note: The default
value of weights of be~
havioral indicators and
rating weights of com~
petency methods is 0.

g~ Note: While updating
associations, the Profi~
ciency level must be in
sequence, starting with
1.

While creating associ~
ations, the existing
proficiency levels are
associated to the com~
petency by default.
The proficiency level
specified in the Input
JSON should be differ~
ent from the ones
already existing.

ciency Levels", "beha~
vioralindicator":[{
"displayName":"test~
BI", "weight":30 }.{
"displayName":"test~
B12", "weight":30 } ],
"weights":[ { "meth~
od":"ManagerAssess~
ment", "rating":105 },
{ "method":"Sel~
fAssessment", "rat~
ing":105 }, { "meth~
od":"Feedbackfro~
mOthers", "rat~
ing":1000 }, { "meth~
od":"LearningOffer~
ing", "rating":10 } ],
"proficiency":[ { "dis~
playName":"testprofi~
ciency"”, "descrip~
tion":"proficiencyde~
scription”, "profi~
ciencylLevel™:7 }, {
"displayName":"test~
Proficiency2", "de~
scription":"proficiency~

descriptiontest", "profi~
ciencyLevel™:8%} 1}

Request Body

{

"description': "testSkillUpdate",
"name': "testSkillUpdate",
"securityDomain': {

"id": "domin000000000000001",

“displayName™: "world"

"associations": {
[

"skill Goup": [],

"rateskill by": "Proficiency Levels"

"behavi oral i ndicator": [



}!

L,
"di spl ayNanme": "met hod2"
"wei ght": 50,
"id": "cpevi 000000000001041"

}

1.
"wei ghts": |
nmet hod": "Learning O fering"

"rating": 10

}!

{
"met hod": "Self Assessnent",
"rating": 100

%1
"met hod": "Feedback from O hers"
"rating": 100

%l
"met hod": "Manager Assessnent",
"rating": 10

}

1,

"di spl ayName": "nethodl",
"wei ght": 30,
"id": "cpevi 000000000001040"

"proficiency": [

"displayhbne": " Poor "
"description": nul
"prof|C|encyLeveI 1

"id" cvaI000000000001001

"displayhbne": "Bel ow Aver age"
"description": nul
"prof|C|encyLeveI 2

"id" Cp|v|000000000001002

"displayhbne": "AMeraQEU
"description": nul
"prof|C|encyLeveI 3

"id" cvaI000000000001003

"displayhbne": "Above Aver age"
"description": nul
"prof|C|encyLeveI 4

"id" cvaI000000000001004

"displayhbne": "CUtstandingU
"description": nul
"prof|C|encyLeveI 5

"id" cvaI000000000001005

"di spl ayNanme": " CQutstandi ngl",
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"description": null,
"proficiencyLevel ": 6,
"id": "cplvl 000000000001006"

}!

L, o
"di spl ayName": "test_ Proficiency",
"description": null,
"proficiencyLevel": 7

}

]
}
+

g~ Note: To remove the owner association details, use the PUT operation.

GET THE DETAILS OF A PARTICULAR COMPETENCY

Overview

Returns complete information about a competency based on the Competency's ID that is passed as a parameter value.

Requires OAuth
No

Method
GET

URL
https://< hostname-api .sabacloud.com>/v1/competency/:id
ge- Note: Use ?includeassociation=true to retrieve the association details as well:

https://< hostname-api .sabacl oud.com>/v1/competency/:id?includeassociation=true

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the Competency's ID.

https://< hostname-api .sabacl oud.com>/v1/competency/:id/name%3D< CompetencyName> ?includeassociation=true

Calling Options

Table 32: Calling Options

Name Description Sample Value Data Type Required?

id Competency's ID string Yes

Return Values

"description”: "testSkill",
"name': ""testSkill",
"securityDomain™: {
"id": ""domin000000000000001",
“displayName™: "world"



},

tidh:

''compt000000000001141"",

"associ ations": {
"skill Goup": [],

"rateskillby": "Proficiency Levels"

"behavi oral i ndi cator": [

}
L,
"di spl ayNanme": "met hod2"
"wei ght": 50,
"id": "cpevi 000000000001041"
}
1.
"wei ghts": |
"met hod": "Learning O fering"
"rating": 10
"met hod": "Self Assessnent",
"rating": 100
"met hod": "Feedback from O hers"

}
1,

"di spl ayName": "nethodl",
"wei ght": 30,
"id": "cpevi 000000000001040"

"rating": 100

"met hod": "Manager Assessnent",
"rating": 10

"proficiency": [

P

P

P

P

"displayhbne": " Poor "

"description": nul
"prof|C|encyLeveI 1
"id" cvaI000000000001001

"displayhbne": "Bel ow Aver age"
"description": nul
"prof|C|encyLeveI 2

"id" Cp|v|000000000001002

"displayhbne": "AMeraQEU
"description": nul
"prof|C|encyLeveI 3

"id" cvaI000000000001003

"displayhbne": "Above Aver age"
"description": nul
"prof|C|encyLeveI 4

"id" cvaI000000000001004

"di spl ayNanme": " CQutstandi ng",
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"descri ption": null,
"profici encyLeveI . 5,
"id": "cplvl 000000000001005"

I
U, _
"di spl ayNarre": "Qut st andi ngl",
"descri ption": null,
"profici encyLeveI . 6,
"id": "cplvl 000000000001006"
I
U, o
"di spl ayNarre" : "testProficiency",
"descri ption": null,
"profici encyLeveI DT,
"id": "cplvl 000000000001015"
}
]
}
}
g~ Note: Associations will not work with the includeDetails=true query param. This is applicable only for specific
~ object search.
g~ Note: For more details on this see REST API Reference.
Use case

This enhancement makes the Role REST APIs more flexible.

Pass user-friendly IDs to REST APIs

How did it work?

The following REST APIs only accepted internal IDs:

» UPDATE THE DETAILS OF A FACILITY

* GET THE DETAILS OF A PARTICULAR FACILITY

» UPDATE THE DETAILS OF A LOCATION

» GET THE DETAILS OF A PARTICULAR LOCATION

* UPDATE THE DETAILS OF A JOB FAMILY

* GET THE DETAILS OF A PARTICULAR JOB FAMILY

» UPDATE THE DETAILS OF A JOB TYPE

* GET THE DETAILS OF A PARTICULAR JOB TYPE

» UPDATE THE DETAILS OF A ROLE

e GET THE DETAILS OF A PARTICULAR ROLE

« UPDATE THE DETAILS OF AN INTERNAL ORGANIZATION
» UPDATE THE DETAILS OF AN EXTERNAL ORGANIZATION
* GET THE DETAILS OF AN ORGANIZATION

 UPDATE THE DETAILS OF A COMPETENCY

» GET THE DETAILS OF A PARTICULAR COMPETENCY

» UPDATE THE DETAILS OF A COMPETENCY

* GET THE DETAILS OF A PARTICULAR COMPETENCY

* GET THE REQUIRED PROFILE DETAILS OF A PARTICULAR PERSON
e UPDATE A PROFILE FOR GIVEN PERSON ID [EXTERNAL]
* UPDATE A PROFILE FOR GIVEN PERSON ID [INTERNAL]


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

* UPDATE A PERSON'S FLIGHTRISK DETAILS

* UPDATE COREPROFILE DETAILS OF A PERSON

* UPDATE THE RETIREMENT RISK DETAILS OF A PERSON

» UPDATE THE POTENTIAL RATING DETAILS OF A PERSON

» UPDATE THE SABA MEETING PROFILE DETAILS OF A PERSON
* UPDATE THE INTERESTS DETAILS OF A PERSON

 UPDATE THE TEAM DETAILS OF A PERSON

* GET THE DETAILS OF A PARTICULAR POSITION

How does it work now?

These REST APIs now also accept user-friendly IDs in addition to the internal IDs.
UPDATE THE DETAILS OF A FACILITY

URL
https://< hostname-api.sabacl oud.com>/v1/facility/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the facility_no instead of the internal Facility's ID.

https://< hostname-api.sabacloud.com>/v1/facility/facility no%3D<FacilityNo>
GET THE DETAILS OF A PARTICULAR FACILITY

URL
https://< hostname-api.sabacl oud.com>/v1/facility/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the facility_no instead of the internal Facility's ID.

https://< hostname-api.sabacloud.com>/v1/facility/facility no%3D<FacilityNo>
UPDATE THE DETAILS OF A LOCATION

URL

https://< hostname-api.sabacloud.com>/v1/location/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the loc_no instead of the internal Location's ID.

https://< hostname-api .sabacl oud.com>/v1/location/loc_no%3D< LocationNo>
GET THE DETAILS OF A PARTICULAR LOCATION

URL
https://< hostname-api.sabacloud.com>/v1/location/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the loc_no instead of the internal Location's ID.

https://< hostname-api .sabacl oud.com>/v1/location/loc_no%3D< LocationNo>
UPDATE THE DETAILS OF A JOB FAMILY

| System | 113



| System | 114

URL
https://< hostname-api.sabacl oud.com>/v1/jobfamily/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Job Family's ID.

https://< hostname-api.sabacl oud.com> /v1/jobfamily/name%3D< JobFamilyName>
GET THE DETAILS OF A PARTICULAR JOB FAMILY

URL
https://< hostname-api.sabacl oud.com>/v1/jobfamily/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Job Family's ID.

https://< hostname-api.sabacl oud.com> /v1/jobfamily/name%3D< JobFamilyName>
UPDATE THE DETAILS OF A JOB TYPE

URL
https://< hostname-api .sabacl oud.com>/v1/jobs/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the jobCode instead of the internal Job Type's ID.

https://< hostname-api.sabacl oud.com> /v1/jobs/jobCode%3D< JobCode>
GET THE DETAILS OF A PARTICULAR JOB TYPE

URL
https://< hostname-api .sabacl oud.com>/v1/jobs/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the jobCode instead of the internal Job Type's ID.

https://< hostname-api.sabacl oud.com> /v1/jobs/jobCode%3D< JobCode>
UPDATE THE DETAILS OF A ROLE

URL

https://< hostname-api .sabacl oud.com>/v1/role/:id

URL (User-friendly)

You can use a user-friendly URL which accepts the name instead of the internal Role's ID.
https://< hostname-api.sabacloud.com>/v1/role/name%3D< RoleName>

GET THE DETAILS OF A PARTICULAR ROLE

URL
https://< hostname-api .sabacloud.com>/v1/role/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the internal Role's ID.
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https://< hostname-api.sabacloud.com>/v1/role/name%3D< RoleName>
UPDATE THE DETAILS OF AN INTERNAL ORGANIZATION

URL
https://< hostname-api.sabacl oud.com>/v1/organization/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the number instead of the internal Organization's ID.

https://< hostname-api .sabacl oud.com>/v1/organization/number%3D< OrgNo>
UPDATE THE DETAILS OF AN EXTERNAL ORGANIZATION

URL
https://< hostname-api.sabacl oud.com>/v1/organization/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the number instead of the internal Organization's ID.

https://< hostname-api .sabacl oud.com>/v1/organization/number%3D< OrgNo>
GET THE DETAILS OF AN ORGANIZATION

URL
https://< hostname-api .sabacl oud.com>/v1/organization/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the number instead of the internal Organization's ID.

https://< hostname-api .sabacl oud.com>/v1/organization/number%3D< OrgNo>
UPDATE THE DETAILS OF A COMPETENCY

URL
https://< hostname-api.sabacl oud.com> /v1/competency/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the Competency's ID.

https://< hostname-api .sabacl oud.com>/v1/competency/:id/name%3D< CompetencyName>
GET THE DETAILS OF A PARTICULAR COMPETENCY

URL
https://< hostname-api.sabacl oud.com> /v1/competency/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the name instead of the Competency's ID.

https://< hostname-api .sabacl oud.com>/v1/competency/:id/name%3D< CompetencyName>
GET THE REQUIRED PROFILE DETAILS OF A PARTICULAR PERSON

URL
https://< hostname-api.sabacloud.com>/v1/people/:id:(:searchFields)
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URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://< hostname-api .sabacl oud.com>/v1/people/username%3D< User Name>
UPDATE A PROFILE FOR GIVEN PERSON ID [EXTERNAL]

URL
https://< hostname-api.sabacl oud.com> /v1/people/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://< hostname-api .sabacl oud.com>/v1/people/username%3D< User Name>
UPDATE A PROFILE FOR GIVEN PERSON ID [INTERNAL]

URL
https://< hostname-api .sabacl oud.com> /v1/people/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://< hostname-api .sabacl oud.com>/v1/people/username%3D< User Name>
UPDATE A PERSON'S FLIGHTRISK DETAILS

URL
https://< hostname-api.sabacl oud.com>/v1/people/:person_id/flightRisk/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Flight Risk's ID.

https://< hostname-api.sabacl oud.com>/v1/people/username%3D<Username>/flightRisk/username%3D<Username>?type=:type
UPDATE COREPROFILE DETAILS OF A PERSON

URL
https://< hostname-api.sabacl oud.com> /v1/people/:person_id/coreProfile/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Core Profile's ID.

https://< hostname-api.sabacd oud.com>/v1/people/username%3D<Username>/coreProfile/username%3D<Username>?type=:type
UPDATE THE RETIREMENT RISK DETAILS OF A PERSON

URL
https://< hostname-api.sabacl oud.com>/v1/people/:personld/retirementRisk/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Retirement Risk’s ID.

https://< hastname-api.sabad oud.con™ Avl/peoplefusername%3D<Username>/retirementRisk/username%3D<Username>2type=:type
UPDATE THE POTENTIAL RATING DETAILS OF A PERSON
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URL
https://< hostname-api.sabacloud.com>/v1/people/:person_id/potentialRating/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Potential Rating's ID.

https://< hosname-api.sabad oud.com>/v1/people/username%e3D<Usemame>/potentialRating/username%3D<Username>?type=:type
UPDATE THE SABA MEETING PROFILE DETAILS OF A PERSON

URL
https://< hostname-api.sabacl oud.com>/v1/people/:person_id/centraProfile/:id

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Saba Metting Profile's ID.

https://< hostname-api .sabad oud.con>/v1/people/username%3D<Username>/centraProfile/username%3D<Username>?type=:type
UPDATE THE INTERESTS DETAILS OF A PERSON

URL
https://< hostname-api.sabacl oud.com>/v1/people/:person_id/interests/:personld

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://< hostname-api.sabacl oud.com>/v1/people/username%3D< User Name> /interests/username%3D< User Name>
UPDATE THE TEAM DETAILS OF A PERSON

URL
https://< hostname-api.sabacl oud.com>/v1/people/:person_id/teamInfo/:personld

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://< hostname-api.sabacl oud.com> /v1/people/username%3D< User Name> /teamInfo/username%3D< User Name>
UPDATE THE NETWORK INFO DETAILS OF A PERSON

URL

https://< hostname-api .sabacl oud.com>/v1/people/:person_id/networkInfo/:personld

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://< hostname-api.sabacl oud.com> /v1/people/username%3D< User Name> /networkInfo/username%3D< User Name>
GET THE DETAILS OF A PARTICULAR POSITION

URL
https://< hostname-api.sabacloud.com>/v1/position/:id:(:searchFields)

URL (User-friendly)
You can use a user-friendly URL which accepts the position_id instead of the internal Position's ID.



https://< hostname-api .sabacl oud.com>/v1/position/position_id%3D<PositionID see on Ul>

P Note: For more details on this see REST API Reference.

Use case

Many attributes are identified by internal IDs. The developer first needs to GET the internal ID before using it as an
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attribute. This enhancement makes the REST APIs more user friendly by now accepting user-friendly IDs in addition

to the internal IDs.

The Create/Update Course REST APIs now considers the Customer

Service Representative value

How did it work?

The CREATE A NEW COURSE and UPDATE THE DETAILS OF A COURSE REST APIs did not support the

Customer Service Representative value.

How does it work now?

The CREATE A NEW COURSE and UPDATE THE DETAILS OF A COURSE REST APIs now supports the Customer

Service Representative value.
CREATE A NEW COURSE

Overview

Creates a new course

Requires OAuth
No

Method
POST

URL

https://< hostname-api.sabacloud.com>/v1/course

Calling Options

Table 33: Calling Options

Name Description Sample Value Data Type Required?
featured Whether featured? false string No
validTill Valid till 0 string No
type Type 0 string No
description Description TestCoursel2 string Yes
avail_web Available for web? true string No
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Name Description Sample Value Data Type Required?
training_units Training Units 0 string No
notifyBefore Notify Before 1 string No
avail_call_center Available for Call Center? |true string No
price Price "null" string No
avail_from Available From 2013-11-12T00:00:00 | string Yes
recertWindow Recertification window 0 string No
disc_from Discontinued from 2017-11-12T00:00:00 | string No
min_ct Min Count 0 string No
version \ersion string No
title Title tets string Yes
published Published false string No
max_ct Max Count 0 string No
abstrac Abstract "null” string No
audienceType Audience Type string No
target_days Target Days As Int 0 string No
course_no Course No 00006713 string Yes
discontinued Discontinued false string No
displayName Display Name "null" string No
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Name

Description

Sample Value

Data Type

Required?

securityDomain

Security Domain

"1d": ""dom~
1M000000000000001
name :
"world"

}

string

Yes

field_of study

Field of study

{
"fosld": {

llidll:

}’
"credits':

o
}

string

No

required_prerequisites

Required prerequisites

{

"courseld": {

string

No

recommended_pre~
requisites

Recommended prerequisites

“courseld": {

UidT:
+

string

No

customValues

Custom fields

"customQ™; "1"

string

No

csr_id

Customer Service Represent~

ative

{"id": "em~
plo000000000533317",
"displayName": "user
one" }

string

No
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Request Body

{

"featured": "false",
“validTill": 0",
“type': 0",
“domain™: {
"displayName™: "Domain2"

}1
"audienceType': [{
"audience_type_id": {
*id": "audie000000000200000",
“displayName™: "CustomerTypel™

3,
"required prerequisites": [{
"courseld": {
"id": "cours000000000202785"

+
. {

""courseNumber': "A"
.

"recommended_prerequisites": [{
"‘courseNumber': "WBT_BASE"
. {
"courseld": {
"id": ""cours000000000200026"

}
3. {

""courseNumber™: "EMAY"™

3,
"field_of study": [{
“fosld": {
"id": "fldst000000000001001""
}

,redits": "2

{
"fosld": {
"displayName™: "FOS1"

},
"credits': "5"

31,

"'version': ''v15",

"csr_id":

"id": "enpl 0000000000533317",
"di spl ayName": "user one"

}

ustomValues™: {

"@type': "map",

""customO': "'1',

"customll: null,
"custom10': null,
"custom9': null,
"custom13”: null,
"customl2™: null,
"customl4': null,
"custom3": null,
"custom4': null,
"customl™: null,
"custom2™: null,
"custom7': null,
"custom8": null,
"custom5™: null,
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""custom6': null

}

"description”: "hi, this is interesting",
"avail _web': "true",

“traininig_units™: 12",
"avail _call _center': "true",

"price': "12",

"avail_from™: ""2013-08-12T00:00:00",
"recertWindow'": "0",

"disc_from": "2018-11-12T00:00:00",
“title”: "New_septl5",

"abstrac”: "null",

"target_days": "0",

"course_no': 00006728,
"published": "false",
"discontinued": "false"

Return Values

{
“tags”: [1,
"abstrac™: ",
"category': [1.,
"avail_from": "2016-03-21T00:00:00.000-0400",
"title": "dfgfdgdf",
"validtill_type": O,
"validtill_frequency": null,
“validtill_daymonth™: null,
"validtill_start _daymonth™: null,
"avail_web": true,
"avail _call _center': false,
"published": true,
""course_no'': "'DDDDSDAS'",
“validtill _unit”: 0,
"vendor_id": null,
"csr_id":
"id": "enpl 0o000000000533317",
"di spl ayName": "user one"

}

ubscribed”: false,
"audienceType": [],
""updated_on": "2016-03-21T06:38:30.000-0400",
"created by': "uone',
"updated_by': ""uone',
""created_on": ""2016-03-21T06:38:30.000-0400",
"created_id": "emplo000000000533317",
"training_units": 0,
"test": false,
"field _of study": [1,
"recommended_prerequisites': [],
"“required_prerequisites”: [],
“allPrices: [
{
"amount': O,
"displayVvalue': "0 USD",
“"curr_id": {
"1d": "crncy000000000000167",
“displayName™: "US Dollars"

}’
"id": "plent000000000069938"
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}

:mage":
"hittps: //static<hostnane>/assets/</1 jydso303osA/spf/skin/vireframe/mediia/ images/Coursestcomerce .png' ',

1

"consume_within_cert": false,
"show_web2_0_actions™: true,
"max_ct": null,

"min_ct": null,

"waitlist max": null,
"recertwindow_unit”: O,
"deepLinkUrlis™: [

"https://<hostname>/Saba/Web spf/ATHDB1/common/ledetail/cours000000000040770",

"https://<hostname>/Saba/Web_ spf/ATHDB1/common/ledetai l/DDDDSDAS"
]1

"version': null,
"language'": [

"strl™: 0000000000,
"language_id": {
"id": "lange000000000000001",
"displayName™: "English"

}1
"id": "g12rc000000000079263"

}
1. )
“"parent_id"”: null,
"type": O,

“owner': [1,
“valid_till": null,
"notify_before": null,
"recert_window": null,
"featured: false,
"createGroupPolicyval': false,
"target_days': O,
"description”: "TestCoursel2",
"status": "INEFFECT",
"customValues": {
"ExCustom4™: null,
"ExCustom5™: null,
"customO0": null,
"ExCustom8'': null,
"ExCustom9": null,
"customl™: null,
"ExCustom3™: null,
"ExCustoml™: null

}

ecurityDomain™: {
"id": "domin000000000000001",
"displayName": "world,domain"
},
"id": "cours000000000040770",
"href':
"https://<hostname-api .sabacloud.com>/v1/course/cours000000000040770"

}

UPDATE THE DETAILS OF A COURSE
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Overview

Update a course

Requires OAuth
No

Method
PUT

URL

https://< hostname-api.sabacloud.com>/v1/course/:courseid

Calling Options

Table 34: Calling Options

Name Description Sample Value Data Type Required?
courseid Course's ID cours000000000202108 | string Yes
featured Whether featured? false string No
validTill Valid till 0 string No
type Type 0 string No
description Description TestCoursel2 string Yes
avail_web Available for web? true string No
training_units Training Units 0 string No
notifyBefore Notify Before 1 string No
avail_call_center Available for Call Center? |true string No
price Price "null” string No
avail_from Available From 2013-11-12T00:00:00 | string Yes
recertWindow Recertification window 0 string No
disc_from Discontinued from 2017-11-12T00:00:00 | string No
min_ct Min Count 0 string No
version \ersion string No
title Title tets string Yes
published Published? false string No
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Name Description Sample Value Data Type Required?
max_ct Max Count 0 string No
abstrac Abstract "null" string No
audienceType Audience Type string No
target_days Target Days As Int 0 string No
course_no Course No 00006713 string Yes
discontinued Discontinued? false string No
displayName Display Name "null” string No
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Name

Description

Sample Value

Data Type

Required?

securityDomain

Security Domain

"1d": ""dom~
1M000000000000001
name :
"world"

}

string

Yes

field_of study

Field of study

{
"fosld": {

llidll:

}’
"credits':

o
}

string

No

required_prerequisites

Required prerequisites

{

"courseld": {

string

No

recommended_pre~
requisites

Recommended prerequisites

“courseld": {

UidT:
+

string

No

customValues

Custom fields

"customQ™; "1"

string

No

csr_id

Customer Service Represent~

ative

{"id": "em~
plo000000000533317",
"displayName": "user
one" }

string

No




Request Body

{
"featured": "false",
“validTill": 0",
“type': 0",
“domain™: {
"displayName™™: "Domainl™

"éudienceType": L

"audience_type id": {
"id": "audie000000000200000",
"displayName™: "CustomerTypel"

3
}
,"csr id":

"id": "enmpl 0000000000533317",
"di spl ayName": "user one"

"}equired_prerequisites" :[{"courseld” : {"id" :

"'cours000000000202785"}},{"'courseNumber': "A"}],

"recommended_prerequisites" :[{"courseNumber': "WBT BASE"},{''courseld":
{"id": "cours000000000200026"}},{ "courseNumber™: "EMAY"}],

"field_of study": [{"fosld" : {"id":

"f1dst000000000001001"}, "credits":""2"},{"fosld": {"displayName":

"FOS1"},"credits':"5"}],
"version':""v16",

"customValues" : {"@type':"map" ,"customQO™: "1",
"customll™: null,

"customl0": null,

"custom9'': null,

"customl13": null,

"customl2”: null,

"customl4”: null,

"custom3": null,

"custom4': null,

"customl™: null,

"custom2™: null,

"custom7'': null,

"custom8": null,

"custom5': null,

"custom6™: null},

"description™: "hi, this is interesting",
“avail_web": "true",

"traininig_units": "12",

"avail _call_center': "true",

“price: 12",

"avail_from": ""2013-08-12T00:00:00",
"recertWindow": 0",

"disc_from": "2018-11-12T00:00:00",
"title": "New_septl5",

"abstrac': "null",
""target_days":"0",

"‘course_no'': '"00006729",
"published":"false",

"discontinued": "false"

Note: For more details on this see REST API Reference.
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Use case

N/A

Audience Type to support Lookup

How did it work?

The UPDATE AUDIENCE TYPES / AUDIENCE SUB TYPES ASSIGNED TO A PERSON REST API did not support
accepting the audience type as a lookup value.

How does it work now?

The UPDATE AUDIENCE TYPES / AUDIENCE SUB TYPES ASSIGNED TO A PERSON REST API now supports
accepting the audience type as a lookup value.

UPDATE AUDIENCE TYPES / AUDIENCE SUB TYPES ASSIGNED TO A PERSON

Overview

Updates the audience types of a Person / Employee to the list sent as Input JSON. Any existing Audience Types not
part of the current list will be deleted and those not already present will be added.

Requires OAuth
No

Method
PUT

URL
https://< hostname-api.sabacloud.com>/v1/people/:person_id

Calling Options

Table 35: Calling Options

Name Description Sample Value Data Type Required?

person_id Person / Employee ID of per~ string Yes
person to whom Audience / | sn000000000001000
Sub Audience Type is to be

assigned

audiencetypes List of Audience Types / [{\"displayName\": |string Yes
Audience Sub Typesto be |\"Audience Type 1\",
assigned to a person \"id\";

\ aL0iE000000000001168: i o~
playName\": \"Audi~
ence Sub Type 1\",
\"id\":
\'sea0000000000001L165¢
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Request Body

{
"audiencetypes':
{"i1d":"audie000000000001105"},
{"id":"audie000000000001106""}
1

}

Request Body (Using lookup)

{
"audiencetypes: [
{"'displayName': "Contractors'},
{""displayName': "Engineering"}
}

g~ Note: For more details on this see REST API Reference.

Use case

N/A

Merge Person's Profile API to support Audience type merge and Person
number swapping

How did it work?

The Merge Person's Profile API did not support Audience type and Person number swapping.

How does it work now?

The Merge Person's Profile AP now supports the Audience type and Person number swapping.
MERGE PERSON'S PROFILE

Overview

When a learner moves from one external organization to another, there is a need to move history of completed learning
elements. This APl merges a peron's profile.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api.sabacl oud.com>/v1/common/profile/:personld/action/merge
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Calling Options

Table 36: Calling Options

Name Description Sample Value Data Type Required?
personld Primary Person/ Employee's | per~ string Yes
ID sn000000000001000
@type Input JSON class hame com.saba.rest.busi~ | string Yes
nesscomponent

.dto.ProfileMergeDTO

secondaryPersonld Secondary Person / Employ~ [ em~ string Yes
ee's ID plo000000000201009

secPersonStatusAfter~ | Secondary person's status | Terminated string No

Merge after merge

isMergeSecuri~ Whether to merge Security | true string Yes

tyChecked Roles or not

isrecalculate~ Whether to recalculate com~ | true string Yes

CompsStatusChecked | pletion status for Certifica~
tions/Curriculum or not

isMergeVcAndBlen~ | Whether to merge Virtual | true string Yes
dedClassChecked and Blended class Tran~
scripts or not

isMergeAudience~ | Whether to merge Audience | false string Yes
TypeChecked Type or not

isSwapPersonNum~ | Whether to swap Person No | false string Yes
berChecked or not

Request Body

{

"@type': "‘com.saba.rest.businesscomponent.dto.ProfileMergeDTO",
"'secondaryPersonld”: "emplo000000000200928",
""'secPersonStatusAfterMerge':"Terminated",
""IsMergeSecurityChecked": false,
""IsMergeVcAndBlendedClassChecked': false,
"isrecalculateCompStatusChecked": false,

"i sMer geAudi enceTypeChecked": true,

"i sSwapPer sonNunber Checked": t rue

Return Values

{

"@type': "org.codehaus. jackson.node.ObjectNode",
"href':
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""http://<hostname-api - sabacloud . com>/v1/common/profi le/emplo000000000200874/resource""
}

© Note: For more details on this see REST API Reference.

Use case

When a learner moves from one external organization to another, there is a need to move history of completed learning
elements. The current web services to create Adhoc transcripts, grant certifications and curriculums meet this need. But
it results in multiple calls. Using this Web service, the people admin should be able to merge two profiles. The destination
profile should have completed courses, acquired certifications, and acquired curriculums from the source profile.

GETTHE DETAILS OF A PARTICULAR GOAL API to provide last progress
details

How did it work?
The GET THE DETAILS OF A PARTICULAR GOAL API did not support returning the last progress details of a goal.
How does it work now?

The GET THE DETAILS OF A PARTICULAR GOAL API now supports returning the last progress details of a goa
by passing progress as the value to the searchFields parameter.

URL
https://< hostname-api .sabacl oud.com>/v1/performance/goals/gasgn0000000000013367?searchFields=progress

Sample progress detail attribute value:

""goalProgressDetail™: {
"comment": "Hello coment onlydsdssadsad ddd",
"overwritePercentage': false,
"pictureURL":
""htttp - //<hostname>/production/employeePicture/notdc000000000201236 employeePicture.JPEG™,

"progressid”: ""gprog000000000003791",
"goalUnit": null,
"sortNumber™: 4,
"percentageCompleted”: O,
"observationDate™: 1459499311000,
"assignmentld”: ""gasgn000000000001336",
"currentValue': null,
"metadata': null,
"goalStatus'": {
"statusValue': "gstts000000000001002",
"id": ""gstts000000000001002",
"displayName™: "Completed”,
"locale': null,
"primaryKey": {
"id": ""gstts000000000001002",
"prefix': "gstts"

}

rogressReporter™: {
"sourceType'": "InternalPerson",
"activitySourceType'": {

}
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"'sourceType': O,

"listld": ""sys1i000000000003037",
llkeyll: IIOII,

"displayName": "Person"

}1

"id": "emplo000000000001000",
“displayName': "User One",
"locale™: null

}
}
g~ Note: For more details on this see REST API Reference.
Use case

This enhancement updates the existing REST API to now also return the last progress details of a goal.

Search for people based on whether they are marked as a resource

How did it work?

The SEARCH PROFILE INFORMATION and FIND PROFILE INFORMATION APIs did not support searching for
people based on whether they are marked as a resource.

How does it work now?

The SEARCH PROFILE INFORMATION and FIND PROFILE INFORMATION APIs now support searching for
people based on whether they are marked as a resource using a new search attribute called is_resource.

FIND PROFILE INFORMATION
To retrieve people based on whether they are Instructors:
https://< hostname-api.sabacl oud.com>/v1/people?type=internal &q=(is_resource%3D%3Dtrue)

Return Values:

{
"facets": [1,

"startlndex": 1,
"hasMoreResults': true,
"totalResults': 15,
"itemsPerPage': 1,
"results": [

{

is_resource’: true,

"1d": "emplo000000000200091",

"href':
"https://<hostname>-api . sabacloud.com/v1/people/emplo000000000200091""

b
1
3
SEARCH PROFILE INFORMATION

To retrieve people based on whether they are Instructors:

https://<hosthame-api.sabacloud.com>/v1/people/searchQuery?type=internal &f=(username,city,state)
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Request Body:

"conditions" :

L
{ _
"name":'"'Is_ resource",
"operator":"'=="",
"value":"true"
}
1
}
Return Values:
{
"facets": [1,
"startlndex": 1,
"hasMoreResults': true,
"totalResults": 15,
"itemsPerPage': 1,
“results™: [
{ _
" Is_resource': true,
"1d": "emplo000000000200091",
"href":
"https://<hostname>-api .sabacloud.com/v1/people/emplo000000000200091""
}
1
}
' Note: For more details on this see REST API Reference.
Use case

The current REST API for finding people information does not allow searching for people based on whether they are
marked as a resource or not. This enhancement makes it possible.

Audience Type support for the Certification and Curriculum Search APIs

How did it work?

The FIND THE DETAILS OF THE CERTIFICATION/CURRICULUM REST API did not support accepting the
audience type check parameter as a search query parameter which means it does not verify the audience types before
returning the certification and curricula.

How does it work now?

The FIND THE DETAILS OF THE CERTIFICATION/CURRICULUM REST API now supports accepting the audience
type check parameter (at_check) as a search query parameter.

Adding this condition peforms an Audience Type check and only the certifications / curricula matching the Audience
Type of the learner will be returned.

Note: Irrespective of the value of the at_check query parameter, the Audience Type check will be done, if it is
added in the search query.

FIND THE DETAILS OF THE CERTIFICATION/CURRICULUM
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Overview

Returns the details of the Certification/Curriculum along with the 1D, Name and the Deeplink URL based on the provided
search criteria.

Requires OAuth
No

Method
GET

URL
https://< hostname-api.sabad oud.con v1/:componentName?q=(:criteria_field==:field_value)&count=:count&startPage=:startPage

Examples
https://< hostname-api.sabacl oud.com>/v1/certification?q=(name%3D%3D001Certificate,at_check%3D%3Dtrue)

https://< hostname-api .sabacl oud.com>/v1/curriculum?g=(name%3D%3Dcurriculal,at_check%3D%3Dtrue)

Calling Options

Table 37: Calling Options

Name Description Sample Value Data Type Required?
componentName The name of the desired curriculum enumerated Yes
component (certification or
curriculum).
criteria_field The search criteriai.e. the |name string Yes
field name.

You can use any field with
"isSearchFilter": true.

o Note: To find out the
fields that have "is~
SearchFilter": true, in~
voke the "Get the Meta
details" REST APIs.

field_value The search value for the abc string Yes
specified search criteria.

count The number of records per |10 string No
page.
startPage The start page number for |1 string No

the list of records.

e Note: For more details on this see REST API Reference.
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Use case

Till now the certification and curriculum search web service took into account the security roles, domains and privileges
of the logged in user. All along, it was fine because these APIs have been called in the Admin context. Now, with end
users invoking the APIs, there are other parameters that need to be included while determining whether to give access
(read or write or both). This enhancement adds a new parameter for the audience type check. If a learner searches the
catalog, then this web service will return only the certification and curricula whose Audience Types aligns with Audience
Type of the learner.

Lookup support for the Transcript API

How did it work?

The CREATE A NEW TRANSCRIPT REST API only accepted internal IDs to identify a learner.

How does it work now?

In the CREATE A NEW TRANSCRIPT REST API the following fields can be used as a lookup to identify a learner
for the learners or the deliveredby attributes:

« ID

e Username
e person_no
e email

* S5.N0

CREATE A NEW TRANSCRIPT

Overview

Creates a new transcript. If the CourselD is passed as an input, then the REST API will work as it is. If the CourselD is
not passed but the CourseNo or CourseName is passed as an input, the REST API will consider it as an existing catalog
otherwise as a non-existing catalog and create a new course based on CourseNo and CourseName details.

Requires OAuth
No

Method
POST

URL
https://<hostname-api.sabacl oud.com> /v1/transcript

Calling Options

Table 38: Calling Options

Name Description Sample Value Data Type Required?

@type @type com.saba.offering.ad~ | string Yes
hoclearning.Ad~
HocLearningTran~
scriptDetail
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Name Description Sample Value Data Type Required?
learners Learners string Yes

learnerld supports lookup

(ID, Username, person_no,

email, ss_no).
location Location Pune string No
deliveryType Delivery Type €0/cat000000000000004 | string No
completionDate Completion Date 2013-11-18 string Yes
fos FOS string No
competencies Competencies string No
courseld Course's ID string Yes
endTime End Time string No
version \ersion 1.1 string No
startTime Start Time string No
deliveredBy Delivered By string No

Supports lookup (1D, User~

name, person_no, email,

SS_N0).
duration Duration string No
offeringEndDate Offering End Date string No
description Description string No
courseNo Course No string No
offeringStartDate Offering Start Date string No
courseName Course Name testing string Yes
defaultCourseCredits | Default Course Credits string No
customValues Custom values [\"list\",[{\"@type\": |string No

\"CustomAttributeVal~
ueDetail\" \"name\":
\"customO\" \"data~
type\": {\"@type\":
\"CustomAttribute~
Datatype\" \"value\":
18} \"value\": null,
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Name Description

Sample Value

Data Type

Required?

\"displayName\":
\"cus~

tomO\"},{\" @type\":
\"CustomAttributeVal~
ueDe~

tail\" \"name\":\"cus~
tom1\", \"datatype\":
{\"@type\": \"Custom~
AttributeData~

type\" \"value\": 18},
\"value\": null \"dis~
playName\": \"cus~
tom1\"},{ \"@type\":
\"CustomAttributeVal~
ueDetail\" \"name\":
\"custom2\" \"data~
type\": {\"@type\":
\"CustomAttribute~
Datatype\",\"value\":
18}, \"value\":
null\"displayName\":
\"custom2\"},{
\"@type\": \"Custom~
AttributeValueDe~
tail\" \"name\": \"cus~
tom3\" \"datatype\": {
\"@type\": \"Custom~
AttributeData~

type\" \"value\": 18 },
\"value\": null \"dis~
playName\": \"cus~
tom3\"} 1]

Request Body (Using lookups to identify a learner)

"@type':"com.saba.offering.adhoclearning.AdHocLearningTranscriptDetail",

"learners”:[
“"java.util .ArrayList",

L
{

"@type':"com.saba.offering.adhoclearning.Learnerinfo",

"| earnerl d":"uone@aba. cont,

"grade”:null,
"score”:[

"Java.math._BigDecimal",

99

]1

""completedOnDate": {
ll@typell : lldatell ,
"time':"2013-11-06"

}1

"addedToProfileOn":{
ll@typell : lldatell ,
"time':"2013-11-05"



+
+
1

ocation':"Pune",

1

"deliveryType':"eqcat000000000000004",

“fos": [
“"java.util .ArrayList",

L
{

"@type':"com.saba.offering.adhoclearning.FOSInfo™,
"fosld":"fldst000000000001043",

“"credits'":[
"Java.math._BigDecimal",
23
1
}
1

’ompetencies":[
"java.util _ArrayList",

L
{

1

"@type':"com.saba.offering.adhoclearning.Competencylnfo",
"‘competencyld':"compt000000000001003",
""competencylLevel l1d":"cplvi000000000001029"

}
1

]!

"courseld":""cours000000000200400™",

""courseNo":null,

""courseName" :null,

del i veredBy": "457-55-5462"

"defaultCourseCredits": [
"java.math._BigDecimal™,

0
1.
"customValues": [
"list",
L

{ _ _
"@type' :"CustomAttributevValueDetail™,
"name'':"custom0",

"datatype':{
"@type' :""CustomAttributeDatatype",
"value':18
}.
"value':"test_custom 1",
"displayName":""customQ"

3,

{ _ _
"@type':"CustomAttributevalueDetail™,
"name™:"customl',

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18
},
"“value":null,
“displayName™:"customl™
3
{

"@type' :"CustomAttributevalueDetail",
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"name' :"'custom2™,

"datatype':{
"@type' :""CustomAttributeDatatype",
"value':18

}

’alue":null,
"displayName":""custom2"

3, '

"@type':"CustomAttributevalueDetail™,
"name’ :"'‘custom3",

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

}

alue™:null,
“displayName™:""custom3™

Return Values

"@type'': "com.saba.learning.services.transcript.AdhocTranscriptCreationinfo",

"errorCount": O,
“errorMap™: {

"@type': "map"

"éuccessMap": {
"@type': "map",
""persn000000000001000™: {

"@type': "‘com.saba.learning.services.transcript.Transcriptinfo™,
"transcriptld”: "ofapro00000000005792",
"transcriptStatus': {

"@type': '"‘com.saba.offering.offeringaction.CompletionStatus",
"description”: "Successful",

"statusIntVvValue™: 200,
"statusValue': "200",

"name': "'Successful’,
llkeyll: IIZOOII
}
}

uccessCount': 1,

"courseld": "cours000000000200400"
3

}

© Note: For more details on this see REST API Reference.

Use case

Transcripts can now be created/updated using the above mentioned fields instead of internal IDs.
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https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

Lookup support for additional REST APIs

How did it work?

The Lookup support was missing for some REST APIs.

How does it work now?

The lookup support is now available for the following REST APIs.

Profile

* CREATE A PROFILE [EXTERNAL PERSON]

* CREATE A PROFILE [INTERNAL PERSON]

* UPDATE A PROFILE FOR GIVEN PERSON ID [EXTERNAL]

* UPDATE A PROFILE FOR GIVEN PERSON ID [INTERNAL]

* UPDATE A PROFILE FOR GIVEN PERSON NAME [EXTERNAL]
* UPDATE A PROFILE FOR GIVEN PERSON NAME [INTERNAL]

Attributes that support lookup
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JSON Attribute Ul Attribute Component Name
securityDomain Domain name Domain
timezone_id Timezone name Time Zone
currency_id ISO code of currency Currency
requiredJobRoles Name of the Job Role Role
optionalJobRoles Name of the Job Role Role

home_company _id

Organization number / Organization
name

Organization, External / Organization,
Internal

location_id

loc_name (displayName)

Location

company_id

Organization number / Organization
name

Organization, External / Organization,
Internal

home_domain

Domain name

Domain

manager_id

Username of Person

Person, Internal/ Person, External

jobtype_id

Name of the Job Type

JobType

Organization

« CREATE A NEW INTERNAL ORGANIZATION
* UPDATE THE DETAILS OF AN INTERNAL ORGANIZATION
« CREATE A NEW EXTERNAL ORGANIZATION
» UPDATE THE DETAILS OF AN EXTERNAL ORGANIZATION

Attributes that support lookup
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JSON Attribute Ul Attribute

Component Name

parent_id Organization number / Organization | Organization, External / Organization,
name Internal

currency_id ISO code of currency Currency

contact_id Username of Person Person, Internal/ Person, External

securityDomain Domain name

Domain

objectives_administrator Username of Person

Person, Internal/ Person, External

childorg Organization number / Organization | Organization, External / Organization,
name Internal
budgetapprover Username of Person Person, Internal/ Person, External

continueeducation Continue education name

CEPlan

Location

» CREATE A NEW LOCATION
* UPDATE THE DETAILS OF A PARTICULAR LOCATION

Attributes that support lookup

JSON Attribute Ul Attribute Component Name

timezone_id Timezone name Time Zone

dept_id Organization number / Organization | Organization, External / Organization,
name Internal

contact_id Username of Person Person, Internal/ Person, External

securityDomain Domain name

Domain

owner Username of Person

Person, Internal/ Person, External

Facility

« CREATE A NEW FACILITY
* UPDATE THE DETAILS OF A FACILITY

Attributes that support lookup

JSON Attribute Ul Attribute Component Name
location_id loc_name (displayName) Location
securityDomain Domain name Domain

owner Username of Person

Person, Internal/ Person, External




Job Family
« CREATE A NEW JOB FAMILY

» UPDATE THE DETAILS OF A JOB FAMILY

Attributes that support lookup
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JSON Attribute Ul Attribute Component Name
job JobCode JobType
Job Type

» CREATEA NEWJOB TYPE

* UPDATE THE DETAILS OF A JOB TYPE

Attributes that support lookup

JSON Attribute Ul Attribute Component Name
family_id Job family name JobFamily

role Role name Role
nextcareerstep jobcode JobType
securityDomain Domain name Domain

Role
e CREATE A NEW ROLE

 UPDATE THE DETAILS OF A ROLE

Attributes that support lookup

JSON Attribute Ul Attribute Component Name
securityDomain Domain name Domain

skill Competency name Competency

owner Username of person Person, Internal/ Person, External
continueeducation Continue education name CEPlan

checklist Checklist name Checklist

learningevent

For course : course_no/ title; for certi~
fication and curricula : Name of certi~
fication / curricula

Offering Template/ Certification/ Cur~
riculum

Competency
* CREATE A NEW COMPETENCY

» UPDATE THE DETAILS OF A COMPETENCY

Attributes that support lookup
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JSON Attribute Ul Attribute Component Name
securityDomain Domain name Domain
skillGroup Skill group name CompetencyGroup

behavioralindicator

Behavioral Indicator name

Competency Evidence

proficiency

Proficiency name

CompetencyLevel

Position

» CREATE A NEW POSITION

* UPDATE THE DETAILS OF A POSITION

Attributes that support lookup

JSON Attribute

Ul Attribute

Component Name

securityDomain

Domain name

Domain

Organization

Organization number / Organization
name

Organization, External / Organization,
Internal

location

Loc_no/loc_name

Location

Job

JobCode

JobType

= Note: For more details on this, see Introduction > Some Quick Info > Using Lookup fields topic of REST API
Reference.
Use case

Many attributes and resources are identified by a 20 char internal ID. The developer first needs to GET the 20 char
internal 1D before using it as an attribute of another resource. Developer also needs to retrieve 20 char ID of a person
to perform any updates on that person. This is not efficient. This enhancement addresses such issues by adding the
lookup support for many attributes.

Order details API to return Billing Address and Payment details

How did it work?

The GET THE ORDER DETAILS OF A PARTICULAR ORDER REST API did not return the Billing Address and
Payment details.

How does it work now?

The GET THE ORDER DETAILS OF A PARTICULAR ORDER REST API now returns the Billing Address and
Payment details.

GET THE ORDER DETAILS OF A PARTICULAR ORDER

Overview

Returns the order details of a particular order.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
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Requires OAuth
No

Method
GET

URL

http://<hostname-api .sabacloud.com>/v1/learning/order/:id

Calling Options

Table 39: Calling Options

Name Description Sample Value Data Type Required?
id Order's ID in~ string Yes
tor000000000203305

Return Values (Sample of Billing Address details)

billingAddress: {
componentName: "Address",
addressString: "Addrl=bill_addrl, Addr2=bill_addr2 Addr3=,
City=bill_city, State=bill_state, Zip=bill _zip, Country=bill_country",
email: null,
addrl: "bill_addrl™,
addr2: "bill_addr2",
city: "bill_city"”,
zip: "bill_zip",
addr3: "',
incomplete: false,
tag: O,
state: "bill_state",
country: "bill_country",
owner: null,
primaryKey: null,
locale: null,
id: null,
displayName: null,
updateMetadata: null,
auditReason: "audit with reason"

}.

Return Values (Sample of Payment details)
paynents:[

gatewayResult:null,
gatewayTransactionld:"4613148193746322501518",
amount:{
amount:20.7,
isocode:""USD",
amountString:'20.70 USD",
currency:{
id:"'crncy000000000000167",
displayName:"'US Dollars"



}
}’ - - -
trainingUnits:null,
subscriptionld:null,
paymentType:{
paymentType:11,
name:"'CyberSource",
displayName:"'CyberSource"

subscriptionNo:null,
trainingUnitAgreement:null,
purchaseOrder:null,
paymentStatus:{
paymentStatus:1,
name:"'"PaymentCompleted",
displayName:""Payment completed"

learningSubscriptionld:null,

invoiceNo:null,

address:{
componentName:"Address",
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addressString:"Addrl=billingl, Addr2=b2 Addr3=b3, City=bc, State=bs,

Zip=bz, Country=AL",
email:null,
addrl:"billingl",
addr2:"b2",
city:"bc",
zip:"bz",
addr3:"b3",
incomplete:false,
tag:0,
state:"bs",
country:"AL",
owner:null,
primaryKey:null,
locale:null,
id:null,
displayName:null,
updateMetadata:null,
auditReason:"audit with reason"

}1
id:""mopay000000000010420",
owner:{

id:"intor000000011130229",
displayName:null

}
1.

e Note: For more details on this see REST API Reference.

Use case

Extended enterprise customers have extensive integrations with tax and CRM systems to pass order and payment

information. This enhancement will help close some gaps related to the order information that is available in Saba Cloud

which could not be pulled from REST API.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

| System | 146

Enrollment details APl now considers BST

How did it work?
The GET THE DETAILS OF AN ENROLLMENT REST API did return timezone details in British Summer Time.
How does it work now?

The GET THE DETAILS OF AN ENROLLMENT REST API now returns the timezone details in British Summer
Time.

GET THE DETAILS OF AN ENROLLMENT

Overview

Returns the details of the enrollment

Requires OAuth
No

Method
GET

URL
https://< hostname-api.sabacl oud.con>/v1/enroliments/:id/sections:regdetail classdetail actions,sessionsdetail, learning Assignments

Calling Options

Table 40: Calling Options

Name Description Sample Value Data Type Required?
id Registration's ID reg~ string Yes
dw000000000004020

Return Values

Output JSON:
{

"@type': "'com.saba.learning.services.registration.ClassRegistrationDetail",
"learningEventDetail™: {
"@type': "LearningEventDetail",
"securityDomain™: null,
"customValues": null,

"paths'": null,

“title": null,

"vendor™: null,

"recurring': false,
“validTill": O,

"notifyBefore'": O,
“"validTillType'": O,
“validTillFrequency'": null,
“validTillDayMonth™: null,
"validTillStartDayMonth™: null,



"sensitive': false,
“"validTillunit": O,
""componentName': null,
"availableFrom"”: null,
“discontinuedFrom”: null,
"'suppressscore': false,
"showWeb2 0 actions': false,
"consumeWithinCert": false,
"discontinued": false,
"targetDays'": null,
"completedSuccessfully™”: true,
"completed': false,

"notes": null,

"ratings'": null,
"socialProfile": null,
"owners": null,
"learningEventType™: null,
"publishToCatalog™: false,
"imageURL": "',
"learnerCredits™: null,
"associatedLearning: null,
"learningEventld”: null,
"recertWindowUnit”: O,
"pastCreditDays™: O,
"historyLookupPolicy™: null,
"tagDetails": null,
"continuousLaunchEnabled": false,
"oneClickRegEnabled": false,
"learningEventOwners™: null,
"consumptionStats': null,
"fosDetails": null,
"cpfDetail": null,
"assignmentDetails": null,
"hideClassMates": false,
"customFieldsvalue™: null,
"ownersValue': null,
"learnerCreditsString™: ",
"offeredAs": null,
"recertWindow": O,
"InactivePaths'": null,
"hideLaunchBySequencing™: null,
"blockersBySequencing™: null,
"learningEventConsumers™: null,
"licencePlans": null,
"practiceArea': null,
"practiceType': null,
"licenseType™: null,
"numberOfRequiredCourses™: null,
"errorMessages': null,
"preRequisitesAndEquivalents™: null,
"description”: null,
"registered'": false,
"actions™: null,

"id": null,

"owner': null,

"tags'': null,

"version': null,

"group: null,

“status™: null,

"children": null,

""tagName": null,
"primaryKey": null,
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"updateMetadata™: null,
"factoryName': "‘com.saba.learning.services. learningevent.LearningEventDetail"’,

"auditReason': "audit with reason™,
"locale": null,
"displayName™™: null

}’

"registrationld": "regdw000000000306257",
"instructors': null,
"otherRegistrationsForCourse™: null,
"learningAssignments™: null,
"actionsForRegistration™: null,
"classAttachments': null,
""consumptionData": null,

"classSessions'": {

"@type': '"‘com.saba.learning.services.offering.0fferingScheduleDetail",
"l ocati onTi mezone": ({
"@ype": "Servicebj ect Ref erence”

"id": "tzone000000000000022"
"di spl ayNane": "Event Location(Chennai) Tine Zone - BST"

"user Ti mezone": {

"@ype": "ServiceObj ect Ref erence”
"id": "tzone000000000000022"

"di spl ayNane": "BST"

"sessionslInUserTimezone": ["list", [{

"@type': '"'com.saba.learning.services.common.SessionDetail",
"endDate": {
"@type': "‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone': "02-MAY-2016",
"timelnUserTimeZone': "11:00 AM",
"timelnCustomTimeZone": null,
"datelnCustomTimeZone': null,
"customTimeZoneDate': O,
"timelnStandardFormat™: "6:00 AM"™,
"datelnStandardFormat': "05/02/2016",
"timelnLocale': "6:00 AM",
"locale™: "02-MAY-2016",
"date™: 1462183200000

}!

"startDate": {

"@type': '"‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone': ""02-MAY-2016"",
"timelnUserTimeZone': "10:00 AM",
"timelnCustomTimeZone™: null,
"datelnCustomTimeZone'": null,
""customTimeZoneDate": O,
"timelnStandardFormat™: "5:00 AM™,
"datelnStandardFormat': ""05/02/2016",
"timelnLocale': "5:00 AM",

"locale': "02-MAY-2016"",

"date': 1462179600000

"launchUrl": null,
"exportURL": null,
"vleEventld": null,
"vieExtld": null,
"vleProvid": null,
""sessionName': ""1',
"startTime'": "5:00 AM",
"endTime'": "6:00 AM",
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"duration: 60.0,
"resources': ["list", [11,
""factions': null,

"id": "timel000000000048151"

3. {
"@type': ""com.saba.learning.services.common.SessionDetail",
"endDate": {
"@type': '"‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone": "02-MAY-2016",
"timelnUserTimeZone": "1:00 PM",

"timelnCustomTimeZone'": null,
"datelnCustomTimeZone'": null,
"customTimeZoneDate': O,
"timelnStandardFormat™: "8:00 AM™",
"datelnStandardFormat': ""05/02/2016",
"timelnLocale'™: ""8:00 AM™",

"locale': ""02-MAY-2016"",

"date': 1462190400000
¥,
"startDate": {

"@type': '"‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone': ""02-MAY-2016"",
"timelnUserTimeZone": "12:00 PM",
"timelnCustomTimeZone'": null,
"datelnCustomTimeZone'": null,
"customTimeZoneDate': O,
"timelnStandardFormat™: "7:00 AM™,
"datelInStandardFormat™: ""05/02/2016",
"timelnLocale': "7:00 AM",

"locale': ""02-MAY-2016"",

"date'': 1462186800000

"launchUrl': null,
"exportURL": null,
"vleEventld": null,
"vileExtld": null,
"vleProvid'": null,
""sessionName': "2",
"startTime': "7:00 AM",
"endTime': ""8:00 AM™,
"duration': 60.0,
"resources': ["list"”, []11,
"actions': null,

"id": "timel000000000048152"

H1.

"sessionslinLocationTimezone": ["list", [{

"@type': ""‘com.saba.learning.services.common.SessionDetail™,
"endDate": {

"@type': '"‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone': ""02-MAY-2016"",
"timelnUserTimeZone': "5:00 AM",
"timelnCustomTimeZone™: null,
"datelnCustomTimeZone'": null,
""customTimeZoneDate": O,
"timelnStandardFormat': ""12:00 AM",
"datelnStandardFormat': ""05/02/2016",
"timelnLocale': "12:00 AM",

"locale': "02-MAY-2016"",

"date': 1462161600000

}’
"startDate": {
"@type': '"‘com.saba.customtypes.DateWithLocale",
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"datelnUserTimeZone': ""02-MAY-2016",
"timelnUserTimeZone': "5:00 AM",
"timelnCustomTimeZone": null,
"datelnCustomTimeZone™: null,
""customTimeZoneDate": O,
"timelnStandardFormat™: ""12:00 AM",
"datelnStandardFormat': ""05/02/2016",
"timelnLocale': "12:00 AM",

"locale': ""02-MAY-2016"",

"date': 1462161600000

"launchUrl": null,
"exportURL"™: null,
"vleEventld": null,
"vieExtld": null,
"vileProvid”: null,
""sessionName': ""1',
"startTime'": "5:00 AM",
"endTime'": "6:00 AM",
"duration': 60.0,
"resources': ["list", [11,
"actions': null,

"id": "timel000000000048151"

3. {
"@type': "com.saba.learning.services.common.SessionDetail",
"endDate": {

"@type': '"‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone': ""02-MAY-2016"",
"timelnUserTimeZone": "5:00 AM",
"timelnCustomTimeZone'": null,
"datelnCustomTimeZone'": null,
""customTimeZoneDate': O,
"timelnStandardFormat™: "12:00 AM",
"datelInStandardFormat™: ""05/02/2016",
"timelnLocale': "12:00 AM",

"locale': ""02-MAY-2016"",

"date™: 1462161600000

}1

"startDate": {

"@type': '"‘com.saba.customtypes.DateWithLocale",
"datelnUserTimeZone'": "02-MAY-2016"",
"timelnUserTimeZone": "5:00 AM",
"timelnCustomTimeZone'": null,
"datelnCustomTimeZone'": null,
""customTimeZoneDate': O,
"timelnStandardFormat™: "12:00 AM™,
"datelnStandardFormat': '"05/02/2016",
"timelnLocale': "12:00 AM",

"locale™: "02-MAY-2016"",

"date': 1462161600000

}

aunchurl™: null,
"exportURL™: null,
"vleEventld": null,
"vileExtld": null,
"vleProvid": null,
""sessionName': "2",
"startTime'™: "7:00 AM™,
"endTime'"™: ""8:00 AM™,
"duration': 60.0,
"resources': ["list"”, [11,
"actions': null,
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"id": "timel000000000048152"

1.
"exportURL": null,

"defaultView": O
¥

ourseRequirers™: null,
"classDetail”: null,
"registrationinfo: null,
""courseSocialProfile": null,
"hideLaunchBySequencing": false,
"blockersBySequencing™: null,
"group™: null

. Note: For more details on this see REST API Reference.

Use case

This enhancement ensures that this Web Service now returns the correct timezone with the correct summer time.

PROFILE REST APIs auto-assign the OOB security roles

How did it work?

The CREATE A PROFILE REST API did not auto-assign the OOB security roles as it happens when a new user is
created via the UI.

How does it work now?

The CREATE A PROFILE REST REST API now auto-assigns the OOB security roles.

In addition to the values sent for "securityRoles" as part of the INPUT JSON while creating a new user using the REST
API, the OOB security roles should be auto-assigned to the newly created user.

The following OOB security roles are auto-assigned to the internal user alongwith the role(s) passed via the Input
JSON/signup rule:

e Common Privileges in world domain world

» Internal Person Basic Privileges <home_domain>

* Internal Person Login Privileges <security _domain>
« Report Privileges in world domain world

The following OOB security roles are assigned to the external user alongwith the role(s) passed via the Input JSON/signup
rule:

e Common Privileges in world domain world
« External Person Basic Privileges <security_domain>
» Report Privileges in world domain world

. Note: For more details on this see REST API Reference.
Use case

If these OOB security roles are not auto-assigned, the user gets an error on account activation page.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
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New REST APIs

APIls for retrieving, adding and updating Delivery modes

How did it work?

There were no REST APIs to retrieve, add and update Delivery modes.

How does it work now?

The following new REST APIs will now allow retrieving, adding and updating Delivery modes:

GET THE META DETAILS OF DELIVERY MODE

Overview

Returns the meta details of the Delivery Mode.

Requires OAuth
No

Method
GET

URL

https://< hostname-api.sabacl oud.com>/v1/deliverymode/meta:(:searchFields)

Calling Options

Table 41: Calling Options

Name Description Default Value Data Type Required?

searchFields Indicate what additional de~ string No
tails needs to be returned

GET ALL DELIVERY MODE

Overview

Returns all Delivery Mode for which the user has access.

Requires OAuth
No

Method
GET

URL

https://< hostname-api.sabacl oud.com>/v1/deliverymode?count=:count&startPage=:startPage



Calling Options

Table 42: Calling Options
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the list of records.

Name Description Default Value Data Type Required?
count The number of records per |10 string No

page.
startPage The start page number for |1 string No

GET THE DETAILS OF A PARTICULAR DELIVERY MODE

Overview

Returns complete information about a Delivery Mode based on the Delivery Mode's ID that is passed as a parameter

value.

Requires OAuth

No

Method
GET

URL

https://< hostname-api.sabacloud.com>/v1/deliverymode/:id:(:searchFields)

Calling Options

Table 43: Calling Options

tails needs to be returned

Name Description Default Value Data Type Required?
id Delivery Mode's ID string Yes
searchFields Indicate what additional de~ string No

FIND THE DETAILS OF THE DELIVERY MODE

Overview

Returns the details of the Delivery Mode along with the ID, Name and the Deeplink URL based on the provided search

criteria.

Requires OAuth

No

Method
GET
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URL
https://< hostname-api.sabad oud.com> Avl/deliverymode?g=(:criteria__field%3D%3D:field_value)&count=:count&startPage=:startPage

Calling Options

Table 44: Calling Options

Name Description Default Value Data Type Required?
criteria_field The search criteria i.e. the | status string Yes

field name.
field_value The search value for the 100 string Yes

specified search criteria.

count The number of records per |10 string No
page.
startPage The start page number for |1 string No

the list of records.

FIND THE DETAILS OF DELIVERY MODE (USING POST - RANGE BASED SEARCH)

Overview

Returns the details of the Delivery Mode.

Requires OAuth
No

Method
POST

URL
https.//< hogtname-api .sabad oud.com>Av1/deliverymode/searchQuery?count=:count&startPage=:startPage&includeDetails=:includeDetails

Calling Options

Table 45: Calling Options

Name Description Default Value Data Type Required?
conditions Conditions [{"name":"descrip~ | string Yes
tion","operat~
or":"==","value":"De~

scription2'"}]

count 10 string No

startPage 1 string No
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Name Description Default Value Data Type Required?
includeDetails Returns the details of the | true string No
Delivery Mode in the search
Request Body
"conditions™:[
{

"name':"duration",

"operator™:"=="",

"value':""240"

}
1
}
CREATE A NEW DELIVERY MODE
Overview
Creates a new Delivery Mode
Requires OAuth
No
Method
POST
URL
https://< hostname-api.sabacloud.com>/v1/deliverymode
Calling Options
Table 46: Calling Options
Name Description Default Value Data Type Required?
description Description description string No
duration Duration 0 string No
securityDomain Security Domain string Yes
vendor_id Vender string No
available_from Available from string No
csr_id Customer Service Represent~ string No
ative

training_units No of Training Units string No
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Name Description Default Value Data Type Required?
delivery_id Delivery Type string Yes
acronym Delivery Mode No string Yes
offer_temp_id Course string Yes
discontinued_from Discontinued from string No
disp_call_center Display for call center false string No
disp_web Display for web false string No
customValues custom Values string No

Request Body

{

"description': "test",
"duration: O,
"securityDomain': {
"1d": ""domin000000000000001",
“displayName™: "world"

"Qendor_id": {
"id": "cmpny000000000200005",
"displayName": "Vendorl"

"available from™: null,

“esr_id": {
"id": "emplo000000000200321",
"displayName': "Akhlaque Ahmed"

}

raining_units": 2,

“delivery id": {

"id": "egcat000000000000014",
"displayName': "Blended"

}

cronym': 123-sadfsa",
"offer_temp_id": {

"id": "cours000000000202186",
“displayName': "Brown Bag"

}

"disp_call_center': true,

"disp_web'": true,

"customValues™: {
""custom9': 9",
""customO™: 0",
"custom3': ""3",
‘custom4': "4,
‘customl': ""1',
"‘custom2': ''2',
"custom7'': 7",
""custom8': "'8",
""customb5*: "5,
""custom6'': "6"

"’iscontinued_from": ''2016-03-25T00:00:00.000+0530",



}

UPDATE THE DETAILS OF A DELIVERY MODE

Overview

Updates an existing Delivery Mode based on the Delivery Mode's ID that is passed as a parameter value.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api .sabacloud.com>/v1/deliverymode/:id

Calling Options

Table 47: Calling Options
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Name Description Default Value Data Type Required?
id Id of Delivery Mode id string Yes
description Description description string No
duration Duration 0 string No
securityDomain Security Domain string Yes
vendor_id Vender string No
available_from Available from string No
csr_id Customer Service Represent~ string No
ative
training_units No of Training Units string No
discontinued_from Discontinued from string No
disp_call_center Display for call center false string No
disp_web Display for web false string No
customValues custom Values string No
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Request Body

{
"description”: "test",
"duration": O,
"securityDomain': {
"1d": ""domin000000000000001",
"displayName™: "world"
"vendor_id": {
"1d": ""cmpny000000000200005",
"displayName": "Vendorl"
"available from": null,
“"csr_id": {
"id": "emplo000000000200321",
"displayName": "Akhlaque Ahmed"
}»
“"training_units™: 2,
"discontinued_from": "2016-03-25T00:00:00.000+0530",
"disp_call_center': true,
"disp_web": true,
"customValues": {
"‘custom9': 9",
"customO0': "0",
"custom3*: 3",
""custom4': "'4',
"customl™: "1',
‘custom2™: 2",
"‘custom7': "7,
"custom8': "8",
"custom5™: "5,
"custom6': "6
}
}
g~ Note: For more details on this see REST API Reference.
Use case

This enhancement makes it possible to retrieve, add and update Delivery modes using REST APIs.

APIls for retrieving, adding, updating and deleting currency exchange
rates

How did it work?

There were no REST APIs to retrieve, add, update and delete currency exchange rates.

How does it work now?

The following new REST APIs will now allow retrieving, adding, updating and deleting currency exchange rates:

FIND THE META DETAILS OF EXCHANGE RATE

Overview

Returns the meta details of the Exchange Rate.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

| System | 159

Requires OAuth
No

Method
GET

URL

https://< hostname-api.sabacl oud.com>/v1/exchangerate/meta:(:searchFields)

Calling Options

Table 48: Calling Options

Name Description Default Value Data Type Required?

searchFields Indicate what additional de~ string No
tails needs to be returned.
Acceptable values are (case-
sensitive)

Return Values

"sampleData™: {
"src_id": null,
"end_date'": null,
"start_date'": null,
"batch_id": null,
"dest_id": null,
“"rate': null,
"id": null,
"href":

"http://<hostname-api .sabacloud.com>/v1/exchangerate/ccyex000000000000001""

}

’ame": "Currency Exchange Rate™,
“displayName': "Currency Exchange Rate",
"attributes": [

"name': "batch_id",
"displayName": ""Batch I1d",
"description™: null,
"iIsRequired”: true,
"isAutoGenerated': false,
"type'': "string",
"isReference'": false,
"isProtected”: false,
“display': true,
""isSearchFilter': true

"name'': "created_ by",
"displayName": "Created by",
"description™: null,
"iIsRequired”: true,
"iIsAutoGenerated": false,
"type'': "string",
"isReference": false,



"isProtected": false,
“display': true,
"maximumLength': 255,
"isSearchFilter”: false

"name": '‘created_id",
"displayName': "Created 1d",
"description”: null,
"iIsRequired”: true,
"isAutoGenerated”: false,
"type'': "string",
"isReference': false,
"isProtected": false,
"display'": true,
"isSearchFilter": false

"name": ''created on",
"displayName": "Created on",
"description”: null,
"iIsRequired”: true,
"isAutoGenerated™: false,
"type'': "date",
"isReference': false,
"iIsProtected": false,
"display'": true,
"isSearchFilter": false

"name": "'dest_id",
"displayName': "Dest Id",
"description”: null,
"iIsRequired”: true,
"isAutoGenerated™: false,
"type'': "object",
"isReference”: true,
"isProtected": false,
"display'": true,
"isSearchFilter': true

"name": "end_date",
"displayName': "End Date",
"description”: null,
"iIsRequired": false,
"isAutoGenerated™: false,
"type'': "date",
"isReference': false,
"iIsProtected": false,
"display'": true,
"isSearchFilter': true

"name': "id",

"displayName": "Exchange Rate
"description”: null,
"iIsRequired”: true,
"isAutoGenerated™: true,
"type'': "string",
"isReference': false,
"isProtected": false,

iID",
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“display': true,
"isSearchFilter": true

“"name': "'rate',
"displayName™: "Rate",
"description™: null,
"iIsRequired'": true,
"isAutoGenerated': false,
"type': "real",
"isReference': false,
"isProtected": false,
“display': true,
"isSearchFilter": true

"name™: *'src_id",
"displayName™™: "Src 1d",
"description™: null,
"iIsRequired'": true,
"isAutoGenerated': false,
"type'': "object",
"isReference'": true,
"isProtected": false,
“display': true,
"isSearchFilter": true

"name™: *'start_date",
"displayName™: "Start Date",
"description™: null,
"iIsRequired": true,
"isAutoGenerated': false,
"type'': "date",
"isReference': false,
"isProtected": false,
“display': true,
"isSearchFilter": true

"name': "updated_by",
"displayName™: "Updated by",
"description™: null,
"iIsRequired": true,
"isAutoGenerated': false,
"type'': "string",
"isReference': false,
"isProtected": false,
“display': true,
"maximumLength': 255,
"isSearchFilter': false

"name': "updated_on',
"displayName": "Updated on",
"description”: null,
"iIsRequired": true,
"iIsAutoGenerated": false,
"type': "date",
"isReference': false,
"isProtected": false,
“display': true,
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"isSearchFilter': false

}
1
}
GET ALL EXCHANGE RATES
Overview

Returns all exchange rates available in the system.

Requires OAuth
No

Method
GET

URL

https://< hostname-api .sabacl oud.com>/v1/exchangerate?count=:count&startPage=:startPage

Calling Options

Table 49: Calling Options
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Name Description Default Value Data Type Required?
count The number of records per |10 string No

page.
startPage The start page number for |1 string No

the list of records.

Return Values

“facets": [1,
"startlndex": 1,
"results": [

"1d": ""ccyex000000000200020",

"href":
"http://<hostname-api .sabacloud.com>/v1/exchangerate/ccyex000000000200020""
3
"1d": ""ccyex000000000200046",
"href':
"http://<hostname-api .sabacloud.com>/v1/exchangerate/ccyex000000000200046"
}l
"id": "ccyex000000000200047",
"href":
"http://<hostname-api .sabacloud.com>/v1/exchangerate/ccyex000000000200047""
}

"hasMoreResults': true,



"totalResults": 28,
"itemsPerPage': 3

}

GET THE DETAILS OF A PARTICULAR EXCHANGE RATE

Overview
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Returns complete information about a exchange rate based on the exchange rate's id that is passed as a parameter value.

Requires OAuth
No

Method
GET

URL

https://< hostname-api.sabacloud.com>/v1/exchangerate/:id:(:searchFields)

Example:

https://< hostname-api.sabacl oud.com> /v1/exchangerate/ccyex000000000200001

Calling Options

Table 50: Calling Options

tails needs to be returned.
Acceptable values are (case-
sensitive)

Name Description Default Value Data Type Required?
id Exchange Rate's ID string Yes
searchFields Indicate what additional de~ string No

Return Values

{ _
"src_id": {
"id": "crncy000000000000001",
"displayName™: "US Dollars"

"}ate": 2,
"end_date': "2017-03-03T00:00:00.000+0530",

"'start_date': "2016-03-03T00:00:00.000+0530",

"batch_id": {

"id": "exbch000000000000002",
"displayName': null

"éest_id": {
"id": "crncy000000000001005",
“displayName™™: "Currencyl”

"id: ''ccyex000000000200185""
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FIND THE DETAILS OF THE EXCHANGE RATE

Overview

Returns the details of the exchange rates along with the ID, Name and the Deeplink URL based on the provided search
criteria.

Requires OAuth
No

Method
GET

URL

https://< hastname-api.sabad oud.com>v1/exchangerate?g=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage
Examples:

Search exchange rate by source currency

https://< hostname-api.sabacloud.com>/
v1/exchangerate?q=(src_id%3D%3Dcrncy000000000000004)&includeDetails=true

Search exchange rate by destination currency

https://< hostname-api.sabacloud.com>/
v1/exchangerate?q=(dest_id%3D%3Dcrncy000000000000168)&includeDetails=true

Search exchange rate by start date

https://< hostname-api.sabacl oud.com>/ v1/exchangerate?q=(start_date%3D%3D02/01/2016)&includeDetails=false
Search exchange rate by start date

https://< hostname-api.sabacloud.com>/ v1/exchangerate?q=(end_date%3D%3D02/01/2016)&includeDetails=true

Calling Options

Table 51: Calling Options

Name Description Default Value Data Type Required?
criteria_field The search criteria i.e. the | name string Yes

field name.
field_value The search value for the string Yes

specified search criteria.

count The number of records per |10 string No
page.
startPage The start page number for |1 string No

the list of records.

The following are the fields that you can use as the criteria_field:
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Field name Field description Example
src_id If this field is passed, exchange rates |src_id%3D%3D
for a currency will be returned. ¢rncy000000000000001
src_name If this field is passed, exchange rates |src_name%3D%3DUS%20Dollar
for a currency will be returned.
src_isocode If this field is passed, exchange rates |src_isocode%3D%3DUSD
for a currency will be returned.
dest_id If this field is passed, exchange rates | dest_id%3D%3D
available to currency provided will be | crncy000000000200968
returned.
dest_name Exchange rate for a currency will be | dest_name%3D%3DUS%?20Dollar

returned.

dest_isocode

Exchange rate for a currency will be
returned.

dest_isocode%3D%3DUSD

start_date All exchange rates having a given start | start_date%3Dge%3D2015-01-08
date will be returned.
end_date All exchange rates having a given end | end_date%3DIe%3D2015-01-08

date will be returned.

Return Values

"facets": [1,
"startindex": 1,
"results": [

{

}

"end_date'": null,

"'start_date™: "1900-01-01T00:00:00.000+0530",

“"rate": 1,

"src_id": {
"id": "crncy000000000000001",
“displayName™: "US Dollars"

¥,
"dest_id": {
"1d": "crncy000000000000001",
"displayName': "US Dollars"
}!
"batch_id": {
"id": "exbch000000000000002",
"displayName': null

},
"1d": ""ccyex000000000200020"

"ﬁasMoreResults": true,
"totalResults': 1,
"itemsPerPage': 1

}

FIND THE DETAILS OF EXCHANGE RATE (USING POST - RANGE BASED SEARCH)



Overview

Returns the details of the exchange rate along with the ID, Name and the Deeplink URL based on the provided search

criteria.

Requires OAuth
No

Method
POST

URL

https://< hostname-api.sabad oud.con™> AvL/exchangerate/searchQuery?count=:count&startPage=:startPage&includeDetails=:includeDetails

Calling Options

Table 52: Calling Options

returned.

Name Description Default Value Data Type Required?
conditions Conditions [{"name"; "src_iso~ |string Yes
code","operator":
"==""value":
"USD"}]
count 10 string No
startPage 1 string No
includeDetails Returns the details of the ex~ | true string No
change rate in the search
The following are the fields that you can use as the conditions > name:
Field name Field description Example
src_id If this field is passed, exchange rates |src_id%3D%3D
for a currency will be returned. ¢rncy000000000000001
src_name If this field is passed, exchange rates |src_name%3D%3DUS%20Dollar
for a currency will be returned.
src_isocode If this field is passed, exchange rates |src_isocode%3D%3DUSD
for a currency will be returned.
dest id If this field is passed, exchange rates | dest_id%3D%3D
available to currency provided will be | crncy000000000200968
returned.
dest_name Exchange rate for a currency will be | dest_name%3D%3DUS%20Dollar
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Field name Field description Example

dest_isocode Exchange rate for a currency will be |dest_isocode%3D%3DUSD
returned.

start_date All exchange rates having a given start | start_date%3Dge%3D2015-01-08

date will be returned.

end_date All exchange rates having a given end
date will be returned.

end_date%3DIle%3D2015-01-08

Request Body

{
"conditions" :[{
"name': "src_id",
"operator': '==",
"value'™: "crncy000000000000001"}]
}

Return Values

"facets": []1,
"startlndex": 1,
“"results": [

{

"end_date'": null,
"start_date": ""1900-01-01T00:00:00.000+0530",
“rate": 1,
"src_id": {
"id": "crncy000000000000001",
"displayName™: "US Dollars"

}!

“dest_i1d": {
"id": "crncy000000000000001",
"displayName™: "US Dollars"

}1

"batch_id": {
"id": "exbch000000000000002",
“displayName™: null

¥,
"id": "ccyex000000000200020"
3

"hasMoreResults™: true,
"totalResults': 1,
"itemsPerPage’™: 1

}
CREATE A NEW EXCHANGE RATE

Overview

Create new currency exchange rate.

Requires OAuth
No



Method
POST

URL

https://< hostname-api.sabacl oud.com> /v1/exchangerate

Calling Options

Table 53: Calling Options
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Name Description Default Value Data Type Required?

src_id The source currency {"id": string Yes
"'omcy000000000202976'}

dest_id The destination currency {"id™: string No
"'omcy000000000203005'}

start_date Starting date of exchange |2016-03-03 string Yes

rate

end_date Ending date of exchange rate | 2019-03-03 string Yes

rate Rate 15 string Yes

batch_id Exchange rate batch {"id": "ex~ string No
bch000000000000001"}

Request Body

{

"@type":”

.
"dest_id"

¥
"start_date': "2016-03-03",
"end_date': "'2017-03-03",

"rate':2,
"batch_id"

}

com.saba.currency.ExchangeRateDetail",
“src_id": { "id": "crncy000000000000001", "displayName': "USD"

{"id": "exbch000000000000002"}

UPDATE THE DETAILS OF A EXCHANGE RATE

Overview

Allows updating an existing exchange rate based on the Exchange Rate's ID.

Requires OAuth

No

Method
PUT

{ "id": "crncy000000000000002", *‘displayName™: "INR™



URL

https://< hostname-api .sabacl oud.com>/v1/exchangerate/:id

Calling Options

Table 54: Calling Options
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Name Description Default Value Data Type Required?
id Exchange Rate's ID string Yes
rate Rate 15 string No
start_date Starting date of exchange |2016-03-03 string No
rate
end_date Ending date of exchange rate | 2019-03-03 string No
Request Body
{ _
"@type' :"com.saba.currency.ExchangeRateDetail",
“src_id": { "id": "crncy000000000000001", "‘displayName': "'USD"
} ’
"dest_id": { "id": "crncy000000000000002", *‘displayName™: "INR"
} ’
"start_date': "2017-12-20",
"end_date': "'2019-03-03",
“rate:2.5
}
DELETE A EXCHANGE RATE
Overview
Deletes an Exchange Rate.
Requires OAuth
No
Method
DELETE
URL
https://< hostname-api .sabacl oud.com>/v1/exchangerate/:id
Calling Options
Table 55: Calling Options
Name Description Default Value Data Type Required?
id Exchange Rate's ID string Yes




o Note: For more details on this see REST API Reference.

Use case

This enhancement makes it possible to retrieve, add and update currency exchange rates using REST APIs.

APIls for retrieving, adding, updating and deleting list values

How did it work?
There were no REST APIs to retrieve, add, update and delete list values.

How does it work now?

The following new REST APIs will now allow retrieving, adding, updating and deleting list values:

g~ Note: These APIs only support the user LOV and not the system LOV.

GET A PARTICULAR LIST VALUE

Overview

Returns the details of a particular list value.

Requires OAuth
No

Method
GET

URL
https://< hostname-api .sabacloud.com>/v1/lov/:id

Calling Options

Table 56: Calling Options
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Name Description Default Value Data Type

Required?

id The ID of the list value listv000000001002987 | string

Yes

Return Values

{

"startindex": 1,

"facets": [1,

"hasMoreResults': false,

"totalResults': 1,

"1temsPerPage™: 10,

"results": [

{ _

"name': " listlteml10",
"description”: " listlteml0",


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

"id": "listv000000001002989",

“lovList": {
"displayName'": "customl:WBT Offering",
"id": " 1isti000000000001006"

he

+
1
+

GET LIST VALUE BY LIST ID AND LIST VALUE NAME

Overview

Returns the list value details by list value's ID and name.

Requires OAuth
No

Method
GET

URL

https://< hostname-api .sabacloud.com>/v1/lov/:id/:name

Example:

https://< hostname-api.sabacl oud.com> /v1/lov/listi000000000001006/listItem10

Calling Options

Table 57: Calling Options
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Name Description Default Value Data Type Required?
id List value's ID 1isti000000000001006 | string Yes
name Name of the list value listitem10 string Yes

Return Values

{

"startindex': 1,
"facets": []1,
"hasMoreResults": false,
"totalResults": 1,
"itemsPerPage': 10,
“"results": [
{ _
"name™: " listlteml0",
"description™: " listlteml0",
"id": "listv000000001002989",
"lovList": {
"displayName': "customl:WBT Offering",
"id": " listi000000000001006™
}
}



1
}

SEARCH LIST VALUES

Overview

Returns the list value details based on the search parameters.

g~ Note: The data that is returned as a part of the search is based on the logged in user's locale.

Requires OAuth

No

Method
GET

URL
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https://<hostname-api.sabacl oud.com> v L/lov?g=(:criteria)&count=:count&startPage=:startPage&includeDetails=:includeDetails

Example:

https://< hostname-api.sabacl oud.com>/v1/lov?g=(list_id%3D%3Dlisti000000000001006)&includeDetails=true

Calling Options

Table 58: Calling Options
Name Description Default Value Data Type Required?
criteria The search criteria i.e. the | B/DV/EDRO000000000P8Y | string Yes
criteria field name with
search value.
count The number of records per |10 string No
page.
startPage The start page number for |1 string No
the list of records.
includeDetails Returns the details of the | true string No
List Values in the search

Return Values

“"results":[

"id":" listv000000000200083",

"href":"http://<hostname-api .sabacloud.com>/v1/1ov/1istv000000000200083"

3
{

"id":" 1istv000000000200084",
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"href'":"http://<hostname-api .sabacloud.com>/v1/1ov/1istv000000000200084"
b
]1
"startlndex":1,
"hasMoreResults'":false,
"totalResults':2,

"itemsPerPage':10,
"facets":[ ]

}
ADD VALUE TO LOV FOR AN ATTRIBUTE

Overview

Allows adding a value to the LOV for a particular attribute.

Requires OAuth
No

Method
POST

URL
https://< hostname-api.sabacloud.com>/v1/lov

Calling Options

Table 59: Calling Options

Name Description Default Value Data Type Required?

@type Type list entry detail com.saba.lov.List~ string Yes
EntryDetail

name The name of the list value | TestListValue string Yes

description Description of the list value | This is created for string No

testing purpose

lovList List ID and displayName | {\"@type\": string Yes
\'java.util. HashMap\"\'io ™
\Tisi000000000020141\ \ cis~
playName\":\"cus~
tom1:WBT Offer~
ing\"}

Request Body

{
"@type':"com.saba.lov.ListEntryDetail",

"name':"Listlteml",
"description”:"This is Test Listltem Value",
"lovList":{



"@type':"java.util _HashMap",
"id":"listi000000000001006",
"displayName":""customl:WBT Offering

Return Values

{

"@type':"com.saba. lov.RestLovDetail",
"name':"Listltem21",
"description”:"This is Test Listltem21 Value",
"lovList":{
"@type':"map",
"displayName":"customl:WBT Offering",
"1d":"listi000000000010141"

"id": " 1istv000000001003048"
}

UPDATE VALUE OF LIST

Overview

Allows updating the value of a list.

[ 1

Requires OAuth
No

Method
PUT

URL (Using ID)
https://< hostname-api .sabacloud.com>/v1/lov/:id

URL (Using Name)

https://< hostname-api.sabacl oud.com> /v1/lov/name=<ListValueName>

Note: Updating the value of a list is supported by either providing the list value ID or list value name.
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Calling Options

Table 60: Calling Options
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playName\":\"cus~
tom1:WBT Offer~
ing\"}"

Name Description Default Value Data Type Required?
id ID of the list value or name | listv000000001002986 | string Yes
of the list value.
g Note: Toenter the
name of the list value
give the input as:
name=<listValue~
Name>
@type Type list entry detail com.saba.lov.List~ string Yes
EntryDetail
name The name of the list value | TestListValue string Yes
description Description of the list value | This is created for string Yes
testing purpose
lovList List Id and displayName {\"@type\": string Yes
\'java.util. HashMap\" \ ic\ ™
\ii000000000020141 N s~

Request Body

{
"@type':"com.saba.lov.ListEntryDetail",

"name' : "Listltem5",

"description”™ : "This is Test Listltem5 Value",

"lovList":
"@type': "java.util_HashMap™,
"id":"1isti000000000010141"",
"displayName':""customl:WBT Offering"

}
}

DELETE ITEM FROM LIST

Overview

Deletes an item from the list using the 1D of the list value.

Requires OAuth
No

Method
DELETE



URL
https://< hostname-api .sabacl oud.com>/v1/lov/:id

Calling Options

Table 61: Calling Options
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Name Description Default Value Data Type Required?
id ID of the list value listv000000001002986 | string Yes
DELETE ITEM FROM LIST (BY LISTID AND NAME OF THE LIST VALUE)

Overview

Deletes an item from list using the ID and name of the list value.

Requires OAuth

No

Method

DELETE

URL

https://< hostname-api .sabacl oud.com>/v1/lov/:id/:name

Calling Options

Table 62: Calling Options

Name Description Default Value Data Type Required?
id List ID 1isti000000000010141 | string Yes

name Name of the list value TestListValue string Yes

P Note: For more details on this see REST API Reference.

Use case

User LOV changes through custom solutions are made up to several times per year. This enhancement makes it possible

to retrieve, add and update list values using REST APIs.

Search API to retrieve the details of the security roles

How did it work?
There were no search REST APIs to retrieve the details of the security roles.

How does it work now?


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068
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The following new search REST API will now allow retrieving the details of the security roles:
FIND THE DETAILS OF THE SECURITY ROLES

Overview

Returns the details of the security roles for which the user has access, based on the provided search criteria.

Requires OAuth
No

Method
GET

URL
https://< hostname-api.sabacl oud.com>/v1/securityrole?g=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage
Example:

https://< hostname-api.sabacloud.com>/v1/securityrole?q=(is_compound%3D%3Dtrue)

Calling Options

Table 63: Calling Options

Name Description Default Value Data Type Required?
criteria_field The search criteria i.e. the string Yes
field name.

« isCriteriaBased
e is_compound
* name

field_value The search value for the string Yes
specified search criteria.

¢ isCriteriaBased:
true/false

e is_compound: true/false

count The number of records per |10 string No
page.
startPage The start page number for |1 string No

the list of records.

Return Values

{

""hasMoreResults'":false,
"totalResults':1,
""itemsPerPage':10,
"facets": [
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"results":[

"name' :""Human Capital Admin®,
"id":""cpriv000000000000106",

"href' :""http://<hostname-api - sabacloud.com>/v1/securityrole/cpriv000000000000106"
}

"startlndex'":1

}

o Note: For more details on this see REST API Reference.

Use case

This enhancement makes it possible to search for security roles based on the specified search criteria.

APIls for retrieving, adding and updating Job Requisitions

How did it work?

There were no REST APIs to retrieve, add and update Job Requisitions.

How does it work now?

The following new REST APIs will now allow retrieving, adding and updating Job Requisitions:

FIND THE DETAILS OF THE JOB REQUISITION

Overview

Finds the details of the Job requisitions.

Requires OAuth
No

Method
GET

URL

https://<hosthame-api.sabacloud.com>/v1/job-requisition?g=(;criteria)&count=:count&startPage=:startPage


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

Calling Options

Table 64: Calling Options
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Name Description Default Value Data Type Required?
criteria The search criteria i.e. the | employment~ string Yes
criteria field name with Type%3D%3DPerman-~
search value. ent
You can use any field with
"isSearchFilter": true.
g Note: To find out the
fields that have "is~
SearchFilter": true, in~
voke the "Get the Meta
details" REST APIs.
count The number of records per |10 string No
page.
startPage The start page number for |1 string No
the list of records.

Return Values

"facets':

1.

"startlndex': 1,
""hasMoreResults': true,
"totalResults': 52,
""ItemsPerPage': 10,

"results":

{

"id": "jobrg000000000001044",

L

"href': "http://<host_name>/v1/job/jobrq000000000001044?type=requisition”

3.
{

"id:
“"href':

3.
{

"idT:
“"href':

3.
{

"id":
“"href':

A

"id":
“href":

''Jobrgq000000000001045""

"http://<host_name>/v1/job/jobrg000000000001045?type=requisition’

"' Jobrgq000000000001046*

"http://<host_name>/v1/job/jobrg000000000001046?type=requisition’

*'jobrg000000000001047**

"http://<host_name>/v1/job/jobrg000000000001047?type=requisition”

*'jobrg000000000001050°*"

"http://<host_name>/v1/job/jobrg000000000001050?type=requisition"
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3,
{

"id": "jobrg000000000001004",
"href': "http://<host _name>/v1/job/jobrq000000000001004?type=requisition™

3
{

"id": "jobrg000000000001020",
"href': "http://<host_name>/v1/job/jobrq000000000001020?type=requisition”

3.

"id": "jobrg000000000001060",
"href': "http://<host_name>/v1/job/jobrq000000000001060?type=requisition"

3.
{

"id": "jobrg000000000001086",
"href': "http://<host_name>/v1/job/jobrq000000000001086?type=requisition”

3.
{

"id": "jobrg000000000001088",
"href': "http://<host_name>/v1/job/jobrq000000000001088?type=requisition™

+
1
}

FIND THE DETAILS OF THE JOB REQUISITION (Using POST - Range based search)

Overview

Returns the details of the job requisitions along with the ID, Name and the Deeplink URL based on the provided range
based search criteria.

Requires OAuth
No

Method
POST

URL

https://< hostname-api .sabacl oud.com>/v1/job-requisition/searchQuery?count=:count&startPage=:startPage



Calling Options

Table 65: Calling Options
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Name

Description

Sample Value

Data Type

Required?

conditions

The search conditions.

You can use any field with
"isSearchFilter": true.

g Note: To find out the
fields that have "is~
SearchFilter": true, in~
voke the "Get the Meta
details” REST APIs.

You can use search operators
such as:

. :gt:
e =Qge=
o =|t=

o =le=
e =eQ=
e —ne=

[{"status":"DRAFT"}]

string

Yes

count

The number of records per
page.

10

string

No

startPage

The start page number for
the list of records.

1

string

No

Request Body

{
}

"conditions" :

Return Values

{
"facets": []1,
"startindex':

11

""hasMoreResults': true,
"totalResults': 84,
"itemsPerPage': 10,

“"results”: [

"id": "jobrg000000000001040™,

[{"status'":"DRAFT"}]

"href': "http://<host_name>/v1/job-requisition/jobrqgo00000000001040"

3.
{

"id": "jobrg000000000001044",

"href': "http://<host_name>/v1/job-requisition/jobrqgo00000000001044"

3
{



id":

‘href'':

tidT

"href':

1
}

“"href":

"' jobrgq000000000001045™,

"'Jobrgq000000000001046"",

" "Jobrg000000000001047",
"http://<host_name>/v1l/job-requisition/jobrqgo00000000001047"

: "jobrq000000000001050",
"1 "http://<host_name>/vl1/job-requisition/jobrqo00000000001050"

"'z "jJobrg000000000001060",
" "http://<host_name>/v1/job-requisition/jobrqgo00000000001060"

"z "jobrg000000000001080*,
"I "http://<host_name>/v1/job-requisition/jobrgq000000000001080""

: ""Jobrg000000000001081",
"> "http://<host_name>/v1/job-requisition/jobrqgo00000000001081"

"'z "jJobrg000000000001082",
" "http://<host_name>/v1/job-requisition/jobrqgo00000000001082"

GET ALL JOB REQUISITIONS

Overview

Returns all job-requisitions.

Requires OAuth

No

Method
GET

URL

https://< hostname-api.sabacl oud.com>/v1/job-requisition?count=:count&startPage=:startPage

Calling Options

Table 66: Calling Options

"http://<host_name>/v1l/job-requisition/jobrqgo00000000001045"

"http://<host_name>/v1/job-requisition/jobrqo00000000001046"
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Name

Description

Default Value

Data Type

Required?

count

The number of records per
page.

10

string

No
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Name

Description Default Value

Data Type

Required?

startPage

The start page number for |1
the list of records.

string

No

Return Values

"facets": [1,
"startindex": 1,
"hasMoreResults': true,

"totalResul

ts": 84,

"1temsPerPage™: 10,

"results':

{

L

"id": "jobrg000000000001040",
"href': "http://<host_name>/v1/job-requisition/jobrqgo00000000001040"

}-
1.
"id":
"href":
3>
1.
idT:
"href":
}-
{..
id':
"href':
}-
{..
"id":
"href":
3>
1.
idT:
"href":
}-
{..
id':
"href':
}-
1.
"id":
"href":
3>
1.
idT:
"href":
}-
{..
id':

"' jJobrgq000000000001044"",

"http://<host_name>/v1l/job-requisition/jobrqgo00000000001044"

"' jJobrgq000000000001045*,

"http://<host_name>/v1/job-requisition/jobrqo00000000001045"

*'jobrgq000000000001046*,

"http://<host_name>/v1l/job-requisition/jobrqgo00000000001046"

"' jJobrgq000000000001047,

"http://<host_name>/v1l/job-requisition/jobrqgo00000000001047"

"' jJobrq000000000001050*,

"http://<host_name>/v1/job-requisition/jobrqo00000000001050"

*'jobrgq000000000001060*,

"http://<host_name>/v1l/job-requisition/jobrqgo00000000001060"

"' jJobrg000000000001080",

"http://<host_name>/v1l/job-requisition/jobrqo00000000001080"

"' jobrq000000000001081*,

"http://<host_name>/v1/job-requisition/jobrqo00000000001081"

*'jobrgq000000000001082*,

"href': "http://<host_name>/v1/job-requisition/jobrqgo00000000001082"

}
1
+

GET THE DETAILS OF A PARTICULAR JOB REQUISITION



Overview

Returns the details of a particular job-requisition.

Requires OAuth
No

Method
GET

URL

https://< hostname-api.sabacloud.com>/v1/job-requisition/:id:(:searchFields)

Calling Options

Table 67: Calling Options
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Name Description Default Value Data Type

Required?

id The ID of the desired job re~ | jobrq000000000001020 | string
quisition

Yes

Return Values

{

"location": {
"id": "locat000000000001000",
"displayName™: "Locationl"

"description”: "<p>recruting test 01 job</p>",
"source": null,
"requisitionTemplate": {

"1d": "reqtp000000000000001",

"displayName™: "System Default Template™

"employmentType™: ""Permanent",
"requisitionStage": [1,
"requiresTravel': false,
"requiresResume": true,
"requiresCoverlLetter™: false,

"‘companyDescription': "'<p>Company Description for the Requisition

Template</p>",
"requiresPreAssessment': false,
"organization": {

"1d": "bisut000000000001000",
"displayName™: "BusinessuUnitl"

}.

"status'': "DRAFT",

"sourceType': null,

"JobFamily": {
"1d": "jfmly000000000001000",
"displayName™: "Position job family"

"title": "HPEngineer3",
"approvedOn™: null,
"targetDate': null,
""googleMapWidget': null,



"publishedOn™: null,
"jobType': null,

"notes'": '"'<p>Perfect</p>",
“'submittedOn™: null,
"minExperience’: 2,
"maxExperience': 5,
“interviewers": [1,
“"recruiter”: [

"stakeholderType'": "RECRUITER",
“requisition”: {
"id": "jobrg000000000001045",
"displayName': "HPEngineer3"

}1

"stakeholder™: {
"id": "persn000000000201414",
“displayName™: "fname Iname"

}’
"id": "rsthd000000000001059"
3

"industry': "Computer Software',
"applicantType'": "INTERNAL-ONLY",
"closedDate': null,
“"hrPartner™: {
"id": "emplo000000000001043",
"displayName": "User3 Four3"
},
"hiringManager™: {
"1d": "emplo000000000001000",
"displayName'": "User One"

}1
"minimumSalary': 20000,
"maximumSalary': 500000,
“requisitionNo™: ""1043",
"qualification": '<p>everything</p>",
"salaryType': "YEARLY",
"JobAdStyle'": "Cool",
"noOfOpenings': 1,
"ISEEOCReq": true,
"unpublishType'": "NONE",
"unpublishDays": 30,
"endOfMonth™: false,
"marketAverage': null,
"referralBonus'": null,
"unpublishDate": null,
“"plainTextSM™: null,
"pieChartSM”: null,
"barChartSM™: {

"type": "BAR-CHART",

"owner": {

"1d": "jobrg000000000001045",
“displayName™: "HPEngineer3"

}’
"identifier': "barChartsSm",
"smartWidgetValues™: [

"name': "Developer",
llvaluell: ll2ll’
"parent: {

"id": ""smtwd000000000001042",
"displayName": "Experience"
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}1

"id": ""smtvl1000000000001089"
]}
"’martWidget_visibiIity": "ANYONE™",
"title": "Experience”,

"id": ""smtwd000000000001042™
}

rogressBarSM": null,
"midSalary': 260000,
"midBudget': 260000,
""maxBudget'': 500000,
"salaryCurrency”: null,

"category': "Professionals",
""compensation': "Nothing",
"costCenter': "Everything",

"isFeaturedJobExternal': false,
"referralBonusCurr': null,
"educationQualification": null,
"1d": "jobrq000000000001045",
"customValues": {

"custom9'': null,

"customO": null,

"custom3'": null,

"custom4': null,

"customl™: null,

"custom2™: null,

"custom7'': null,

"custom8": null,

"custom5': null,

"custom6': null

"éecurityDomain": {
"1d": ""domin000000000000001",
“displayName™: "world"

"jobboards": 1
s

GET THE META DETAILS OF JOB REQUISITION

Overview

Returns the meta details of a job-requisition component.

Requires OAuth
No

Method
GET

URL

https://< hostname-api.sabacl oud.com> /v1/job-requisition/meta
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Return Values

"sampleData": {

"location': null,
"description”: null,
“source™: null,
"requisitionTemplate™: null,
"employmentType™: null,
"requisitionStage'": null,
"requiresTravel': false,
"requiresResume": true,
"requiresCoverlLetter™: false,
"‘companyDescription”: null,
"requiresPreAssessment': null,
"organization'": null,
"status': ""DRAFT",
"sourceType': null,
"JobFamily™: null,

“title”: null,
approvedOn™: null,
"targetDate': null,
""googleMapWidget'": null,
"publishedOn™: null,
"jobType™: null,

"notes'": null,
"submittedOn': null,
"minExperience': null,
"maxExperience': null,
"interviewers': null,
“recruiter™: null,
"industry': null,
"applicantType'": "INTERNAL-ONLY",
""closedDate™: null,
"hrPartner': null,
"hiringManager': null,
“minimumSalary™”: null,
"maximumSalary': null,
"requisitionNo": null,
"qualification": null,
"salaryType': "YEARLY",
"JobAdStyle": null,
"noOfOpenings™: 1,
"ISEEOCReq": false,
"unpublishType™: "NONE",
"unpublishDays'": 30,
"endOfMonth™: false,
"marketAverage': null,
“referralBonus™: null,
"unpublishDate'": null,
“"plainTextSM": {

"type': null,

"owner': null,

"identifier”: null,

"smartWidgetValues™: null,

"smartWidget_visibility'": "ANYONE",

"title": null,

"1d": null

},

"pieChartsSM": {
“type': null,
"owner": null,
"identifier": null,
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"smartWidgetValues'™: null,
“smartWidget_visibility": "ANYONE",
“title™: null,

"1d": null

}!

"barChartSM": {

“"type': null,

"owner': null,

"identifier”: null,
"smartWidgetValues': null,
“smartWidget_visibility”: "ANYONE",
"title”: null,

"1d": null

}

rogressBarSM": {
"type': null,
“owner™: null,
"identifier”: null,
"smartWidgetValues'™: null,
“smartWidget_visibility": "ANYONE",
“title": null,
"1d": null

"midSalary™: null,
"midBudget': null,
"maxBudget™: null,
"salaryCurrency": {

*id": "crncy000000000000001",
“displayName™: "US Dollars"

"category': null,
""compensation': null,
"costCenter™: null,
"isFeaturedJobExternal™: false,
“referralBonusCurr™: {

"1d": "crncy000000000000001",
"displayName': "US Dollars"

"educationQualification": null,
"id": null,
"customValues™: {
""custom9'': null,
"customO": null,
"custom3": null,
"custom4': null,
"customl™: null,
"custom2': null,
"custom7': null,
"custom8'": null,
"custom5™: null,
"custom6': null

}

’ecurityDomain": {
"id": "domin000000000000001",
“displayName': "world"

"jobboards": null,

"href': "http://<host_name>/v1/job/jobrg000000000000001?type=requisition”
he
+

CREATE A NEW JOB REQUISITION



Overview

Creates a new job requisition

Requires OAuth
No

Method
POST

URL

https://< hostname-api.sabacl oud.com>/v1/job-requisition

Calling Options

Table 68: Calling Options
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for the Requisition
Template

Name Description Default Value Data Type Required?
location Location {\"id\": string Yes
\1oca000000000001000K X tis~
playName\": \"Loca~
tion1\"}
description Job Description <p>recruting test 01 | string Yes
job</p>
source Source string No
targetDate Target date string No
organization Organization X} 0000000000000 § b~ | string Yes
playName\":\"Busines~
sUnit1\"}
requisitionTemplate | Job Requisition Template | {\"id\":\"re~ string Yes
Q0000000000000 Y ‘dis~
playName\":null}
employmentType Type of Employment string No
requisitionStage Requisition Stage string No
requiresTravel Requires Travel string No
requiresResume Requires Resume string No
requiresCoverLetter | Allow Cover Letter string No
companyDescription | Company Description Company Description | string Yes
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Name Description Default Value Data Type Required?
requiresPreAssess~ | Requires Pre-Assessment string No
ment
status Status DRAFT string Yes
unpublishDays Unpublish Days 30 string No
endOfMonth End Of Month string No
marketAverage Compensation Displayed to string No
Candidates (Public)
referralBonus Referral Bonus string No
unpublishDate Unpublish Date string No
plainTextSM Plain Text Type Smart Wid~ string No
gets
pieChartSM Pie Chart Type Smart Wid~ string No
gets
barChartSM Bar Chart Type Smart Wid~ string No
gets
progressBarSM Progress Bar Type Smart string No
Widgets
midSalary Salary (mid) string No
midBudget Budget (mid) string No
maxBudget Budget (max) string No
googleMapWidget Google Map Widget string No
minExperience Minimum Experience string No
maxExperience Maximum Experience string No
interviewers Interviewers string No
recruiter Recruiter string No
industry Industry string No
applicantType Publish to INTERNAL-ONLY |string Yes
closedDate Close date string No
hrPartner HR Partner {\"id\": \"em~ string Yes

Plo000000000001043) s~
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Name Description Default Value Data Type Required?

playName\": \"User3

Four3\"}
hiringManager Hiring Manager {\"id\": \"em~ string Yes

pla000000000001000N N dis~

playName\": \"User

One\"}
minimumSalary Minimum Salary 20000 string Yes
maximumSalary Maximum Salary 50000 string Yes
qualification Qualifications <p>BE</p> string Yes
salaryType Salary Type YEARLY string Yes
jobAdStyle Job Advertisement Style Cool string Yes
noOfOpenings Number of Hires 2 string Yes
iISEEOCReq Is EEOC Required string No
unpublishType Auto-Unpublish string No
sourceType Source Type string No
category EEOQ Job Category Not Specified string No
compensation Compensation Displayed to string No

Candidates (Public)

costCenter Cost Center string No
salaryCurrency Salary Currency {8 $bro, 0000000000006A S HB~- | string Yes

playName\":\"US Dol~

lars\"}
publishedOn Published On string No
jobType Job string No
notes Notes string No
title Job Title HPEnNgineer3 string Yes
submittedOn Submitted On string No
approvedOn Approved On string No
jobFamily Job Family {\"id\": string Yes

firiy COC000000001000K b~
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Name Description Default Value Data Type Required?
playName\": \"Job
Family 121\"}
educationQualification | Education Qualification string No
isFeaturedJobExternal | Mark the external job post~ string No
ing featured
referralBonusCurr Referral Bonus Currency string No
customValues Custom Values string No
securityDomain Domain {\"id\": \"dom~ string Yes
in00000000000000N"\ dlis~
playName\":
\"world\'"}
jobboards Job Boards string No
Request Body
{ _
"location: {
"1d": "locat000000000001000",
"displayName™™: "Locationl"
"aescription": "<p>recruting test 01 job</p>",

"source": null,

"requisitionTemplate™: {
"id": "regqtp000000000000001",
"displayName™": "System Default Template™

"employmentType™: "Permanent",
"requisitionStage": [],
"requiresTravel': false,
"requiresResume™: true,
"requiresCoverlLetter™: false,
""companyDescription': "<p>Company Description for the Requisition
Template</p>"',

"requiresPreAssessment': false,
"organization: {

"1d": "bisut000000000001000",

“displayName': "BusinessUnitl"

"'status'': "DRAFT",

"sourceType': null,

"JobFamily": {
"id": "jfmly000000000001000",
“displayName': "Position job family"

}1

"title": "HPEngineer3",
"approvedOn': null,
"targetDate': null,
"*googleMapWidget™: null,
"publishedOn': null,
"jobType': null,

"notes'": "'<p>Perfect</p>",
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"submittedOn': null,
"minExperience': 2,
"maxExperience': 5,
"interviewers": [],
“recruiter: [

{
"'stakeholderType': "RECRUITER",
"'stakeholder': {
"1d": "persn000000000201414",
"displayName": "fname Iname"
}1
"id": "rsthd000000000001059""
}
"industry": "Computer Software",
"applicantType™: "INTERNAL-ONLY",

"closedDate: null,
"hrPartner™: {
"1d": "emplo000000000001043",
"displayName': "User3 Four3"

"ﬁiringManager": {
"id": "emplo000000000001000",
"displayName™: "User One"

"minimumSalary': 20000,
"maximumSalary': 500000,
"requisitionNo": "1043",
"qualification™: "'<p>everything</p>",
"salaryType': "YEARLY",
"JobAdStyle': "Cool",
"'noOfOpenings': 1,
"ISEEOCReq": true,
"unpublishType'": "NONE",
“unpublishDays™: 30,
"endOfMonth™: false,
"marketAverage': null,
"referralBonus": null,
"unpublishDate'": null,
"plainTextSM": null,
"pieChartSM™”: null,

"atat{ i 'nil, §e Y BRER, irtifie * lata e, Gt  Emae; Satiniphvaality  ANOE, SatiniptA e [ tae  ha ) d e 1T},

"progressBarSM": null,
"midSalary': 260000,
"midBudget': 260000,
""maxBudget'': 500000,
"salaryCurrency": null,

"category': "Professionals",
"compensation': "Nothing",
"costCenter': "Everything",

"isFeaturedJobExternal': false,
"referralBonusCurr': null,
"educationQualification": null,
"customValues": {

"custom9": null,

"customO™: null,

"custom3": null,

"custom4': null,

"customl™: null,

"custom2™: null,



"custom7': null,
"custom8": null,
"custom5"™: null,
"custom6': null

X

’ecurityDomain": {
"id": ""domin000000000000001",
"displayName™: "world"

} ’
""Jobboards™: []

Return Values

"id": "jobrg000000000001140",
“displayName™: "HPEngineer3",

"href': "http://<host_name>/v1/job-requisition/jobrqgo00000000001140"

}

. Note: For more details on this see REST API Reference.

Use case

Customers will be able to bring jobs they created in other systems or automate the job creation process.

APIls for adding and updating Goals, Goal Progress and Status

How did it work?
There were no REST APIs for adding and updating Goals, Goal Progress and Status.
How does it work now?

The following new REST APIs will now allow adding and updating Goals, Goal Progress and Status:
CREATE GOAL FOR SELF/TEAM

Overview
Creates a Goal for self/team.
' Note:

To create a goal with a parent goal, set the parentGoal field, or else keep it null.

To create a goal with approval, set submitForApproval to true, or else keep it false.

To create a goal for self, set the assignee field of goal AssignmentDetail and set the assignee field of
SabaGoalRestDetail as null.

To create a goal for team, set the assignee field of SabaGoalRestDetail object.
The following are the available goal status ID:

« ACTIVE_GOAL_STATUS = "gstts000000000001000"
« INACTIVE_GOAL_STATUS = "gstts000000000001001"
« COMPLETED_GOAL_STATUS = "gstts000000000001002"
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https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

Requires OAuth
No

Method
POST

URL

https://<hostname-api.sabacl oud.com> /v1/performance/goals

Calling Options

Table 69: Calling Options
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proval or not

Name Description Default Value Data Type Required?
@type @type com.saba.rest.ser~ string Yes
vice.goal.Saba~
GoalRestDetail
goalAssignmentDetail | Detail of a Goal Assignment string Yes
goalDefinitionDetail | Detail of a Goal Definition string Yes
organizations Organization string No
assignees Assignee of goals (Required string No
only while creating team
goal)
isDirectIndirect Whether it is direct or undir~ string No
ect goal
selectedObjective Selected Objective string No
tasks Tasks to add string No
parentGoal Wrapper Reference of parent string No
goal
associationsData Association Data string No
submitForApproval | Whether to submit for ap~ string No

Request Body (Self)

{

"@type':"'com.saba.rest.service.goal .SabaGoalRestDetail",

"goalAssignm
"@type”:"
"locked":
"‘assignee

"@type

entDetail":{

com.saba.rest._service.goal _RestGoalAssignmentDetail™,

false,

"":"com.saba.party.person.entity.EmployeeReference",
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"id":""emplo000000000200503"

"goalDefinition":null,

"goalAssignmentStatus':{
"@type':"com.saba.goal .entity.GoalStatusReference",
"statusValue':""gstts000000000001000",

"id":""gstts000000000001000"
}

rchived":false,
"source":{

"@type':"com.saba.party.person.entity_EmployeeReference",
"id":""empl0000000000001000""

}1

"startDate":{
ll@typell : lldatell ,
""time':"2016-04-07",
"date':""2016-04-07"

}’

"dueDate" :{
"@type':"date",
"time™:"2016-04-30",
"date':""2016-04-30"

"originalDueDate" :null

"éoalDefinitionDetail":{
"@type':""com.saba.rest.service.goal .RestGoalDefinitionDetail",
"owner" :{

"@type':"com.saba.party.person.entity_EmployeeReference",
"id":""emplo000000000200503"

}

equired":null,

"duration:null,

"pullInReview":false,

"smartGoal”:null,

"FixedStartDate":null,

"FfixedEndDate'" :null,

"title":"new",

""goalCategory':{

"@type':"com.saba.goal .entity.GoalCategoryReference",
"1d":""gcate000000000000011"

}’

"goalDefinitionStatus™:{
"@type':""com.saba.rest.service.goal .RestGoalDefinitionStatus",
"listld":"sys1i000000000006003",

"key":"Active"

""shared":false,
"template':false,
"pushed":null,
"goalMetric":{

"@type':"com.saba.goal .entity.GoalMetricReference",
"id":""gmetro00000000001042"

"éoalAction":{

"@type':"com.saba.goal .entity.GoalActionReference",

"1d" :""gactn000000000001041""
}1
"goalUnit”:{

"@type':"com.saba.goal .entity.GoalUnitReference",
"id":""gunit000000000001004"

}.



"goalType":{

"@type':"com.saba.goal .entity.GoalTypeReference",
"id":""goalt000000000000001"

}

initialvalue™:1,
"targetValue:2,
""goalVisibility":"gvizro00000000001002",
"description":"<p>Hel lo</p>",
"libGoalVisibilityKey":null,
"auditDetail":null,
“definitionCustomValues': [
“list",
L
{ _ _
"@type' :"CustomAttributevalueDetail",
"name™ :"custom0",
"datatype’:{
"@type' :"CustomAttributeDatatype’,
"value':18

"Qalue":"l",
"displayName" :null

"@type' :"CustomAttributevValueDetail",
"name" :""customl’,
"datatype':{

"@type' :"CustomAttributeDatatype",

"value':18

'I\’Ial uell : ll2ll ,
"displayName" :null

"@type':"CustomAttributevValueDetail™,
"name' :"'‘custom2",
"datatype':{

"@type' :"CustomAttributeDatatype',

"value':18

}

’alue":"3",
"displayName" :null

"@type' :"CustomAttributevalueDetail",
"name™ :"custom3",
"datatype’:{

"@type' :"CustomAttributeDatatype’,

"value':18

"Qalue":"4",
"displayName" :null

"@type' :"CustomAttributevValueDetail",

"name" :""custom4',

"datatype':{
"@type':"CustomAttributeDatatype’,
"value™:18

'I\’Ial uell : ll5ll ,

"displayName" :null
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}
1

"@type' :"CustomAttributevalueDetail",

“name' :""custom5'’,

"datatype™:{
"@type' :"CustomAttributeDatatype’,
"value':18

}1

“value™:"6"

"displayNamé":null

"@type' :"CustomAttributevValueDetail",

"name' :"'custom6’,

"datatype':{
"@type' :"CustomAttributeDatatype",
"value™:18

'I\’Ial uell : ll7ll ,

"displayName" :null

"@type':"CustomAttributeValueDetail™,

"name" :""custom7',

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

"Qalue":"8",

"displayName" :null

"@type' :"CustomAttributevalueDetail",

“name' :""custom8"’,

"datatype’:{
"@type' :"CustomAttributeDatatype’,
"value':18

“value™:"9"

"displayNamé":null

"@type' :"CustomAttributevValueDetail",

"name' :"'custom9’,

"datatype':{
"@type':"CustomAttributeDatatype’,
"value™:18

}’

LAl alue'l:'l'l

"displayNaﬁe":null

"isLibraryGoal":false

}.

"organizations":[

nI iSt",

L

1
1.
"tasks":[
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“list",
L
{ _ _
"@type':"com.saba.rest.service.goal .RestTaskDetail",
“owner”:null,
"taskStatus':""100",
"title":"new task"
}
1

1

"parentGoal™:{
"@type':"com.saba.goal .GoalReferenceWrapper",
""goalDefinition":{
"@type' :"com.saba.goal .entity.GoalDefinitionReference",
"id":""gdefn000000000002903"",

"displayName":null

""goalAssignment™:{
"@type' :"com.saba.goal .entity.GoalAssignmentReference",
"1d" :""gasgn000000000010431"",
"displayName" :null

"selectedObjective":null,
"associationsData': [

“list",

L

{ _
"@type':"com.saba.rest.service.goal .GoalAssociationBasicDTO",
"activityld":"teams000000000001083"",
"requiredLevelld":null,
"purpose':""Reference"

) ¥

{ _
"@type':"com.saba.rest.service.goal .GoalAssociationBasicDTO",
"activityld":"crtfy000000000200162",
"requiredLevelld":null,
"purpose':null

) ¥

{ _
"@type':"com.saba.rest.service.goal .GoalAssociationBasicDTO",
"activityld":"compt000000000001141"",
"requiredLevelValue':1,
"purpose':null

}

1

"éubmitForApproval":true,
"isDirectindirect":false

}

Return Values (Self)

"GoalResultWrapper':{
"@type' :"com.saba.goal .GoalResultWrapper",
"operationResultEnum":""SUCCESS",
"goalResultColl":[

nl iSt",

L
{
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"@type':"com.saba.goal .GoalResult",
"approvalStatus':{
"@type':"com.saba.goal .GoalDefinitionApprovalStatus",
"listld":"sys11000000000006030",
""key'':"'200",
"displayName'":""Pending Approval™

"successFlag":true,
"successGoalReference":{
"@type':"com.saba.goal .GoalReferenceWrapper",
"goalDefinition™:{
"@type':"com.saba.goal .entity.GoalDefinitionReference",
"sourceType' :"Goal",
""componentName':"Goal Definition",
"activitySourceType'":{
"'sourceType™:5,
"listld":"sys11000000000003037",
"key'':"'5",
"displayName':""Goal™

}

’rescriptionActionType":{
"displayName":"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,
"name' :""GoalDefinition",
llkeyll : lllll

},

"1d":""gdefn000000000002980",

“displayName™:null,

"locale™:{
"@type"”:"loclref",
"id":"local000000000000001",
"displayName" :null

}1

"primaryKey":{
"@type':"com.saba.persist._Objectld",
"id":""gdetn000000000002980"",

"prefix":"gdefn"
}

oalAssignment™:{
"@type':"com.saba.goal .entity.GoalAssignmentReference",
"sourceType' :"Goal",
"1d" :""gasgn000000000010556"",
"displayName" :""gasgn000000000010556"",
"locale":{
"@type”:"loclref",
"1d":"local000000000000001",

"displayName" :null

}

},

"primaryKey":{
"@type':"com.saba.persist.Objectld",
"1d":""gasgn000000000010556",
"prefix":""'gasgn™

}

+

ssignee':{
ll@typell : llemploll ,
"sourceType':"InternalPerson™,
"activitySourceType':{

"'sourceType':0,

}



"listld":"sys1i1000000000003037",
"key':"0",
"displayName":""Person"

"id":"emploOOOOOOOOOOOlOOl",
"displayName'":""User Two",
"locale":null

}

’oaIErrorList":nuII,
"failedGoalDetail " :null

}
1
1

Request Body (Team)

"@type':"com.saba.rest.service.goal .SabaGoalRestDetail",
"goalAssignmentDetail":{

"@type':"com.saba.rest.service.goal .RestGoalAssignmentDetail",

"locked":false,
"assignee':{

"@type':"com.saba.party.person.entity.EmployeeReference",

"id":""empl10o000000000200503"
}

oalDefinition”:null,

""goalAssignmentStatus™:{

"@type':"com.saba.goal .entity.GoalStatusReference",
"statusValue':""gstts000000000001000",

"id":""gstts000000000001000"

"archived":false,
"source':{

"@type':"com.saba.party.person.entity_EmployeeReference",

"id":""empl10000000000001000"

}1

"startDate":{
"@type':"date",
"time':""2016-04-07"",
"'date':"'2016-04-07"

}1

"dueDate" :{

ll@typell : lldatell ,
“time':""2016-04-30",
"date':""2016-04-30"

"originalDueDate" :null

"éoaIDefinitionDetaiI":{

"@type':"com.saba.rest.service.goal .RestGoalDefinitionDetail",

“owner™:{

"@type':"com.saba.party.person.entity_EmployeeReference",

"id":""emplo000000000200503"
}

equired":null,
"duration”:null,
“"pullInReview":false,
"smartGoal' :null,
"fixedStartDate":null,
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"fixedEndDate" :null,
"title":"new",
""goalCategory':{

"@type':"com.saba.goal .entity.GoalCategoryReference",
"id":""gcate000000000000011"

}’

"goalDefinitionStatus":{
"@type' :"com.saba.rest.service.goal .RestGoalDefinitionStatus",
"listld":"sys1i000000000006003",

"key":"Active"

""shared":false,
"template':false,
"pushed" :null,
"goalMetric":{

"@type':"com.saba.goal .entity.GoalMetricReference",
"id":""gmetro00000000001042"

"éoalAction":{
"@type':"com.saba.goal .entity.GoalActionReference",
"1d":""gactn000000000001041""
}!
"goalUnit”:{

"@type':"com.saba.goal .entity.GoalUnitReference",
"id":""gunit000000000001004"

}

"’oaIType":{

"@type':"com.saba.goal .entity.GoalTypeReference",
"id":""goalt000000000000001"

"initialvalue':1,
"targetValue:2,
"goalVisibility":"gvizro00000000001002",
"description”:"<p>Hello</p>",
“"libGoalVisibilityKey":null,
"auditDetail":null,
"definitionCustomValues™:[
“list",
L
{ _ _
"@type':"CustomAttributevValueDetail™,
"name’ :"'‘custom0",
"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

"Qalue":"l",
"displayName™" :null

"@type' :"CustomAttributevalueDetail",
"name™ :"customl’,
"datatype:{

"@type' :"CustomAttributeDatatype’,

"value':18

"Qalue":"2",
"displayName" :null

"@type' :"CustomAttributevValueDetail",

"name':"'custom2™,
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"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

}»

"value™:"3",

"displayName™" :null

"@type' :"CustomAttributevalueDetail",

“name' :""custom3"’,

"datatype:{
"@type' :"CustomAttributeDatatype’,
"value':18

"Qalue":"4",

"displayName":null

"@type' :"CustomAttributevValueDetail",

"name" :""custom4',

"datatype':{
"@type':"CustomAttributeDatatype’,
"value™:18

'I\’Ial uell : ll5ll ,

"displayName" :null

"@type':"CustomAttributeValueDetail™,

"name" :""custom5"’,

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

"Qalue":"G",

"displayName" :null

"@type' :"CustomAttributevalueDetail",

"name’:""custom6’,

"datatype’:{
"@type' :"CustomAttributeDatatype’,
"value':18

}1

“value™:"7",

"displayName" :null

"@type' :"CustomAttributevValueDetail",

"name" :""custom7',

"datatype':{
"@type' :"CustomAttributeDatatype’,
"value™:18

'I\’Ial uell : ll8ll ,

"displayName" :null

"@type':"CustomAttributevValueDetail™,
"name" :""custom8"’,
"datatype':{

"@type' :"CustomAttributeDatatype',
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"value':18
"value':"9",
"displayName" :null
3
{ _ _
"@type' :"CustomAttributevValueDetail",
"name'':"custom9”,
"datatype':{
"@type' :"CustomAttributeDatatype",
"value'™:18
}.
“value™:"",
"displayName':null
}
1
"isLibraryGoal':false
},
"organizations":[
"list",
L
1
1.
"tasks":[
"list",
L
{ _ _
"@type':"com.saba.rest.service.goal .RestTaskDetail",
"owner":null,
""taskStatus™:""100",
"title":"new task"
}
1
1

arentGoal:{
"@type' :"com.saba.goal .GoalReferenceWrapper",
"goalDefinition":{
"@type':"com.saba.goal .entity.GoalDefinitionReference",
"1d":""gdefn000000000002903",

"displayName" :null

""goalAssignment™:{
"@type':"com.saba.goal .entity.GoalAssignmentReference",
"1d":""gasgn000000000010431",
“displayName™:null

"éelectedObjective":null,
"associationsData": [

“list",
[{
"@type' :"com.saba.rest.service.goal .GoalAssociationBasicDTO",
"activityld":"teams000000000001083"",
"requiredLevelld":null,
"purpose':""Reference"
}1
{

"@type' :"com.saba.rest.service.goal .GoalAssociationBasicDTO",
"activityld":"crtfy000000000200162",
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}
1

"requiredLevelld":null,
"purpose':null

"@type':"com.saba.rest.service.goal .GoalAssociationBasicDTO",

"activityld":"compt000000000001141™,

"requiredLevelValue':1,
"purpose':null

"éubmitForApproval":true,
"assignees™:[
nl iSt",

L
{

}
1

"@type':"com.saba.party.person.

*1d":"emplo000000000001000"

"@type' :""com.saba.party.person.

"*id":""empl10000000000200088"*

"@type' :"com.saba.party.person.

"*id":""empl10000000000200504"

"@type':"com.saba.party.person.

"*1d":"emplo000000000200502"

"@type' :"'com.saba.party.person.

*id":""empl10000000000200487"

"isDirectlndirect":false

}

Return Values (Team)

"GoalResultWrapper':{
"":"com.saba.goal .GoalResultWrapper",
"operationResultEnum":""SUCCESS",
""goalResultColl': [

“list",

"@type

L

{

entity.EmployeeReference™,

entity.EmployeeReference",

entity._EmployeeReference",

entity.EmployeeReference™,

entity.EmployeeReference",

"@type':"com.saba.goal .GoalResult",

"approvalStatus':{

"@type':"com.saba.goal .GoalDefinitionApprovalStatus™,

"listld":"sys11000000000006030",

llkeyll = IIZOOII ,

"displayName":""Pending Approval"

"successFlag":true,
""successGoalReference™:{

"@type':"com.saba.goal .GoalReferenceWrapper",

""goalDefinition":{
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"@type':"com.saba.goal .entity.GoalDefinitionReference",
"sourceType' :"Goal",

""componentName':""Goal Definition",
"activitySourceType':{
"'sourceType:5,
"listld":"sys11000000000003037",
"key'':"'5",
"displayName":""Goal""

"ﬁrescriptionActionType":{
“displayName™:"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,
"name' :""GoalDefinition",
"key":"1"
X
"1d":""gdefn000000000002973",
"displayName™:null,
"locale":{
"@type':"loclref",
"id":""1ocal000000000000001™",
"displayName" :null
}1
"primaryKey" :{
"@type':"com.saba.persist.Objectld",
"id":""gdefn000000000002973",
"prefix":"gdefn"
}

oalAssignment™:{

"@type':"com.saba.goal .entity.GoalAssignmentReference",
"sourceType' :"Goal",

"1d":""gasgn000000000010541"",

"displayName" :""gasgn000000000010541"",
"locale™:{

"@type":"loclref",

"id":""1ocal000000000000001",
"displayName':null

X

"primaryKey":{
"@type':"com.saba.persist._Objectld",
"i1d":""gasgn000000000010541"",
"prefix":""gasgn"

}

}

ssignee':{

"@type':"emplo™,

"sourceType':"InternalPerson”,

"activitySourceType':{
"sourceType':0,
“listld":"sys1i000000000003037",
“'key':"0",
"displayName™":""Person"

}

"id":"emplo000000000001001",
"displayName'":"User Two",
"locale":null
¥, i
""goalErrorList":null,
"failedGoalDetail":null

}.
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"@type':"com.saba.goal .GoalResult",
"approvalStatus':{
"@type':"com.saba.goal .GoalDefinitionApprovalStatus",
"listld":"sys1i000000000006030",
"'key':"'200",
"displayName":""Pending Approval"

"successFlag":true,
""successGoalReference':{
"@type':"com.saba.goal .GoalReferenceWrapper",
"goalDefinition™:{
"@type' :"com.saba.goal .entity.GoalDefinitionReference",
"sourceType' :"Goal",
""componentName':""Goal Definition",
"activitySourceType':{
"'sourceType':5,
"listld":"sys11000000000003037",
""key'":"'5",
"displayName':""Goal™

}

,rescriptionActionType":{
“displayName™:"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,

"name' :""GoalDefinition",
"key":"1"

}1

"1d":""gdefn000000000002974",

"displayName™:null,

"locale":{
"@type":"loclref",
"id":"local000000000000001",
"displayName" :null

"ﬁrimaryKey":{

"@type':"com.saba.persist.Objectld",
"id":""gdefn000000000002974",

"prefix":"gdefn"

""goalAssignment:{
"@type' :"com.saba.goal .entity.GoalAssignmentReference",
"sourceType' :"Goal",
"1d" :""gasgn000000000010542"",
"displayName™ :""gasgn000000000010542",
"locale™:{
"@type'":"loclref",
"id":"1ocal000000000000001"",

"displayName" :null

"primaryKey":{
"@type':"com.saba.persist._Objectld",
"i1d":""gasgn000000000010542",
"prefix":""gasgn"

}

}

ssignee':{
"@type':"emplo™,
"sourceType':"InternalPerson™,
"activitySourceType':{

}
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"'sourceType':0,
"listld":"sys11000000000003037",
llkeyll : IIOII ,
"displayName™":""Person"

}1

"id":"empl10o000000000200003"",
"displayName':""Human Administrator’,
“locale™:null

"éoalErrorList":null,
"failedGoalDetail' :null

"@type':"com.saba.goal .GoalResult",
"approvalStatus':{
"@type':"com.saba.goal .GoalDefinitionApprovalStatus",
"listld":"sys1i000000000006030",
"'key':"'200",
"displayName":""Pending Approval"

"successFlag":true,
""successGoalReference':{
"@type':"com.saba.goal .GoalReferenceWrapper",
"goalDefinition™:{
"@type':"com.saba.goal .entity.GoalDefinitionReference",
"sourceType' :"Goal",
""componentName':""Goal Definition",
"activitySourceType':{
"'sourceType™:5,
"listld":"sys11000000000003037",
""key'":"'5",
"displayName':""Goal™

"ﬁrescriptionActionType":{
“displayName™:"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,

"name' :""GoalDefinition",
"key":"1"

}1
"i1d":""gdefn000000000002975",
"displayName™:null,
"locale":{
"@type":"loclref",
"*id":""1ocal000000000000001"",

"displayName" :null

"ﬁrimaryKey":{
"@type':"com.saba.persist.Objectld",
"id":""gdefn000000000002975",

"prefix":"gdefn"
}

"éoalAssignment":{
"@type':"com.saba.goal .entity.GoalAssignmentReference",

"sourceType' :"Goal",
"1d" :""gasgn000000000010543"",
"displayName™:""gasgn000000000010543"",
"locale™:{
"@type'":"loclref",
"id":"1ocal000000000000001",

"displayName" :null



}

"primaryKey" :{
"@type':"com.saba.persist.Objectld",
"1d":""gasgn000000000010543",
"prefix™:""'gasgn™

+
+

ssignee':{

"@type':"emplo",

"sourceType™:"InternalPerson™,

"activitySourceType":{
"'sourceType':0,
"listld":"sys11000000000003037",
"key':"0",
"displayName™":""Person"

}

}1

"id":"emplo000000000200004",
"displayName':"'System Administrator",
"locale:null

"éoalErrorList":null,
"failedGoalDetail' :null

"@type':"com.saba.goal .GoalResult",
"approvalStatus':{
"@type':"com.saba.goal .GoalDefinitionApprovalStatus",
"listld":"sys1i000000000006030",
"'key':"'200",
"displayName":""Pending Approval™

"successFlag":true,
""successGoalReference':{
"@type':"com.saba.goal .GoalReferenceWrapper",
"goalDefinition™:{
"@type':"com.saba.goal .entity.GoalDefinitionReference"
"sourceType' :"Goal",
""componentName':""Goal Definition",
"activitySourceType':{
"'sourceType':5,
"listld":"sys11000000000003037",
""key'":"'5",
"displayName':""Goal™

"ﬁrescriptionActionType":{
“displayName™:"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,

"name' :""GoalDefinition",
"key":"1"

}1
"i1d":""gdefn000000000002976"",
"displayName™:null,
"locale":{
"@type":"loclref",
*id":""1ocal000000000000001"",

"displayName" :null

"ﬁrimaryKey":{
"@type':"com.saba.persist._Objectld",
"i1d":""gdefn000000000002976",
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"prefix":""gdefn"
}

"éoalAssignment":{

"@type':"com.saba.goal .entity.GoalAssignmentReference"

"sourceType' :"Goal",
"id":""gasgn000000000010544"",
"displayName' :"'gasgn000000000010544"",
"locale":{
“@type”:"loclref”,
"i1d":""1ocal000000000000001"",

"displayName™" :null

},

"primaryKey" :{
"@type':""com.saba.persist.Objectld",
"1d":""gasgn000000000010544",
"prefix™:""'gasgn™

+

}

ssignee':{

"@type':"emplo",

"sourceType™:"InternalPerson™,

"activitySourceType':{
"'sourceType':0,
"listld":"sys11000000000003037",
"key':"0",
"displayName™":""Person"

}

}1

"id":"emplo000000000200120",
"displayName'":""B~" O"pool\"$#@I\""",
"locale":null

}

oalErrorList”:null,
"failedGoalDetail":null

"@type':"com.saba.goal .GoalResult",
"approvalStatus':{
"@type':"com.saba.goal .GoalDefinitionApprovalStatus",
"listld":"sys1i000000000006030",
"'key':"'200",
"displayName":""Pending Approval™

"successFlag":true,
""successGoalReference':{

"@type':"com.saba.goal .GoalReferenceWrapper",
"goalDefinition":{

"@type':"com.saba.goal .entity.GoalDefinitionReference"

"sourceType' :"Goal",
""componentName':""Goal Definition",
"activitySourceType':{
"'sourceType™:5,
"listld":"sys11000000000003037",
""key'":"'5",
"displayName':""Goal™

¥

,rescriptionActionType":{
“displayName™:"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,

"name' :""GoalDefinition",
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llkeyll = lllll

}’

"id":""gdefn000000000002977"",

"displayName":null,

"locale™:{
"@type'":"loclref",
"id":""1ocal000000000000001"",
"displayName':null

"primaryKey":{
"@type':"com.saba.persist._Objectld",
"i1d":""gdefn000000000002977"",
"prefix":""gdefn"

}

oalAssignment':{

"@type':"com.saba.goal .entity.GoalAssignmentReference",

"'sourceType' :"Goal",

"id":""gasgn000000000010545"",

"displayName' :"'gasgn000000000010545",

"locale":{
"@type'":"loclref",
"i1d":""1ocal000000000000001"",
"displayName:null

}

"primaryKey" :{
"@type':"com.saba.persist.Objectld",
"1d":""gasgn000000000010545",
"prefix™:""'gasgn™

+

}

ssignee':{

"@type':"emplo",

"sourceType™:"InternalPerson™,

"activitySourceType':{
"'sourceType':0,
"listld":"sys11000000000003037",
"key'':"0",
"displayName™:""Person""

}

"id":"empIoOOOOOOOOOZOO428",
"displayName':""'mgrOl1 mgr01™,
"locale":null

}

oalErrorList”:null,
"failedGoalDetail":null

1
1
}
}

CREATE PROGRESS OF A GOAL

Overview

Creates progress of a Goal.

Requires OAuth
No
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Method
POST

URL

https://< hostname-api.sabacloud.com>/v1/performance/goals/:goalld/createProgress

Calling Options

Table 70: Calling Options

Name Description Default Value Data Type Required?
goalld ID of goal string Yes
@type @type com.saba.rest.ser~ string Yes
vice.goal.RestGoalPro~
gressDetail
goalStatus Status of a Goal string Yes
goalUnit Goal Unit Reference string No
percentageCompleted | The total percentage com~ string No
pleted
currentValue Current value string No
comment Comment string No
auditReason Audit Reason string No

Request Body

{

"@type':"'com.saba.rest.service.goal .RestGoalProgressDetail",
"goalStatus™:{

"@type':"com.saba.goal .entity.GoalStatusReference",

"id" :""gstts000000000001000"

},

"goalUnit":{
"@type'":"'com.saba.goal .entity.GoalUnitReference",
"id":""gunit000000000001004™"

}

ercentageCompleted':58,
"currentValue':1.58,
"comment"':"f",
"auditReason":"audit with reason”

Return Values

"@type':"'com.saba.rest.service.goal .RestGoalProgressDetail",
"goalStatus™:{



"@type' :"com.saba.goal .entity.GoalStatusReference",

"id":""gstts000000000001000"

}! _
"goalUnit":{

"@type':"com.saba.goal .entity.GoalUnitReference"

"percentageCompleted':48,
"currentValue':null,

""comment'':"asd",

"auditReason":"audit with

}

CHANGE STATUS OF A GOAL

Overview

Changes the status of a Goal

Requires OAuth
No

Method
PUT

URL

reason"

https://<hosthame-api.sabacloud.com> /v1/performance/goals/.goalld/changeStatus

Calling Options

Table 71: Calling Options
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age or not

Name Description Default Value Data Type Required?
goalld ID of goal string Yes
@type @type com.saba.rest.ser~ string Yes
vice.goal.RestGoalPro~
gressDetail
goalStatus Status of a Goal string Yes
goalUnit Goal Unit Reference string No
percentageCompleted | The total percentage com~ string No
pleted
currentValue Current value string No
comment Comment string No
auditReason Audit Reason string No
overwritePercentage | Whether to overwrite percent~ string No




Request Body

{
"@type' :"com.saba.rest.service.goal .RestGoalProgressDetail",
"goalStatus'":{
"@type':"com.saba.goal .entity.GoalStatusReference",
"1d":""gstts000000000001002"
},
"goalUnit":{
"@type':"com.saba.goal .entity.GoalUnitReference",
B ol
}s
"percentageCompleted”:0,
"currentValue':null,
"comment":null,
"auditReason":"audit with reason",
"overwritePercentage":true
}

Return Values

"GoalProgressReference':{
"@type':"com.saba.goal .entity.GoalProgressReference",
"‘componentName':"Goal Progress’,
"i1d":""gprogd000000000003959",
“displayName™:""",

"locale":null,

"primaryKey" :{
"@type':"com.saba.persist.Objectld",
"1d":""gprogd000000000003959",
"prefix":"'gprog"

}

s

}

UPDATE APPROVER OF GOAL

Overview

Updates the approver of a goal

Requires OAuth
No

Method
PUT

URL

https://< hostname-api .sabacl oud.com>/v1/performance/goals/:goalld/approvers
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Calling Options

Table 72: Calling Options
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Name Description Default Value Data Type Required?
goalld Id of goal string Yes
@type @type com.saba.rest.ser~ string Yes
vice.goal.RestAp~
provalDetail
restApprover Detail of a Goal Approver string Yes
changelLog Log of changes of attributes string No

Request Body

"@type':''com.saba.rest.service.goal .RestApprovalDetail™,
"restApprover':{
"@type':"com.saba.rest.service.goal .RestApprover",
"approverStatus':{
"listld":"sys11000000000003077",

"'key':"'300"
"épprovers":[

“list”,

. {
"@type':"com.saba.party.person.entity.EmployeeReference",
"id":""empl10000000000200503"

}

1

1

omments' :""sdfs"

}l
"*changelLog™: [

"liSt",
. {

"@type':"com.saba.rest.changelog.RestChangeLogDetail",

"id":"cclog000000000001068"",

""changeLogApprovalStatus™:{
"@type':"'com.saba.rest.changelog.RestChangeLogApprovalStatus'
"'key':""300"

}

%’

"@type' :"com.saba.rest.changelog.RestChangelLogDetail",

"id":""cclog000000000001069",

""changeLogApprovalStatus':{
"@type':"'com.saba.rest.changelog.RestChangeLogApprovalStatus'
"'key':"'300"

}

}1
{

"@type':"com.saba.rest.changelog.RestChangeLogDetail",



"id":""cclog000000000001070",
""changeLogApprovalStatus':{
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"@type':"'com.saba.rest.changelog.RestChangeLogApprovalStatus",

"'key':"'300"

"@type':"'com.saba.rest.changelog.RestChangeLogDetail",

"1d":""cclog000000000001071"",
""changeLogApprovalStatus':{

"@type':"'com.saba.rest.changelog.RestChangeLogApprovalStatus',

nkeyn = n300n

}
}
1

Return Values
204 No Content
UPDATE GOAL FOR SELF/TEAM

Overview

Updates a Goal for self/team

Requires OAuth
No

Method
PUT

URL
https://<hosthame-api.sabacloud.com>/v1/performance/goals/:goalld

Calling Options

Table 73: Calling Options

Name Description Default Value Data Type Required?
goalld ID of goal string Yes
@type @type com.saba.rest.ser~ string Yes
vice.goal.Saba~
GoalRestDetail
goalAssignmentDetail | Detail of a Goal Assignment string Yes
goalDefinitionDetail | Detail of a Goal Defenition string Yes
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Name Description Default Value Data Type Required?

organizations Organization string No

assignees Assignee of goals (Required string No
only while creating tem
goal)

isDirectIndirect Whether it is direct or undir~ string No
ect goal

selectedObjective Selected Objective string No

submitForApproval | Whether to submit for ap~ string No
proval or not

isPartialUpdate Whether it is partial update string No
or not

Request Body

"@type':"com.saba.rest.service.goal .SabaGoalRestDetail",

"goalAssignmentDetail":{

"@type':"com.saba.rest.service.goal .RestGoalAssignmentDetail",

"locked":false,
"mandatory":false,
"source":{
"@type':"emplo’,
"activitySourceType'":{
"listld":"sys1i000000000003037"",
"sourceType™:0,
"key'":"0",
"displayName™:""Person"
¥,
"sourceType':"InternalPerson",
"1d" :"emplo000000000001000",
"displayName'":"User One",
"locale":{
"@type”:"loclref",
"id":"1ocal000000000000001™,
"displayName':null

}

"assignee':{
"@type':"emplo’,
"activitySourceType':{
"listld":"sys11000000000003037",
"'sourceType'™:0,
"key'':""0",
"displayName":""Person"

3

ourceType™:"InternalPerson’,
"id":"empl10000000000001000",
"displayName':""User One",
"locale":{

"otype':"loclref",
"1d":"local000000000000001",
“displayName':null



}

ueDate":{
ll@typell : lldatell ,
"'time':""2016-04-30T00:00:00",
"date':""2016-04-30T00:00:00""

}

""goalDefinition":{
"@type':"com.saba.goal .entity.GoalDefinitionReference",
"prescriptionActionType':{
“displayName™:"Goal"",

"logicClassForPrescriptionActionType':"GoalPrescriptionPush™,
"name' :""GoalDefinition",

"key":"l"
}

,ctivitySourceType":{

"listld":"sys11000000000003037",
"'sourceType':5,

llkeyll : ll5ll ,
"displayName":""Goal""

"sourceType' :"Goal",
"‘componentName™:"Goal Definition™,
"i1d":""gdefn000000000002965",
"displayName':"app2",
"locale":{

"@type":"loclref",

*id":""1ocal000000000000001"",
“displayName™:null

"6rimaryKey":{

"@type':"com.saba.persist.Objectld",
"id":""gdefn000000000002965",
"prefix":""gdefn"

3
"étartDate":{
"@type':"date",

"time':'""2016-04-07T00:00:00",

“'date’:""2016-04-07T00:00:00""
}

oalAssignmentStatus':{

"@type' :"com.saba.goal .entity.GoalStatusReference",
"statusValue':""gstts000000000001000",
"id":""gstts000000000001000",
"displayName":"Active",

“locale™:null,

"primaryKey" :{

"@type':"com.saba.persist.Objectld",
"id":""gstts000000000001000",
"prefix":""gstts"

}

riginalDueDate":null,
"archived':false,

"assignmentld':""gasgn000000000010513",
"dueDays':"'30.04.2016",

X

‘assigneePicture R = hittp://<hostrame>/productiav/armloyesPicture/notoio000000000201236 enployeePicture JPEG,

"assignmentCustomValues™: [
nl iSt",
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"@type' :"CustomAttributevalueDetail",

"name’:""custom9",

"datatype™:{
"@type' :"CustomAttributeDatatype’,
“value™:18

}

"value":null,

"displayName":""custom9"

"@type' :"CustomAttributevValueDetail",

"name' :""custom0’,

"datatype':{
"@type' :"CustomAttributeDatatype",
"value™:18

}

"value":null,

"displayName":""customQ"

"@type':"CustomAttributeValueDetail™,

"name" :""custom3"’,

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

}

"value":null,

"displayName™:""custom3"

"@type' :"CustomAttributevalueDetail",

“name' :""custom4'’,

"datatype’:{
"@type' :"CustomAttributeDatatype’,
“value™:18

}

“"value":null,

"displayName":""custom4"

"@type' :"CustomAttributevValueDetail",

"name" :""customl’,

"datatype':{
"@type':"CustomAttributeDatatype’,
"value™:18

}

"value":null,

"displayName":""customl"

"@type':"CustomAttributeValueDetail™,

"name" :""custom2",

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

}

"value":null,

"displayName™:""custom2"
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"@type' :"CustomAttributevValueDetail",

"name" :""custom7'’,

"datatype':{
"@type' :"CustomAttributeDatatype",
"value™:18

}

"value":null,

"displayName":""custom7"

"@type':"CustomAttributevValueDetail™,
"name' :"'‘custom8",
"datatype':{

"@type' :"CustomAttributeDatatype',

"value':18

}

"value":null,

"displayName™:""custom8"

"@type' :"CustomAttributevalueDetail",
"name™ :"custom5',
"datatype’:{

"@type' :"CustomAttributeDatatype’,

"value':18

}

"value":null,

"displayName":""custom5"

"@type' :"CustomAttributevValueDetail",

"name™:"custom6’’,

"datatype':{
"@type':"CustomAttributeDatatype",

"value':18

}

"value":null,

"displayName":""custom6"

}
1

"assignmentMetadata':{
"@type':"com.saba.ejb.UpdateMetadata,
"timestamp':''1349202383",

"locale":{
"@type'":"loclref",
"i1d":""1ocal000000000000001"",
"displayName™" :null

},

"primaryKey" :{
"@type':"com.saba.persist.Objectld",
"1d":""gasgn000000000010513",
"prefix’:""'gasgn™

+

’issedGoaI":false

}

"goalDefinitionDetail":{
"@type':"com.saba.rest.service.goal .RestGoalDefinitionDetail",
"i1d":""gdefn000000000002965",
owner" :{

"@type':"emplo",



"activitySourceType':{
"listld":"sys11000000000003037",
"sourceType':0,
llkeyll : IIOII ,
“displayName™:""Person"

}

ourceType":"InternalPerson’,
"id":"emplo000000000001000",
"displayName":null,
"locale":null

X

uration":0,
"description':"<p>adsa</p>",
"shared": false,
"securityDomain':{

"@type':"com.saba.domain.entity.DomainReference",

"1d":""domin000000000000001",

"displayName™":"world",

"locale":null,

"primaryKey" :{
"@type':"com.saba.persist.Objectld",
"1d":""domin000000000000001",

“prefix:""domin™

}

"auditDetail":null,
"pullInReview":true,
"title":"app2",
"fixedStartDate":null,
"definitionCustomValues': [
"list",
L
{ _ _
"@type':"CustomAttributevalueDetail™,
"name™ :"custom0",
"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

"Qalue":"Z",
“displayName™:null

"@type' :"CustomAttributevalueDetail",

"name™ :"customl’,

"datatype':{
"@type':"CustomAttributeDatatype’,

"value':18

"Qalue":"Z",
"displayName" :null

"@type' :"CustomAttributevValueDetail™,

"name' :"'custom2’,

"datatype':{
"@type' :""CustomAttributeDatatype",
"value':18

"Qalue":"Z",

"displayName" :null
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"@type' :"CustomAttributevalueDetail",

"name':""custom3",

"datatype':{
"@type':"CustomAttributeDatatype’,
"value':18

"Qalue":"Z",

"displayName" :null

"@type' :"CustomAttributevValueDetail™,

"name' :"'custom4’,

"datatype':{
"@type' :""CustomAttributeDatatype",
"value':18

"Qalue":"Z",

"displayName" :null

"@type':"CustomAttributevalueDetail",

"name' :""custom5'’,

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

"Qalue":"Z",

“displayName™:null

"@type' :"CustomAttributevalueDetail",

"name’:""custom6’,

"datatype':{
"@type':"CustomAttributeDatatype’,
"value':18

}1

“value':""2",

"displayName" :null

"@type' :"CustomAttributevValueDetail™,

"name' :"'custom7',

"datatype':{
"@type' :""CustomAttributeDatatype",
"value':18

"Qalue":"Z",

"displayName" :null

"@type':"CustomAttributevalueDetail™,

"name' :""custom8"’,

"datatype':{
"@type' :"CustomAttributeDatatype',
"value':18

"Qalue":"Z",

“displayName™:null

"@type' :"CustomAttributevalueDetail",
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"name' :"'custom9’,

"datatype':{
"@type' :""CustomAttributeDatatype",
"value':18

"Qalue":"Z",

"displayName" :null
+
1

]!
""goalApprovalStatus™:{

"@type":""com.saba.rest._service.goal _.RestGoalDefinitionApprovalStatus",

"'key':"'300",
"description":"Approved"

}!

"goalDefinitionStatus™:{
"@type':"com.saba.rest.service.goal .RestGoalDefinitionStatus",
"key'"' :""Active",

"description”:"Active"

},
"goalVisibility":"gvizro00000000001002",
"parentLibGoalld”:null,
"goalVisibilityName":""Everyone",
"definitionMetadata':{
"@type':"com.saba.ejb.UpdateMetadata”,
"timestamp':"'1591708561",
"locale":{
"@type”:"loclref",
"1d":"local000000000000001",

“displayName':null

}1

"primaryKey":{
"@type':"com.saba.persist.Objectld",
"id":""gdefn000000000002965",

"prefix":""gdefn"
¥

"template':false,
"expiryDate":null,
“"libGoalVisibilityKey":null,
"required":false,

"pushed": false,
"fixedEndDate":null,

"shortDescription:"",
"goalType":{

"@type':"com.saba.goal .entity.GoalTypeReference",
"i1d":""goalt000000000000001",
"displayName™":""Performance Goal",
"locale":{
"@type':"loclref",
*i1d":""1ocal000000000000001"",
“displayName™:null

}

"’rimaryKey":{

"@type':"com.saba.persist.Objectld",
"id":""goalt000000000000001"",

"prefix":"goalt"

ks
}’
""goalCategory':{

"@type':"com.saba.goal .entity.GoalCategoryReference",
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"id":""gcate000000000000011"

"isLibraryGoal':false,
"initialvalue':1,
"goalMetric™:{
"@type':"com.saba.goal .entity.GoalMetricReference",
"1d" :""gmetr000000000001040"
},
"goalAction":{
"@type':"com.saba.goal .entity.GoalActionReference",
"1d":""gactn000000000001040"

}!

"goalUnit":{
"@type':"com.saba.goal .entity.GoalUnitReference",
"id":""gunit000000000001004"

"smartGoal':false,
"targetValue™:2

kérganizations":[
“list”,
L
1

1

Request Body (Submit for approval)

{
"@type':"com.saba.rest.service.goal .SabaGoalRestDetail",
"isPartialUpdate':true,
"goalAssignmentDetail":{
"@type':"com.saba.rest.service.goal .RestGoalAssignmentDetail"
"éubmitForApproval":true
}

Request Body (Mark as Archive or Unarchived)

{
"@type':"com.saba.rest.service.goal .SabaGoalRestDetail",
"isPartialUpdate":true,
"goalAssignmentDetail":{
"@type':""com.saba.rest.service.goal .RestGoalAssignmentDetail",
"archived':true
he
+

Return Values
204 No Content

- Note: For more details on this see REST API Reference.

Use case

This enhancement makes it possible to add and update Goals, Goal Progress and Status using REST APIs.


https://community.sabacloud.com/Saba/Web_spf/SPCTNT351Site/common/resources/resourcedetail/simrs000000001015068

APIs for adding, updating, deleting and retrieving Currency list of a
person

How did it work?
There were no REST APIs for adding, updating, deleting and retrieving Currency list of a person.

How does it work now?

The following new REST APIs will now allow adding, updating, deleting and retrieving Currency list of a person:

ADD CURRENCY TO PERSON

Overview

Adds a person’s currency.

Requires OAuth
No

Method
POST

URL

https://< hostname-api.sabacloud.com>/v1/people/:personld/currencyL.ist

Calling Options

Table 74: Calling Options
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Name Description Default Value Data Type Required?
currencyList currencyL.ist to be associated | [{ string Yes
i ‘amngy00000000000000L

Active":false }]

personld ID of the Person string Yes

Request Body

{

"currencyList” : [{
"1d"™ : "crncy000000000000001",
"isoCode"™ : "Rs",
"isActive" : true

3 A
"1d" : "crncy000000000000002",
"isoCode" : ''cyl",
"isActive" : false

id|



Return Values

"id": "persn000000000001027",

"displayName": "CTWO3",

"href': ""https://<host_name>/v1/people/persn000000000001027""
}

MARK THE CURRENCY ACTIVE/INACTIVE

Overview

Updates the account currency of the Person.

Requires OAuth
No

Method
PUT

URL
https://<hosthame-api.sabacl oud.com> /v1/people/:personld/currencyList/:currencyld

Calling Options

Table 75: Calling Options
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Name Description Default Value Data Type Required?
personid Person's ID string Yes
currencyld Currency ID of the currency string Yes

to be updated

active Set the currency to active/in~ | true string Yes
active

Request Body

"active': false

}

DELETE PERSON'S CURRENCY

Overview

Delete a currency from the associated currency list of a particular person.

Requires OAuth
No



URL
https://< hostname-api.sabacloud.com>/v1/people/:personld/currencyList/:currencyld

Calling Options

Table 76: Calling Options
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Name Description Default Value Data Type Required?
personid Person's 1D string Yes
currencyld Currency ID of the currency string Yes

to be deleted

DELETE PERSON'S CURRENCY BASED ON CURRENCY ISOCODE LOOKUP

Overview

Deletes a currency from the associated currency list of a particular person based on currency isocode lookup.

Requires OAuth
No

URL
https://< hostname-api.sabacloud.com>/v1/people/:personld/currencyList/name=:isoCode

Calling Options

Table 77: Calling Options

Name Description Default Value Data Type Required?
personld Person's ID string Yes
isoCode ISO code of the currency string Yes

GET THE REQUIRED PROFILE DETAILS OF A PARTICULAR PERSON

Overview

Returns the required profile details of a particular person based on the Person's ID passed as a parameter value.

Requires OAuth

No

Method
GET

URL

https://< hostname-api.sabacloud.com>/v1/people/:id:(:searchFields)
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Example
https://< hostname-api .sabacl oud.com>/v1/people/persn000000000001027:(currencyL.ist)

Calling Options

Table 78: Calling Options

Name Description Sample Value Data Type Required?

id Person's ID per~ string Yes
sn000000000001000

searchFields Indicate the field(s) that you | flightRisk string No

intend to extract:
flightRisk,socialProfile,tran~
scripts,externalWorkHis~
tory,interests,competencies,
centraProfile,education,core~
Profile,languages,team~
Info,imProfile,customSec~
tionl, secondaryAddress,cus~
tomSection3,careerint~
erests,customSection2,extern~
alCertifications, mobility,net~
workInfo,potentialRating,
requiredJobRoles, optional~
JobRoles, securityRoles, ob~
jective, currencyList

Return Values

"id": "persn000000000001027",
"currencylList": [

{
"nane": "US Dol | ars",
"default": true,
"precision": 2,
"active": true,
"short _name": "USD',
"iso_code": "USD',
"id": "crncy000000000000001"
I
{
"nanme": "dc",
"default": false,
"precision": 2,
"active": false,
"short_name": "dc",
"iso_code": "dc ",
"id": "crncy000000000202978"
I
{

"nanme": "Currency2",
"default": true,
"precision": 2,
"active": false,



"short nanme": "CY2",
"iso_code": "CY2",
"id": "crncy000000000001006"

"name": "Currencyl",
"default": false,
"precision": 2,
"active": false,
"short_nane": "CY1",
"iso_code": "CY1",
"id": "crncy000000000001005"
}
]
}

g~ Note: For more details on this see REST API Reference.

Use case
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This enhancement makes it possible to add, update, delete and retrieve the Currency list of a person using REST APIs.

API to mark a task/registration module complete

How did it work?

There was no REST API for marking a task/registration module complete.

How does it work now?

The following new REST API will now allow marking a task/registration module complete:

MARK A TASK / REGISTRATION MODULE COMPLETE

Overview

Allows to mark a task/registration module complete.

Requires OAuth
No

Method
PUT

URL

https://< hostname-api.sabacl oud.com> /v1/learning/enroll/assignments/action/:regModuleld?action=:actionName

Calling Options

Table 79: Calling Options

Name Description Sample Value Data Type

Required?

regModuleld Registration module's ID string

Yes
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Name Description Sample Value Data Type Required?
actionName Action to be performed. markComplete enumerated Yes
Accepted values:
¢ markComplete
« signoff
@type Input JSON class name com.saba.learning.ser~ | string Yes
vices.activities
.RegistrationModule~
Actioninfo
evaluatorlds List of evaluator IDs [list", string No
['em~
plo000000000001026"]
]

Request Body (To mark complete or request evaluation)

{

"@type':"com.saba.learning.services.activities.RegistrationModuleActioninfo"

"evaluatorlds'":[
"I iSt",

"*emp10000000000001026**

Request Body (To approve task)

{

"@type':""com.saba.learning.services.activities.RegistrationModuleActionlnfo"

"learnerld" : "emplo000000000001026"
}

Return Values
204 No Content

g~ Note: For more details on this see REST API Reference.

Use case

This enhancement would allow embedding tasks links in external interfaces and sites like Sharepoint without the user

having to access the Saba Ul to launch the task or mark it as evaluated.
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API to delete a facility

How did it work?

There was no REST API for deleting a facility.

How does it work now?

The following new REST API will now allow deleting a facility:

DELETE A FACILITY

Overview

Deletes a particular facility using facility number.

Requires OAuth
No

Method
DELETE

URL
https://< hostname-api.sabacl oud.com> /v1/facility/facility_no=:facility_no

Calling Options

Table 80: Calling Options

Name Description Default Value Data Type Required?

facility _no Facility's number 001000 string Yes

Return Values
Status 200 OK

g~ Note: For more details on this see REST API Reference.

Use case

This enhancement would allow embedding tasks links in external interfaces and sites like Sharepoint without the user
having to access the Saba Ul to launch the task or mark it as evaluated.

Caching for REST APIs

How did it work?
REST API results were not cached.

How does it work now?
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The GET ALL REST APIs results can now be cached to improve the performance of the GET ALL REST end points.

g~ Note: By default, this feature will be disabled. To enable this feature, submit a support request. For assistance,
- contact your Customer Success Manager.

As of now, all the records that the GET APIs retrieve will be cached, however, in the upcoming releases, there will be
a configurable limit option that will allow setting the number of records (returned by the GET ALL APIs) that need to

cached.

Use case

REST Web services are widely used by customers to build their own app and surface them in Saba Cloud. Out of the
many available Web services, the Get All end points are heavily used to get all the records for the provided component.
With the growing volume of data, at times there are performance issues. Caching of data returned by the Get All REST
APIs would help improve the performance of these REST end points and enable APl GET requests for larger datasets
with higher order page numbers to return successfully without timeouts.

Manage prescriptive rule when the rule creator is terminated

How did it work?

When the PR is created to run with creator privileges, the PR uses created_by and created_id fields to authenticate
and run the PR. But, when the creator is terminated, there was no provision to change the creator from Ul. Also, the
created_by and created_.id fields are more of audit fields hence they should not be updated from backend.

How does it work now?

A new field Owner has been added on the New Prescriptive Rule page that will track the owner that creates the PR.
The user can still choose to execute the rule with creator's privileges or administrator's privileges. Any person who has
the privileges to edit the PR, can change the owner.

g~ Note: A force audit is performed on changing the owner of the PR.
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Figure 18: Owner field in PR

Use case
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The PR owner can now be tracked and edited and the same can be viewed in the Processing History tab once the PR

process starts.

New attributes in the Sm

How did it work?

art List criteria of a prescriptive rule

The smart list criteria of a prescriptive rule does not include some of the talent and career planning attributes.

How does it work now?

Saba Cloud now introduces the following new attributes in the smart list criteria of a prescriptive rule:

1. Talent Pool

a. Pool Name

2. Career Planning

a. Career Path 1



b.

C.

d.

i. Timeframe 1
ii. Timeframe 2
iii. Timeframe 3
iv. Timeframe 4

Career Path 2

i. Timeframe 1
ii. Timeframe 2
iii. Timeframe 3
iv. Timeframe 4

Career Path 3

i. Timeframe 1
ii. Timeframe 2
iii. Timeframe 3
iv. Timeframe 4

Career Path 4

i. Timeframe 1
ii. Timeframe 2
iii. Timeframe 3
iv. Timeframe 4

Il

Member Selection

Requiremenis.

Emer Log Processing Hislony

e cimna o] ©

Uss the axisting critena @ Defing 3 ndav Crleria

* Groupl J

Ime |isde - Career Fath 1 Tirrseframe 1
Timaframa 1
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2L + Add Group Timeframe 4
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Figure 19: New component privilege for PR
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The admin can fetch the members from PR via Smart List using the Career Path & Talent attributes. The PR pulls all

the members who have created career paths and who are associated with any talent pool.
The above attributes are accessbile from the following clickpaths:

1. Admin > Talent > Talent Pool > Create Pool > Manage Pool > Find Candidates
2. My team > Talent > Create pool > Criteria > Manage Pool > Find Candidates

Use case



The people admin can now assign career paths and talent pools to users using the Career Planning and Talent Pool

attributes.

Prescriptive rule member selection using local CSV upload

How did it work?

| System | 235

Although Saba Cloud allowed prescriptive rule member selection using an external source such as SFTP or HTTP, it
did not provide the ability to add members in bulk by uploading a local CSV file.

How does it work now?

This update allows people administrators to add prescriptive rule members in bulk by uploading a local CSV file
containing user details. After a successful upload, all active users are displayed in the member list when they are

previewed.

To upload the local CSV file:

1. Navigate to the Member Selection tab of the required prescriptive rule.
2. Click External Source.
3. Select Local from the External source type dropdown list. The File field appears.
4. Browse and select the required CSV file containing the member details from your local machine.
5. Click the Upload button.
6. Click the Save button.
ain Member Selection Requirements Error Log Pracessing Histary Analysis
Member selection mode: | Dynamic Criteria source i)
External source Local ~ @
ype:
File: Browse
Upload

Figure 20: Add members using CSV file

Use case

For certain organizations, it is not feasible to define criteria-based membership while assigning learning such as

certifications via prescriptive rules, and so, they need to do the assignment in bulk by uploading an external file. However,
for security reasons, they cannot store the files outside their environment and upload them via the current options such
as SFTP, HTTP or Saba Cloud. Therefore, there is a need to provide an option to upload files containing user information
directly from a local machine.
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Prescriptive rule for course and review can be executed by
administrator privileges

How did it work?

When the course and review is pushed via prescriptive rule (PR), it is created with creator privileges. Such PRs are not
visible on Ul as they are created in backend and cannot be searched. They will appear in the Monitor tab, only when
the PR execution fails.

How does it work now?

The prescriptive rule for course and review can be executed by administrator privileges as well. This is now governed
by the privilege Can create a prescriptive rule that runs with administrator privileges in the Prescriptive Rule
component. By default, this privilege is disabled. When this privilege is enabled, then the PRs created through course
and review will be created with admin privileges. When this privilege is disabled, then the PRs created through course
and review will be created with creator privileges. So if a catalog admin or performance admin has this privilege, and
if they assign a course or assign the review to users, then that PR will be created with admin privilege instead of creator
privilege. This privilege will also affect the internal PRs that are created by Instructor desk while assigning learner with
CSV and qualified completed courses.

Simple Security Role Details: System Admin >

[E

= required

Security Role® System Admin
Description Grants access to all Functionality in System Adm
- ; fﬂ’
Domair world -

Domain Based
-
1pe Criteria Basad

Components People

-
Component Prescriptive Rule ¥

Component Privileges Print I Export | Madify Table
Granlt Access Privilege

MNew

Edit

Delete

View

Change Domain

T

Can create a prescriptive rule that runs with administrater privileges I

Execule
Can View Protected Data

Admin View

Figure 21: New component privilege for PR

Use case
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The catalog admin and performance admin can now choose whether to assign a course and assign a review through
admin privileges or creators privilege.

Changes to the Team Overview page

How did it work?

On the Team Overview page for managers:

« If an alternate team members of a manager had any direct reports, then there was no way to view them from the
Team Overview page.

» If a person reporting to the manager's position had any direct reports, then there was no way to view them from the
Team Overview page.

» The reporting positions for a manager were displayed in the top drilldown filter of the Team Overview page.

« There was no way for managers to filter their direct, alternate or other team members by their organization or job
type on the Team Overview page.

How does it work now?

This update enhances the Team Overview page for managers as follows:

« When managers select the Alternate Team option on the Team Overview page, they now see a <x> Direct Reports
link for each alternate member who has direct report. Clicking this link takes the manager to the page displaying
that member's direct reports. Further, if any of these members have direct reports, then the <x> Direct Reports link
is present for them. Managers can use the link to navigate further down the hierarchy till they reach the bottom of
the hierarchy for member.

« The All Others option in the top dropdown filter is renamed to Other Team(s).

» Similarly, when managers select the Other Team(s) option on the Team Overview page, they now see a <x> Direct
Reports link for each member who has direct report. Clicking this link takes the manager to the page displaying that
member's direct reports. Further, if any of these members have direct reports, then the <x> Direct Reports link is
present for them. Managers can use the link to navigate further down the hierarchy till they reach the bottom of the
hierarchy for member.

« The top dropdown filter on the Team Overview page now displays the logged in user's held position.

e Team Overview page now displays two new dropdown filters, namely, Organization and Job for Direct, Alternate
and Other Team(s) view. Managers can specify the required organization or job type in these fields to filter their
reports. The filter option values for direct and alternate view are shown based on the organization or job type of all
reports. While the filter option value for the Other Team(s) view is calculated based on the reports to the position of
the logged in user. Drilling down the hierarchy of reports, the filter values change based on the context of the user
or position the manager is in.
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Team Overview for| Alternate Team v

Organization » | [Job w
Int Last 5 Int Fi... _
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Figure 22: Enhanced Team Overview page

Use case

« Managers need to navigate down their hierarchy, irrespective of whether it is a person hierarchy or a position hierarchy.

« Managers having multiple teams in multiple locations need to filter the list of their reporting team members by
location so that they can assign location-specific training to them. The managers also need to assign job-specific
training to a group of customer service representatives. The filters on the Team Overview page allow managers to
perform these actions.
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Not contains as the new filter operator

How did it work?

There was no filter operator to completely filter out certain string data.

How does it work now?

A new filter operator called Not contains is now available to completely filter out certain string data.

£) Person Usemame Mot Contains » | | Milesh ﬂ-
Equal
Mot Equal
Starts Viith
Containg
Mot Contains
m_
Mot In
Is Empty
|5 Mot Emphy
Is Logged In

Figure 23: Not contains filter operator
You can also choose the Case Sensitive option for this filter operator.

£) Person Usemame Mot Contains |~ Nilesh - 3

7| Mandalory
| Editable

| Case Sensitive
A —

Figure 24: Not contains filter operator - with Case Sensitive option

Use case

This enhancement is useful for filtering out some data, for example: Exclude an entire email domain or names with the
word "test".
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Color picker accepts Hex color code for Report Theme

How did it work?
The color picker for the Report Theme was limited to using the slider for the desired colour.
How does it work now?

While creating or editing a theme for reports which are used in PDF, the color picker now also allows entering Hex
color code.

Save Report T X

Report Details Select Theme For Report

@ Ugs Exntieg Thama | 1) nound 2 - Creats Maw Thama
ﬁ Security

Conditicnal Formatting

HH
gy coonenas
O]
»

Scheduling Infonmeation

T reeee

Backgroues| ¥

Save and Apply | | Peses

Figure 25: Hex color code

Use case

The ability to select colour was limited to using the slider for the desired colour which was not a user friendly way to
determine the exact branding RGB value.

Report notice messages presented as notice bubbles

How did it work?

The report notice messages (refresh messages) appeared at different locations in report window and didn't acquire
immediate user attention.

How does it work now?

In this update, these notice messages will appear on the top of launched reports as "Notice Bubble". The messages will
fly into the view once the report is launched and will be animated until the user hovers on it once and views the message.
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On hover, the notice bubble expands and the underlying message is shown. You can move the mouse away to close the
expanded view or you can click the "X’ icon to remove the notice.

Schwdube Context Test
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Figure 27: Hovering on the bubble
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Use case

The current presentation of the report notice messages (refresh messages) is not so intuitive and attention seeking. This
enhancements makes all these notice messages more prominent.

Grouping for Crosstab reports

How did it work?
The grouping functionality was not available for Crosstab reports.
How does it work now?

Crosstab reports now support grouping. While creating a crosstab report you can add upto 5 secondary dimensions.

Add Secondary Dimanslons for Person First Neme'

Flelds Added dimensions
& Person Lemame

Parson E-mal

Person Type

Add upto 5§ secondary dimensions

I T A S A R E k.

Note: The additional secondary dimensions can be added from the same entity as of the row dimension. You can
only add dimensions and not Metrics.

Figure 28: Adding secondary dimensions
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Figure 29: Crosstab report with grouping

Use case

N/A

How did it work?
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Quarterly and Hourly scheduling of Analytics reports

Scheduling the Analytics reports quarterly and hourly was not supported.

How does it work now?

It is now possible to schedule the Analytics reports quarterly and hourly.
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Figure 30: Additional frequencies

You can select the Quarterly option in the Frequency dropdown. After selecting the frequency type as Quarterly you
need to select the Day of month value to schedule the report for every quarter on that day.

Scheduling Information

—
Schedule Filters

Fragueamty®: Cuartarty L Day af month* $ .
Date From 17.03.2016 = =

Time 16 200 |2 18T - (BMT+05:30) Chennai, Holkata, Mumbal, New Delhi

Report format® Cav » [] Data Only

CSV separator iaw

Run as recipiant

combaxt

Recipient type @ Email ) Parson Smart list

Email address +

Subject Hello -
Add 5S¢ hedule Cancel

Figure 31: Quarterly

P Note:

* If you pass the Day of month as a value that has already passed for the current month then the report will be
scheduled for that date of the next month, post which the report will be scheduled quarterly.
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» If you pass the Day of month as a value which is yet to pass for the current month then the report will be
scheduled for that date of the current month, post which the report will be scheduled quarterly.

» If you have set the Day of month as 30th of November for the first run which means the next run would be
30th February (which does not exist), in this case, the scheduler will run on next scheduled date i.e. 30th of

May.

You can select the Hourly option in the Frequency dropdown. After selecting the frequency type as Hourly you need
to select the Hourly Frequency (x) to schedule the report for every x hours within the specified date range.

[ B

Schedule Filters

Frequency® Hal w How :
fréque
Date From 7.03.2016 To"
Report format* C8v b Data Cnly
CSV separator g
Run as recipient
conkext
Recipient type @ Email Parson Smart list
Email address +
bjiec Hello
Bod velcom
3] Uk Canc el
Note:

» The hourly frequency value can be in the range: 1-12. If you set the Hourly Frequency value greater than 12,
the report will execute only once in a day which is the same as scheduling the report daily on that time.

« If you pass the Hourly Frequency value ‘x’ and a date range, the report will be scheduled for every ‘x” hours
for each day in the date range starting from 12 am.

For example:
Frequency type: Hourly
Hourly Frequency: 5
Start date: 23/11/2015
End date: 25/11/2015

For days: 23, 24 and 25 the report will be scheduled at: 12AM, 5 AM, 10 AM, 3 PM, 8 PM

o Note: After 8PM the report will not be schedule after 5 hours i.e. 1AM of next day. After the day is
complete, the scheduler will start from the next day i.e. 12 AM and the cycle of 5 hours continues
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Use case
Figure 32: Hourly

This enhancement makes the Analytics Report Scheduler more flexible.

Tent card reports

How did it work?
This is a new functionality.
How does it work now?

Analytics now allows creating simpler forms of reports that you can print out and place like tent cards. Tent card reports
have a printing format which allows placing them on a paper for this purpose.

g~ Note: To enable the feature, submit a support request. For assistance, contact your Customer Success Manager.
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Person Domain world
Person Raole Engineer Role 1

Course Title AdvancedJava

Figure 33: Tent card report

While creating/editing a report, you can enable the tent card report option for that report.
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Figure 34: Enable Tent Card

After you enable the Tent Card option for a report, you can download it.
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Figure 35: Download Tent Card

Whilst downloading it, you can design the tent card by adding the required attributes.
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Figure 36: Designing the Tent card report

To add the required attributes, you can drag them to the Front or Back areas or you can click + and select Add to front
or Add to back.

o Note: Saba recommends adding not more than 5 attributes on either side (Front or Back).
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Figure 37: Drag the required attributes
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After designing the Tent card report you can download it.

Figure 38: Add the required attributes
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Use case

This enhancement provides a printable format which allows placing the report content on paper.

Figure 39: Download the Tent card report

Custom metrics support aggregation in total row

How did it work?
Custom metrics in Analytics did not support aggregation in total row.
How does it work now?

You can now define the total row aggregation for the custom metrics while creating or editing custom metric.
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Figure 40: Defining custom metrics

By default the aggregation for the new custom metric will be set to None. You can choose one of the following options
for aggregation:

* Sum
* Average

g~ Note: All the existing custom metrics will default to None. You can edit them (if required) to set the aggregation.

A global custom metric will carry forward the defined aggregate operators in the reports which cannot be modified at
report level.

In Grouped reports, when roll ups are calculated for the custom metrics for the summary rows, aggregation is performed
on their composite values first. The formula is then evaluated on the result of the composite values' aggregations to get
the rolled up value for the custom metric in the summary rows. For the total rows, the aggregation of custom metrics is
performed on the already evaluated values present in the top level summary rows. For custom metrics with "Average"
as the total row aggregation, the total will be the sum of the values in the top level summary rows (groupings) divided
by the count of the summary rows (groupings).
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In addition to this, the following OOB Formula metrics will now support SUM total in the total rows wherever applicable:

» Courses Not Started in Certification Path
» Courses Not Started in Curricula Path

The following table indicates how the custom metric total row aggregation (SUM and AVG) is applicable to the Analytics
reports:

Report Type Report PDF Excel CSVv
FlatList No No Yes Yes

Grouped Yes Yes NA Yes

Hierarchy Yes NA NA Yes

Cross Tab Yes Yes Yes Yes

Data Extract No No No No

Use case

Figure 41: Group report

N/A

Reorder report filters

How did it work?
It was not possible to reorder report filters by dragging and dropping, similar to Dimensions and Metrics.
How does it work now?

You can now reorder the report filters by dragging and dropping, similar to Dimensions and Metrics, where filter order
can be altered while authoring the report or report within a dashboard.



In the create or edit view of the report, notice the handle icon next to each report filter.
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Figure 42: Handle icon for filters
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You can grab that icon and drag it to move that filter to the desired position in the filters listing, a highlight line will
appear for all allowed positions along with a valid/invalid icon to denote whether filter can be placed there.
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Figure 43: Dragging filters
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If filter groups are available, the filter groups are always at the bottom of filters list while primary (i.e. independent of
any group) filters will stay at the top, and only such primary filters are reorderable and filters within groups do not have
the handle icon.

= Note: You cannot drag any primary filter into a group while reordering, instead click on the Filter Configure icon
and then group the filters.

If you do not re-order any filters, then by default, the filters during the report execution will be sequenced as all the
mandatory filters first followed by the optional filters.

Use case
Figure 44: Dragging filters - Invalid

This enhancement improves the user experience while creating/editing a report.

Interchange axis/legend dimension values in a dashboard report

How did it work?
It was not possible to interchange the axis/legend dimension values in a dashboard report.
How does it work now?

You can now interchange the axis/legend dimension values in a dashboard report.

This update introduces a new button for interchanging the axis/legend dimension values in a dashboard report's creation/edit
widget.
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Figure 45: Dashboard report's creation/edit widget

Use case

This enhancement improves the user experience.
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Report execution details to be available on the top of the reports

How did it work?

The report execution details were not available on the top of the reports. They were only available at the bottom of the

report.

How does it work now?

The report execution details are now available on the top of the reports. When you download a report or a dashboard as
a pdf or excel, the execution details will be printed at the top of the downloaded report. This is only available for PDF

and Excel exports.
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g Note: The same is applicable for the scheduled reports.

Course Catalog

PR
Generaled on 04/11/2016 §:20 FM PST by User One.

No chart configured

Filters
Cionbent name Equal ae_AICC

00200451 a_AICC
00200460 ae ACC
a8 conen AE-E-D02001 80 ae AICC
ae_conten AE-E-00200128 e
corten AE-A-D020012T ae_AICC
Created by: User One.
Generated on 04/1 172016 9:20 PM PST by User One.
Figure 46: Report execution details
; - g C 1] E
1 Generated on 04-APR-2016 800 AM TOT by User Ome.
1 | Created by: User One.
E
4 Filters
5 Is Terminated Equal No
b
T Person Full Name Person First Name Domain Domain Name  Person Work Phone  Person Date of Birt
§ IM Customer M world
% A Datum Corporation (sa Customer_Pariner A Datum Corporation(sa  world
10 Acera Customer Acera world
11 Advanced Design & Drafti Customer Advanced Design & Drafi  world
12 Advanced Machining Techn Customer Advanced Machining Techn  world
13 Adventure Works (sample] Customer_Partner Adventure Works (sample)  world
14 Agrels Apartments Agency Customer Agrela Apartments Agency  world

Figure 47: Report execution details

Use case

Prior to this enhancement, the same data was only provided at the bottom of the report. With this enhancement, a
convenience of viewing the report run date and time on top has been provided.
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Share reports or dashboards with specific users using manager or
employee as the audience

How did it work?

You could only share reports or dashboards with individual users using Admin as the Audience.

How does it work now?

You can now share reports or dashboards with individual users using Manager as well as Employee as the Audience in
addition to Admin. While sharing the report using Action > Share, you can now choose an individual user using the
person picker.

Course Completion Details - DEMO : Security Settings ?T X
Audience | Manager [ Employee
Secunty Role Q,

Hame Username

Useri Cnet UONE1

wonaTT uoneTT UONETT

shubhangi_esmx lpndhe_ssmx UONE_ES_MX

ftest uone TPATHRIKARBSE@SABACOM

St tastuser SCUONE -

woned_clone uoned_clong UONEI_CLONESDOGS 182000
Direct Report UR 6

wone 17 uonel1? UONETT
Admin I users ones UONES PidDO00000a2E 101 5403086030007 895
Employes I usar one UONE CerpidmO00D00ar281c 10124 03bBGC 3200793
uone2? uone22 UONE22

1Tet1d | )

Cancel

h"‘l

Use case

It was possible to share reports with individual users for ADMIN context. This enhancement extends the same for
Manager and Employee contexts.

Figure 48: Person picker while sharing with manager or employee as the audience

Hide non-editable report filters

How did it work?
It was not possible to hide non-editable report filters.
How does it work now?

While saving the report, you will now have an option to hide non-editable report filters. A check box will be available
to allow this.
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Figure 49: Hide non-editable report filters

If you check the Hide non-editable filters, all the non-editable report filters will be hidden in the PDF, Excel and CSV

file.
g~ Note: Even the secondary non-editable filters will be hidden.
Use case

Previously, during the execution of the report, all filters that were added in the report were presented to the person
executing the report. Some of these filters were having preset values and were not editable for the person executing the
report. This enhancement thus provides the ability to hide such filters from the person executing the report.

Control the visibility of extended custom fields

How did it work?

It was not possible to control the visibility of extended custom fields.

How does it work now?

This update provides an option to show or hide the corresponding Analytics attributes in the dimension list for extended
custom attributes which means that if the extended custom fields are marked to be hidden on the application side, they
will also be hidden in Analytics.



Domain-Specific Attributes
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s

Edit Attribute
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Back Save

Figure 50: Extended custom fields marked as hidden/display on the application side

You can set this option under Analytics Settings > Configuration.
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Figure 51: Control the visibility of extended custom fields
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Select the Control visibility of Extended custom attributes option to view extended custom fields in Analytics, only
if they are marked to be displayed for that particular domain in the system.

- Note: If this option is unchecked, all the extended custom attributes will be displayed in Analytics, regardless of

their visibility in system.
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Assumptions:
When the functionality is disabled:

1. Create a report having extended attribute (Excustom1).
2. Turn off the visibility of the attribute (Excustom1l).
3. Enable the Functionality.

In this scenario, the Excustom1 attribute will be not listed in main attribute group (Attribute Tree View). But the
user can still see Excustoml in report (filter / dimension list).

The user can perform all the operations (Copy/Delete/Schedule/Share/History/Theme/Export/Download) on the
same report as before when the functionality was enabled. If the functionality is enabled, then the above operations
will not consider attribute domain visibility.

The concept of domain hierarchy is not applicable. This works in the same manner in Analytics as it works in the main
application.

When the functionality is enabled, the attributes may take time to load.

As the data is getting cached in Analytics, any change in the extended custom fields on the system side requires clearing
cache in Analytics.

Before importing a report (having extended custom fields) on a site, the extended custom fields should be created (with
the same name) on that site.

Use case

Based on the Ul display controls, customers can now show or hide the corresponding Analytics attributes in the dimension
list for extended custom attributes.

Support for currency symbols in reports

How did it work?

The existing attributes did not support displaying currency symbols in the reports.

How does it work now?

This update provides the support for displaying currency symbols in the reports.

g~ Note: To enable the feature, submit a support request. For assistance, contact your Customer Success Manager.
This section lists the attributes that support currency symbols.

Table 81: Attributes Details

Parent Entity Name Entity Name Attribute Name Type
Learning Courses Course Price List Amount | Dimension
Learning Classes Class Price List Amount Dimension

Learning Classes Budgeted Total Amount Dimension
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Parent Entity Name Entity Name Attribute Name Type
Learning Classes Budgeted Unit Cost Dimension
Learning Classes Actual Total Amount Dimension
Learning Classes Actual Unit Cost Dimension
Learning Orders and Orderltems Order Total Charges Dimension
Learning Orders and Orderltems Order Item Unit Cost Dimension
Learning Orders and Orderltems Subscription Price Dimension
Learning Orders and Orderltems Subscription Limit in Cost | Dimension
Price
Learning Orders and Orderltems Subscription Order Item Dimension
Price
Learning Orders and Orderltems Training Unit Price Dimension
Learning Orders and Orderltems Order Discount Amount Dimension
Learning Orders and Orderltems Order Item Tax Amount Dimension
Learning Resource Assignment Resource Rate Amount Dimension
Learning Resource Assignment Resource Assignment Re~ | Dimension
source Rate
Recruiting Candidate Details Candidate Salary requested | Dimension
Recruiting Job Requisition Details Job Requisition From Dimension
Recruiting Job Requisition Details Job Requisition To Dimension
Recruiting Job Offer Job Offer Agency Fee Dimension
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Parent Entity Name Entity Name Attribute Name Type

Recruiting Job Offer Job Offer Offered Salary Dimension

Recruiting Job Offer Job Offer Referral Bonus | Dimension
Amount

Use case

Currency symbols can now be prefixed to Learning and Recruiting dimensions that represent a price or compensation

amount.

Support for derived dimensions

How did it work?

It was not possible to add derived dimensions i.e dimensions based on logical conditions.

How does it work now?

You can now add a new derived dimension and set the logical conditions based on which the value of the dimension

will be determined.

To create a new derived dimension, whilst you create a new report click the + icon.

g~ Note: Alternatively, you can also add a new derived dimension using Settings > Global Custom Attributes which
will be available for use in all reports. Just like Custom Metrics, the Delete button is available only in this view
and it is enabled only for dimensions which are not used in any of the reports.

your Customer Success Manager.

. Note: By default, this feature is disabled. To enable the feature, submit a support request. For assistance, contact
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Figure 52: Add a new dimension

This brings up the Add a custom dimension window, where you can use the Constructs such as IF, THEN, ELSE,
ELSE IF, END IF, etc. to build the expression that will be evaluated to derive the value of the dimension.

Initially, only the IF constuct will be enabled. To begin creating the condition, click the IF construct.
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Add a custom dimension

CHaEsl it Disadriin

& P Cusom Dimarsicn

IF

Click on "IF" contruct to get started

Initialy, Saly the If Coaslruc] s
enabled, User needs 10 Chck i
1o Begia creabing a condition

Note: In the Dimensions list, only the dimensions available in the selected Entity category and support filtering
are shown.

Add the required dimensions along with the appropriate operators to form the IF condition.



| Analytics | 267

Add a custom dimension
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Figure 54: Add dimensions and operators

For every dimension that you add, you need to click the edit icon and set a value for it.

Figure 53: Use the IF construct
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A condition is valid only when all the added dimensions have filter condition provided and the entire condition expression
can be evaluated programmatically (i.e. balanced brackets and proper combination of dimensions and constructs).
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Note: If you've not set the value or if the condition is invalid, the status bar indicates the same. Similarly, the status
bar also indicates a valid condition.
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Figure 56: Valid condition

Figure 55: Editing the dimension value

Enter an appropriate value for the dimension that you added.

g~ Note: Editing a condition is similar to editing a report filter.
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Figure 57: Editing a dimension value

After you add the required dimension and the operators, click the THEN construct. Clicking the THEN construct

completes the IF condition and allows you to provide the outcome for a successful condition.

Add a custom dimension
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Figure 58: Use the THEN construct
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After you click the THEN construct, you can either add a dimension (which will be treated as a value) or enter a plain
text value to provide a custom constant string as a value.

Add a custom dimension X

Global Cusiom Dirension

& Piew Custom Dimension

Dimensions THEM Flear &1
L

Course Tite + -

Courss Course 1D =+

Course Version +

Courss Available From + T H E N

Course Discontinised Fram + Drag & Drop or Click a Dimension to be treated as Value or Click on Plain

Courss CMPer + Text Input button to provide custom value

f:uursa Owmer's Croanizabion 4; =

NSINECES

an gather choose an sxisting
s00 OF enler a plain text valee

Cancel

Figure 59: Adding a dimension or text value

After you are done with the THEN construct, click the ELSE contruct to set the outcome for the failed condition or click
the END IF condition to complete the expression.
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Cardel

Figure 60: Use the ELSE construct

g~ Note: Atany point, if you wish to change it, you can click the delete icon to update value again.

After you click the ELSE construct, add a dimension (which will be treated as a value) or a plain text value. Alternatively,
click the IF construct to build one more IF condition (ELSE IF), thus creating IF...ELSE ...IF chain.
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Figure 61: Add a dimension or a new IF condition

Once you are done with building the expression, you click END IF which completes the entire expression.

Click Preview to take a look at what you've built.
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Figure 62: Click Preview
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After you click END IF, you
can préwew the composition

- Condition Preview
IF Course Tite Equal Brown Bag123 [ Course version Equal 12
THEN Course Tite
ELSE Course Vrsian
END IF

Figure 63: The actual preview
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After you've saved the custom dimension, the newly created dimension appears in the list of Dimensions. You can click
the edit icon, to edit the custom dimension sections or click Clear All to clear entire condition and start all over again.

Build a Flat List Report
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Figure 64: Edit dimension

Use case

This enhancement is useful in cases where the user wants a date value in the output based on the delivery_type.

Example:

IF

delivery_type = ILT
THEN

Session End Date

ELSE IF

delivery_type = WBT
THEN Session Start Date
ELSE

Module Completed Date
END IF
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Branding support by domain

How did it work?
Branding support by domain was not available.

How does it work now?

The Configure Domains button will now be available while configuring themes for individual report / dashboard and
updating a report definition.

o Note: The Configure Domains button will not be available for the global theme configuration under Settings.

Centification Summary by Status : Theme x

@ Edit Existing theme  Themel b Create Hew Theme

Sarve Cancel

Figure 65: Configuring theme for individual report/dashboard
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Cenification Summary by Status : Theme

Select theme o associate with Domain; Q,

Repor € Themet

£ Theme2

Select domains

Select themes

Saret Agsociabion Cancel

Click Configure Domain. This brings up a popup window that allows selecting a theme.

Using the dropdown you can select themes to associate with the domain of the report.

o Note:
For a particular theme you can select a maximum of 10 domains.(The default value is 5 which is configurable under

Analytics Settings).
For a report you can configure a maximum of 10 themes. (The default value is 5 which is configurable under
Analytics Settings).
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Figure 67: Configure the no. of domains and themes

For a report, while downloading the PDF, if the user security domain matches with any of the theme domain association
then that particular theme is applied for that PDF.

g~ Note: If no association is found then the default theme is applied. If the default theme does not exists, then no
theme is applied to the PDF. Domain hierarchy is not considered.

Figure 66: Updating report definition

Use case

Customers who use their Saba Cloud instance for their extended enterprise can benefit with a multi-branding possibility
and wins for their business with this feature.

Analytics to provide rich text support for extended custom fields

How did it work?

Extended custom fields in Analytics did not support rich text.

How does it work now?

This update enhances the extended custom fields in Analytics to support rich text.
Use case

There is a need to store HTML/rich text in extended custom fields.
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New Reports

User Distribution Report

How did it work?
This is a new report.
How does it work now?

This report provides information about the active and inactive users available in the system at the time of execution of
this report.

Ubsaer Distribution Report *x
Report Date: B4MT2016 11.88 P e m
¥ Fiilers P n Type |8 Mol Emply AND  Person Ubemame Mol In E WMMERCEADMIN
Select an appropriale charl secton bo accomdingly fiter the nepod data WESTEEE -
400
Iz
24 - AZtew Uses Counl
& Inactve User Count
& Head Count
indsanal & £
Porson Typs
alw

Soringorsar ~ Agtive User Count

Person Trpe Acthie Usar Coount Inactive User Comt Hiead Count
el 2 4 7
Enterral 132 1 133

Figure 68: User Distribution Report Example

Report Details

This section provides high-level details of the User Distribution Report report.
Filters

This report uses the following mandatory filters:

1. Person Type

Dimensions

This report uses the following dimensions:

1. Person Type
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Metrics
This report uses the following metrics:

1. Active User Count
2. Inactive User Count
3. Head Count

Use case

The Saba Adoption Metrics are now placed under the Adoption category. This report signifies usage and adoption metrics
by type and will be available for execution from within the Analytics module.

Login Report
How did it work?
This is a new report.

How does it work now?

This report provides indicates the total number of logins for a particular period along with a count of unique users.
This report needs the following services:

e System
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Figure 69: Login Report Example

Report Details

This section provides high-level details of the Login Report.

Filters
This report uses the following mandatory filters:

1. Is Terminated
2. Login Date within a defined range

Dimensions

This report uses the following dimensions:
1. Login Date

Metrics

This report uses the following metrics:

1. Total number of Logins

2. Unique Person Count

Use case
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The Saba Adoption Metrics are now placed under the Adoption category. This report signifies usage and adoption metrics
by type and will be available for execution from within the Analytics module.

Registration Report

How did it work?
This is a new report.
How does it work now?

This report provides the number of registrations for a particular period for both the internal and the external users along
with a count of unique users.

This report needs the following services:
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Figure 70: Registration Report Example

Report Details

This section provides high-level details of the Registration Report.
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Filters
This report uses the following mandatory filters:

1. Is Terminated
2. Registration Date within a defined range

Dimensions
This report uses the following dimensions:

1. Registration Date (Can be grouped monthly/yearly as required)
2. Person Type

Metrics
This report uses the following metrics:

1. Count of Registrations
2. Unique Person Count

Use case

The Saba Adoption Metrics are now placed under the Adoption category. This report signifies usage and adoption metrics
by type and will be available for execution from within the Analytics module.

Transcript Report

How did it work?
This is a new report.
How does it work now?

This report provides the total number of transcripts (completed learning) with the completion date for a particular period
along with a count of the unique users.

This report needs the following services:

* Learning
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Figure 71: Transcript Report Example

Report Details

This section provides high-level details of the Transcript Report.
Filters

This report uses the following mandatory filters:

1. Is Terminated

2. Completed Courses (Transcript) Status

3. Completion Status

4. Completed Courses (Transcript) Date Marked Complete within a defined range

Dimensions

This report uses the following dimensions:

1. Completed Courses (Transcript) Date Marked Complete (Can be grouped monthly/yearly as required)
Metrics

This report uses the following metrics:

1. Count of Completions
2. Unique Person Count



| Analytics | 285

Use case

The Saba Adoption Metrics are now placed under the Adoption category. This report signifies usage and adoption metrics
by type and will be available for execution from within the Analytics module.

Certification Gap Analysis by Role

How did it work?

There was no way to easily identify individual user's information in this report.

How does it work now?

An additional dimension called "Person username" is added to help identify the information easily.

Certification Gap Analysis by Role TR
Report Date: 15,00 2016 003 58 56 -l m

v Fiilers ! Y i A M

» Grouping options

Paersom Job Type Hama Manager Full Mame Paryon Full Hamse Person Hole Person Usemama I Regared Robs Cartilicabor

B JotType

= Us'er Five
S Usars Fred

= Rola2

oS Vg i Db

i U T

i 9dadad one upl -

Figure 72: Certification Gap Analysis by Role Report example

Report Details

This section provides high-level details of the Certification Gap Analysis by Role Report.
Filters

This report uses the following mandatory filters:

1. Include Manager Hierarchy (Default value: Yes)
2. Manager Hierarchy Full Name
3. Is Terminated (Default value: No)

Dimensions
This report uses the following dimensions:

1. Person Job Type Name
2. Manager Full Name
3. Person Full Name
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Person Role

Person Username

Is Required Role

Certification Name

Student Certification Status
Certification Completion Percentage

© ©® N O

Use case

In most cases, users will have more than 100 individual line items in their profile making it difficult to identify for which
user the record is linked to. This enhancement helps identifying the information easily.

Attendance and Result Summary by Class

How did it work?
The Attendance and Result Summary by Class only had one mandatory filter.
How does it work now?

This report now has some additional optional filters:

1. Registration Date (Range)
2. Scheduled Class Location
3. Person Organization Name

Use case

This enhancement helps specifying the scope of the search for course completion.

Learning

How did it work?
These are new attributes.
How does it work now?

This section describes the attributes that have been added under the Learning reports model in the Saba application.

Table 82: Learning Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Resource Assignments Instructor Type Dimen~ Type of Instructor e.g. Internal or
sion External
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Entity Name Attribute Name Attribute Description
Type
Resource Assignments Instructor Organization Type | Dimen~ Type Of Instructor's Organization
sion e.g. Internal or External
Assessment Results Assessment Content Format | Dimen~ Content Format for Assessment
sion Content
Learner Certification Details | Previous Learner Certifica~ | Dimen~ Status of Learner Certification pri~
tion Status sion or to current status
Learner Certification Details | Previous Learner Certifica~ | Dimen~ Latest Learner Certification Status
tion Status Updated by sion Updated By
Learner Certification Details | Previous Learner Certifica~ | Dimen~ Date on which last learner certific~
tion Status Updated On sion ation status was updated
Learner Curricula Details | Previous Learner Curricula | Dimen~ Status of Learner Curricula prior
Status sion to current status
Learner Curricula Details | Previous Learner Curricula | Dimen~ Latest Learner Curricula Status
Status Updated by sion Updated By
Learner Curricula Details | Previous Learner Curricula | Dimen~ Date on which last learner cur~
Status Updated On sion ricula status was updated
Resource Assignments Appointment Duration Dimen~ Duration of Resource Appointment
(Minutes) sion in Minutes
Resource Assignments Appointment Duration Metric Total Duration of Resource Ap~
(Minutes) pointments in Minutes
Module Details Content Last Attempt Date~ | Dimen~ Date and Time of Last attempt on
Time sion Content
Orders and Orderltems Order Contact Email Dimen~ Email of Person added as Order
sion Contact
Module Details Content Last Attempt Num-~ | Dimen~ Last Attempt Number for content

ber

sion
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Entity Name Attribute Name Attribute Description
Type
Certification Programs Certification Program Name | Dimen~ Name of Certification Program
sion

Certification Programs Certification Program Dimen~ Date from which Certification
Available From sion Program will be available

Certification Programs Certification Program Dis~ | Dimen~ Date from which certification pro~
continued From sion gram will be discontinued

Certification Programs Certification Program Lan~ | Dimen~ Language for Certification Pro~
guage sion gram

Certification Programs Certification Program Class | Dimen~ ID of the Class selected in Certific~
ID sion ation Program

Certification Programs Certification Program Class | Dimen~ Name of the Class selected in Cer~
Name sion tification Program

Certification Programs Certification Program Class | Dimen~ Start Date of the scheduled Class
Start Date sion selected in Certification Program

Certification Programs Certification Program Class | Dimen~ End Date of the Scheduled Class
End Date sion selected in Certification Program

Certification Programs Certification Program Class | Dimen~ Date of availability for the
Available From sion Selfpaced Class selected in Certi~

fication Program

Certification Programs Certification Program Class | Dimen~ Date of discontinuation for the

Discontinued From sion Selfpaced Class selected in Certi~
fication Program

Certification Programs Certification Program Class | Dimen~ Delivery Name of the Class selec~
Delivery Name sion ted in Certification Program

Certification Programs Certification Program Class | Dimen~ Maximum seats available for the
Max Seats sion scheduled class selected in Certific~

ation Program
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Entity Name Attribute Name Attribute Description
Type
Certification Programs Certification Program Class | Dimen~ Maximum seats Waitlisted for the
Waitlist Seats sion scheduled class selected in Certific~
ation Program
Certification Programs Certification Program Dimen~ ID of the Course Present in the
Course ID sion Certification Path used for Certific~
ation Program
Certification Programs Certification Program Class | Dimen~ Shows Yes if the Class is Mandat~
Is Mandatory sion ory and No if the class is Sugges~
ted
Certification Programs Certification Program Class | Dimen~ Date on which class added to Cer~
Created On sion tification Program was created
Certification Programs Certification Program Class | Dimen~ Date on which class added to Cer~
Updated On sion tification Program was last modi~
fied
Curricula Programs Curricula Program Name Dimen~ Name of Curricula Program
sion
Curricula Programs Curricula Program Available | Dimen~ Date from which Curricula Pro~
From sion gram will be available
Curricula Programs Curricula Program Discontin~ | Dimen~ Date from which Curricula pro~
ued From sion gram will be discontinued
Curricula Programs Curricula Program Language | Dimen~ Language for Curricula Program
sion
Curricula Programs Curricula Program Class ID | Dimen~ ID of the Class selected in Cur~
sion ricula Program
Curricula Programs Curricula Program Class Dimen~ Name of the Class selected in Cur~
Name sion ricula Program
Curricula Programs Curricula Program Class Dimen~ Start Date of the scheduled Class
Start Date sion selected in Curricula Program
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Curricula Programs Curricula Program Class End | Dimen~ End Date of the Scheduled Class
Date sion selected in Curricula Program
Curricula Programs Curricula Program Class Dimen~ Date of availability for the
Available From sion Selfpaced Class selected in Cur~

ricula Program

Curricula Programs Curricula Program Class Dimen~ Date of discontinuation for the
Discontinued From sion Selfpaced Class selected in Cur~
ricula Program

Curricula Programs Curricula Program Class Dimen~ Delivery Name of the Class selec~
Delivery Name sion ted in Curricula Program

Curricula Programs Curricula Program Class Dimen~ Maximum seats available for the
Max Seats sion scheduled class selected in Cur~

ricula Program

Curricula Programs Curricula Program Class Dimen~ Maximum seats Waitlisted for the
Waitlist Seats sion scheduled class selected in Cur~
ricula Program

Curricula Programs Curricula Program Course | Dimen~ ID of the Course Present in the
ID sion Curricula Path used for Curricula
Program
Curricula Programs Curricula Program Class Is | Dimen~ Shows Yes if the Class is Mandat~
Mandatory sion ory and No if the class is Sugges~
ted
Curricula Programs Curricula Program Class Dimen~ Date on which class added to Cur~
Created On sion ricula Program was created
Curricula Programs Curricula Program Class Dimen~ Date on which class added to Cur~
Updated On sion ricula Program was last modified
Registration Attendance Session Start Dimen~ Start Date and Time of Attendance

Date Time sion Session
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Entity Name Attribute Name Attribute Description
Type
Reqgistration Attendance Session End Dimen~ End Date and Time of Attendance
Date Time sion Session
Orders and Orderltems Order Ship To Address1 Dimen~ Address1 of Order Shipping Ad~
sion dress
Orders and Orderltems Order Ship To Address2 Dimen~ Address2 of Order Shipping Ad~
sion dress
Orders and Orderltems Order Ship To City Dimen~ Order Shipping Address City
sion
Orders and Orderltems Order Ship To State Dimen~ Order Shipping Address State
sion
Orders and Orderltems Order Ship To Country Dimen~ Order Shipping Address Country
sion
Orders and Orderltems Order Ship To Zip / Pin Dimen~ Order Shipping Address ZIP / PIN
sion
Assessment Question Details | Assessment Topic Name Dimen~ Name of the Assessment Topic
sion
Assessment Question Details | Assessment Topic Passing | Dimen~ Shows Yes if the passing is re~
Required sion quired for the topic
Assessment Question Details | Assessment Topic Passing | Dimen~ Minimum score required to com~
Score sion plete Assessment
Assessment Question Details | Assessment Topic Question | Metric
Count
Assessment Question Details | Assessment Test Question | Metric
Count
Curricula Details Curricula Added to Role Dimen~ Description of Role to which Cur~
Description sion riculum was added
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Entity Name Attribute Name Attribute Description
Type
Curricula Details Curricula Learning Item Is | Dimen~ Shows Yes if the Approval Policy
Approval Required sion on Course in Curricula is set to
Approval Required for Registration
else shows No
Courses Show Recurring Course Filter This is to be used as a filter only.
History If not pulled in report or set to 'No',
then the report will not show the
history data for the recurring
courses. When set to "Yes', the re~
port shows the history data for the
recurring course.
Courses Course Owner Username Dimen~ Username of the Course Owner
sion
Courses Is Re-Acquisition Required | Dimen~ Shows Yes if the Completed Recur~
sion ring Course requires Re-acquisition
Courses Course Assigned By (All Dimen~ Course Assigned By (All Sources)
Sources) sion
Courses Course Assigned By (All Dimen~ Course Assigned By (All Sources)
Sources) Source Type sion Source Type
Courses Course Audience Type Cus~ | Dimen~ CustomO field of Audience Type
tomO sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Customl field of Audience Type
tom1 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Customz2 field of Audience Type
tom2 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Customa3 field of Audience Type
tom3 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Custom4 field of Audience Type
tom4 sion Associated with Course
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Entity Name Attribute Name Attribute Description
Type
Courses Course Audience Type Cus~ | Dimen~ Customb field of Audience Type
tom5 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Customé field of Audience Type
tom6 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Custom?7 field of Audience Type
tom?7 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Custom8 field of Audience Type
tom8 sion Associated with Course
Courses Course Audience Type Cus~ | Dimen~ Custom9 field of Audience Type
tom9 sion Associated with Course
Courses Course Price List Amount | Dimen~ Course Price Amount added to
sion Course Price List for given cur~
rency
Courses Course Price List Audience |Dimen~ Audience Type for Course Price
Type sion List
Courses Course Price List Available | Dimen~ Date from which the Price List at~
From sion tached to Course is available
Courses Course Price List Currency |Dimen~ Currency for which Course Price
sion was added to Course Price List
Courses Course Price List Discontin~ | Dimen~ Date from which the price list at~
ued From sion tached to course will be discontin~
ued
Courses Course Price List Name Dimen~ Name of Price list attached to
sion Course
Classes Catalog Class Owner Domain Dimen~ Domain of Class Owner for
sion Classes Catalog
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Content Details Content Owner Domain Dimen~ Domain of Content Owner
sion
Content Details Catalog Content Owner Domain Dimen~ Domain of Content Owner for
sion Content Details Catalog
Certification Details Is Role Required for Job Dimen~ Is Role Required for Job
sion
Certification Details Certification Added To Role | Dimen~ Description of Role to which certi~
Description sion fication was added
Certification Details Certification Learning Item | Dimen~ Shows Yes if the Approval Policy
Is Approval Required sion on Course in Certification is set to

Approval Required for Registration
else shows No

Certification Details Is Recertification Path Dimen~ Shows Yes if the current path is
sion marked as recertification path
Classes Class Notes Category Dimen~ Category of Notes added to Class
sion
Classes Class Price List Amount Dimen~ Class Price Amount added to Class
sion Price List for given currency
Classes Class Price List Audience | Dimen~ Audience Type for Class Price List
Type sion
Classes Class Price List Available | Dimen~ Date from which the Price List at~
From sion tached to Class is available
Classes Class Price List Currency | Dimen~ Currency for which Class Price
sion was added to Class Price List
Classes Class Price List Discontin~ | Dimen~ Date from which the price list at~
ued From sion tached to Class will be discontin~

ued
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Entity Name Attribute Name Attribute Description
Type
Classes Class Price List Name Dimen~ Name of Price list attached to Class
sion
Classes Is Class Price Inherited from | Dimen~ Shows Yes if the Price defined in
Course sion Class is inherited from Course else
shows No
Classes Is Overridden Price Dimen~ Shows Yes if class price is overrid~
sion den from course price
Classes Class Owner Domain Dimen~ Domain of Class Owner
sion
Classes Class Notes Added On Dimen~ Date on which Notes were added
sion to the Class
Classes Class Notes Added By Dimen~ Full name of the person who added
sion notes to class
Learner Certification Details | Certification Learning Item | Dimen~ Date on which the Course was re~
Registration Date sion gisterd for given Certification
Learner Curricula Details | Curricula Learning Item Re~ | Dimen~ Date on which the Course was re~
gistration Date sion gisterd for given Curricula
Learning Request Learning Request Notes Dimen~ Category of Notes Added to
Category sion Learning Request
Learning Request Learning Request Notes Dimen~ Username of the person who added
Created By sion note to Learning Request
Learning Request Learning Request Notes Dimen~ Date on which note was added to
Created On sion learning request
Transcript Is Latest Course Completion | Dimen~ This is to be used as a filter. A
sion person can have more than one

transcripts for the same course.

This filter is to added to the report
and when it is set to Yes, the report
shows only the latest completions.
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Entity Name Attribute Name Attribute | Dashboard | Description
Type

Similarly, it can be used to elimin~
ate the latest completion or just

used as a dimension to identify the
latest completion. When this filter
is set to Yes, only the complete

transcripts will be reported, the In
progress ones will not be reported.

e Note: 'Is Latest Course
Completion' filter can be
used to identify latest comple~
tion for recurring course. Re~
port output will be governed
by above both filter logic
combined together.

g Note: Any incomplete tran~
script which has completion
date as NULL will be ig~
nored. Latest completion will
show only the completed
transcripts.

Orders and Orderltems Payment Amount Currency | Dimen~ Currency Name for Payment
sion Amount

Orders and Orderltems Subscription Order Item Dimen~ Currency Name for Subscription

Currency sion Order Item

Orders and Orderltems Order Discount Currency | Dimen~ Currency Name for Order Discount
sion

Orders and Orderltems Order Item Notes Category |Dimen~ Category of Notes added to Order
sion Item

Orders and Orderltems Order Notes Category Dimen~ Category of Notes added to Order
sion

Orders and Orderltems Order Notes Added On Dimen~ Date on which Notes were added
sion to the Order

Orders and Orderltems Order Notes Added By Dimen~ Full name of the person who added

sion notes to order
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Orders and Orderltems Order Item Notes Added On | Dimen~ Date on which Notes were added
sion to the orderitem
Orders and Orderltems Order Item Notes Added By | Dimen~ Full name of the person who added
sion notes to orderitem
Registration Instructor Notes Added By |Dimen~ Username of the person who added
sion notes to registration
Registration Instructor Notes Added On | Dimen~ Date on which note was added to
sion registration
Registration Instructor Notes Category | Dimen~ Category of Notes added by In~
sion structor to Registration
Resource Assignment Appointment Notes Added | Dimen~ Username of the person who added
By sion note to Appoinment
Resource Assignment Appointment Notes Added | Dimen~ Date on which Notes were added
On sion to Appointment
Transcript Transcript Notes Category | Dimen~ Category of Notes added to Tran~
sion script
Use case

Previously, only one source of assignment was shown in the "Course Assigned By" dimension. With this enhancement,
it is possible to list the multiple sources for the same course assigned to the learner. For customers with regulatory audits,
this will fulfill a major reporting requirement.

Analytics

How did it work?
These are new attributes.
How does it work now?

This section describes the attributes that have been added under the Analytics reports model in the Saba application.
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Table 83: Analytics Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Reports Report Updated On Dimen~ Date on which Report definition
sion was last updated

Reports Subscription Created On Dimen~ Date on which Report Subscription
sion was created

Reports Subscription Updated On | Dimen~ Date on which Report Subscription
sion was last updated

Use case

N/A

Performance

How did it work?

These are new attributes.

How does it work now?

This section describes the attributes that have been added under the Performance reports model in the Saba application.

Table 84: Performance Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type
Goals Is Archived Goal Dimen~ Shows Yes if the Goal has been
sion Archived and No if its not.
Review Details Review Owner Person Dimen~ Person Number for Review Owner
Number sion
Review Cycle Audit Details | Review Cycle Audit Com~ | Dimen~ Component name linked to Review
ponent sion Cycle Audit Trails
Review Cycle Audit Details | Review Cycle Audit Descrip~ | Dimen~ Audit Action Description for Re~
tion sion view Cycle
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Entity Name Attribute Name Attribute Description
Type
Review Cycle Audit Details | Review Cycle Audit Attrib~ | Dimen~ Review Cycle Attribute name for
ute sion which data was audited
Review Cycle Audit Details | Review Cycle Audit Old Dimen~ Old value of Review Cycle Attrib~
Value sion ute
Review Cycle Audit Details | Review Cycle Audit New | Dimen~ New Value of Review Cycle Attrib~
Value sion ute
Review Cycle Audit Details | Review Cycle Audit Created | Dimen~ Full name of user who modified
By (Fullname) sion the Review Cycle Attribute Value
Review Cycle Audit Details | Review Cycle Audit Created | Dimen~ Username of the user who modi~
By (Username) sion fied the Review Cycle Attribute
Value
Review Cycle Audit Details | Review Cycle Audit Created | Dimen~ Date on which Review Cycle At~
On sion tribute value was modified
Review Cycle Audit Details | Review Cycle Audit Reason | Dimen~ Reason for which Review Cycle
sion Audit data was added
Review Cycle Audit Details | Review Cycle Audit Proxy | Dimen~ Full name of the Proxy User who
Full Name sion added Audit data for Review Cycle
Review Cycle Audit Details | Review Cycle Audit Proxy | Dimen~ Username of the Proxy User who
Username sion added Audit data for Review Cycle
Review Cycle Audit Details | Review Cycle Audited On | Dimen~ Date and Time of the Audit cre~
(MM/DD/YYYY sion ation for Review Cycle
HH:MI:SS)
Review Audit Details Review Audit Component | Dimen~ Component name linked to Review
sion Audit Trails
Review Audit Details Review Audit Description | Dimen~ Audit Action Description for Re~

sion

view




| Analytics | 300

Entity Name Attribute Name Attribute | Dashboard | Description
Type
Review Audit Details Review Audit Attribute Dimen~ Review Attribute name for which
sion data was audited
Review Audit Details Review Audit Old Value Dimen~ Old value of Review Attribute
sion
Review Audit Details Review Audit New Value Dimen~ New Value of Review Attribute
sion
Review Audit Details Review Audit Created By | Dimen~ Full name of user who modified
(Fullname) sion the Review Attribute Value
Review Audit Details Review Audit Created By | Dimen~ Username of the user who modi~
(Username) sion fied the Review Attribute Value
Review Audit Details Review Audit Created On | Dimen~ Date on which Review Attribute
sion value was modified
Review Audit Details Review Audit Reason Dimen~ Reason for which Review Audit
sion data was added
Review Audit Details Review Audit Proxy Full Dimen~ Full name of the Proxy User who
Name sion added Audit data for Review
Review Audit Details Review Audit Proxy User~ | Dimen~ Username of the Proxy User who
name sion added Audit data for Review
Review Audit Details Review Audited On Dimen~ Date and Time of the Audit cre~
(MM/DD/YYYY sion ation for Review
HH:MI:SS)
Use case

Enables the performance admin to track all changes to Overall Rating score within a Cycle. It will help understand who
changed the rating and why.

System

How did it work?



These are new attributes.

How does it work now?
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This section describes the attributes that have been added under the System reports model in the Saba application.

Table 85: System Details

sion

Entity Name Attribute Name Attribute Description
Type

Prescription Rule Prescriptive Rule Updated | Dimen~ Date on which Prescription Rule

On sion was last updated
Prescription Rule Prescriptive Rule Updated | Dimen~ Date on which Prescription Rule
On sion was last updated

Prescription Rule Prescriptive Rule CustomO | Dimen~ CustomoO field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom1 | Dimen~ Custom field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom2 | Dimen~ Custom?2 field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom3 | Dimen~ Customa3 field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom4 | Dimen~ Custom4 field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom5 | Dimen~ Customb5 field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom6 | Dimen~ Custom6 field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom?7 | Dimen~ Custom? field of Prescriptive Rule
sion

Prescription Rule Prescriptive Rule Custom8 | Dimen~ Custom8 field of Prescriptive Rule
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Prescription Rule Prescriptive Rule Custom9 | Dimen~ Custom9 field of Prescriptive Rule
sion
Use case
N/A
Social

How did it work?

These are new attributes.

How does it work now?

This section describes the attributes that have been added under the Social reports model in the Saba application.

Table 86: Social Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Groups Group Folder Name Dimen~ Group Folder Name
sion

Groups Group Folder Description | Dimen~ Group Folder Description
sion

Groups Group Parent Folder Name | Dimen~ Group Parent Folder Name
sion

Groups Is Featured Folder Dimen~ Is Featured Folder
sion

Groups Group Folder Owner Dimen~ Group Folder Owner
sion

Groups Group Folder Created On | Dimen~ Group Folder Created On
sion

Groups Group Folder Updated On | Dimen~ Group Folder Updated On
sion
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Groups Group Folder Resource Type | Dimen~ Group Folder Resource Type
sion
Groups Group Folder Resource Title | Dimen~ Group Folder Resource Title
sion
Groups Group Folder Resource Dimen~ Group Folder Resource Owner
Owner sion
Groups Group Folder Resource Cre~ | Dimen~ Group Folder Resource Created On
ated On sion
Groups Group Folder Resource Up~ | Dimen~ Group Folder Resource Updated
dated On sion On
Groups Group Folder Resource Metric Group Folder Resource Count
Count
Use case
N/A
Saba Pulse

How did it work?

These are new attributes.

How does it work now?

This section describes the attributes that have been added under the Saba Pulse reports model in the Saba application.

= Note: The information for the Job Name, Country, Organization Name and Location Name attributes are
recorded at the time when the sentiments feedback is recorded. These attributes do not show the current data as
seen on the person profile.

Table 87: Saba Pulse Details

sion

Entity Name Attribute Name Attribute | Dashboard | Description
Type
Saba Pulse Details Saba Pulse Category Dimen~ | Available |Saba Pulse Category
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Saba Pulse Details Location Number Dimen~ | Awvailable |Location Number
sion
Saba Pulse Details Location Name Dimen~ | Available |Location Name
sion
Saba Pulse Details Organization Number Dimen~ [ Available |Organization Number
sion
Saba Pulse Details Organization Name Dimen~ | Available |Organization Name
sion
Saba Pulse Details Manager Person Number | Dimen~ | Available | Manager Person Number
sion
Saba Pulse Details Manager Username Dimen~ | Available | Manager Username
sion
Saba Pulse Details Manager Full Name Dimen~ | Awvailable | Manager Full Name
sion
Saba Pulse Details Job Name Dimen~ | Available |Job Name
sion
Saba Pulse Details Country Dimen~ | Available | Country
sion
Saba Pulse Details Created On Dimen~ | Available |Created On
sion
Saba Pulse Details Updated On Dimen~ | Available |Updated On
sion
Saba Pulse Details Percentage of people respon~ | Metric Available | Average Percentage of people re~
ded Happy sponded Happy
Saba Pulse Details Percentage of people respon~ | Metric Available | AveragePercentage of people re~

ded Sad

sponded Sad
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Entity Name Attribute Name Attribute | Dashboard | Description
Type
Saba Pulse Details Percentage of people respon~ | Metric Available | AveragePercentage of people re~
ded Neutral sponded Neutral
Saba Pulse Details Saba Pulse Score Metric Available | Average Saba Pulse Score

Use case

N/A

Profile

How did it work?
These are new attributes.

How does it work now?

This section describes the attributes that have been added under the Profile reports model in the Saba application.

Table 88: Profile Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Person Details Person Audience Type Cus~ | Dimen~ CustomO field of Audience Type
tomO sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ CustomL field of Audience Type
tom1 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Customz2 field of Audience Type
tom2 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Customa3 field of Audience Type
tom3 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Custom4 field of Audience Type
tom4 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Custom5 field of Audience Type
tom5 sion Associated with Person




| Analytics | 306

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Person Details Person Audience Type Cus~ | Dimen~ Customé field of Audience Type
tom6 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Custom?7 field of Audience Type
tom7 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Customs field of Audience Type
tom8 sion Associated with Person

Person Details Person Audience Type Cus~ | Dimen~ Custom9 field of Audience Type
tom9 sion Associated with Person

Person Details Active User Count Metric Available | Count of active users

Person Details Inactive User Count Metric Available | Count of inactive users

Use case

The Saba Adoption Metrics are now placed under the Adoption category.

Recruiting

How did it work?

These are new attributes.

How does it work now?

This section describes the attributes that have been added under the Recruiting reports model in the Saba application.

Table 89: Recruiting Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Candidate Details Candidate Type Dimen~ Type of Candidate e.g. Internal or
sion External

Job Requisition Details Job Requisition URL Dimen~ URL for Job Requisition
sion

Use case
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This enhancement solves multiple uses cases where the candidates can be redirected to the job requisition on company's
career site from other job boards / web pages / job exchanges (government) and any other media.

To Do List

How did it work?
These are new attributes.

How does it work now?

This section describes the attributes that have been added under the To Do List reports model in the Saba application.

Table 90: To Do List Details

Entity Name Attribute Name Attribute Description
Type
Use case
N/A
Learning

How did it work?

The following attributes have been updated:

e Is Mandatory Question

How does it work now?

This section describes the attributes that have been updated under the Learning reports model in the Saba application.

Table 91: Learning Details

Entity Name Attribute Name Attribute Description
Type

Assessment Question Details | Is Mandatory Question Dimen~ Returns Yes if the question marked
sion as mandatory else No

Use case
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N/A

Profile

How did it work?

The following attributes have been updated:

« Potential Positions Potential Job
» Potential Positions Readiness

How does it work now?

This section describes the attributes that have been updated under the Profile reports model in the Saba application.

Table 92: Profile Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Potential Jobs Potential Job Readiness Dimen~ | Available |Potential Job Readiness
sion

Potential Jobs Potential Job Potential Job | Dimen~ . Potential Job
sion Available

The following attributes are no longer available for reporting:
» Pay Range Midpoint
g~ Note: The existing reports using this attribute are also updated to remove it from the report design.

Use case

N/A

Talent

How did it work?
The following attributes have been updated.

Table 93: Talent Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Career Path Current Position Dimen~ | Available | Application number of the candid~
sion ate

How does it work now?
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This section describes the attributes that have been updated under the Talent reports model in the Saba application.

Table 94: Talent Details

Entity Name Attribute Name Attribute | Dashboard | Description
Type

Career Path Current Job Dimen~ | Awvailable | Application number of the candid~
sion ate

Use case

N/A

Additional attributes to support dropdown (LOV)

How did it work?
N/A
How does it work now?

The following is a list of attributes that now support dropdown (LOV).
g~ Note: The LOV /PICKER column indicates if the attribute supports a dropdown (LOV) or a search (Picker).

Table 95: Attributes Details

Parent Entity Name Entity Name Attribute Name LOV/PICKER
Profile Person Job Type Person Job Type CustomOto | LOV

Person Job Type Custom9
Profile Person Manager Manager CustomO to Man~ | LOV

ager Custom9

Profile Person Location Person Location CustomO to | LOV
Person Location Custom9

Learning Curricula Details Curriculum CustomO to LoV
Curriculum Custom9

Learning Certification Details Certification CustomO to LoV
Certification Custom9

Performance Review Details Review CustomO to Review | LOV
Custom9
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Parent Entity Name Entity Name Attribute Name LOV/PICKER

Performance Review Cycle Details Review Cycle CustomOto |LOV
Review Cycle Custom9

Profile Skills Skill Custom0 to Skill Cus~ | LOV
tom9

Performance Goals Goals Custom0O to Goals LoV
Custom9

Learning Courses Course Custom0 to Course |LOV
Custom14

Learning Courses Prerequisite Course Custom0 | LOV
to Prerequisite Course Cus~
tom14

Learning Classes scheduled Class Location | LOV
Customo0 to scheduled Class
Location Custom9

Learning Registrations Registrations CustomOto |LOV
Registrations Custom9

Learning Orders and Orderltems Order CustomO to Order LoV
Custom9

Learning Orders and Orderltems Subscription Order Custom0 | LOV
to Subscription Order Cus~
tom9

Learning Orders and Orderltems Subscription CustomO to LoV
Subscription Custom9

Learning Orders and Orderltems Training Unit Agreement | LOV
Custom0 to Training Unit
Agreement Custom9

Learning Orders and Orderltems Training Unit CustomOto | LOV

Training Unit Custom9
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Parent Entity Name Entity Name Attribute Name LOV/PICKER

Learning Learning Request Learning Request CustomO | LOV
to Learning Requestion Cus~
tom9

Learning Courses Catalog Course Custom0O to Course | LOV
Custom14

Learning Resource Assignment Instructor CustomO to In~ |LOV
structor Custom9

Learning Resource Assignment Instructor Location Custom0O | LOV
to Instructor Location Cus~
tom9

Learning Resource Assignment Room Location CustomO to | LOV
Room Location Custom9

Learning Resource Assignment Room CustomO to Room LOV
Custom9

Learning Resource Assignment Instructor Organization Cus~ | LOV
tomo0 to Instructor Organiza~
tion Custom9

Learning Content Details Content Inventory Custom0 | LOV
to Content Inventory Cus~
tom9

Learning Content Details Catalog Content Inventory Custom0 | LOV
to Content Inventory Cus~
tom9

Recruiting Candidate Details Candidate CustomO to Can~ | LOV
didate Custom9

Recruiting Job Requisition Details Job Requisition Custom0O to | LOV
Job Requisition Custom9

Recruiting Job Offer Job Offering CustomO to Job | LOV

Offer Custom9
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Parent Entity Name Entity Name Attribute Name LOV/PICKER
Learning Checklist Details Checklist Custom0 to LoV
Checklist Custom9
System Prescription Rules Prescriptive Rule Custom0 |LOV
to Prescriptive Rule Cus~
tom9
Use case
N/A

Change in the behaviour of the metric Unique Person Count

How did it work?

The metric Unique Person Count was calculated as a SUM.

How does it work now?

The metric Unique Person Count is now calculated as a count to provide a distinct count of People in report.

e Note: This metric will not be available for crosstab chart and stack bar charts.

Use case

N/A
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Search enhancements for test and survey assessments

How did it work?

The Question ID for questions was not displayed in search results of questions in Saba assessments. Resultantly,
identifying the correct question among questions with same title text was difficult without the Question ID.

How does it work now?

With this update, the search results for questions in various areas of Saba assessments displays the Question ID column.
Assessment administrators can add or remove the column using the new ability to add or remove columns in search
results table.

The following areas of Saba assessments now show the Question ID column by default:

e Learning > Manage Assessment > Manage Test & Survey Edit a test/survey in Draft state > Topics & Questions
> Manage Questions > Actions > Search & Add

« Learning > Manage Assessment > Manage Test & Survey Version a test/survey in Published state > Topics &
Questions > Manage Questions > Actions > Search & Add

The Question ID column must be manually added to the results table for the following areas:

e Learning > Manage Assessment > Test Question Pool
« Learning > Manage Assessment > Survey Question Pool

To add or remove a column:

1. Navigate to any of the above areas where the search results table for questions is displayed.
Click the dropdown arrow icon besides any column title.

Click the Columns menu. A list of all available columns names appears.

Select or clear the checkbox for the required column to show or hide the column respectively.

Hw
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| Mew Question - | | Actions -

[ Question Type Author Version Status Actions
Sort Ascendi
] Multiple currency Haot Spaot Iser Cne 1 Published E—
Sort Descending
[C] Multiple-Hotspot - Click on the name: Hot Spot ser One 1 Question : - ¥
Type
[] Earthis the only planet with a single | True/False User Cne e | ctions - |
¥l | Version
[C] Which of these planets have aring sy All That Apply ser One Id | ctions - |
Status
] Whatis the the smallest planetin Sal Multiple Choice ( User One e | Actions - |
B QuestionID
] Click on the pencil. Hot Spot User One | T | Actions - |

Figure 73: New Question ID column

o Note:

» This enhancement is available for both, Learning and Recruitment assessments.
e This enhancement is not supported in inline authoring, though.
» Ifaquestion does not have a Question ID, then a blank is displayed in the column for that question.

Use case

Since there can be multiple questions with the same title text, assessment administrators, who manage thousands of
questions, have to heavily rely on the unique Question ID to identify the questions that they need for creating assessments.

Support for multiple questions per page in assessment player

How did it work?
The Saba assessment player did not support the display of multiple questions per page.
How does it work now?

With this update, Saba Cloud allows assessment administrators to configure a test or survey assessment such that the
assessment supports the display of multiple questions per page of the Saba assessment player.

Assessment administrators can configure the following new properties for both test or survey assessments:
» Multiple Questions Per Page
If set to Yes, then the assessment displays multiple questions per page of the Saba assessment player.
For tests:

« If the question order is set to Random or In-order, then it displays "n" humber of questions per page where "n"
is defined by Questions Per Page property.

« If the question order is set to Topic, then it displays "n" number of questions per page based on each topic. For
example, if Topic 1 has 15 questions and Topic 2 has 20 questions and Questions Per Page property is set to
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10, then it displays 10 Questions of Topic 1 on Page 1, remaining 5 questions of Topic 1 on Page 2, 10 questions
of Topic 2 on Page 3, and remaining 10 questions of Topic 2 on Page 4.

For surveys, it displays "n™ number of questions per page where "n" is defined by Questions Per Page property.

If set to Yes, then the Previous button on the assessment player honors the Allow Navigation property value. If the
Allow Navigation property is set to "true" for the test, then the Previous button is displayed on the player, otherwise
not.

If set to No, then the assessment displays on one question per page of the Saba assessment player.
By default, this property is set to No.
e Questions Per Page

This property is a number field, with a range of 2 to 25. This property is enabled only when the Multiple Questions
Per Page property is set to Yes.

These properties are available for both tests and survey assessments in Learning and Recruitment areas.

Player Controls

Allow Review: W| () Hide Answers in Review: |Em ()
Show Scorecard: m| Break down by Topic: m|
ll\)ﬂ:;l;\ci};?le Questions Per m| i ] Questions Per Page: 2 =l i ]
Figure 74: Multiple questions per page property in a Test
i ]

Multiple Questions Per Page: m| o Questions Per Page: 2

<
@

Figure 75: Multiple questions per page property in a Survey
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Sample Test

User One Cuestions 1-10al12

1. Is the Earth the only planet with a single mogn?
s

Mo

2. Is Novotel restaurant good?
Yed

Mo

4. Which planet has the most moons?

Meplung
3
e =3
10 2016 Saba Sofware, Int. All rights resened powered by

! saba Cloud

Figure 76: Multiple questions per page in assessment player

Limitations for Tests

« If the Multiple Questions Per Page property is enabled for a test assessment, then the following properties are not
supported for that assessment:

e Time Limit for Per Question
e Show Question List

» If the Multiple Questions Per Page property is enabled for a test, then any media attachments on questions in the
test are not available during the test launch.
» The new properties are not available during inline authoring of tests in both Learning and Recruitment areas.

« The assessment cannot contain Hotspot type questions if these properties are enabled for the assessment. If you have
added such question in an assessment and then set this property, then Saba Cloud displays a conflict message
prompting you to remove the Hotspot questions.

Use case

Learners need not scroll through multiple pages to answer every question in the assessment. Instead, they need to see
multiple question in a single page and save time.

Support to handle abrupt closure of an assessment

How did it work?

Saba Cloud did not support learners to resume a test or survey assessment if it was suspended or closed abruptly.

How does it work now?
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With this update, Saba Cloud provides support to resume a test or survey assessment from the last answered question
if the assessment was suspended or closed abruptly.

When a learner resumes such a test assessment, then the following message prompt is displayed:

"Your previous attempt of thistest had ended abruptly. However, all previously submitted responses and comments were
saved. The test will resume from the last answered question of your previous attempt.”

When a learner resumes such a survey assessment, then the following message prompt is displayed:

"Your previous attempt of this survey had ended abruptly. However, all previously submitted responses and comments
were saved. The survey will resume from the last answered question of your previous attempt.”

Limitation

Any data related to time limit and answered question is not saved if the Next or Finish button is not clicked before the
abrupt closure of an assessment.

Use case

A user attempts a test with several number of questions and completes a substantial number out of those questions.
However, if the test ends or closes abruptly due to unforseen reasons such as a sudden system shutdown or lost connection,
then all the answered data of the user is lost and the user has to start afresh from the first question. Instead, the test needs
to resume from the last answered question so that the user's time and efforts are saved.

Hide correct answers while reviewing a test

How did it work?
If the test feedback was enabled, then learners were able to see correct answers while reviewing their test.
How does it work now?

With this update, Saba Cloud allows administrators to configure whether to show or hide correct answers to learners
while reviewing their test by introducing the following new test property:

* Hide Answers in Review
Possible values: Yes or No
Default value: No

If this property is set to Yes, then correct answers/choices are not displayed against questions in the Review Mode.
When set to Yes, the following statuses of the question are displayed next to the Question Text:

e Correct
e Incorrect
« Partially Correct
¢ Neutral
e Skipped

* Not Evaluated

Note: For Essay type questions with weight greater than zero, it always shows the status as Not Evaluated. If
the weight is zero, then the status shown is Neutral.
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Player Controls

Allow Review: ﬁ Never | @ Hide Answers in Review: "’99. (] |

Show Scorecard: No Break down by Topic: No

Multiple Questions Per veshTR

Page: "S L] 1]

Figure 77: Hide Answers in Review property

This property is also available in the Playmode Template with the same default values.

o Note: This new property is applicable only to test assessments in Learning.

Use case

There is a need to hide the correct answer with the feedback so that students are forced to review a test and learn.

Enhancements to the Manage Test & Survey page

How did it work?

The Manage Test & Survey page did not support pagination. Resultantly, all test and survey assessments in a folder
were listed on a single page and the page would take time to load when a folder contained a large number of tests and
surveys. The Advanced Search option on this page did not provide the option to search by a test ID or a survey ID.

How does it work now?

This update enhances the Manage Test & Survey page for assessments by adding pagination support and an improved
search capability.

Pagination Support

Now, on clicking a folder in the assessment library, the page displays a list of tests and surveys in a paginated format.
By default, the pages displays a minimum of 10 items per page if there are 10 or more items in a folder. Administrators
can customize the number of items they want to see in a page by selecting a value from the Items Per Page dropdown
list.

Additionally, the pagination feature provides the following capabilities:

« Navigation - Previous Page, Next Page, First Page and Last Page buttons

» Custom navigation to any page using the Page text field

« Refresh button to refresh the records on the page

« Total records count along with number of records displayed on the current page

Note: The pagination support is also added to the search (simple or advanced) results displayed on the Manage
Test & Survey page.
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Test Name « Type Version Status Author Updated On Actions
[ 10MinTest Test 2 Fublished Sachin Malil 08-FEB-2016 Actions ~
[ 28dan Test 1 Published user one 28-JAN-2016 Actions -
[[] EssayCne Test 2 Draft Sachin Maliu 10-MAR-20_ .. Actions -
[[] PublishTestZMin Test 1 Draft Sachin Maliu 19-FEB-2016 Actions -
[[] RegKejulMin Test 1 Draft Sachin Malil 17-FEB-2016 Actions -
] sPc-52543 Test 1 Published Charles Foster  18-JAN-2016 Actions -
Page |1 of 3 | b || M| | ltems Per Page: 0 | Displaying 1 - 10 of 22

Figure 78: Pagination support for Manage Test & Survey page

New Search Field
This update also adds the following new search field to the Advanced Search:

e Testor Survey ID

Specify a test ID or a survey ID as the search criteria. Saba Cloud performs an exact match for the specified ID and
returns results accordingly. This field supports the use of % as a wild card character.

Test/Survey Title: Flaymode Template: w

Test'Survey 1D: 0
Figure 79: New Search Field

Use case

There is a need to support pagination on the Manage Test & Survey page to enhance usability and avoid delays while
loading the page.

Persistent display of source language text for question translation

How did it work?

Saba Cloud did not persistently display the text for the source language for reference during translation on the Add/Edit
Translation page. It only displayed the source language text for a field as a mouse-over tip and this tip disappeared
after the set time interval.

How does it work now?
This update enhances the Add/Edit Translation page such that the text for the source language is displayed as a static

element below the respective editable fields for reference during translation. The mouse-over tooltip for the source
language text is retained as well.



Add/Edit Translation

Translation available for: o English

Language™: French
Question Type: Yes/No

Question™:

Do you like ice-cream?

Answers:

Yes

H

(]

General
Feedback:

Ice-cream must be eaten frozen!

| Save & Exit || Save & Add Translation || Add New || Cancel |

Figure 80: Changes to the question translation Ul

Use case
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It is helpful for administrators to persistently see the text for the source language as a reference during question translation.

Display topic and section headers in assessments

How did it work?

Tests and surveys in Saba assessments did not display topic headers and section headers respectively to learners.

How does it work now?

This update provides assessment administrators the ability to configure the display of topic headers and section headers

in tests and surveys respectively.

They can configure the following new properties to show or hide topic/section headers:



Table 96: Show or hide topic/section headers
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ers

If set to Yes, then Saba Cloud displays the section name
for survey questions in the assessment player. If set to No,
then no section name is not displayed.

Assessment Property Name Description Default
Type Value
E:S/IZ It?slmode Show Topic Headers If set to Yes, then Saba Cloud displays the topic name for No
P test questions in the assessment player. If set to No, then
no topic name is not displayed.
Surveys Show Section Head~ No

Player Controls
Allow Review:

Show Scorecard:

Multiple Questions Per
Page:

% - T
-
e

I Show Topic Headers:

-1

Break down by Topic: m|

Figure 81: Show Topic Header property

Multiple Gluestions Per Page: |Em )

Show Section Headers: |Em ;]

Figure 82: Show Section Header property

e Note:

» These properties are available only if the Advanced Assessments service is enabled.
 This feature is available in both Learning and Recruiting assessments.

» Headers are displayed even in the Review mode.

» For the default topic/section, the header name is displayed as "Default".

If these properties are enabled, then:

« Forsingle question per page, the header is displayed at the top of each question/page in the player, when the question
order is either "In-Order" or "Topic Defined".



Sample Test - Solar System

User One Question 4 of 12
Topic: Moons of the Solar System

Which planet has the most moons?
& Mars

& Mereury

& Saturn

@ Jupiter

@ Neptune

7 Uranus

@ Venus

™ Earth

Copyright ® 2016 Saba Software, Inc. All rights reserved.

Time Remaining: 00:09:21

powered by

< saba Cloud

Figure 83: Single question per page - Topic header

Sample Survey - Solar System

User One Question 2 of 3
Section: Moons of Solar System

Which planet is the smallest
@ Mercury
@ Pluto

© Mars

Copyright® 2016 Saba Software, Inc. All rights reserved.

Previous m

powered by
!¢ saba Cloud

Figure 84: Single question per page - Section header
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For single question per page, the headers are displayed for Questions Lists as well. In Questions List, the questions

are grouped on the basis of topic name.

Sample Test - Solar System

User One
=l Topic: Default (3 Questions)

@ 'Which of these planets do not have any moons?
@ Maich the celestial object to its type
@ Isthe Earth the only planet with a single moon?

- Topic: Moons of the Solar System (2 Questions)

@ Which planst has the most moons?
@ Match the asteriod fo its discoverer

= Topic: Topic 2 (2 Questions)

@ Multiple Choice Question

Copyright @ 2016 Saba Software, Inc. All rights reserved

Figure 85: Single question per page - Topic header for Question list - In-Order/Defined order

Question List

powered by

4 Saba Cloud

For multiple questions per page, when question order is In-Order, the header is displayed at the top of each group

of questions on each page in the player.



Sample Test - Solar System

User One Questions 4 - 6 of 6

Topic: Moons of Solar System

4, How many days does it take the earth to travel around the sun? n
@ 365
@ 30

Topic: Incredible India

5. States of India n

E Pune
m Rajasthan

] Punjab

E Delhi

-

Copyright® 2016 Saba Software, Inc. All rights reserved. powered by

* saba Cloud

Figure 86: Multiple questions per page - Topic header - In-Order
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For multiple questions per page, when question order is Topic-Defined, the header is displayed at the top of each

page in the player.
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Sample Test - Solar System

User One Questions 3 -5 of 12 Time Remaining: 00:09:41

Topic: Moons of the Solar System

3. Is the Earth the only planet with a single moon?

@ Yes n

© No

4. Which planet has the most moons? (o
L]

@ Mars n
@ Venus
@ Jupiter
@ Uranus
@ Mercury
@ Neptune
= oo T
Copyright ® 2016 Saba Software, Inc. All rights reserved. powered by

‘¢’ saba Cloud

Figure 87: Multiple questions per page - Topic header - Topic-Defined

Limitation

If the Show Topic Headers property is enabled for a test, then the Question Order property for that test cannot be set
to "Random". If set to "Random", then Saba Clouds displays a conflict error message and does not allow you to save
the changes till you resolve the conflict.

Use case

Headers for topics and sections in test and survey assessments respectively help improve usability for learners who use
topics/sections to organize their test/survey.

Improved survey scoring

How did it work?

Saba Cloud used the simple average of section scores for calculating the summary score of a survey assessment. And
the way the summary score and the section scores for a survey were presented was confusing for users.

How does it work now?

This update enhances the survey scoring mechanism by introducing the survey property Summary Scoring Mode,
which has the following options:

* Weighted Average of Sections - This is the new score calculation method.

If this option is selected, then each survey section gets a weight corresponding to the total question weights of all
the scored questions in the section. So as long as each section gets scored, the summary score looks just like it does
if the survey only contained one section, and therefore works similar to test scores.
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This is the default option.
Formula:
Summary Score (Weighted Average) =

(Sum of all Question Scores/ Sum of weight of all Questions) * (Max Summary Scale value - Min Summary Scale
value) + Min Summary Scale value

Where:
Section Score = Sum of all Question Scores/ Sum of weight of all Questions
» Simple Average of Sections - This is the existing score calculation method.
If this option is selected, then the summary score is calculated as a simple average of all section scores in the survey.
Formula:
Summary Score (Smple Average) =

(Sum of all Section Scores/ Sum of all Sections) * (Max Summary Scale value - Min Summary Scale value) + Min
Summary Scale value

Where:
Section Score = Sum of all Question Scores/ Sum of weight of all Questions

Survey Properties

Is Anonymous: |Em
Allow Question Comment:|Em o

Scoring Enabled: ACE] No |

Summary Scale Minimum Value: |0 = Maximum Value: |5 ~ 0

Summary Scoring Mode: @ ‘Weighted Average of Sactions (D) Simple Average of Sections

Show Survey Scorecard: ] No | ) Show Section Details in Yes El
S— Scorecard: o

Summary Score Display: @ Use Summary Scale @ Use percentage

Section Score Display: D) Use Summary Scale @ Use percentage

Figure 88: New properties for surveys

To support the new scoring method, this update introduces the following changes to survey properties:
e Scoring Enabled

The default value of this property is now set to Yes, instead of No. This change allows users to adjust the Summary
Scale that is used to store results.

e Summary Scale - Minimum Value

The default value is now set to 1 instead of 0 (zero). This ensures that the default survey scores are inline with the
default Likert scale questions.

e Summary Scale - Maximum Value



| Learning | 328

The limit for the maximum value is now increased to 100.

« Section Score Display

Introduces this new survey property that allows section scores to be displayed either as summary scale or percentage.
It provides the following options:

e Use Summary Scale
e Use Percentage

e Summary Score Display

Introduces this new survey property that allows the summary score to be displayed either as summary scale or
percentage in the scorecard. It provides the following options:

e Use Summary Scale
e Use Percentage

Note: The summary and section scores cannot be rolled up to display as a single type because the current system
displays summary as a range and section scores as percentages.

[

Use case

Training departments in certain organizations use surveys at the end of each quarter. To assess the trainees based on the
survey scores, it is important to enhance the summary score calculation and display the summary and section scores in
a normalized manner.

Adaptive branching in surveys

How did it work?

Survey assessments in Saba Cloud did not support branching capability. Users had to answer questions in a specified
sequence only. Saba Cloud did not provide any option to jump to any particular section based on the response to the
attempted question in the survey.

How does it work now?

With this update, survey assessments in Saba Cloud support adaptive branching. Adaptive branching is the ability of a
survey that allows learners to branch or jump to pre-determined sections in the survey based on the response to an
attempted previous question. Currently, surveys in Saba Cloud support only section-level branching.

The following question types are not supported for branching:

o Essay
* Pulldown
e All that apply

To enable branching capability, assessment authors must select the Yes option for the Enable Branching option in the
Survey Info tab while defining a survey.



Survey Info
Title:*
Description:
Survey ID:
Version:
Status: DRAFT
Domain: waorld
Author: user ane
Security: @ Domain Based @) Manage @
Add Language (0 Yes @ No @
Support?
Enable @ Yes O No @
Branching

Figure 89: Enable Branching checkbox
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After adding sections and questions to the survey, authors can mark a question as a branched question by clicking the
No link under Branched column. Only one branched question is allowed per section. When clicked, the link changes
to Yes, indicating that the question is a branched question. Clicking the Yes link changes it back to No, indicating the
question is not branched. However, demarking a branched question also removes the associated branching logic defined

for that question.

Sections and Questions

Survey Structure  » AdaptSurvey1

[] Question

[F] Is the sky blue?

[F] Mumbai is the capital of India.

2)

Type

Yes/MNo

True/False

Required

Na

No

New Question - | | Actions -

Branched

No

Yes

Actions

| Actions ~ |

| Actions ~ |

Figure 90: Branched column

When branching is enabled, the survey editor displays an additional tab titled Branching Logic. This tab allows authors
to define the branching logic for branched questions. Only questions marked as "branched" are displayed in this tab.
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Survey Info Branching Logic

=)

Preview |

Section Name Question Actions
Sections & Questions

E.

AdaptSurvey1 Mumbai is the capital of India. Add/Update Logic

AdaptSurvey2 Which cities are located in Europe? Add/Update Logic

Messages

Survey Properties

@ [

Branching Logic

[

Preview & Publish

Figure 91: Branching Logic tab

To add or update the branching logic, click the Add/Update Logic link for the required question. The Branching Logic
popup window appears. For a response, select the required choice from the corresponding dropdown list. When a user
attempts the survey question and selects the response, the survey branches out to this pre-selected choice. The dropdown
list of choices also has the Exit Survey option. This option allows users to exit the survey.

o Note: The choice list displays branched questions from subsequent sections only.

The branching logic also provides the following special options:

» If not answered - This option allows users to branch to a choice even if the question is not answered.
* Apply to all - This option allows users to branch to the same choice in the survey, irrespective of the response to
the question.

Branching Logic
Mumbai is the capital of India.
If answer response is: Then go to:
Apply to all
True
False

If not answered

Save & Exit | | Close |

Figure 92: Add/Update branching logic

Click the Preview button to preview the flow of the survey.
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Welcome to Clarity Survey x
Zoom
G0 !
[ Section Name L.
NOTE: This is wherebranching starts
B Question Name Which area are you employed in?
[ Choice Ermier e /

Mamemng am sae..

\

Whichievel are
==

-Contct Canre Man 1 ooltip -
[ R T T o — Intooltip-
- Management 1.questiontext is
- Team Leader/Supervisor Fooiansvemd large

- General Staff 2. If multiple choices

- Other (If so, please specify) directs to same
- If not answered
section

)

Figure 93: Preview branching logic

Notes

» The adaptive branching capability in surveys is available only if the Advanced Assessment service is enabled.
» The adaptive branching capability is available in both Learning and Recruitment survey assessments.

« Branching to a question in any previous section of a survey is not supported.

« The branching logic is always applied after all questions in the section are attempted.

« Subsequent sections are not skipped automatically. For example, if a there are 4 sections in a survey, titled 1.Laptop,
2.0nling, 3.0ffline, and 4.Payment, and if a Yes/No question in section 1.Laptop has branching logic where a Yes
directs to section 2.0nline and a No to 3.Offline, then if a user response is Yes, then the user is directed to section
2.0nline followed by 3.0ffline and 4.Payment. In this case, section 3.Offline is not skipped automatically. It is up
to the assessment authors to manually set the branching logic in section 2.0nline to branch the user to section
4.Payment if they want the user to not attempt section 3. Here, the Apply to all option comes handy such that the
author can define a branching question in section 2.0nline where all responses are set to branch to section 4.

Use case

A survey needs to provide a choice of next questions to users based on their responses to an attempted question.

Additional search filters in class roster

How did it work?

Instructors and learning administrators were not able to search for learners in a class roster using person data such as
Person Legal ID.
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How does it work now?

With this update, Saba Cloud displays the following additional search filters when instructors and learning administrators
search for learners in a class roster:

e Person Legal ID
Specify the person legal ID of the required learner.
Note: This field is displayed only if the "Can View Protected Data" privilege is enabled on "Person, Internal”
component for the logged-in user.
e Email ID

Specify the email ID of the required learner.

You can use the new fields individually or in combination with existing fields to search for learners in the roster.
To view the new search filters in the class roster:

e Click Admin > Instructor > Edit a class > Show filters
e Click Admin > Learning > Manage Classes > Search and edit a class > Roster > Show filters

Hide filters
First Name: Last Name: Person ID: Registration date on or after: Registration date an or before:
Order no: Status: Email Ferson Legal ID:

All -

Apply fiters | Clear filters

Edit selected for:

Figure 94: Additional search filters in class roster

With this update, the Person Legal ID and Email ID are also displayed in the tooltip that appears when you hover the
cursor over the learner name in roster search results.

Use case

Organizations need additional fields to search for people in a class roster. For example, organizations using a SSO
solution to access Saba Cloud use the Person Legal ID instead of the usual Person ID field to store the user ID. Such
organizations need the Person Legal ID option to filter learners in a class roster.

Roster print PDF enhancements

How did it work?

Saba Cloud did not provide the ability to display a company logo and watermark image in the PDF that could be printed
from a class Roster.

How does it work now?

With this update, Saba Cloud enhances the class Roster Print PDF functionality such that the printed PDF can now
display the following along with the existing Roster data:

e A company logo

e A watermark image
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To print a Roster PDF, login as an Instructor or Learning administrator > Search for a scheduled class and edit it. Go to
the class Roster, and click the Print/Export icon

The company logo displayed in the Roster PDF is the same image that appears in the Saba Cloud site header, whereas
the watermark image displayed in the Roster PDF is the same image that is used as the login page background image.
System administrators need to first configure the company logo and the watermark image for the site so that they are
displayed in the Roster PDF.

To configure a company logo for the site:

1. Go to System > Configure System > Microsites.

2. Search for the required microsite and edit it.

3. Click the Configure branding tab.

4. Upload the required image using the Upload your company logo or provide URL field.

To configure a watermark image for the site:

1. Go to System > Configure System > Microsites.

2. Search for the required microsite and edit it.

3. Click the Configure branding tab.

4. Upload the required image using the Upload login page background image URL field.

Note:

-

» If the company logo or background image URL is empty or invalid, then the Roster PDF is generated without
the logo and watermark.

 For certain static images that are provided with Saba Cloud, the relative paths for images work only if these
images are available under the "assets" directory.
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Configure branding

Microsite information

1. Upload your company logo or provide URL*

Upload Image
Configure branding Choose file | Mo file chosen

N,

Entera URL"

hitps.iidgathdb1.sabacloud.com/324 352 3/production/at
Site properties
2. Main navigation background color™

3. Selected item background color™

E-Commerce 4, Main navigation text color®

5. Selected item text color™

LLEL

6. Header background color Black ¥

7. Upload login page background image URL*

Upload Image

Choose file | No file chosen

Entera URL"

hitps.iidgathdb1.sabacloud.com/production/athdb1/pub

Figure 95: Configure branding properties for roster PDF

Use case

Printing the class roster is very handy for instructors while conducting a classroom training. It is very useful to have the
company logo and any additional watermark image on the printed roster to provide a distinguished identity to the roster.

Configure display of credits on completed learning of learners

How did it work?

If the Continuing Education Credits service was enabled for a learner's domain, then the learner could view credits for
their completed learning. There was no provision to control the visibility of credits.

How does it work now?

Saba Cloud now allows system administrators to configure the visibility of credits for completed learning of learners
by introducing the following new setting:

* View earned credits on completed learning
Possible values: On and Off

Default value: On
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If this setting is enabled on a learner domain and the course domain, then the learner can view the earned credits for
their completed learning. If disabled, then the credits are not displayed for the completed learning.

To configure the setting go to Admin > System > Configure System > Continuing Education System.

g~ Note: When the setting is disabled, Print Certificate, Export Certificate, and notifications, if any, for completed
courses still fetch credit information if corresponding keywords are added to them.

Use case

There is a need to configure the visibility of credits for completed learning of learners.

Display view credits link in catalog search results

How did it work?

The learning catalog search results for courses did not display the View credits link even if a course had Continuing

Education credits associated with it.

How does it work now?

With this update, Saba Cloud displays the View credits link in catalog search results for courses that have Continuing
Education credits associated with them. If no credits are available for a course, then this link is not displayed.

Search Results

Clear All | Back
Resource Type

More than 61 results found

All
Learning Catalog (160+)

(E

Learning Event Type
Apply Filter = Clear Filter
Class/Course (160+)

Delivery Type

Apply Filter | Clear Filter
Web-Based (153+)
Instructor-Led (6)
Virtual Classroom (1) Course_PRBulkDrop

Course (3 classes)
Language

Apply Filter = Clear Filter
English (160+)

View credits

; iew classes
Location

Apply Filter  Clear Filter
Bombay (3)

Sortby | Relevance v

Results per page 12~

Competency Related Offering
Course (1 class)

This offering template is created so it related to
competency with different level

View credits

Launch

=)

Figure 96: View credits link in catalog search results - Grid View



Search Results

Clear All | Back
Resource Type

All
Learning Catalog (160+)
Learning Event Type

Apply Filter | Clear Filter
Class/Course (160+)

Delivery Type

Apply Filter = Clear Filter
‘Web-Based (153+)
Instructor-Led (§)
Virtual Classroom (1)

Language
Apply Filter = Clear Filter
English (160+)

Location

Apply Filter = Clear Filter
Bombay (3)
Location (3)

More than 61 results found  Sortby | Relevance v Results per page

Course_PRBulkDrop

u Course (3 classes)

WView credits

‘iew classes | - |Share| Bookmark | Tags: .. )

Competency Related Offering
@ Course (1 class)
This offering template is created so it related to competency with different level

0uUsD

WView credits

Launch | = |Share|Eoo|-\marl-\ Tags: .. @

%’ MultiCurrency_Price@Offering

= Course (1 class)
“\__, This course has the prices defined at the offering level.
30 UsD

View credits

classes | - |Share| Eool-\marl-\| Tags: .. Q

12
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g Note: As per existing behavior of the View Credits link in course or class details pages, when the Continuing
Education service is enabled and Field Of Study service is disabled, the View Credits link is replaced by Available
credits link even in catalog search results.

Figure 97: View credits link in catalog search results - List View

Use case

When learner search for courses in a catalog, they need to view the course credits upfront. This eliminates the need to
navigate inside a course to view the credits.

How did it work?

Enhanced class and course details pages

The class details pages in Saba Cloud did not display course-related information such as course description, course
attachments, course custom details and so on.

How does it work now?

With this update, Saba Cloud enhances the class details and course details pages to provide details upfront and improve

usability.

Enhanced Class Details Page

The class details page now displays a seamless mix of the following class and course information:

» Course and class descriptions
» Course, class and delivery mode attachments, whichever are available
» Course custom information is shown in a separate section

< More actions link is replaced with a button that shows the primary action and a dropdown for other actions



water conservation
L (ID: 00200427)

EE

Course description : Water conservation encompasses the policies, strategies and activities made to manage fresh water as a sustainable
resource, to protect the water environment, and to meet current and future human demand. Population, household size, and growth and
affluence all affect how much water is used. Factors such as climate change will increase pressures on natural water resource . more...

You have registered for the following class

Class ID : WATER_CONSERVATION_WBT | Retake |
Web-Based

Class description : Water conservation programs involved in social solutions are typically initiated atthe local level, by either municipal
water utilities or regional governments. Comman strategies include public outreach campaigns,[4] tiere ... more

Language: English CPF: Yes
Duration: 01:00
Attachments
Class Attachments:
& wht class public url - Promotions 1=l wbtclass public file - Setup(Re-order form)

Course Attachments:

& course public url - Reference

Print Certific ate Share Export Certificate Change Status
Activities
Name Status Action
"f ! Task_22032016 (O Notevaluated Mark Complete

Figure 98: Enhanced class details page

Enhanced Course Details Page
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My Status

J User One
‘ emJobTitle

Status: [EMT==mICompleted on: 03/23/2016
(1 more active registration)
View credits

Class information

Custom0 : Class custom data
Custom1 : Class custom data2
Course information
Custom0 : water conservation
Custom2 : water storage
Classmates
" e &
1 3

Completions so far Total registrations

The course details page now displays multiple classes in a single view. This view incorporates:

Course description
Class description for each class in the course
Class and delivery mode attachments for each class

More actions link is replaced with a button that shows the primary action and a dropdown for other actions
All clickable links like View credits, View details, Attachments, and so on, are displayed below various class details



(ID: 00200427)

B water conservation

Course description : Water conservation encompasses the policies, strategies and activities made to manage fresh water as a sustainable
resource, to protect the water environment, and to meet current and future human demand. Population, househaold size, and growth and
affluence all affect how much water is used. Factors such as climate change will increase pressures on natural water resource ... more

You have registered for the following class

Class ID : WATER_CONSERVATION_ILT Free

¥ Instructor-Led Mark Complete | +
0372272016 7
Pune

Class description . One fundamental conservation goal is universal metering. The prevalence of residential water metering varies
significantly worldwide. Recent studies have estimated that water supplies are metered in less than 30% of UK hous ... more
Instructor: Language: English Available seats: 47 CPF: No
Jane Instructor Duration: 32:00 Waitlisted: 0

View credits View detail Attachments~ 03/22/2016 (3:00 AM - 5:00 PMIST)»  Allinstructors »

Class Attachments:
&2/ ilt class public url - Job Aid Bl it class public file - Promotions

Delivery Mode Attachments:
& iltdel mode public url - POC W Delivery attachment - Reference

w- Class ID: COPIED_CLASS3 Free
N Instructor-Led \iew Summary | -
0411212016 -
Pune

!

Class description - Cne fundamental conservation goal is universal metering. The prevalence of residential water metering varies
significantly worldwide. Recent studies have estimated that water supplies are metered in less than 30% of UK hous ... mare..

Instructor: Language: English Available seats: 49 CPF: No
User Three Duration: 32:00 Waitlisted: 0

View credits View detail Attachments»  04/12/2016 (9:00 AM -5:00 PMIST)»  Allinstructors »

Figure 99: Enhanced course details page

Use case
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My Status

i User One
‘ emJobTitle

Status:

Course Statistics
Vil
2 2

Completions this Total completions
year

Course information

Available credits: 0 Credits
Custom0: water conservation
Custom2: water storage

Course Attachments:

% course public url

When registering for a class, a learner needs to see the course description on the class details page. After registration,
the learner needs to see a seamless mix of course and class descriptions, and course and class attachments.

Display available credits in a popover

How did it work?

Learners had to click the View Credits link on a course or class to view the credits available to them.

How does it work now?

With this update, learners can now view the available credits for a course or class just by hovering the mouse cursor
over the View Credits link. Saba Cloud displays a popover with the following details:

« Total credits

* Four Field of Studies with the number of credits and max credits for each

* A View more link, if the FOS exceeds four
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Course with FOS
@ Course (1 class)
CPF: No
0
View credits b
Launch -  Course with FOS Total credits: [ D
MName Credits | Max Credits
Course1 FOS3 FOS10 10710
Course (1 clas
FOS for defect 25 25
CPF: No ) .
5 USD FOs regression 20 30730
View credits | FOS1111 10/10
Launch | - | Share | Bookmark | Tags: .. )

Figure 100: View credits popover
= Note: The existing behavior of the View credits link remains unaffected with this change. Clicking the View
credits link still displays the View credits popup window for the course/class.
Use case

There is a need to reduce the number of mouse clicks and improve usability while viewing course or class credits by
learners.

New reminder notification for class commencement

How did it work?

Saba Cloud natifications do not provide person-specific information in a registration for session-based classes to learners.

How does it work now?

This update introduces the following new natification on the Registration component:
e Class Commencement Reminder as per Registration

The natification is triggered X days before a class commences, based on learner registrations for the class, where X
is defined in the Reminders field of an event. This notification provides the ability to send notifications to learners
on multiple days by adding the reminder days as a comma-separated list in the event.

To configure this notification, navigate to System > Configure System > Orders > Notifications.

To support the new notification, the following new keywords are added to various components:

Table 97: New Keywords

Component Name Keywords Added

Registration ¢  @Reg_Student_ CompanyName@

e  @Reg_Student CompanyAddri@
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Component Name Keywords Added

¢  @Reg_Student_CompanyAddr2@

¢  @Reg_Student_CompanyCity@

e  @Reg_Student_CompanyZip@

¢ @Reg_Student_CompanyCountry@
¢  @Reg_ClassFacilityContactEmail@
¢ @Reg_ClassFacilityContactFax@

e @Reg_ClassFacilityContactName@
e @Reg_ClassFacilityContactPhone@
¢ @Reg_ClassFacilityCountry@

ILT Offering e @Offering_ClassFacilityCountry@

e @Offering_ClassFacilityContactPhone@
e @Offering_ClassFacilityContactName@
*  @Offering_ClassFacilityContactFax@

e @Offering_ClassFacilityContactEmail@

To support the new notification, the following new named query is added to various components:

Table 98: New Named Queries

Component Name Named Queries Added
Registration Person who created the registration
ILT Offering

VC Offering

Use case

There is a need to communicate person-specific information in a registration for session-based classes to learners by
means of direct notifications.

Enhanced registration and cancellation confirmation pages

How did it work?

There was no provision to display any additional information on the registration and cancellation confirmation pages
of session-based classes.

How does it work now?

This update enhances the registration confirmation page for internal users, order confirmation page for external users
and registration cancellation confirmation page when cancelling a single registration item for session-based classes.
These pages now display additional information, including links if any, to users so that it can lead them to go to external
sites and take further action.

g~ Note: For learner and manager flows, the additional information is displayed on the registration confirmation/order
confirmation pages only when registering for a single session-based class. This information is not displayed for
bulk registration of session-based classes from learner and manager flows.



Configuration

The following new attributes are introduced on ILT Offering, Blended Offering, and Virtual Class components:

By default, the Display checkbox for these attributes is cleared, which means these fields are not displayed for
session-based classes. System administrators can enable these attributes by selecting the Display checkbox.

Enrollment Text
Cancellation Text

broadcast

Broadcast

cancellation_text

Cancellation Text

class_no

course_no

csr_id

delivery_id
description
disp_for_call_center
disp_for_web
do_not_drop_post
duration
elements_to_complete
end_date
enforced_seq
enrnll=clnse

Class 1D
Course Mo.

Customer Service Representative

Delivery

Description

Display far Call Center
Display far Learner

Do Mot Drop_master_updas
Duration (HH:MM)

Cptional Elements to Complete
End Date

Enforced Sequence
Enroliment Closes Before

enrolliment_text

Enraliment Text

facility_id
group_id

Facility
Group 1D

Boolean
Mema
String
String
String
String
String
Boolean
Boolean
Date
Real
Integer
Date
Integer
Date
Memao
String
String

Figure 101: New attributes on session-based class components

Definition
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If enabled, then these fields are displayed while creating session-based classes under the Registration Information
section. Learning administrators can customize these fields to include text, images, URLs and keywords. If these fields
are populated for a class, then they are displayed on the registration and cancellation confirmation screens. If these fields

are empty for a class, then they are not displayed on the confirmation screens.
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Registration Information

Min Count* 1 |

Max Count* 120 |

Max In Wait List* 20 |

Student Count G

Students Waitlisted 1]

Vendor | |f—k|@

Reprossntatve. | )&

Allow Drop @Yes: this class can be dropped anytime after registration
(Mo, this class cannot be dropped on | @
and after date

Enrollment Text IE JF U s

IFaragraph - FontFamily += FontSizes » ==

Please click next to complete the registration :

L TR
Eiﬁ.dministrator has requested to book hotel room as a EE I"-.IE}{TE
vpart of the registration e
« I »
table Words: 21
Cancellation Text [ Bl witad) S
IFaragraph - FontFamily += FontSizes » ==
?lease click next to CANCEL the reagistration
Administrator has requested to book hotel room as a :: NEKTE

part of the registration e

p Words: 21

Figure 102: New registration fields for session-based classes



20186.

20186.

20186.

20186.

Status:Registered

Contact: User Super
Order discount: 0 USD

Registration Information:

Registration Confirmation

You registered for
Check Link To Hotel1

Pune

Cancellation Policy

Please click next to complete the registration :

the registration

Start date:26-APR-2016

- Cancellation charge of 20.0 % if dropped between 06-AFR-2016 and 10-AFR-
- Cancellation charge of 10.0 % if dropped between 11-APR-2016 and 15-AFR-
- Cancellation charge of 5.0 % if dropped between 16-APR-2016 and 20-AFPR-
- Cancellation charge of 2.0 % if dropped between 21-APR-2016 and 28-AFR-

- Cancellation charge of 100.0 % if dropped on or after 29-AFPR-2016.
- Cancellation charge of 52.0 % for all other days.

Order Number: 00081420
Cost: 10 USD

Administrator has requested to book hotel room as a part of -

Figure 103: Registration confirmation page

@ Order successful
Payment authorization was successful and learning items are purchased and available in your My Plan. An email notification is
sent to you. You can find enrolled learning in your plan. You can also view your Order history and make changes or cancel your
enrollment within the time limit specified for respective learning items.

Order number Status Crder date
00081424 Confirmed 29-APR-2016
Item Details
Learning People Enrol... Unit price Cost Tax Total cost
{UsD)
5 Check Link To Hotel1 Wyself 10 10 072 10.72
@ Delivery type: Instructor-Led
Start Date: 26-APR-2015
Location: Pune
Duration: 02:00
Language: English
Learning items (1) Sub-total 1072
Organization discount
(10%) 1
Final amount 972
Payment Details
Payment Transaction number = Status Cost (USD)
Invoice 00002881 Payment completed 972

Your next steps

Find more catalog items
View order history
View my learning

Registration Information:

Please click next to complete the registration
Administrator has requested to book hotel NEXT
room as a part of the registration

Figure 104:

Order confirmation page
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Cancel this order

You are about to cancel this purchase. Please review and confirm before you do so. You will not be able to revert this action.

Order number 00081420
Status Confirmed

Learning ltems associated with
order 1

Total order amount (USD) 10

Cancellation Policy
Late charge of 100.00% if dropped 3 days after order date

Additional information is requested to complete this transaction. Please note if the field has an asterisk (*) next to it
the field is required. If there is no asterisk (*) next to the field it is optional.

Reg . Custom field: Select One v
LOW: ne o

Cancellation Information:

Please click nextto CANCEL the registration :

Administrator has requested to cancel hotel room as a part of ﬁ

the cancellation process.

No

H

Figure 105: Registration cancellation page
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Cancel this order

You are about to cancel this purchase. Please review and confirm before you do so. You will not be able to revert this action.

Cancellation Policy
Late charge of 100.00% if dropped 3 days after order date
Tax on late charge 8 %

Additional information is requested to complete this transaction. Please note if the field has an asterisk (*) next to it
the field is required. If there is no asterisk (*) next to the field it is optional.

Reg . Custom field: »
LOV: -

Cancellation Information:

Please click next to CAMCEL the registration :

Administrator has requested to cancel hotel room as a part of m
the cancellation process.

Order number 00081423 Class Status Cost USD
status Confirmea Check Link To Hotel1 Processing 10.72
Learning ltems associated Refund
with order 1
Total order amount (USD) 9.72
Sub-total 10.72
Discount 1
Total oy
Refundable ltems Total 972
Cancellation fee g
Tax on cancellation fee 072
Total cancellation fee 972
Final refund amount 0

Figure 106: Order cancellation page

Use case
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Some organizations want to provide additional information and links to separate sites that learners can link to from the
class registration workflow. The registration confirmation page facilitates them to provide such details so that learners

can be directed to make a hotel reservation, gather necessary information or additional information that the organization
wants to gather about their participants. Similarly, the cancellation confirmation page also allows them to send a message

or link to a site to cancel hotel reservations or other necessary things.

Enhanced editing capability on certification versioning

How did it work?

Certain certification attributes are not available for modification after a certification is created. While versioning a

certification, it was not possible to modify these attributes and thereby, administrators lost the capability to create the

new certification version to the desired specifications.

How does it work now?
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This update enhances the editing capabilities of certifications while versioning them such that more attributes of the
original certification are now available for modification in the new version. When learning administrators version a
certification, on step 2 Modify Certification of the versioning wizard, they can click the certification name link to open

the certification details page for editing.

Learners may find registering for this certification complex

1.Specify Version Number 2. Modify Certification 3.Push Certification

| certification Preview

path = :
Specify 3 path name and leaming modules for the path. Each module is a group of courses and Elj Dot Certificate

certifications, which are the actual learning to be completed. - newPath
Name* |newPath - RecertPath1

Discontinued From I— @

Recertification Path

Modules New Module | Print | Export

| Up | Down | Name |Acti0n5 |
@ @ Modulel: myModule Delete

| Copy Path | | Add Ancther Path || Back || MNext==

Figure 107: Certification name link during versioning

On this page, they can modify attributes such as Enforce Module Sequencing and Expiry Type.

Expiration and Recertification
Selectthe duration in which the certification expires and the duration in which learners must complete leaming items on the recertification path in order
to recertify. If you do not enter a value for Expires in field, then the certification never expires and learners do not need to recertify. If you require the
learner to recertify, then enter a recertification path in the Completion Criteria section.
; () ®)Duration
Expiry Type (&)
piry Type 2= Day of Month and Frequency

Expiresin |5 Days ¥ @
Re-take this certification |4 days before certification expiration to re-certify @}
Send reminder days before certification expiration @}

Registration Rules
Select rules for registration that the learner must follow when registering for the cerification.
Enforce Module Sequencing Learners must register for all modules and complete them in the arder in which they are defined
@

(2 Learner must select the classes with end date before target date selected in the completion criteria section.
Enforce Target Date 2/ 9 P

One-click registration 'i?:' The learner will be registered for all classes of a matching program on selecting 'Register’.
continuous launch o) Launch all web-based classes sequentially on completion of previous class.
o

Figure 108: Edit certification details during versioning

Use case

While versioning a certification, learning administrators need to modify certification attributes such as Enforce Module

Sequencing that are available in the original certification.
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Restrict the ability to approve or reject class enrollment requests

How did it work?

Users possessing the role of managers had by default, the ability to view class enrollment requests of their reporting
members and further approve or reject them. There was no way to restrict such users from approving or rejecting such
enrollment requests.

How does it work now?

This update provides the ability to define a manager-like custom role who can view class enrollment requests of reporting
team members but restrict their ability to approve or reject them.

To achieve this, Saba Cloud provides the following new security privilege on the Registrations component:
« Can approve-reject enrollment request by others

If enabled for a security role, then users in that role have the ability to approve or reject class enrollment requests of
others. If disabled, then they cannot approve or reject class enrollment requests of others.

By default, this privilege is assigned to the following security roles in Saba Cloud:

* Approver

e Manager

e Alternate Manager

* Human Capital Admin
e Superuser

Limitations for the Approver security role:

« If "Can approve-reject enrollment request by others" privilege is enabled for the Approver role, then system
administrators must also enable the "Can drop registration for others any time" security privilege on the Registrations
component for that role. If not, then users having the Approver role cannot reject class enroliment requests.

Note: If an ad hoc user is assigned the Approver role, then it is recommended that administrators take precaution
while assigning these privileges to ad hoc users because these users get the power to drop any other registrations
in the system as well.

« Ifanad hoc user is added to the approver flow, but the "Can approve-reject enrollment request by others" security
privilege is disabled. for Approver role, then Saba Cloud still sends out notification emails for approve/reject requests
to the ad hoc user. However, after clicking the Approve/Reject link, Saba Cloud displays an "Insufficient privileges"
error to the ad hoc user.

Use case

Organizations in certain countries do not want their employees in the role of managers from approving or rejecting class
enrollments of reporting team members. A new security privilege that restricts this ability of managers is required. If
the privilege is removed from the manager role, then the manager can view learner enrollments needing approved but
cannot approve or reject them.
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Enhanced remote content server security

How did it work?

Saba Cloud provided security for content hosted on remote content servers using a time-based mechanism.

How does it work now?

With this update, Saba Cloud enhances the security of launch URL of content hosted on a remote content server using
a cookie-based mechanism so that only authorized users can access the content.

To enable security of content launch URL, Saba "admin" users need to configure the following new site-level property
for Content:

¢ Generate time-based launch URL for secured RCS
Possible values: "true" or "false"
Default value: "false"

If this property is set to "true", then the generated launch URL for content hosted on a remote content server, can be
transferred over the network, but has a time-based expiry. By default, it is set to "false", where the launch URL is
secured using a cookie-based mechanism such that it cannot be transferred over the network and prevents unauthorized
access of content. Any attempt to transfer the URL to a browser other than the one used by the current logged in
user, results into a "403 Forbidden" error. The enhanced security works on MS Internet Explorer 10 and 11, Mozilla
Firefox, and Google Chrome browsers.

Consider Content Attemptin
"Suspended” state for completion far 0
SCORM2004 type content

Consider Content Attempt in "Suspended” state for completion.
Malue 0=Default value takes content specific values. 1=Cansider
Content attempt in "Suspended” state. 2=Do not consider Content
attempt in Suspended state.)

Generate Secured Content Launch

URL with Rest Service false

[ftrue, a secured Caontent Launch URL will be generated By Defaul
the value is false.

Generate time-based launch URL for

secured RCS false

If selected then generated UREL can be transfered over network but
will have expire in defined time.

Hide "Exit Without Saving” far 0
SCORM2004 type content

Figure 109: New Content property for secured RCS
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g~ Note: You must also ensure that the "Is a secure server" property for the Nginx or 11S server for RCS is enabled.

Supported Content Formats
This enhancement supports the following content formats only:

e Fileas URL
e Deployed SCORM
« ZIP

Notes

» The content launch URL is secured for remote content servers secured with Nginx and I1S servers.
e CDN is not supported.
e TinCan content format is not supported.

 If the site name is added to LIST_LDSRCS in the Sabadownload.ini property file, then cookie-based security is
enforced irrespective of the Generate time-based launch URL for secured RCS site level property.

Updated content.security File

This update provides an updated content.security file. If you are using I1S server to serve the RCS content, then you
must replace the existing content.security file with the new one.

To download the latest version of this file:

1. Login to Saba Cloud as a cloud "admin™ user.

2. Click Content > Remote Content Server Files.
3. Click the Downloads Files for 11S Server button.
4

. Download the iis.zip file, extract it to a convenient location and copy the content.security file from the extracted
files.

5. Replace your existing content.security file with the latest one.
Use case

The security of launch URL for content deployed on a remote content server must be enhanced so that it is accessible
only to valid users after authentication.

Buyer can view redemption code in the order confirmation page

How did it work?

When an external learner use to buy the learning item for others, a redemption code use to generate. This redemption
code is sent through email to list of people mentioned in the notify people action. If the people are not notified, then
there was no other way to retrieve the redemption code.

How does it work now?

From this update, when an external learner buys the learning item for others, the generated redemption code will be
shown on the Ul to the buyer in the following pages:

« Order confirmation page
e Learner's order history



* Registrar order history
e Message center

« Rest API to get the order details

Order Conflimation

00208125

hem Details

Lt raing)

Domain_SabaDev_courselon
_us

MW; Wab-Based
Language: Erp

Learning fems (1)

Coupon code : NS
Total coupa digcoun (B0%) : 2627

Confirmed

Poople En ...

Redemption Code: 1FASAFBIIC

Payment Details

Payinent Transaction number -

Linit price

Satus

29.02.2016

Descount

Sub-total

v ganization discount
(10%)

Cost (LD

Total cost

3579

5 B4

Figure 110: Redemption code on Order confirmation page
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Order Details: Order Number 00208122 e (|

Ordar Cardact A 0neg
Created On 20022016
arder Slabus Conflinmgd

Biled Ta Companiyl

Daher Information
Customi
Cugbomi
Custamz
Custom3
Cusbom4
Cugtams
Cushome
Cusbom?
Cugtoms
Gustoma
Customi
Cusbomi
GCustamil
Customi 3
Customid

Paywnient Details Print | Export

Method OF Payment | transaction o | Payment stats | amoun | action

Invpice Mi 00003200 Paymienl cormgleded T35
UsD

Owebrr Moties Add Mote

Mo items found

Fedemgtion Code!  1FAGAFED3C

Otler tems

Adjugt All Prices | Modity Table

Figure 111: Redemption code on Order history page
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R demgiion Code

Message Center —_
@ Hi, you have created 4 rew Redemplion code - AR 27 IE 2

P |

B Redemption Code
Hi, e VD FRa% B Pl FEOGMEibon £000 * DAMR12FIED e et 3 ne Flesemens

B minuies. ago

Figure 112: Redemption code in learner's message center

Use case

The Buy for Others workflow is now improvised by displaying the redemption code.

Buying learning items with deferred payments

How did it work?

Prior to this update, the learner had to pay for an order during the registration only as there was no provision to buy now
and pay later.

How does it work now?

From this update, the learner can buy and register for a course/class and make the payment later. To support this, a new
setting Allow the learner to place the order and make the payment later under Services > Orders has been introduced.
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Figure 113: Allow deferred payment setting

By default, this setting is disabled. When this setting is disabled, the learner has to place the order and make the payment
immediately. When this setting is enabled, the learner can place the order and on the Payment screen need to click the
Pay later button. On this screen if the learner clicks the Confirm button, a popup is shown to select the payment type.

g~ Note: This is applicable for both, orders & subscription orders.

mum

Payment Oplions Surmrmany

Purchase Orders Swlbcription 11
Py Iy purtianse oooer Swalabie i poul Orpanzalis Crpanization dacount | 30%

F_:-:_al amubunt 80.85

Credit Card

Py Wil poaar Credl card

Figure 114: Pay later button on Payment screen

On clicking Pay later, the order is confirmed but with the Payment Initiated status.



@ Order successful

Your next steps

Whirw O tadls

Learning Nems associuled with order 1

Todal grder amount (WED) 8083

Agd paymeant

[o T Te— S Cvoer date
00208025 Payment Initiated 18.04.2016
Hen Dutails
Sl LN Ll Chas Ly Unil price Cosl Tax Total cost
(S0
& P
L earming fems (1 S Bokal 184
O pasdzation disc ound
[Sirs)
Fnal amound oag
Figure 115: Order created with Payment Initiated status
Order History
Owder & Subscnption Orders
Subscripion Titke: Order Date: Last 30 days -
Agply TR Claar fillgrs
14.04. 2016
Order number 00208001 Class Status Acticns
Status  FPayment Inmated
Subscription 11 Pending Paymsm sk Tral
Learning ltems assockated with order 1
Total ofrder amownt (USD) 8085
Audit Trail  View detadls | Acsd payment
14.04.2016
Ovder number 00207959 Class Status Actions
Status Payment Infated
Subscription 11 Pending Paymem awt Tenl

Figure 116: Add payment link on Order History
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The learner can now continue with taking up the course or class and make the payments whenever ready. To make the
payment, the learner must navigate to ME > Order History and find the order with Payment Initiated status. Click

Add payment corresponding to the order, choose the payment method, and make the payment.

The above flow is applicable for registrar too where registrar can register the user for course and pay later.

Use case
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When a learner buys any learning item using a purchase order or training unit, he/she had to make the payment
immediately. But, by the time the purchase order or training agreement gets approved, the course used to get completed
or the seats were unavailable. Hence, there was need that the learner should be able to sign up for the training until the
purchase order or training unit is ready and then make the payments later. Through this enhancement, the user can now
buy the learning item and pay later.

Choose the required credit card type for payment

How did it work?

There was no provision for admin to add a support for all types of credit card or any specific card.

How does it work now?

From this update, the Credit Card flow now supports Visa, Master Card, Amex, and Discover type of credit cards. A
new property Supported card type is added in the Payment Configuration properties at the microsite level. The system
admin must navigate to System > Sites > <sitename> > Payment Configuration property and add the required types
of credit cards in the Supported card type property. The system admin can add any or all of the above card types in
this property. The admin must specify multiple card names by seperating each with a comma.

Payment Configuration

CreditCard Engine CyberSource

Mame of CreditCard processing engine (PayFlow / CyberSource /
Stripe)

Payment flows for external users |On

Enable Payment flows for external users of the microsite(On / Off)

Supported card type visa,mastercard, amex, discover

Comma separeted list of supported credit card type(visa / mastercard /
amex / discover)

«EIEE

LFiE
[
I

Figure 117: New property at Microsite level

Based on the type of cards added in this property, the Card Type dropdown list on the Credit Card payment page will
populate those cards.



Credit Card

Pay with your credit cand

Credit card details

Card Type *
Visa w
Visa
MasterCard

American
Express

Discover

Card number *

Expiration date ™

W b

Card security code ™

Billing address

Address 1*
thir

Address 2

Address 3

City ®

sadgas

State

Email

cone@testcom

Country *
Brazil

Zip code

Figure 118: Credit Card Type
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Validation has also been added on the Card number field against the selected card type. If the card type and card number
does not match, an Invalid card number message will be shown to the user.

Credit card details

Card Type *

First name *

st

Last name "

Tl

Card number *
1234567894564565
Expiration date *

\1 @ Invalid card number I
2022

Card security code ™

Billing address

Address 1*
hir

Address 2
Address 3
City *
sadgas

State

Email *

coneg@iesioom

Country
Brazil

Zip code

Figure 119: Validation on card type and card number

Use case

The admin can now add the supported credit card type on the Microsite so that only those credit cards will be available

for payment to the user.



Course visible for request learning regardless of active classes

and associated currencies

How did it work?
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If the Pricing setting was enabled, then even if the course had no class, the course was still visible to all the learners no
matter whats the currency type of the base price. But once the class was created, the course use to be visible to learners
only if the organization's or learner's default currency would match with the currency of the class. If it didn't match, the

course would not appear.

How does it work now?

From this update, the learner will not only be able to search for such courses but will also be able to submit learning
request. If a course has a class in a currency different from the learner's currency, the learner will be able to search for
that course and also submit the learning request for that course. The course will be returned only if the Learning Requests
service under Learning@Work > Catalog is enabled. If the Learning Requests service is disabled, the courses will

not be visible for request submission.

Hi, Charies Foster =

i = | Indian
Basmaans

Leamning Catakog =~ Mew Leaming Event

Mors than 61 results found for Tew Laaming Event Sortby | A2 ¥

Net 1 201 Corporate Safely Traning

Course (0 class)
Andi he workds mosl populsr mobds 55

3 U G Lee ol fhe Googhe CPF: No

i3 there are more

tha d games availiable on W Credns
Googhs P SEp YOU Enberiained, Alongside
s of songs and Books, & __mons
CPF: No
e credits

[§]

6 Curmmculum
Recuming Course (0 class)
CEsl

CPF: No

Prerequisite Courses: title counse AMA N
e credits

Fequast Lasmng

Figure 120: Course visible for request learning
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it
and thousands of movies. Android devices are already smart, and will o
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1 fn ]

There are no active classes available. | Submit a request

to Pla Share Tag Booknrark

Figure 121: Request for learning from Course details page

Use case

A user is using the same catalog globally, but is scheduling the ILT classes locally, with a local price in different
currencies. When a class is added to the course in one currency, the course is not visible to other learners in other
countries. Due to this, the learners do not know whether that course exists in the catalogue anymore. With this
enhancement, the learners will now be able to search and request for learning for courses that are in different currencies.

Display learner's billing and shipping address in order details

How did it work?

In Payment Details, the learner's address is not shown when the order is paid through credit card. In addition to that,
the Tax-related information section shown only shipping address and not the billing address.

How does it work now?

From this update, the registrar can track learner's addresses from the Order details page. When the payment is made
through credit card, the registrar can view learner's billing address. To view the address, the registrar must:

1. Navigate to Learning > Registrar Desktop > Order History.

2. Search for the order whose payment was done using Credit Card.

3. Click the order number.

4. Under Payment Details, click Address detail to view the learner's address.

Also, under Tax-related information, the registrar can now view learner's shipping and billing address.
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Payment Details

Method Of Payment Transaction 1D Payment Status Amount | Action
Stripe ch_124iutCayLQBnKguLlJusP1Y2 Payment completed 354 USD  JAddress
deta
Order Notes Add Mole

Mo items found

Tax-related information
Shipping address Org_Main_Add1
Aping Org_Main_City, 32432
TX, US
Org_Bill_Add1
|55 S
Bilking adaress Org_Bill_Clty, 343432
TX, Unites States
WAT Mumber

Figure 122: Learner's addresses on Order details page

Both the addresses are driven by Billing Party and Use order contacts addresses for orders even if bill to party is
organization settings under the Orders service.

If Billing Party and Use order contacts addresses for orders even if bill to party is organization settings are disabled,
then the learner's organization address will be shown. If both the settings are enabled, then learner's addresses will be
shown under Payment Details and Tax-related information.

g~ Note: Thisenhancement is actually driven by the GET THE ORDER DETAILS OF A PARTICULAR ORDER
REST API. To know more about the API changes, refer Order details API to return Billing Address and Payment
details.

Use case

This enhancement will improve the usability by passing the order and payment information to tax and CRM systems.

Purchase a class in alternate currency

How did it work?

Prior to this release, only guest users were able to search for the courses that were in different currencies. The currencies
use to be displayed in the dropdown in the header panel next to the Language dropdown list.

How does it work now?

From this update, along with the guest users, the logged-in learner will also be able to view multiple currencies in the
dropdown list based on the Bill to learner itself instead of learner's organization setting. The dropdown list will
display either currencies associated with the learner or the learner's organization. The organization's/learner's most
preferred currency will be selected by default. The changed currency will be applicable only for that session which
means if the user logs in again, the default currency will be displayed in the dropdown. Based on the selected currency;,
the catalog search, catalog details will be displayed in the selected currency. Also, the order will be created in the selected
currency.
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Figure 123: Course price displayed in alterate currency

The learner can then go ahead and buy the course in the available currency.

Use case

This feature helps in making the system truly internationalised since learners are not bound to a single currency and can
purchase classes across the globe using the region specific currency.

Renew active subscription orders

How did it work?

When a user has already subscribed for a subscription order, the subscription order details page still shows the Buy now
button to the user.

How does it work now?

From this update, the Buy now button for already subscribed subscription orders is replaced with the Renew button.
The Renew button will appear even before its expiry. On clicking Renew, follow the same payment flow and renew

your subscription order.
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Figure 124: Renew button on Subscription order details page
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On clicking the course title from the subscription order details page, the Buy now button corresponding to each class
is now replaced with the Enroll button. Similar to the class enrollment flow from the subscription order details page,

the user can enroll for the class directly without redirecting to the payment page, irrespective of whether the Use

subscription as default payment option for learner setting under Subscription is enabled or disabled. While enrolling
for these courses or classes, the learner does not have to pay again because they are part of the subscription and the

learner has already paid for it.
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Figure 125: Enroll button for class

Use case

This feature improves the usability of subscription orders.

Select e-commerce configuration based on domain or microsite

How did it work?
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When a user belonging to domain A and microsite A logged into microsite B, the theme of the microsite B was based
on the user's domain (i.e. domain A) and not of the microsite through which the user actually logged in. However, the
site property configurations were fetched from the logged-in microsite (i.e. microsite B).

Though the payment configuration based on microsite-domain setting, worked for many users. It will be challenging
and confusing for those who were using single URL for all users.

How does it work now?

From this update, the user can choose whether to fetch the entire e-commerce configurations from the microsite associated
with the user's domain, or not. If it's not defined, then the configurations will be pulled from the default microsite. To
support this, a new setting Select ecommerce configuration based on domain has been introduced in Services >
E-Commerce. By default, this setting is enabled. When it is enabled, the microsite level configurations will be fetched
from the microsite associated with the logged-in user's domain.

Settings: E-Commerce

Configure the policy setlings for the service to malch your company’s business processes. Enable or disable associated features

Settings Notifications Description

Select ecommerce configuration based on domain

If this BR is enabled then the following properties will be taken from microsite associated with the used’s  '®
domain instead of the microsite that the user has logged into: Shopping cart, Supported payment types
Payment gateway configuration, tax configuration

Spit Fayment Refund Fnonty
Refund credit card payment first once the order with multiple payments is cancelled

Figure 126: New setting in E-Commerce

When this setting is enabled, the following microsite level configurations are fetched:

« Shopping Cart
» Supported Payment Types
» Site properties

» Payment Configuration

« Paypal Configuration

« Cybersource Configuration
» Stripe Configuration

» Tax Configuration

Use case

The users can now get the best advantage of the Microsite unique choices for payment processing, while still have an
option of using one single URL rather than using multiple microsite URLSs.
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Show learner's preferred currency and shipping address when
billing party is organization

How did it work?

When a learner is aligned to an organization:

» On searching for courses in the catalog, the courses are shown in the organization's currency and not in learner's
currency.

< On purchasing the learning events, the Ship to and Bill to address information is pulled from organization details
and not from learner's profile.

How does it work now?

From this update, the currency and shipping address will be driven by the new settings under Orders service.

Billing Party
Bill to learner itself instead of learners organization.

Show learners preferred currency even if bill to party is organization
Displays learning catalog items in learmer's preferred currency.

Use order contacts addresses for orders even if bill to party is organization

Order contacts billing and main address will be considered for order billing and tax shipping
address. N

Figure 127: New settings in Orders

Show learner's preferred currency even if bill to party is organization setting

By default, this setting is disabled. When this setting is enabled, the learning catalog items will be displayed in learner's
preferred currency. The currencies associated with the learner's organization will still be shown on the Ul, but its
preference will be determined by the learner's preferred currency order. If a learner's currency is not part of the
organization's currency, then it will not appear in the UI.

Use order contacts addresses for orders even if bill to party is organization setting

By default, this setting is disabled. When this setting is enabled, the learner's (order contact's) billing address and main
address will be considered for order's billing and tax shipping address. Also, the billing and shipping address that is sent
for credit card calculation and tax calculation respectively, will be picked from learner's (order contact's) profile.

The above settings will have relevance only when the Billing Party setting is disabled.
Use case
Initially, the billing party could be set to either learner or organization, which was restrictive. With these new settings,

even though the Billing Party is organization, the learner will now view the classes or courses in their preferred currency.
In addition, the learner's profile address information will be pulled into orders.

Set priority for refunds in case of split payment

How did it work?
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If a learner has paid through purchase order and credit card for an order, then on refunding, the amount paid by the
purchase was returned first. The remaining amount paid by the credit card was returned later.

How does it work now?

From this update, the learner has the privilege to choose from which payment type the amount will be refunded first, in
case of split payment. A new setting Split payment refund priority under System > Services > E-commerce has been
introduced.

g Note: This setting is applicable only when the payment is made using purchase order and credit card.

Settings: E-Commerce

Configure the policy settings for the service to match your company’s business processes. Enable or disable associated features

Settings Motifications Description

Domain® tavorld ﬁ,

Select ecommerce configuration based on domain

If this BR 15 enabled then the following properties will be taken from microsite associated with the users  ®
domain instead of the microsite that the user has logged inta: Shopping cart, Supported payment types &
Fayment gateway configuration, tax configuration

Split Payment Refund Prionty
Refund credit card payment first once the onder with multiple payments is cancelled L

Figure 128: New setting in E-Commerce

By default, this setting is disabled. When it is disabled, the amount paid by purchase order will be returned first. When
it is enabled, on canceling the order (by learner or by registrar), the amount paid by credit card will be returned first. In
case the order is rescheduled and any late charges (if applicable) are paid using the credit card, then the first payment
made from that credit card will be returned first.
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Figure 129: Refund message when registrar cancels the order
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Figure 130: Refund message when learner cancels the order

Use case

The admin can now specify the priority for refunding payments in case of split payment.
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Ul indications related to registrations for registrar and learning
admin

How did it work?

When learners are added to the Roster and order is payable or when the external learner could not complete the payment
for a class having price, the order is created with the Payment Initiated state. But when the catalog admin and instructor
admin looks at the Roster, there is no indication that the payment is pending for registration because the registration
status is shown as Registered.

How does it work now?

From this update, the Registration status column in the Roster will display warning icons indicating the current status.
On hovering the icon, it will show the exact registration status of the learner.
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Figure 131: Course price displayed in alterate currency

The newly added indications to the Registration status column are:

1. View Approval Status: Appears only when the manager approval is pending. The warning icon is clickable and
will show the approval chain.

2. Payment pending: Appears only when the payment is pending. The warning icon is not clickable.

3. Payment pending, click to view approval status: Appears when approval and payment is pending. The warning
icon is clickable and will show the current approval status.

Use case

Admins couldn't identify that the payment is pending for a learner and allows the learner to be in the confirmed seat
even though they have not paid. Through this enhancement, the admin will have a clear idea about the exact registration

statuses of each learner.
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How did it work?

Saba Cloud did not support the ability to preview social files formats such as doc, pdf, excel, and plain text.

How does it work now?

This update provides the ability to preview social files that are uploaded to Saba Cloud.
The following file formats are supported for preview:

« WORD - ".doc", ".docx"
e PPT -".ppt", ".pptx"

e PDF - ".pdf"

e EXCEL - ".xls", ".xIsx"

The underlying Document Conversion Server converts these file types to the specified format such as HTML to facilitate
the preview.

To enable the preview feature, the Saba "admin" users must configure the following new set of site-level properties
under Document Conversion:

Table 99: Document Conversion properties

Property Description

Convert Social Files Property to enable or disable DCS conversion of social files.

If set to "true", then DCS converts social files, and resultantly the Preview
feature is available to users.

If set to "false", then DCS does not convert social files, and resultantly
the Preview feature is not available to users.

By default, this property is set to "false"

File content conversion format The file format to which DCS converts the social files. The default format

is HTML.

Height Resolution The height resolution that DCS considers for file conversion.

Width Resolution The width resolution that DCS considers for file conversion.




Document Conversion

Convert Social Files false

DCS converts social files.
File content conversion Format  |HTML

DCS converts document to this Farmat.

Height Resolution 630

DCS considers this height resalution for document canversion.

Width Resolution 430

DCS considers this width resolution for document conversion.

Figure 132: Document conversion site-level properties

Social files can be previewed from the following areas in Saba Cloud:

Activity stream
Global search
Resource detail page
Me tab > Files

Use case

Users need the ability to preview files and get a glimpse of their contents before downloading them.
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How did it work?
There was no provision to attach files in reviews.
How does it work now?

From this update, the user can now attach files, such as award certificates, appreciation emails, and so on in the review.
This will help the rater assess the reviewee in a better way. The user can attach the following file formats:

* Word

o Excel

» PowerPoint

e Email

« Images (.jpeg, .png, .bitmap)
e Zip

A new policy Allow file attachment on review is introduced in the review forms. By default, this policy is not selected.
If this policy is selected, the Attach a file action will appear in the Attachment widget.

Calculation Self o
Method: Manager

[] 2nd Level Manager

[C] Alternate Manager

[] Stakehalder

[] Peers
[] Direct Repaorts

Policies: Supports offline review. @
Review owner can move the review back to draft status from active status. @
Display numeric ratings. @
[C] Allow reviewer or reviewee to add skills when initiating the review.

Allow file attachment on review. @

Figure 133: Allow file attachment on review policy

Once the file is attached, the Attachments section will appear in the review. The user can attach a file only when the
review is in the Open state. All the users associated with the review, will be able to view the attached files.
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Figure 134: Attached documents in the review

The user can also add the attachments using the + Add link in the Attachments section.

Add an attachment x
Title *
File * | Browse... |
| Sawve | | Cance

Figure 135: Add attachment

The user can click the filename and download the file. The user can delete the attachment depending on his/hers role in
the review. Reviewee can delete attachments that are added by self and performance admin/review owner can delete
any attachment. The user will not be able to delete the files if they are in Released and Finalised state.

Use case

The reviewee can now attach files to the review which will help the rater assess the reviewee appropriately.

How did it work?

The audit provision was available only when the overall rating is updated through UI.

How does it work now?

From this update, whenever the overall rating is updated, the action will be captured in auditing. The change review
rating attribute in Services > Performance@Work > Reviews > Actions is set to Esignature reason required. Due
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to this, if the overall rating is updated via Ul, then it becomes mandatory to mention the reason. If it is updated via RDI
and the import is successful, then it will be recorded in the audit trails as per the auditing type set at the component level.

The audit action will capture the previous rating, new rating, username who updated the rating, and the reason.

Audit Trail
Print | Export | Modify Table
Action Timestamp | Previous Value | New Value |Author| Reason
Insert 03212016 - Review Fat Silent
72502 Rose  auditing
Al
Update : 03721/2016 DRAFT ACTME Pat audit
cpatr000000000060130 72514 Rose  with
AM reason
Change Review Rating 0323722016 - 5,00, rdi admin  Silent
1:54:11 testing auditing
Al 22nd
March
Demo
Change Review Rating 03/23/2016 5,00,rditesting 3,00,rdi admin Silent
1:56:42 22nd March testing auditing
A Demao 22nd
March
Dema

| Close |

Figure 136: Audit trail on updating the overall rating

Use case

The admin can now capture the reasons as well on updating the overall rating score in reviews.

Flip boxes in N-box of review calibration to people and

description view

How did it work?

In N-box of review calibration, the user had to click on the count of every box to view the people names.
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Figure 137: Earlier view of N-box

The Expand icon on the top-right corner of the box, expands the box to have a bigger view. The (i) icon flips the box

to the description view.

How does it work now?

From this update, in N-box review caibration, the user can see the people names in all the boxes at once. Navigate to
Admin > Performance > Manage Reviews > Open any activated review > N-box calibration. At the top of the N-box,
see the two new button Description View and People View. The Description View button will show the text in all the
boxes. The (i) icon is now removed. The People View button will show the people names in all the boxes.
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Figure 139: People View

Use case

In the review calibration, when a manager is comparing people in N-box, he/she can use these new buttons to flip between
the description and people views.

New settings for org objective and manager goals in My
plan view

How did it work?

Prior to this release, the org objectives and manager goals were by default displayed in the My Plan view and it was not
governed by any settings.

How does it work now?

In this update, the following three new settings are introduced in Services > Performance@Work > Goals:

1. Manager Goals: If this setting is enabled, the Manager Goals link will appear under Me > My Plan > Goals &
Objectives tab and user will be able to create and align their goals with the manager's goals. If this setting is disabled,
the link will be unavailable on My Plan page.
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2. Org Objectives: If this setting is enabled, the Org objectives link will appear under Me > My Plan > Goals &
Obijectives tab and user will be able to create and align their goals with the organization's objectives. If this setting
is disabled, the link will be unavailable on My Plan page.

3. Default view for Manager's Goals or Org Objectives: If this setting is enabled, the Manager Goals link on the

My Plan page will be highlighted or Org objectives link will be highlighted. The admin can enable this setting,
only if the above two settings are enabled.

By default, the above three settings are enabled.

Settings: Goals €3

Configure the policy settings for the service to match your company’s business processes. Enable or disable associated features.

Sattngs Motifications Components Description

. : o
Domain® wiorkd i

Dafault Visibilty

Default visibiity vsed when creating performance goals. Everyone ¥

Tearn Goal Assagnment Member Linit
Team Goal Assagnment Member Limit i

hanager Goals
mpdoyees can align their goals with their manager's goals and view = on
nager's goals in My Plan view. Off
0rg objectives
Org admins can create objectives and employees can creale goals using '™ on
Org objectives from My Plan view .

|Drefault view for Manager's Goals or Org Objectives

Sedect whether the Manager's Goals or the Org Objectives should be the ® oy
idefault view in ME fab. ¥

Figure 140: New settings in Goals service
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Figure 141: My Plan view

Align this goal
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Goal s
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w | Show filers » Clear fiers

Assignad to Start
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Pat Rose DEE0Z015
Pat Rose 08062015

End

11302015

Qr1Z015

0aBIzs

Figure 142: Align goals view

Use case

The user can now enable or disable the manager goals and org objectives as per their requirement.

People admin and HRBP can access user's plan through

profile quicklinks

How did it work?

Prior to this update, the People admin and HRBP could access the following resources from the Profile Quicklinks

section for the respective user:

* Certifications
e Curricula
e Recurring Courses



« Skills
¢ Enrollments

e Completed Course
« Continuing Educations Status

» Profile Snapshot

How does it work now?
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The People admin and HRBP - Performance can now also access the user's plan i.e., Reviews, Goals, and To-Do List
from the Profile Quicklinks section. These links will appear only when the respective service under System > Services
are enabled. For example, the Reviews link will appear under this section only when the Reviews service under

Performance@Work service is enabled.

Edit Profile Of Jim Connell
Main Contact Informaban Addrass Passwaord Fraferanoos
Tide Select One- 7| 72
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Commen g
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a5l Namae* Cennmll

Full Teme

hale ¥

Profile Quicklinks

Figure 143: Profile Quicklinks

On clicking any of these links, admins will be navigated to its corresponding details page where they can drill down on
each item to know more information.
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Figure 144: Goals page from Profile Quicklinks > Goals

Use case

This feature will allow the People admin and HRBP to access the user's plan items at one place. These quick links will
reduce the number of clicks required to view a user's plan details.

How did it work?
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Prior to this release, there was no provision to print the To-Do List.
How does it work now?

From this update, the user will be able to view and print the To-Do List. The print friendly view will show all the items
of the list. The user must navigate to ME > To-Do List View > <To-Do List Name> > More actions > Print To-Do
List.

My Plan » To-Do List View » 2Do list assigned by Michae

2Do list assigned by Michael A (Pat's Manager)

Due: Thu Nov 26 2015 | Overdue by 145 Day(s)

£ Add itemns  [gP Edit

Approved To-Do List
(4 item/s)

%

Show filters »
lteém Name ltem Due Date Progress Actions

Company Ethics Certif Missed by o Fr—
Certification Version:1.0 10012011

Source : Ethics & Complia
iy Assigned

Figure 145: Print To-Do List option

A popup appears which shows all the items of the list under each section. From this popup, the user can click the Printer
Friendly View icon and print the To-Do List.
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Print To-Do List X

2Do list assigned by Michael A (Pat's Manager)

Pat Rose
Crwmear: Michael Amaya

1 Status: Approved- In-progre:
Type: Ganeral To-Do List

Approved Items
Learning
ltem Hame Item Due Date Progress
Company Ethics Certification Missed by 0%
E Certification “ersion:1.0 10012011
Source | Ethics & Complia
Assigned
Information Security in the Workplace Missed by %
E Certification “ersion:1.0 17202013
Source : Pat Rose, Federa
Assigned
|7  Managing Diversity -
. Web-Based “ersion:1.0 On 1M E2012
Score: 20
[,2  Managing Diversity -
. Web-Based “ersion:1.0 On:0T 002012
Score; 20

Figure 146: Printer friendly view of To-Do List

Use case

The user can now print the To-Do List with detailed information on the items in the list.

Submit newly added To-Do list items for approval

How did it work?

Prior to this update, whenever a user add items to the To-Do List, they use to appear in the Proposed additions tab and
at the same time the notification was sent to the owner or co-owner to approve these items.

How does it work now?

From this update, the approval process has been changed. Now, once the items are added to the To-Do list, the user
needs to notify the owner to approve by clicking More actions > Submit for approval.



| Performance | 383

& Add items  [@F Edit

B Remind approver

Active To-Do List o " =
. Submil fi 8l
(2 itemis) - o
. Agc e
& Close
AT Remove fems
Item Mame Item Due Date  Progress Actions

» Print To-Do List

Final Goal with Save buthor Mizsed by Mark Compisie |-
o 12031201;

Mark Complsie =

Figure 147: Submit for approval action

Once done, a notification will be sent to the owner and co-owner to approve. If the owner or co-owner are not available,
then people admin has the authority to approve the items on their behalf. To do so:

1. Navigate to Admin > People > Manage People > To-Do Lists.
2. Search for the To-Do List which has items in pending approval state.
3. Click the To-Do List name.
4. Click View Pending Approvals.
5. Click Approve to approve the items on behalf of owner/co-owner.
6. Enter comments, username and password so that the audit action is tracked.

y View Pending Approvalis) (4 More actions -

Proposed addition(s)

{4 item/s)

50%
ltem Name ltem Due Date  Progress Actions

Complete New Product Line C - 100 Archive -
(=) Work with engineerning to comy -

Complete TeamTrack Cuality - 100% Archies -
o Each member of Cuality Assur

Figure 148: People admin view for To-Do List
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Use case

The user can send the items for approval when ready through Submit for approval action. People admin can now
approve the To-Do list items on behalf of owner and co-owner.

How did it work?

If a goal is in Pending Approval state and the user's manager gets changed, then the previous manager does not have
the access to approve the goal whereas the new manager has no authority to approve the goal.

How does it work now?

From this update, the user has the ability to update the approval flow so that if the approver has changed, the new owner
will have the ability to approve the goal. To do so, the user has to navigate to the goal which is in Pending Approval
state. Then click Update Approval Flow from the dropdown list corresponding to the Status section. Click the warning
sign next to Status to ensure that the approver is updated.

- Status Edit
| On Hold
Fose Pat

Mark Complete

Update Approval Flow
Due Date: 11102014

View changes
Status: Active-Pending Approval &

Figure 149: Update approval flow menu item

The new manager can approve the goal from the list of pending approval item through MY TEAM > Pending Approval >
Filter by goals > Approve or Reject the goal.

If by any chance the manager is not available to approve the goal, the people admin has the authority to approve the
goal on manager's behalf. To do so:

Navigate to ADMIN > People Admin > Manage People > Goals.

Search for a goal that needs to be approved on behalf of someone.

Click the goal title.

Click Approve Goal in the Status section.

Enter your comments and click Approve.

Enter your username, password, and comments to track the audit action, if auditing is enabled at the component
level. The goal is now approved.

o gk wdhE
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Audit Trail
Print | Export | Modify Table
Action Timestamp | Previous Value | New Value |Authnr|Reason
Insert 11062015 - Goal Fose  Silent
5:41:06 Fat auditing
A
Insert 11062015 - Shared Goal Rose  Silent
5:41:06 Fat auditing
A
Goal 110612015 - emplo000000000001001:PROSE Rose  Silent
Submitted 5:41:15 Fat auditing
for Al
Approval
Approval  11/06/2015 Start Approval  Approval workflow triggered. Rose  Silent
Flow 54115 Chain Fat auditing
action Al
taken
Goal is 042712016 - emplo000000000001048:MKOSTER Rose  Silent
Approved 5:46:19 Fat auditing
AM
Approval 04272016 INITIAL Approved Comment -Approved on Rose  Silent
Flow 54619 behalf of Matt. Fat auditing
action Al
taken
| Cloze |

Figure 150: Audit Trail

Use case

This feature will now allow the end user to resubmit the changes for re-approval to the new approvers.

How did it work?
There was no provision to update the overall rating score for reviews in bulk.
How does it work now?

From this update, the system admin can now update the overall rating score through RDI for active, completed, and
disapproved reviews by navigating to System > Manage Integrations > Integration Studio > Ul Import. The object
name is Review Overall Score. Once the file is imported and processed, the data as mentioned in the file will be updated
in the system.
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Figure 151: Update overall score via RDI

The attributes available in the Excel/CSV file are:

1. REVIEWCYCLE
2. USERNAME

3. OVERALLSCORE
4. AUDIT_REASON

The OVERALLSCORE field supports numeric as well as strings value as an input. If Enable Numeric Rating policy
is disabled, then irrespective of the locale, the first rating scale name that matches with the OVERALLSCORE field
will be considered for overriding the review score.

Use case

The admin can now update the overall rating score in bulk via RDI instead of updating it individually through review
calibration.
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Position word changed to job in Career Planning

How did it work?

In Career Planning, the words position and job were used interchangeably. After introducing the Position Management
functionality, we wanted to ensure that there was no confusion between the two terms.

How does it work now?

In Career Planning, the word position is now changed to job so that there is no confusion while referring to the fields
associated with the Position Management.

Hide fillers =

Sae Recommendalions Tile

Figure 152: Term position changed to job

Use case

The word position is replaced with job so that the confusion between them is eliminated in Position Management.

Job family field on Search by Job popup

How did it work?

In Career Planning, the user could search for a job using only the Title filter while adding or editing a job.

How does it work now?

From this update, a new Job family filter is added on the See all Jobs page. Through this filter, the user can now search
for a job using job family while adding or editing any job. On choosing the job family from the Job family picker, the
search results will display the jobs associated with the job family.
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Figure 153: Job family field

Use case

Job titles are not unique amongst the functional areas. The same job title will be available in different departments, but
with a different skill set. Hence, it is vital to know the job family associated with the job so that the user does not
unknowingkly express an interest in a job for which he/she is not actually interested.

How did it work?

One method that could be used by the user to select a job is searching on the name of a colleague. Upon selecting that
person, the system would cross-reference their job.

How does it work now?

The Search by person functionality is now governed by the new Enable Search By Person as option when adding
a job setting under Succession@Work > Career Planning. By default this setting is enabled.



Settings: Career Planning

Configure the policy settings for the s&race to match your company's business processes. Enable or disable assocmted features.

Settings Motifications Components Deescription

Domain® horkd

Enable Search By Person as option when adding a job
This allows people to find the right next step by searching for the person currently in that job. = On
Off
Save Cance

Figure 154: New setting under Career Planning

When it is enabled, the link will appear and user will able to search for a job by any person. The search will display
people belonging to the user's domain. When it is disabled, the Search by Person link will not appear on the popup

while adding or editing any job.
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Edit job x

Name Job Location

Figure 155: Search by Person to add job

Use case

Some companies have job titles that reflect different levels within a job such as Accountant I, Accountant 11, Accountant
111, etc, for internal purposes. These titles are not made public. Hence, the Search by Person functionality will help the
user to find the right next job by searching for the person currently in that job. This will also suppress the visibility of
others' job levels.

How did it work?

In the career path , the JOB OVERVIEW tab of the selected job displays a detailed information on the job. There was
no provision for the incumbent or their manager to comment on their job details.

How does it work now?

In this update, a new functionality Keys to Success has been introduced. Through this, the incumbent and manager can
add more information, such as certifications and learning items required to accomplish this job or addittional
responsibilities associated with this job and so on. The Keys to Success field is available on the JOB OVERVIEW tab
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of the selected job. This field will be visible only when the corresponding settings are enabled in Admin > System >
Configure System > Services > Succession@Work > Career Planning.

Settings: Career Planning &3

Settings_ldeas_Configure the policy settings for the service to malch your company's business processes. Enable or disable
associated features

Settings Motifications Components Description

Enable Search By Person as option when adding a job
This allows people to find the right next step by searching for the parsan currently in that job .

Keys to Success
Display comments in Career Planning -

Allow incumbents associated with the job to add comments 2

Allow managers associated with the job o add comments

Figure 156: Keys to Success settings

The settings are:

» Display comments in Career Planning: By default, this setting is enabled. When this setting is enabled, in the JOB
OVERVIEW tab, the comments will be displayed under Keys to Success section. These comments are entered by
the people who have the same job title. The comments will be displayed in the JOB OVERVIEW tab of all the jobs
chosen in the career path.

« Allow incumbents associated with the job to add comments: By default, this setting is disabled. When this setting
is disabled, incumbents associated with the selected job, will not be able to add any comments in their paths and in
others' paths. To add any comments in the career paths, ensure that this setting is enabled.

« Allows managers associated with the job to add comments: By default, this setting is enabled. When this setting
is enabled, managers associated with the selected job can comment and share their experiences related to this job.
If this setting is disabled, managers can view others' comments in this section, but will not be able to add their
comments.

The incumbents must navigate to Me > Career Planning > Careers > <path-name> and select the required timeline
tab (current or future job title). Then, click the JOB OVERVIEW tab and scroll down to Keys to Success section to
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add their views and experiences associated with the job. If an other user with the same profile has already commented
on this job, then those comments will appear as read-only. The incumbent can like and unlike any of the existing
comments.

The managers must navigate to My Team > <team-member-name> > Career Planning > <path-name> and select the
required timeline tab (current or future job title). Then, click the JOB OVERVIEW tab and scroll down to the Keys to
Success section to add their views and experiences associated with the job.
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Automation

« Lead & manage the QA test automation teams.

» Work closely with Druva leadership, PMs feature test teams, developers, SDETs and define test
automation requirements, plan and deliver

» Lead and facilitate the team in resolving technical issues, roadblocks etc.

:B. ES{:‘;W and evangelize Agile, Lean, and Continuous Development testing best practices such as TDD
» Manage vendors, contracting engineers. Set the expectations and track the deliverable & quality
» Think through hard problems, and work with a team to make them reality.

» Ramp up the automation function to scale to meet demanding product releases with a focus on
reducing the manual test efforts, increase the automation coverage and improve the quality

« LHilize your hands-on skills while providing leadership and strategic guidance to the teams.

« Aftract, retain and keep motivated top talent pool of automation engineers.

« Set the goals for team leads, mentors and grow the team

Qualifications:

« 10+ years of test automation experience with testing products with the following: Python, Ruby,
Java, .NET, SQL, XML, web services.

« Experience in managing test automation teams including the framework development from scratch.
« Ability to understand complex technical details and work with cross functional group leadership.

« Excellent understanding of COAD technigues including design patterns(nice to have).

« Domain knowledge in any of the two : Cloud, storage, virtualization,and networking.

« Experience with all STLC activities: functional, performance, stress, etc.

« Experience with more than one of the leading open source test automation tools and frameworks
such as Robot,Selenium, Watir /N, Fitness, TestNG, Behave and Cucumber etc. L |
« Knowledge of Agile engineering practices such as test-driven development (TDD), behavioral-driven
development (BDD), and continuous integration.

+ Decisive and ready to do what it takes to get the job done including going back to the design board,

taking the buy in from the key stake holders and bringing the necessary organisational or

technological change.

Keys to Success
Comments from the people who have experienc# in this job

programming, simulation and testing, and start-up assistance. Automation Recrufers works with clhients and
¢ andidates in the avtomation and ¢ ontrols ndustry.
15 minutes ago

« Unlike

l Ben Willis: This position will be responsible for automation and controls systems design, specification,

) You like this.

Yogita Desi: Automation GT offers staff members a compeliing package, which includes competitive base pay and
' bonus opportunities, superior benefits, an outstanding work environment and opportunities for career
development. Through these comprehensive offerings, every individual has the ¢h.._more
12 minutes ago
« Like

[Join the discussion

Figure 157: Keys to Success section
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Use case

The HR admin wants to allow employees to post helpful comments on the job associated with them. These comments
will be helpful to other employees who would be interested in considering that position in the future and get a notion
of things that are needed to be successful. The HR admin may also want managers of the same positions to comment as
well since they will have better success stories. By enabling these setting for Career Planning, employees and their

managers can now post their experiences on jobs.

How did it work?

When a user tries to add a job in the timeframe, if the added job is not in synch or in sequence with the earlier job, then
a popup is shown suggesting the sequence of jobs. The jobs shown in the popup were in plain text.

How does it work now?

From this update, the popup will show the sequence of jobs correctly and the jobs will be hyperlinked. On clicking the
job title, the job will be added to that timeframe.

Note X
s ity ineg Towr Bhis o, o wall bikely nead to hold ore of the sequences of pobs
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ik the jobb il B0 add it n the Timelramae
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Figure 158: Updated popup for showing sequence of jobs

Use case

This enhancement improves the usability of adding jobs to timeframe.

How did it work?

In N-box, the user had to click on the count of every box to view the people names.
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Figure 159: Earlier view of N-box

The Expand icon on the top-right corner of the box, expands the box to have a bigger view. The (i) icon flips the box

to the description view.

How does it work now?

| Talent | 396

From this update, the user can see the people names in all the boxes at once. The two buttons, Description View and
People View have been introduced at the top of the N-box. The Description View button will show the text in all the
boxes. The (i) icon is now removed. The People View button will show the people names in all the boxes.
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Figure 161: People View

This fix is applicable for all the N-box that are accessbile from:

Admin > Talent > Talent dashboard > View Bench
Admin > Talent > Talent Pools > Open any talent pool > Compare N-box

My Team > Talent > Talent Dashboard > View Bench

My Team > Talent > Talent Pools

Use case
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A manager uses N-box functionality to compare between the team members. The manager can now use these new buttons
to flip between the description and people views.

N-box Ul changes

How did it work?

The complete name and job title of the person is not shown in the N-box and gets truncated and displays up to 10
characters including ellipsis.
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Figure 162: Old Ul of N-box comparison
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Figure 163: Old Ul of N-box

How does it work now?

In this update, the character length of the person's name is now increased from 10 to 19 characters including ellipsis.

The character length of the person's job title is now increased from 13 to 22 characters including ellipsis.

N-box comparison

Seasoned professional capable of expanded role, but may
be expenencing problems that require coaching and
mentonng

| Mentor/Coach | Professional

<
el

Sergei Petrov
Salles Director

Aaron Good
Customer Service Re.

Figure 164: New Ul of N-box comparison
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Figure 165: New Ul of N-box

Use case

The N-box must provide an unobstructed view of each plotted person's name. Hence, the box size as well as the number
of characters that appear on the name and job title lines within each box has been increased to make it readable.



Chapter

Topics:

« Additional keywords in offer letter

« Assessment data prefilled when
candidate applies for another job

« Default values in the component
attributes

e Upgraded LinkedIn social
authentication APIs

« New fields on the job requisition
wizard

* Notification triggered when
candidate status is changed to
hired

e Two step job application process
for internal candidates

* Ul enhancements in job
requisition and job offer

e Ul enhancements in the Hiring
Team view

« Ul enhancements
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How did it work?

Prior to this update, only the following keywords can be added to the offer letter:

e Career_Site URL

e Salary

e Reqg_Job

« Req_HiringManager

« Candidate_Name

* Rejection_Reason

e SalaryCurrency

« Req_Title

» ApprovedORRejected_Reason
* Reg_OrganizationName

« Req_EmploymentType

« Req_Description

* Req_No

« HR_Partner

e ApprovedORRejected By
« Req_JobFamily

* Req_Qualification

» Status

How does it work now?

From this update, the hiring manager and recruiting admin can now add the following new keywords in the offer letter:

e Job_Location

e Job_Start Date

e Signon_Bonus_Amount

« Monthly_Recoverable Draw_Amount

e Number_of Months_Recoverable Draw
< Monthly_Nonrecoverable_Draw_Amount
¢ Number_of _Months_Nonrecoverable_Draw
e Options_Offered

* RSU_Offered

« Relocation_Amount

« Additional_Pay_Amount

To add the above keywords in the offer letter, navigate to Admin > Recruiting > Manage Job Offers > Offer Letter
Templates > New Offer Letter Template, select the keyword from the Keywords dropdown list and then click Add.

Use case

The hiring manager or recruiting admin will now be able to use the full fledged offer letter wizard to generate offer
letters for the candidates.
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How did it work?

An assessment can be repeated in multiple job requisitions. Therefore, when a candidate is applying for another job
within the same company, the candidate had to retake the same assessment again.

How does it work now?

The candidate still has to retake the assessment but the assessment data will be now pre-filled with the information added
during the earlier job application process. The candidate can either modify or use the same answers.

g~ Note: If the Assessment version is upgraded, then the assessment will be considered as a new assessment and the
answers will not be pre-filled.

Use case

The candidate does not have to enter the data in the assessment again as it will be pre-filled with the previous data. This
enhancement improves the candidate's experience.

How did it work?

Prior to this update, some attributes in the components of the Recruiting service had the Default Value field but, it was
not editable and for few the field was not available.

How does it work now?

In this update, the Default Value field has been added to the following attributes on their respective components. If the
field was already available for any of the attributes, then the field is now made editable. The system admin can add an
appropriate value in this field and the same will be populated on the UI. For example, if there are some fields which are
set as mandatory on Step 2 of the Job offer wizard, then the default values for those fields need to be provided or else
the user will not be able to save the information on the Step 1.

Attributes on Job Requisition Template:

EEO Job Category

Category Visibility

Company Description

Company Description Visibility

Compensation Displayed to Candidates (Public)
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Attributes on Job Requisition Template:

Compensation Visibility

Default Template

Job Description

Description Visibility

Education Qualification

Type of Employment

Employment Type Visibility

Google Map Widget

HR Partner

HR Partner Visibility

Industry

Industry Visibility

Interviewers Visibility

Job Advertisement Style

Job Ad Style Visibility

Maximum Experience

Max Experience Visibility

Minimum Experience

Min Experience Visibility

Notes

Notes Visibility

Organization

Organization Visibility

Pie Chart SM Visibility

Plain Text SM Visibility

Progress Bar SM Visibility
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Attributes on Job Requisition Template:

Qualification

Qualification Visibility

Recruiter Visibility

Requires Travel

Requires Travel Visibility

Screeners Visibility

Domain

Status

Template Stage Visibility

Template Name

Unpublish Days

Unpublish Days Visibility

End Of Month

Unpublish End Of Month Visibility

Auto-Unpublish

Unpublish Type Visibility

Attributes on Offer Letter Template:

Default Template

Title

Attributes on Job Requisition

Publish to

Approved On

EEO Job Category

Company Description

Compensation Displayed to Candidates (Public)

Cost center
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Attributes on Job Requisition

Job Description

Education Qualification

Type of Employment

Hiring Manager

HR Partner

Industry

Is EEOC Required

Mark the external job posting featured

Mark the internal job posting featured

Job Advertisement Style

Job Family

Job

Location

Compensation Displayed to Candidates (Public)

Maximum Experience

To

Salary (mid)

Minimum Experience

From

Number of Hires

Notes

Published On

Qualifications

Referral Bonus

Referral Bonus Currency

Allow Cover Letter
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Attributes on Job Requisition

Requires Resume

Requires Travel

Salary Currency

Salary

Submitted On

Job Title

Unpublish Days

Auto-Unpublish

Attributes on Job Offer

Additional Pay

Reason for Additional Pay

Agency Currency

Agency Name

Approved On

Offer Comments

Employment Type

Hiring Manager

Requires Incentive Plan?

Is Internal Hire?

Additional Pay Amount

Agency Fee

Monthly Non-recoverable Draw Amount

Monthly Recoverable Draw Amount

Offered Salary

Offer Status

Referral Bonus Amount
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Attributes on Job Offer

Referral Source

Relocation Amount

Sign-on Bonus Amount

Start Date

Location

Internal Mentor

Number of Months Non-recoverable Draw

Number of Months Recoverable Draw

Non-recoverable Draws

Offer Currency

Offer Letter

Offer Letter Template

Options Offered

Pending Visa Approval

Recoverable Draws

Referral Bonus Currency

Referral Source Notes

Is Rehire?

Employee

Rejection Reason

Relocation

Requisition Candidate

RSU

RSU Offered

Sign-on

Reason for Sign-on Bonus
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Attributes on Job Offer

Stock Options

Submitted On

Offer Title

Use case

System admin can now configure the default values of the component attributes in Recruiting.

How did it work?

There was a need to upgrade the LinkedIn Social Authentication APIs to support the latest keys generated by LinkedIn
for authentication.

How does it work now?
The LinkedIn social authentication API keys are now upgraded from socialauth-4.5.jar to socialauth-4.11.jar.
Use case

The candidates will now be able to apply for a job through LinkedIn seamlessly.

How did it work?

The custom fields in the job requisition wizard were used to add additional information.

How does it work now?

From this update, the following fields are now added in the Job Details tab of the job requisition wizard:
e Hire Type: Allows the admin and hiring manager to choose the hire type for the job requisition. The options are:

« Replacement Hire
* New Hire (default value)
e Other

< Employment Classification: Allows the admin and hiring manager to choose the appropriate employee classification
for this job requisition. As per Fair Labor Sandards Act (FLSA), the employees need to be classified as eligible or
ineligible for overtime pay and they can be referred as either being exempt or non exempt based on the Act’s
provisions. The options are:

e Exempt
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* Non Exempt
* Not Mentioned (default value)

« Advanced Settings > Business Justification: Allows the admin and hiring manager to mention the information
related to the need for this job requisition. The character limit of this field is 256.

Hire Typi: New Hire w
Employment Mot Mentioned w
Classification:

& MAdvanced Settings

Compensation
Displayed to
Candidates (Publick

Cost center:

Allow Cover Letter: [ ]

In:[u:l:ry: N |
Type of B
Employment:

Is EEQC Required:

EEQ Job Category: Mot Specified w
Dromain:® wiorld M| L
Company B 7 U 5 = X = B Paagaph ~ FontFamily + FontSizes ~ &

Description:*

Company Description for the Requisition Template

> Words: 6=
usiness ] e — S y—— —
ustification: B I VY 5| F ¥F W B |Paygaph ont Family ont Sizes

P Words: 0

Figure 166: New fields on job requisition wizard

Use case

The most commonly used fields which were earlier added as custom fields will now be available upfront in the job
requisition wizard.
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How did it work?

When a candidate is Hired in the Hiring Team view, the people associated with that requisition were notified. But there
was notification to notify when candidate’s status is changed to Hired.

How does it work now?

In this update, a new notification event Candidate is marked as hired has been added under Services >
Recruiting@Work + Internal Opportunities > Notifications. By default, this notification is enabled. The keywords
associated with this notification are:

e @Recruiting_ReqCandidate_Candidate_Name@

e @Recruiting_ReqCandidate_Candidate_Status@

e @Recruiting_ReqCandidate_City@

e @Recruiting_ReqCandidate_Country@

e @Recruiting_ReqCandidate_Date_Of Birth@

e @Recruiting_ReqCandidate_Executive_Summary@
e @Recruiting_ReqCandidate_First Name@

¢ @Recruiting_ReqCandidate_Home_Phone@

e @Recruiting_ReqCandidate_Last Name@

e @Recruiting_ReqCandidate_Mobile_Phone@

e @Recruiting_ReqCandidate_RegSalaryCurrency@
e @Recruiting_ReqCandidate_Salary Requested@

e @Recruiting_ReqCandidate_Skills@

e @Recruiting_ReqCandidate_Spoken_Language@
e @Recruiting_ReqCandidate_State@

e @Recruiting_ReqCandidate_Zip@

Note: Along with the above keywords, this notification also has keywords from the Candidate Job Offer
Accepted notification.



Notifications: Recruiting@Work + Internal Opportunities €a

Configure the notific ation events: for the service. Notifications alert people to activities, meatings, and other updates and send tinely
reminders when actions must be taken. Creale atiachments for evenis to specify email text and include documenis or other files
Schedule penodic events for a specific time penod. Select the checkbox beside events that you wanl to enable

Settings Matific ations Components Description

12
Events Print | Export | Modify Table
" Enable | Events ] Type ]Desc:iptiun |
v Application acknowledgement  Triggened Event Triggered when a candidate applies for a job. An
acknowledgement mail is sent to the candidate
+ Application acknowledgement  Triggered Event Trggered when a candidate is copied for a job. An
for copied candidate acknowledgement mail is sent to the candidate.
o Auto-Merge Profile For Peniodic Event Auto-Merge Profile For Candidate
Candidate
L Auto-Merge Status Triggered Event  Triggered when Auto-Merge Profile for Candidate is
completed Collects logs, status and sends a mail
e Candidate Assessment Triggered Event Triggered when a candidate has not completed assessment fior
Pending the pobs applied
Candidate Auto Rejection Penodic Event Peniodic notification for auto rejection of ¢ andidate
Event
+ Candidate is deleted Triggered Event Trggered when a candidate is deleted
I Candidate 15 marked as hired Tnﬂered Event Tnggered when a candidate 15 marked as hired |
+ Candidate is marked as Triggered Event Trggered when a candidate is marked as rejected for the job
rejected

Figure 167: Candidate is marked as hired notification event

The system admin can choose the required keywords and draft the message subject accordingly.
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When the candidate's status is changed to Hired in the Hiring team, then this notification will be triggered. An email

will be sent only to the hiring manager and recruiter associated with that requisition, to their mailbox.
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From: skadamisaba.com [rmailto: skadamilsabs.com]
Sent: Friday, April 15, 2016 1:50 PM

To: Sandip Parbatrao <5Parbatrac@5aba.com>
Subject: Sandip Parbatrao is marked hired

AT

has been hired for the test (5485) position in Bombay , Maharastra.
You can visit our portal and apply for more jobs.

powered by Saba Cloud

Figure 168: Candidate marked hired notification email

In addition to this, the admin can configure this notification with Webhook action as well. By doing this, when the
notification is triggered, the information will be transmitted seamlessly into the third party systems like HRIS.

Use case

The system admin can now create a Transmit and Webhook notification for marking the candidate as Hired. As a
Transmit action, a notification will be sent to hiring manager and recruiter. As a Webhook action, the data will be
transmitted to HRIS systems.

Two step job application process for internal candidates

How did it work?

Prior to this update, the job application wizard for internal employees was a 4 step wizard. The certain fields from this
wizard were not required for internal employees as they were redundant.
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Figure 169: Older job application wizard

How does it work now?

The job application wizard for internal employees is now a two step wizard where the internal employee has to only
upload or paste the resume on Step 1 and mention additional details on Step 2 like taking the assessment, adding links
to videos or blogs that will showcase your talent, and your current timezone.

1 gip D Step:

Apply for: Senior Test Engineer (5841)

Upload Resume  Paste Resume

Updoad @ resume in the format Word, POF or plain et

Broiwsa

Figure 170: New job application wizard for internal employees

Use case

The wizard is changed to avoid showing duplicate and redundant information.



| Recruiting | 415

How did it work?
N/A
How does it work now?

In this update, the following Ul enhancements are made in the job requisition and job offer.
Job requisition:

1. The custom fields are now removed from the job requisition template.

2. If HireRight is not enabled in the Marketplace and the recruiting admin clicks 1-9 Dashboard on Manage 1-9
Verifications, then the To activate this functionality, please enable the vendor HireRight in the Marketplace. error
message will be shown to the admin on the UI.

3. The recruiting admin, hiring manager, and recruiter can now delete the job requisition in a Draft state. Navigate to
Recruiting > Admin > Job requisitions > Search for a requisition in Draft state > Actions menu > Delete and
delete the requisition.

prospac @ Enginear Dafaiy Job Diraft San Frarcisco CEUSERS Ihs. thx Ihs thz Wiara
Family Edat
L3 J 1B
Akash Tesd hiring masnages Al Jokes Diraf P HREEFREC Sina Mo [
i
dndroid der Al Jobs Draft vinesd location ggeenafiereyzoshimsdesi o gen S0 g
B

Figure 171: Delete job requisition

4. The recruiting admin and recruiter can now activate a job requisition template if it is in an Inactive state. Navigate
to Recruiting > Admin > Manage Job Requisition Template > Search for a requisition template in Inactive state
> Actions menu > Activate and activate the requisition. Once the job requisition template is activated, it will appear
while creating job requisition.

Job Requisition Templates Mew Job Requisition Template | Print | Export | Modify Table
Template Name Job Job Family Status | Updated On | Default Template | Actions
MNew System Default Termplate QA inactive 2015801720 False g,
20150724045052
AF| TEST JOB TEMPLATE_EDITED AFI TEST AF1 TEST JOBS inackive 20140313 False gz

ENGINEER Activate
QE Intarn tamplate QF Intarns_Job nactive 20150213 False
Activate

Figure 172: Activate job requisition template

5. The recruiting admin can now add approvers in the approval chain of the job requisition at once. The admin now
doesn't need to keep saving the details before adding another approver.

6. When the system rejects the candidate through the auto reject periodic notification, then on the activity stream the
message will be displayed as Candidate John Millers has been auto-rejected for the job requisition Automation
Testing (4772)..
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7. When the recruiting admin and hiring manager selects the Location in the job requisition template, then on the Job
Boards & Services tab, the Location and Salary Type fields gets mapped smartly. It shows the corresponding country
in the Location field and supported salary type in the Salary Type field.

% Your data has been mapped to the data that is required by the above job boards. Is it correct?
Job Family 1234 Administrative ~
Location: Chennai India 2
Salary Type: Yearly Per Year w
Employment Type Contract v
Min Experience Years Associate v

Figure 173: Mapped data on Job Boards & Services tab

Job offer:

1. When the hiring manager sends an offer to a candidate, a notification sent to the candidate now shows the job offer
title instead of job requisition title.

From: <devgal@sabadevgal com™>

Date: Wed, Apr 27, 2016 at 11:09 AM

Subject: Congratulations! You have been offered the job of el weber (1741).
To: nitinmane] 985@ gmail com

A '.

Hi Nitin Mane,

Congratulations! We are pleased to confirm that vou have been selected to work as fechmieal writer (1741).
Please click here to view the detailed offer letter and to indicate vour acceptance of this offer.

Smeerely,
Pat Fose

powerad by Saba Cloud

Figure 174: Job offer notification sent to candidate

2. In the Job offer wizard > Candidate Information tab, a new Others option has been added under the Referral
Source field for internal candidates. The recruiting admin or hiring manager can click this option when the internal
candidate is referred by resource other than Employee.



| Recruiting | 417

Candidate Information

First Name: Sheetal Kadam
Last Name: Person
Address:

Address 2:

City:

State/Province:
Zip Code:
Country:

Home Phone:

Email:

Background Check New Screening View status
Is Internal Hire? (-

Is Rehire? ]

Referral Source: Employee

Figure 175: Job offer wizard

Use case

These enhancements improve the usability of job requisition and job offer.

How did it work?

Prior to this update, the following issues were seen on the Hiring Team view:

1. On the Interested tab, the default sorting is Percent Fit.
2. The Hiring Recommendations portlet is shown blank to the interviewer.



3.
4.
5.
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The Mark Hired action is not shown on the Candidate details view.

Need Share this button to share the job on any social networking site other than the ones mentioned in the portlet.
On the My Interviews portlet, the interview time is displayed correctly i.e., in candidate's time zone but, in the
detailed view, the time zone is displayed in the hiring managers time zone.

How does it work now?

In this update, the following changes are done for the Hiring Team view:

1.
2. The Hiring Recommendations portlet is now hidden for the interviewer.

3.

4. The Share this button is now added in the Share this Job on Social Networking Sites portlet so the hiring team

5.

On the Interested tab, the default sorting will be by Interested status instead of Percent Fit.
The Mark Hired action is now available in the Actions dropdown list on the Candidate details page.

member can share the job on any social networking site.
On the My Interviews portlet, the interview time in the detailed view is now displayed in candidate's time zone.

Use case

N/A.

How did it work?

N/A

How does it work now?

In this update, the following Ul changes are made:

1.

The How did you find us? field will be now shown only to external candidates and not internal candidates.
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Figure 176: Internal candidate job application wizard
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The character limit of Experience and Skills widget on the Job Requisition Summary and Job Ad Preview screen

has been increased from 7 to 50 characters.
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Required Experience

Administration

Co-ordination among teams

Required Skills

Communication Skills

Leadership

Team Handling

Figure 177: Experience & Skills widget

3. The New Job Requisition button is now shown in the My Job Requisitions portlet on the Home page.

g~ Note: This button will appear only for those users, who have the privilege to create requisitions.

= My Job Requisitions *

New Job Requisition

Title Role
MM_Test_25 Hiring Manager, Recruiter
Test_MM_1 Hiring Manager, Recruiter
Avery strange job requisit... Hiring Manager, Recruiter
test_MM_01 Hiring Manager, Recruiter

D01_ST_TEST MEX_ DONT A Hiring Manager, Recruiter
Displaying 1to 5 of 148

Figure 178: My Job Requisitions portlet

4. The icons for the internal and referral candidates on the Hiring Team view have been updated.
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Mihir Tathavadekar « Candidate #1 » 1 month ago « Via Career Site .1
[ New

0 0 0 Schedule
% MATCH RATINGS COMMENTS INTERVIEW
&7  View candidate details Not Rated Mare actions = | Mark interested-med.__ |

« Candidate 22 . 4 weeks 8go « Via Career Sie ..]
r_

John Doe

0 0 0 Schedule
% MATCH RATINGS COMMENTS  INTERVIEW
2 | view candidate details Not Rated More actions ~ [ Make offer |

Figure 179: My Job Requisitions portlet

Use case

These enhancements improve the usability.
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How did it work?

Prior to this update, the compensation letters with Active status can be marked as Completed.

How does it work now?

In this update, a new status Approved has been added to the plan cycle so that once all the manager worksheets are
approved, the plan cycle will be moved from Active state to Approved state. Compensation admin can publish letters
to the manager only if the plan is in Approved state. Once it is published, the compensation admin can release the letter

to the employee.

v

Plan Activation
Comp Admin “cancels”
I i
' gt

: _._.-----":q_ v

Al workshests One worksheet _a o¥
reopened e

approved P

Approved )

)
%\
=0
k=1

Comp Admin “completes”

plan cycle

Completed

b

Figure 180: Compensation plan cycle

Once the plan cycle is approved, the compensation admin can mark the plan as completed. Hence, the Close Plan option
is now renamed to Complete Plan Cycle.
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Status
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Name

PH 2016 03 24 Approved Test

Compensation Plan Cycle

| status
Approved

Start Date ==

@ Allocation Due Date >= |

@ Allocation Start Date == |

[@ Domain

| Start Date
25-MAR-2016

E&a&

.l
Q&
Search

Add a New Flan Cycle | Print | Export
End Date '
24-MAR-201T7

| Actions

view Plan Cycle
Add New Employee
Remoye Emiployes
Complete Plan Cycle

=14 E ¥

Figure 181: Complete the approved plan cycle

Use case

The plan cycle will now moved to Approved state only if the manager worksheets are in Approved state and only then
the compensation letters will be published to the manager.

Compensation letter enhancements

How did it work?

Prior to this update:

1. Under Manage Letters > Letter Templates, there was provision to upload letter templates.
2. Under Manage Letters > Generate Letters, there was provision to create new compensation letters.

COMPEnIIGn Homg
Pian Cyies
Conlgeraton

Lniter Beemplaton

[ cenoras Letiers |
Tod Semegs

Compensation Letter Template

Samch
Maimi

Esamphe Templale
PH cusiom cumency Seid lemplate

Esampde Tempiale 2

Cruated On Craated By Actisns
AR08 User Cne 7a
02018 Usar One 78
DPEE01E Uisar Cne 78

Figure 182: Old view of Letter Templates
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New Compensation Letter

Lsher Mg

Status Draft

Select Lesier Template -

Select Data Sounce -

Append Name to File & Fran Cycle cner @

SpltFiles Indraidual & Bulk  Wax Bakh o
Apply Sort

Save

Carcel

Figure 183: Compensation letter creation view

How does it work now?

In this update, the letter templates and compensation letter feature is combined into one so under Manage Letters >
Compensation Letters, user can download the sample letter template, change it as per the requirement and upload the

same while creating a new compensation letter.

o Note: There is no seperate provision of uploading the letter templates.

I T
Pian Syt :
' Compensation Letters
Conlguraton
TRI el Leter Kame Plan Cycie Saatus Created By Croated On
Tusk Degiribe foe Cirall Supat Ligar I-RMAR-2018
PH U Homte ) Lemer Teat 2 PR 2010 02 02 Bk . Publnihd Banr Ligar FFEB-2018

wd Corinin

wa Db

Figure 184: Manage Letters > Compensation Letters

In the Create New Letter view, the Letter Template field is changed where the user will navigate to add the letter

template. The Select Data Source label is changed to Plan Cycle.
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Figure 185: Create New Letter view

Once the information is added and generated, the Letter Generation Progress section appears which will show the
generation progress and the Download button to download the generated letter. The rest of the functionality like publishing
to manager > releasing to candidate remains the same.

Use case

The improved compensation letter creation and generation process is simplified for compensation admins.

How did it work?

The user's profile page shows all the compensation statement and the letters. There was a need to choose whether to
show or hide these under the Profile page.

How does it work now?

From this update, the admin can choose whether to show or hide the compensation statements and letters from employees
and managers. To do this, the following new settings have been introduced in Admin > Configure System > Services
> Compensation@Work > Settings:

« Hide Compensation Statements - If this setting is enabled, then the entire Compensation Statements section under
the user's Profile page will not be displayed. By default, this setting is disabled.

« Hide Compensation Letters - If this setting is enabled, then the entire Compensation Letters section under the
user's Profile page will not be displayed. By default, this setting is disabled. If it is disabled and the compensation
letter is not released to the employee, then the Compensation Letters have not been Released to Employees. Are you
sure you want to close the Plan? warning message will be shown on the Close Plan step of the plan cycle wizard.
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Settings: Compensation@Work €3

Configure the policy settings for the service to match your company’s business processes. Enable or disable associated features.

Settings Motifications Components Description

. . . -
Domain \world .|

Parson compeansation leter cathing policy
MWumber of hours to cache compensation letier before forcing refresh.

Hide Compenszation Statements
Hide Compensation Statements

® of
Hide Compensation Letiers
Hide Compensation Letters on
8 e
Yt

Save Cancel

Figure 186: New settings to hide compensation statements and letters

Based on the selection of settings, the compensation statements and letters will be shown or hidden in the employee's
Profile page.

Compensation Statement
Yoar Actions
07 1S =
2016 ="
L 1=
2014 1 ‘_3
Compensation Letters
Yar Lethir Mafmé Actiond
2018 Later Ralease Coamp Lener Plan ._-_~I cha -
2016 CompLetier Plan Release Emp_Comp Letier Pl <%
2016 PH 2016 04 20 Lemar 05_PH 2016 04 14 Dama -
L

Figure 187: Compensation statements and letters on employee's Profile page
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Use case

The compensation admin has now greater control to determine whether to use compensation statements or letters for
their process or not. Hence, the compensation admin can now show or hide the statements and letters from employees
and managers to avoid any confusion.

How did it work?

The compensation admin could take a snapshot of people profile only during the plan creation process via Import Data
> Create New Snapshot.

How does it work now?

From this update, the compensation admin can now also take a people snapshot before creating the compensation plan.
The admin can navigate to Configuration > People Snapshots and click Create New Snapshot. The snapshot is created
with the current date and time stamp. Once the snapshot is created, its details will be shown on the People Snapshot
page. If any snapshot creation fails, an icon to download the error log will appear in the Actions column.

COTE Ao Heoim

Pian Cycies People Snapshot
Configuration a Niw 50
[i%10] Ho of Uiars  Stalus £ mimsnly Actions
AP 611 A i #i P

10:-AFFR-2018 1157 Al 41 Surcess ]

NCNEase Cusdeings
R0 Tempadte Diearaioe TR-APR-J0NE dd Al o Faled D

Figure 188: People Snapshot

The compensation admin can use these snapshots while creating the compensation plan in Import Data > People
Snapshot. By default, the latest snapshot will be selected in the People Snapshot field, but the admin has the privilege
to choose another, if required.
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Figure 189: People Snapshot

Use case

The compensation admin can now create a snapshot before and use the same in the compensation plan.

Usage of manager hierarchy snapshot

How did it work?

During the plan creation if a snapshot is taken through Import Data > People Snapshot, then the manager from the
snapshot is accountable for the activities related to the plan. However, if the manager is changed after taking the snapshot,
then the new manager is considered for managing the plan activities.

How does it work now?

From this update, the manager from the snapshot will perform the activities that are needed once the plan cycle is created.
Some of the activities are:

« Distributing budget to managers
» Owning the worksheet containing employees
 Identifying the managers at each level

Use case

After taking the snapshot if the user's manager is changed, then the snapshot manager will manage the plan activities.
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How did it work?

There was a need to improvise the Budget distribution page.

How does it work now?

The following changes are done on the plan cycle wizard and the budget distribution process:

1. The Assign Budget step in the New Plan Cycle wizard is now moved to the plan cycle level instead of component
level. This means that if a plan cycle has two or more components, then on the Assign Budget step, the settings will
be selected only once and they will be applicable to all the components. These settings will then determine how the
budget will be distributed for every component.

2. The manager at the 1st level can distribute the budget as follows:

« If the level 1 manager selects the Distribute budget to direct reports who are managers option, only Level 2
managers will be displayed. If the Level 2 managers do not have any eligible employees, then that manager will
not be displayed in the list. If the Level 2 managers have any eligible employees, his/her's name appear in the
list and they can distribute the assigned budget accordingly. The Level 2 managers have to allocate all the funds
that are assigned.

« If the level 1 manager selects the Distribute budget to direct and indirect reports who are managers option,
then only those managers will be displayed who have eligible employees for budget distribution and plan creation.

3. Ifthere is only one component, then the Back button is disabled so that manager doesn't go to first step. But, if there
are more than one components, then the Back button is enabled from the second component onwards.

Busdget Distribution X

Pran Mame  Compeansa tion Budget for 2016

a th Jl a

Managers Currency Doistribautecn Guide Alccate

Fal Rose

=

Figure 190: Budget distribution by 1st level manager

4. The Direct Reports link will appear in the Manager's worksheet only if the higher level manager has selected
Distribute budget to direct and indirect reports who are managers on the Budget Distribution screen.

5. If the compensation admin distributes the funds directly to all the managers, then a Senior Manager with no eligible
direct reports will not be able to access their own plan worksheet, but they can view plan worksheets for their direct
and indirect reports who are managers with eligible reports.

6. If the compensation admin has selected any level in <Level> managers in the organization chart and the Manager
can distribute budget checkbox on the Assign Budget step, then:

a. Ifamanager is a Senior Manager, then the status of the manager plan's worksheet will be in Pending Distribution
status. Once the second step of the wizard is completed, then the Plan Worksheet status changes to Allocation
in Progress.
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b. If a manager is not a Senior Manager, then the direct manager will be in charge. Hence, the status of the plan's
worksheet will be in Allocation in Progress status.

If a Senior Manager with no eligible direct reports manually distributes the budget to direct and indirect reports,
then he/she can access the manager plan's worksheet from My Team > Compensation.
On the first step of the distribution wizard the labels are corrected.
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Figure 191:
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proceeds. The distributing manager cannot have any funds left in Funds Assigned. The Allocate button is enabled.
But the Senior Manager cannot proceed until Funds Assigned matches with Funds Allocated. An error is shown

on the popup.
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Figure 192: Error when funds are not allocated completely

10. The amounts

displayed in the manager's distribution budget flow, Funds Assigned, Funds Allocated, and Distribution

Guide are truncated to the number of digits selected in the Budget Scale field of the component.

Use case

Compensation admins can choose whether or not to allow their managers to re-distribute budgets, but their decision
applies to all the plan components identically. The updated processes ensure consistency in handling of budgets,

distribution, and allocation.
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